AcqKnowledge Software Guide

For Life Science Research Applications

Data Acquisition and Analysis with BIOPAC MP Systems on PC running Windows® or Macintosh®

(Windows 98/98SE/2000/ME/XP)
AcqKnowledge Software Guide

Reference Manual Version 3.7.5 for
MP Hardware/Firmware and AcqKnowledge® Software

Versions
Macintosh®, PowerMac®
Windows® 98/98SE/2000/ME/XP

BIOPAC Systems, Inc.
42 Aero Camino, Santa Barbara, CA 93117
(805) 685-0066, FAX (805) 685-0067
Web Site: http://www.biopac.com
# TABLE OF CONTENTS

INDEX ................................................................................................................................. 291

PREFACE TO ACQKNOWLEDGE SOFTWARE GUIDE .............................................. 7
Welcome .............................................................................................................................. 7
What’s new for AcqKnowledge 3.7 … ................................................................................. 8
Using this Manual ............................................................................................................. 12
User Support System ...................................................................................................... 13
Where do I find help? … .................................................................................................. 14
Human Anatomy & Physiology Society Position Statement on Animal Use ..................... 16

PART A — GETTING STARTED ...................................................................................... 17

Chapter 1 Introduction to MP Systems ........................................................................... 17
Unpacking ........................................................................................................................ 18
MP System Requirements ............................................................................................... 19
MP System Features ...................................................................................................... 21
Application Features ..................................................................................................... 24
MP System Application Notes ...................................................................................... 25

Chapter 2 Working in AcqKnowledge .......................................................................... 27
Launching the AcqKnowledge software ......................................................................... 28
Acquisition ...................................................................................................................... 29
  Setting up channels ....................................................................................................... 30
  Setting up acquisitions ................................................................................................. 31
  Starting an acquisition ................................................................................................. 32
Display modes ................................................................................................................ 33
Toolbars .......................................................................................................................... 35
Analysis .......................................................................................................................... 36
Selecting a waveform ..................................................................................................... 39
Hide a Channel .............................................................................................................. 39
Zoom ............................................................................................................................... 39
Selecting an area ............................................................................................................ 39
Transforming data ......................................................................................................... 40
Measurements ............................................................................................................... 40
Markers .......................................................................................................................... 41
Grids ............................................................................................................................... 41
Journals .......................................................................................................................... 42
Saving data ...................................................................................................................... 43
Printing ............................................................................................................................ 43

PART B — ACQUISITION FUNCTIONS: THE MP MENU ......................................... 45
Acquisitions .................................................................................................................... 46

Chapter 3 Setup Channels ............................................................................................. 47
Setup Channels – The Basics ........................................................................................ 47
Setup Channels – Advanced ......................................................................................... 51
Chapter 4  Setup Acquisition .............................................................................................................. 78
  Setup Acquisition – The Basics ........................................................................................................ 78
  Setup Acquisition – Advanced ........................................................................................................... 84

Chapter 5  Setup Triggering ................................................................................................................. 90
  Digital Triggers ................................................................................................................................. 90
  Analog Triggers ................................................................................................................................. 92

Chapter 6  Setup Stimulator .................................................................................................................. 93
  Square waves .................................................................................................................................. 95
  Tone Stimuli ..................................................................................................................................... 96
  Ramp Waves ...................................................................................................................................... 97
  Arbitrary Waveforms ......................................................................................................................... 98

Chapter 7  Other MP Menu Commands ............................................................................................... 103
  Show Input Values ............................................................................................................................. 103
  Sound Feedback ................................................................................................................................. 106
  Manual Control ................................................................................................................................ 109
  Autoplot and Scroll ............................................................................................................................ 110
  Warn on Overwrite ............................................................................................................................ 111
  Organize Channel Presets (MP150 only) ......................................................................................... 111
  Select Network Adapter (MP150 only) ............................................................................................ 113
  MP150 Serial Number (MP150 only) ............................................................................................... 113
  About MP .......................................................................................................................................... 114

PART C — ANALYSIS FUNCTIONS .................................................................................................. 115
  Keyboard shortcuts ............................................................................................................................ 116
  Right Mouse Shortcuts — Windows® only ....................................................................................... 117
  Contextual Menu — Macintosh only ................................................................................................. 117
  Toolbars ............................................................................................................................................ 118

Chapter 8  Editing and Analysis Features ............................................................................................ 119
  Using the scroll bars ........................................................................................................................... 119
  Changing the scale .............................................................................................................................. 120
  Selecting a waveform / channel ......................................................................................................... 122
  Channel Labels ................................................................................................................................. 122
  Hide a channel ................................................................................................................................. 123
  Cursor Tools ...................................................................................................................................... 123
  Measurements .................................................................................................................................... 124
    Measurement Definitions ................................................................................................................... 129
  Markers ............................................................................................................................................. 139
  Grids on the PC ................................................................................................................................. 140
  Grids on the Macintosh ...................................................................................................................... 145

Chapter 9  File menu commands .......................................................................................................... 149
  New .................................................................................................................................................. 149
  Open .................................................................................................................................................. 150
  Close .................................................................................................................................................. 153
  Save .................................................................................................................................................. 153
  Save As ............................................................................................................................................. 154
  Print ................................................................................................................................................... 157
  Printer setup (PC) / Page Setup (Mac) .............................................................................................. 157
  Exit (PC) / Quit (Mac) ....................................................................................................................... 157
  Preferences — Macintosh only .......................................................................................................... 157

AcqKnowledge Software Guide
Chapter 10  Edit menu commands
Undo / Can’t undo .................................................................159
Cut ....................................................................................159
Copy .................................................................................160
Paste ................................................................................160
Clear / Clear all ................................................................160
Select All ..........................................................................160
Insert waveform ..............................................................162
Duplicate waveform .........................................................162
Remove waveform............................................................162
Clipboard ..........................................................................162
Journal ..............................................................................163

Chapter 11  Transform menu commands ......................................................165
Digital Filtering .................................................................166
  FIR Filters .......................................................................170
  IIR Filters .......................................................................173
Math Functions .................................................................175
Template Functions ..........................................................178
Integral .............................................................................182
Derivative .........................................................................182
Integrate ..........................................................................183
Smoothing ........................................................................183
Difference ........................................................................184
Histogram .........................................................................185
Resample ...........................................................................186
Equation Generator (Expression) .................................................187
Waveform Math .................................................................189
FFT Fast Fourier Transformation .................................................191
Find Peak (Peak Detector) .......................................................197
  Data-driven Mode ...........................................................199
  User-defined Interval Mode ..............................................200
  Off-line Averaging ..........................................................201
Find Next Peak ..................................................................203
Find All Peaks ....................................................................203
Find Rate ...........................................................................208
  Fixed threshold / Auto threshold detect ..........................209
  Remove baseline and Auto threshold detect mode ..........210
  Find Rate Dialog Settings ...............................................210

Chapter 12  Display menu commands............................................................214
Autoscale waveforms ........................................................216
Overlap waveforms ..........................................................216
Compare waveforms ........................................................216
Autoscale horizontal ..........................................................217
Zoom Forward / Back .........................................................217
Reset chart display ............................................................217
Reset Grid — Macintosh only ..............................................218
Adjust Grid Spacing — Macintosh only ...............................218
Set wave positions ...........................................................218
Wave color ........................................................................219
Horizontal axis ..................................................................219
Show ...............................................................................221
Statistics ..........................................................................223
Preferences .......................................................................224
Set Font — PC only ............................................................227
Welcome

Welcome to the AcqKnowledge Software Guide. The MP System is a complete data acquisition system that includes both hardware and software for the acquisition and analysis of life-science data. You can use the MP System for data acquisition, analysis, storage, and retrieval.

AcqKnowledge software not only makes data collection easier, but also allows you to perform analyses quickly and easily that are impossible on a chart recorder. You can edit data, cut and paste sections of data, perform mathematical and statistical transformations, and copy data to other applications (such as a drawing program or spreadsheet).

The MP System can operate on either a Macintosh® or a PC with Windows® (including notebooks). The MPWS system is designed to run on Macintosh® computers running System 7 or better (PowerMac native). The MPWSW system is designed to operate with PC compatibles running Windows®.

Running in the Macintosh® or Windows® environment, AcqKnowledge uses the familiar point-and-click interface common to all Macintosh® and Windows® applications. Complex tasks such as digital filtering or fast Fourier transformations are now as easy as choosing a menu item or clicking your mouse.

This manual covers use of AcqKnowledge software with an MP System and details BIOPAC equipment available for a variety of applications. If the application you desire is not addressed, just visit the BIOPAC web site at http://www.biopac.com to download one of our many Application Notes, or call to request a hard copy.

See also:

- BIOPAC Installation Guide
  (shipped with the software CD)

- BIOPAC Hardware Guide.pdf
  (provides details on MP System modules, transducers, electrodes, etc., and setup and calibration)

- BIOPAC Research Catalog
What’s new for AcqKnowledge 3.7 …

- AcqKnowledge 3.7 runs with the MP100 or MP150 (high-speed) acquisition unit.
- USB and Ethernet options — view and control systems across a network, work outside your lab!
- Variable sample rates
  For analog and calculation channel inputs and stimulator output — record signals with unique sample rates and maximize storage efficiency. The Variable Sampling Rate feature allows different channels of data to be down-sampled from the acquisition sampling rate. Choosing lower sampling rates for signals where meaningful data falls below the Nyquist frequency of the acquisition sampling rate allows more data to be stored in memory or on disk. See pages 30, 31, and 93.
- Calculation channel presets
  For simplified setup and application-specific analysis. Presets are like “templates” that establish parameters, including channel-specific settings, for a broad range of analysis functions. They can be used as is or customized for a specific series or protocol—for example, human vs. small animal or stationary vs. exercising measurements. See page 48.
- Pause/Append when recording to disk
  Data can now be appended when acquiring to disk. You can also append to existing files—just open them, change the storage mode to “Append to Disk” and Start the acquisition. See page 79.
- Off-line Averaging Control Channel
  Average data in one channel, synchronized by another channel. Perform sophisticated averaging protocols (e.g. ERP studies, P300) when the synchronizing channels record the timing of different stimulus types. The SuperLab® system presents images and/or sounds during an experiment and simultaneously outputs digital pulses—use the digital channels to identify when different stimuli are presented. Use the Control Channel to identify when the pulse (image or sound) was presented. The Off-line Averaging function provides the average response to different types of stimuli. See page 201.

Visit the online support center at www.biopac.com
• **Peak detection features**
  New options for % of peak, mean, tracking threshold reference. *See page 197.*

• **Measurement Validation**
  You can validate measurements with the `ValidateMeasurements.acq` sample file that was included with the software. Pay attention to the “*Sample data file*” section of the measurement definitions that begin on page 129, and where included, note which sample points to use for validation (i.e., use the first four sample points in the validation file to validate the Correlate measurement).

• **Display measurements as a graph.**
  Find Peak includes an option to “Display measurements as graph.” As each measurement is calculated, the results are displayed as a new graph channel. This function provides a powerful way to summarize large data files for further analysis. *See page 202.*

• **Quick Start template series** — These ready-to-run experiments include all settings for specific applications...just open the graph template file and click on Start. **Quick Start** template files were installed to the Samples folder. *See page 150.*

<table>
<thead>
<tr>
<th>Quick Start Application</th>
<th>Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>Biomechanics</td>
<td>Gait Analysis, Range of Motion</td>
</tr>
<tr>
<td>Cardiovascular Hemodynamics</td>
<td>Noninvasive Cardiac Output Measurement, ECG Analysis, On-line Analysis Blood Pressure, Blood Flow, LVP</td>
</tr>
<tr>
<td>EBI Electrical Bioimpedance</td>
<td>Cardiac Output</td>
</tr>
<tr>
<td>ECG</td>
<td>On-line ECG Analysis, Einthoven’s Triangle &amp; 6-lead ECG, 12-lead ECG Recordings, Heart Sounds</td>
</tr>
<tr>
<td>EEG</td>
<td>Real-time EEG Filtering, Evoked Responses, Event-related Potentials</td>
</tr>
<tr>
<td>EMG</td>
<td>Integrated (RMS) EMG, EMG and Force</td>
</tr>
<tr>
<td>EOG</td>
<td>Nystagmus Investigation, Saccadic Eye Movements</td>
</tr>
<tr>
<td>Exercise Physiology</td>
<td>Respiratory Exchange Ratio, Noninvasive Cardiac Output</td>
</tr>
<tr>
<td>In vitro Pharmacology</td>
<td>Tissue Bath Monitoring, Pulsatile Tissue Studies, Langendorff &amp; Working Heart Preparations, Isolated Lung Studies</td>
</tr>
<tr>
<td>NIBP</td>
<td>Psychophysiology</td>
</tr>
<tr>
<td>Plethysmography</td>
<td>Indirect Blood Pressure Recordings</td>
</tr>
<tr>
<td>Pulmonary Function</td>
<td>Animal Studies, Lung Volume Measurement</td>
</tr>
<tr>
<td>Psychophysiology</td>
<td>Autonomic Nervous System Studies, Sexual Arousal Studies</td>
</tr>
<tr>
<td>Remote Monitoring</td>
<td>Biomechanics Measurements</td>
</tr>
<tr>
<td>Sleep Studies</td>
<td>Real-time EEG Filtering, Multiple-channel Sleep Recording, On-line ECG Analysis, SpO₂ Analysis</td>
</tr>
</tbody>
</table>

• **Template Save/Open utility**
  Establish the software settings required for your experiment, and then save the file as a Graph Template. Next time anyone needs to perform the experiment, they can just open the template file and click Start. *See pages 150 (open) and 156 (save as).*

• **Customizable Grid options** help you optimize the display and print features. *See page 42.*

• **Sound feature**
  Generate an audio signal as a function of data values from any channel collected using *AcqKnowledge*. Volume level and frequency range are user controllable. *See pages 103-106.*
• **Channel identification system** highlights the active channel.

• **Marker summary to journal** option pastes all marker text to the journal. *See page 139.*

• **Sample rate mouse-over** shows the sample rates for the channel and the acquisition.

• **Measurement result display** mouse-overs show the full result precision and units.

• **Tool-tip mouse-overs** provide helpful hints…just move the cursor over a display feature to generate a descriptive tag.

• **Digital User Support System** — Real-time System Manual, Hardware Guide, Sample Files, etc.

• **Menu customization** *New to Macintosh*
  Configure the AcqKnowledge menus by turning off unnecessary items and saving the revisions. Application menu customization has a corresponding effect on contextual menus.

• **Paste marker summary to journal** *New to Macintosh*
  When “Paste Summary to Journal” is selected from the marker popup menu, the Index, Time (axis info) and Label for all markers in the entire graph will be pasted to the Journal.

• **Zoom restoration** *New to Macintosh*
  Repeat Zoom selections without limitation until another Zoom function is performed. Functional for the Zoom tool, Autoscaling, and the Tile, Overlap, and Compare Waveform options.

• **New Keyboard Shortcuts** *New to Macintosh*
  Command “T” = Autoplot (toggles), Command “-” = Zoom back, Command “+” = Zoom forward

• **PC File Compatibility** *Macintosh only*
  Open and create PC-compatible Graph (*.acq) and Graph Template (*.gtl) files. Variable sampling rate information and hardware settings are retained, and read/write PC Journal files.

• **Calculation Measurement Improvements** *Macintosh only*
  Calculation measurements can be based on any other measurement and can include other Calculation measurements as operands.

• **Interpolated Measurements on Down-sampled Channels** *Macintosh only*
  On a down-sampled channel, the cursor can fall on a point between physical samples. In such cases, some measurements will display interpolated values (using linear interpolation).

• **Multiple File > Open Selection** *Macintosh only*
  Open multiple graph files in a single dialog by holding down the Shift key and selecting multiple files. The Command-A key combination will “Select All” files in the dialog.

• **Balloon Help** *Macintosh only*
  Balloon Help is an online assistance feature to help novice users learn how to use AcqKnowledge. “Balloons” will be generated describing the software functionality of the item under the mouse. (MP100 and MP150, not supported on OS X.)

• **Contextual Menus** *Macintosh only*
  When the Contextual Menu Manager is installed (usually on Mac OS 8.1 and above), the graph window has contextual menus (similar to right-click functionality on the PC) for Waveforms, Measurements, Marker, and Scroll. Control-click to access these menus.

• **Mac OS X Support** *Macintosh only*
  AcqKnowledge 3.7 can run under Mac OS X 10.0.4, the latest operating system available from Apple. Running under OS X allows AcqKnowledge to take advantage of advanced memory and multi-tasking capabilities provide a stable, responsive platform for advanced signal acquisition.

Visit the online support center at www.biopac.com
• **Appearance Manager Compliance Macintosh only**
  The AcqKnowledge 3.7 user interface uses the Appearance Manager, which provides a System 8 Apple Platinum appearance throughout the program (grayscale 3D and grayscale outline), except when run under OS X native, which provides a blue translucent Aqua appearance. Measurement menus are tinted to match the color of the corresponding waveform.

• **Help**
  You can get on-line, searchable help from the Help menu (located under the Apple 🍎 menu on a Macintosh). You can open the BIOPAC Support documents while you are running AcqKnowledge. If you have an active web browser, you can easily access Application Notes from the BIOPAC web site.
Using this Manual

The AcqKnowledge Software Guide is divided into four parts:

Part A Getting Started
You should look through Getting Started whether you’re new to computer-based data acquisition systems or an old hand at physiological monitoring. Use this section to acquaint yourself with how the system works and the most frequently used features.

Part B Acquisition Functions
Explains data acquisition features and gives a detailed summary of different acquisition parameters. Provides an in-depth description of the commands used to determine acquisition rate, acquisition duration, and specialized functions such as triggering, averaging, and on-line calculation of different values.

Part C Analysis Functions
Details information on analysis features; covers the range of post-acquisition analysis functions and transformations available with the MP System. Describes how to edit data, take measurements and perform basic file management options (save, print, etc).

Part D Appendices
Answers frequently asked questions, offers hints for working with files, includes information on upgrading from previous versions, provides technical information about the MP System and other information about the AcqKnowledge software.

See also:

BIOPAC Installation Guide
This guide was included with the software CD. It tells you how to install the hardware and software, and how to be up and running with the MP System in just a few minutes.

Hardware Guide
BIOPAC MP Hardware Guide.pdf gives practical examples of how the MP acquisition unit is used with different components for common types of data acquisition, and includes sample results and applications for widely used test procedures. Provides instructions for connecting external devices to the MP System (electrodes, transducers, amplifiers, and so forth).

Visit the online support center at www.biopac.com
User Support System

User Support System files can be found on your hard drive under C: Program Files/BIOPAC Systems, Inc/AcqKnowledge 3.7/User Support Systems.

-- AcqKnowledge Software Guide.pdf is the software support document

-- BIOPAC MP Hardware Guide.pdf is the hardware guide (with specifications)

The User Support files can also be opened directly from the CD.

The files are in PDF format, and can be read by Adobe Acrobat Reader.

• If you don't currently have Adobe Acrobat Reader, you can download it for FREE at www.adobe.com under the Adobe Acrobat Reader site.

The Samples folder in the BIOPAC program folder contains sample files and, for PC users, graph template Quick Start files for a variety of applications. Quick Start templates establish the channel setup and acquisition parameters required for a variety of applications.

• To open sample files, choose File>Open then Browse to the BIOPAC Samples folder.

• To open a graph template Quick Start file, choose File>Open then Browse to the BIOPAC Samples folder and change “Files of type” to “Graph Template” and then select the desired file.

![Files of type:](image)
Where do I find help?

On-line, searchable help is available while you are running the AcqKnowledge software. Just click on the Help menu (located under the Apple menu on a Macintosh). You can open BIOPAC User Support documents while you are running AcqKnowledge. If you have an active web browser, you can easily access Application Notes from the BIOPAC web site.

The Introductory sections of the manual will provide you with enough information to get up and running with the MP System, and familiarize you with some basic AcqKnowledge functions. There are far more features than described in the first few pages, so here is a guide for how to continue using this manual.

- **Acquiring data**
  
  For more specific information on different types of acquisitions, see Part B — Acquisition Functions. It covers basic acquisition parameters in detail, and describes some acquisition features (such as peak detection techniques and on-line Calculation channels) not covered in the Getting Started section.

- **AcqKnowledge**
  
  Information about how to edit, display and transform data can be found in Part C — Analysis Functions. It explains how to import and export data, how to save files, and other file management commands. This section also explains how to use all of the post-acquisition features of the AcqKnowledge software.

- **Connecting input devices**
  
  To find out how specific modules connect to the MP acquisition unit, turn to the BIOPAC MP Hardware Guide PDF file. This section describes how to connect signal-conditioning modules to the MP acquisition unit and how to connect electrodes and transducers to the modules.

- **Working with large files**
  
  Many users need to perform high speed (i.e., fast sampling rates) or long duration acquisitions. These types of acquisitions tend to generate large (several megabytes) data files that can be difficult to load, store, and view. The MP System can handle such acquisitions — see Appendices A and C for information on how to optimize your setup for these types of acquisitions.

- **Troubleshooting**
  
  Includes a list of the most frequently asked questions regarding the MP System. Check this section (Appendix A) for commonly encountered problems and solutions.

- **Application Notes**
  
  If you need information about an application not covered in this manual, visit the BIOPAC web site at [http://www.biopac.com](http://www.biopac.com) to review more than 50 available Application Notes. Download the Application Note you need, or call to request a hard copy.
IMPORTANT SAFETY NOTICE

BIOPAC Systems, Inc. instrumentation is designed for educational and research-oriented life science investigations. BIOPAC Systems, Inc. does not condone the use of its instruments for clinical medical applications. Instruments, components, and accessories provided by BIOPAC Systems, Inc. are not intended for the diagnosis, mitigation, treatment, cure, or prevention of disease.

The MP acquisition unit is an electrically isolated data acquisition system, designed for biophysical measurements.

Exercise extreme caution when applying electrodes and taking bioelectric measurements while using the MP System with other external equipment that also uses electrodes or transducers that may make electrical contact with the Subject. Always assume that currents can flow between any electrodes or electrical contact points.

Extreme caution is also required when performing general stimulation (electrical or otherwise) on a subject. Stimulation currents should not be allowed to pass through the heart. Keep stimulation electrodes far from the heart and located close together on the same side of the subject’s body.

It is very important (in case of equipment failure) that significant currents are not allowed to pass through the heart. If electrocautery or defibrillation equipment is used, it is recommended that you disconnect the BIOPAC Systems, Inc. instrumentation from the Subject.
Human Anatomy & Physiology Society Position Statement on Animal Use

Adopted July 28, 1995

It is the position of the Human Anatomy and Physiology Society that dissection and the manipulation of animal tissues and organs are essential elements in scientific investigation and introduce students to the excitement and challenge of their future careers.

The Human Anatomy and Physiology Society (HAPS) is a national organization of science educators dedicated to the task of providing instruction of the highest quality in human anatomy and physiology. A fundamental tenet of science is the ordered process of inquiry requiring careful and thoughtful observation by the investigator. As subdivisions of biology, both anatomy and physiology share a long history of careful and detailed examination, exploration and critical inquiry into the structure and function of the animal body. Consistent with the origins and nature of scientific inquiry, HAPS endorses the use of animals as essential to the laboratory experiences in both human anatomy and human physiology.

Historically, the principal tool of investigation in anatomy has been dissection. A properly directed dissection experience goes beyond naming structures and leads the student to conclusions and insights about the nature and relatedness of living organisms that are not otherwise possible. To succeed in their future careers, students must become thoroughly familiar with anatomical structures, their design features and their relationships to one another. Dissection is based on observational and kinesthetic learning that instills a recognition and appreciation for the three-dimensional structure of the animal body, the interconnections between organs and organ systems, and the uniqueness of biological material. While anatomical models, interactive computer programs, and multimedia materials may enhance the dissection experience, they should not be considered as equivalent alternatives or substitutes for whole animal dissection.

HAPS supports the use of biological specimens for anatomical study provided their use is in strict compliance with federal legislation and the guidelines of the National Institutes of Health and the United States Department of Agriculture and that such use fulfills clearly defined educational objectives.

Physiology experiments involving live animals provide an excellent opportunity to learn the basic elements specific to scientific investigation and experimentation. It is here that students pose questions, propose hypotheses, develop technical skills, collect data, and analyze results. It is here that they learn to remain focused on the details of procedure and technique that may influence the outcome of the experiment and the responses of the animal. When faced with unexpected and even erroneous results, students develop and improve their critical thinking and problem solving skills.

Computer simulations and video programs are useful tools that help students acquire a basic understanding of physiologic principles. However, due to the inherent variability and unpredictable nature of biological responses, such programs fail to fully depict the uniqueness of living organisms and should not be viewed as equivalent alternatives or substitutes for live animal experiments. HAPS supports the use of biological specimens in physiology experiments provided their use is in strict compliance with federal legislation and the guidelines of the National Institutes of Health and the United States Department of Agriculture and that such use fulfills clearly defined educational objectives.

Science educators have in common a respect and reverence for the natural world and therefore have a responsibility to share this with their students. They must communicate the importance of a serious approach to the study of anatomy and physiology. HAPS contends that science educators should retain responsibility for making decisions regarding the educational uses of animals. Furthermore, it opposes any legislation that would erode the educator's role in decision making or restrict dissection and animal experimentation in biology.

Used with permission of: The Human Anatomy and Physiology Society (HAPS)
222 South Meramec, Suite 203, St. Louis, MO 63105
1-800-448-HAPS

Visit the online support center at www.biopac.com
Part A — Getting Started

Chapter 1  Introduction to MP Systems

Part A - Getting Started covers the basics of data acquisition and analysis with an MP System. All of the material in this section is covered in more detail in subsequent sections (see Using this Manual).

Overview

The MP System is a computer-based data acquisition system that performs many of the same functions as a chart recorder or other data viewing device, but is superior to such devices in that it transcends the physical limits commonly encountered (such as paper width or speed). Data collection generally involves taking incoming signals (usually analog) and sending them to the computer, where they are (a) displayed on the screen and (b) stored in the computer’s memory (or on the hard disk). These signals can then be stored for future examination, much as a word processor stores a document or a statistics program saves a data file. Graphical and numerical representations of the data can also be produced for use with other programs.

There are two MP Systems available—MP150A or MP100A—with the following distinctions:

<table>
<thead>
<tr>
<th>Function</th>
<th>MP150A</th>
<th>MP100A</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aggregate Sample Rate</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Internal MP Buffer:</td>
<td>400kHz</td>
<td>70kHz</td>
</tr>
<tr>
<td>To Cpt. Memory or Disk:</td>
<td>400kHz</td>
<td>16kHz</td>
</tr>
<tr>
<td>Internal Buffer Size:</td>
<td>6M bytes</td>
<td>16k bytes</td>
</tr>
<tr>
<td>A/D Converter Signal/Noise Ratio:</td>
<td>86 dB typical</td>
<td>90 dB typical</td>
</tr>
<tr>
<td>D/A Resolution:</td>
<td>16 bits</td>
<td>12 bits</td>
</tr>
<tr>
<td>D/A Output rate:</td>
<td>Independent of A/D rate</td>
<td>Synchronous with A/D rate</td>
</tr>
<tr>
<td>Communication to Computer:</td>
<td>Ethernet (10 base T, UDP and DLC Type II)</td>
<td>USB</td>
</tr>
</tbody>
</table>

The MP System can be used on a Macintosh® or on a PC with Windows®. The system utilizes the same hardware, excepting the computer interface. The software has the same “look and feel” on both the Macintosh® and the PC.

➢ For the Macintosh®, the system is referred to as “MPWS”
➢ For PC with Windows®, the system is referred to as “MPWSW”

Your MP System consists of several major components, including hardware and software. The AcqKnowledge software included with your system allows you to edit your data and control the way it appears on the screen, and performs four general functions:

(a) Control the data acquisition process;
(b) Perform real-time calculations (such as digital filtering and rate detection);
(c) Perform post-acquisition transformations (such as FFT’s and math functions);
(d) Handle file management commands (saving, printing, and the like).

The heart of the MP System is the MP data acquisition unit, which takes incoming signals and converts them into digital signals that can be processed with your computer. The MP acquisition unit connects via:

➢ Macintosh® — Ethernet (for MP150A) or USB (for MP100A)
➢ PCs running Windows — Ethernet (for MP150A) or USB (for MP100A)
The system also includes a Universal Interface Module (UIM100A) for connecting external devices to the MP acquisition unit. Connect chart recorders, pre-amplified signals, and digital signals such as those from triggers or event counters/recorders. The UIM100A connects to the front of the MP acquisition unit via two cables (Analog and Digital). As a rule, both cables should be connected. The connectors for each of the two cables are different, so there is only one way the UIM100A can be connected to the MP acquisition unit.

A wall transformer is included with the MP System to convert AC mains power into DC power suitable for system operation and safety.

**Unpacking**

Please confirm that your MP System was delivered with one of each of the following items:

<table>
<thead>
<tr>
<th>MPWS for the Macintosh®</th>
<th>MPWSW for PC with Windows®</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>MP System acquisition unit</strong></td>
<td><strong>MP System acquisition unit</strong></td>
</tr>
<tr>
<td>➢ MP100A or MP150A</td>
<td>➢ MP100A or MP150A</td>
</tr>
<tr>
<td>Universal Interface Module (UIM100A)</td>
<td>Universal Interface Module (UIM100C)</td>
</tr>
<tr>
<td>MP100A only: 25-pin female to 25-pin female cable (0.6 meter)</td>
<td>MP100A only: 25-pin female to 25-pin female cable (0.6 meter)</td>
</tr>
<tr>
<td>MP100A only: 37-pin female to 37-pin female cable (0.6 meter)</td>
<td>MP100A only: 37-pin female to 37-pin female cable (0.6 meter)</td>
</tr>
<tr>
<td>DC wall adapter</td>
<td>DC wall adapter</td>
</tr>
<tr>
<td>MP100: 12 VDC @ 1 Amp (120 or 240 V)</td>
<td>MP100: 12 VDC @ 1 Amp (120 or 240 V)</td>
</tr>
<tr>
<td>MP150: 12 VDC @ 2 Amp (120 or 240 V)</td>
<td>MP150: 12 VDC @ 2 Amp (120 or 240 V)</td>
</tr>
<tr>
<td>MP150A: ETHSW1 Ethernet switch and two Ethernet cables</td>
<td>MP150A: ETHSW1 Ethernet switch and two Ethernet cables</td>
</tr>
<tr>
<td>MP100A: USB1M Mac USB adapter</td>
<td>MP100A: USB1W PC USB adapter</td>
</tr>
<tr>
<td>AcqKnowledge software CD (v3.7) with License Agreement and Registration Card</td>
<td>AcqKnowledge software CD (v3.7) with License Agreement and Registration Card</td>
</tr>
</tbody>
</table>

When you have unpacked and are ready to install your MP System, refer to the “BIOPAC Installation Guide” that was packaged with your software.
**MP System Requirements**

MP System requirements for Macintosh® and for PC with Windows® are outlined in the table below. Recommendations are included to optimize system performance; more memory and a faster system will allow the MP System to perform better.

<table>
<thead>
<tr>
<th>MPWS for the Macintosh®</th>
<th>MPWSW for PC with Windows®</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>You need</strong></td>
<td><strong>You need</strong></td>
</tr>
<tr>
<td>System 8.6 or higher</td>
<td>Windows</td>
</tr>
<tr>
<td>Any Macintosh capable of running System 8.6</td>
<td>Desktop PC capable of running Windows</td>
</tr>
<tr>
<td>A mouse or other pointing device</td>
<td>A mouse or other pointing device</td>
</tr>
<tr>
<td>MP150A operation: Ethernet port</td>
<td>MP150A operation: Ethernet port</td>
</tr>
<tr>
<td>MP100A operation: USB port</td>
<td>MP100A operation: USB port</td>
</tr>
<tr>
<td>About 64 MB of disk space to store the MP System software (AcqKnowledge)</td>
<td>About 64 MB of disk space to store the MP System software (AcqKnowledge)</td>
</tr>
<tr>
<td><strong>Also recommended</strong></td>
<td><strong>Also recommended</strong></td>
</tr>
<tr>
<td>64 MB RAM or better</td>
<td>64 MB RAM or better</td>
</tr>
<tr>
<td>A color monitor</td>
<td>A color monitor</td>
</tr>
<tr>
<td>PowerPC G3 (or higher)</td>
<td>CPU with at least a 128 MHz clock speed</td>
</tr>
<tr>
<td>64 Mbytes of hard disk space</td>
<td>64 Mbytes hard disk space</td>
</tr>
<tr>
<td></td>
<td>A math coprocessor (for 80386-based machines)</td>
</tr>
</tbody>
</table>

**Disk Space**

With any program, you will need disk space to store your data files. Although AcqKnowledge (the MP System software) saves files in a format as compact as possible, it is not uncommon for some users to generate data files on the order of several megabytes. If you are planning to acquire data for long periods (more than a few hours) and/or you are sampling at relatively fast rates (more than 1,000 samples per second), you should have as much available disk space as possible (or have access to a removable storage device). See Appendix B for hints on working with large files.

**Appearance Manager Compliance**

The AcqKnowledge 3.7 user interface uses the Appearance Manager, which provides a System 8 Apple Platinum appearance (grayscale 3D and grayscale outline) throughout the program, except when run under OS X native, which provides a blue translucent Aqua appearance. Measurement menus are tinted to match the color of the corresponding waveform.
Mac OS X Support

*AcqKnowledge 3.7* can run under Mac OS X 10.0.4, the latest operating system available from Apple. Running under OS X allows *AcqKnowledge* to take advantage of advanced memory and multi-tasking capabilities provide a stable, responsive platform for advanced signal acquisition.

For OS X, the minimum recommended memory is 256 Mb and the minimum recommended processing speed is 500Mhz G4. If higher acquisition rates or lower latencies are needed, Mac OS 9 is recommended.

*AcqKnowledge 3.7* runs natively under OS X and takes full advantage of the advanced look and feel of the Aqua interface. It also takes advantage of the improved memory features of Mac OS X, which improve performance and reduce “Out of memory” errors —even eliminates them on some systems.

Under OS X, you can create PDF files by choosing “Print” and then clicking “Preview.”

**Software Limitations**

- OS X does not support Balloon Help.

**MP100 Keyspan Limitations**

- Apple provides only limited serial support, and since the MP100 uses a serial USB interface, it cannot take advantage of all of the advanced features of OS X (such as the Aqua user interface and advanced multi-tasking).

- The MP100 can run with Keyspan hardware only if the Mac OS X Beta Keyspan Drivers are not installed.

**MP150 DLC Limitations**

- An administrator password is required in order to access the Ethernet network under OS X. Without an administrator password, *AcqKnowledge 3.7* can only be used in the “No Hardware” mode for data analysis.
**MP System Features**

In conjunction with your computer, the MP System is a complete system for acquiring almost any form of continuous data, whether digital or analog. The MP System can perform a range of recording tasks, from high-speed acquisitions to long duration acquisitions. Generally speaking, for physiological applications, the MP System is limited only by the speed of your computer and the available memory or disk space.

Features of the MP System include:

**Easy to use**

The MP System offers the same convenient and easy-to-use features which Macintosh® and Windows® users are accustomed to. Since the MP System software runs under these environments, you can run other applications while you are collecting data. In terms of hardware setup the MP System uses simple plug-in connectors and standard interface cables.

*You don’t need a degree in electronics to set up your system!*

**Flexible**

The MP System can be configured for a wide variety of applications, from single channel applications to multiple-device (up to 16 analog and 16 digital) measurements. You control the length of acquisition, the rate at which data is collected, how data is stored, and more...all with a few clicks of the mouse button. Whether you’re measuring alpha waves or collecting zoological data, the MP System can meet your needs.

**Menu flexibility**

You can easily customize menu displays to show only the functions you are using, thereby reducing the risk of error or confusion in your lab. This function is extremely powerful for laboratories working to GLP guidelines. It is also useful for teaching applications where instructors can hide unnecessary menu items. *See Appendix D — Customizing Menu Functionality.*

**High Speed Sampling**

Sample rates up to 400 KHz aggregate (MP150), 70 KHz aggregate (MP100)

**Variable Sample Rates**

Apply different sample rates between channels.

**Distinct stimulator rate**

With the MP150, you can operate the STM100C stimulator at a different rate than the acquisition sample rate.

**View & Control Multiple MP150 units**

View and control multiple MP150 units over a local area network (LAN).

**Calculation Channel Presets**

Customize your recording for specific measurements.

**Template files**

*AcqKnowledge* “Quick Start” templates are available for over 40 applications. Just open the template file and start the acquisition—appropriate settings are established for the selected application.

**On-line Calculation**

Although the MP System provides an extensive array of measurements and transformations you can apply to collected data, sometimes you need to perform computations *while* data is being collected. The on-line Calculation functions allow you to calculate new channels based on incoming signals. This feature allows you to compute BPM, for instance, based on raw ECG data.

**On-line filtering**

Many times, it is preferable to filter data as it is being collected, rather than having to wait until after the fact, so now you can apply filters to incoming data and view the results in real time. That means on-line monitoring of data filtered to suit your needs.
**On-line measurements**
The MP System can instantly compute over a dozen measurements and computations for any given data point(s). These options are available from pull-down menus and include mean, peak-to-peak, value, standard deviation, frequency, and BPM.

**Measurement Validation**
You can validate measurements with the `ValidateMeasurements.acq` sample file that was included with the software. The measurement definitions (page 129) include measurement formulas and “Sample data file” explanations.

**Preview your data**
Similar to chart recorders, the MP System allows you to change both the vertical scale and the horizontal scale. You can change the amplitude scale or the time scale to any value you wish, or you can have the MP System automatically scale them for you.

**Replace (or augment) a chart recorder**
Whether you want to replace a chart recorder or simply supplement an existing setup, the MP System is fully compatible with most major recording devices. What’s more, the MP System is compatible with most popular input devices, so you can continue using the same transducers, electrodes and sensors.

**Simplified editing**
It used to be that once your data was collected, the only way to edit it was with scissors and adhesive tape. Now you can delete unimportant sections of your data with a keystroke. You can “paste” together sections from different waves, or simply edit out noise spikes from individual waves.

**Append mode**
For some applications, data only needs to be recorded during some portions of a long experiment. AcqKnowledge has an “Append” mode that lets you pause the acquisition for as long as you wish, and resume the acquisition as many times as needed. In this mode, you can start and stop a recording as you would with a chart recorder. Appending data saves on storage space and processing time for transformations.

**Digital filtering**
All data contains measurement error and noise. Now you can reduce or eliminate that error by using the digital filters and smoothing transformations included in the MP System. You can smooth data across any number of samples, or filter out noise from any frequency or bandwidth you wish.

**Digital Output**
You can control external devices when an input or calculation channel meets trigger conditions you specify. Use the Control channels to output a pulse when the signal on an analog channel falls above or below a given threshold.

**X/Y plotting**
You can view and acquire data in the form of an X/Y plot, with one channel on the horizontal axis and another on the vertical axis. This allows you to explore relationships between different channels and opens up a whole range of applications, from chaos plots to respiration analysis to vectorcardiograms.

**Histogram function**
You can easily examine the variability and the measures of central tendency of any waveform data with the histogram function. Set the plotting options to suit or let the software determine the “best fit” for graphing your data.

**Math functions**
In many cases, simply collecting raw data is not enough. AcqKnowledge has an array of built in mathematical functions ranging from simple absolute value to computation of integrals, derivatives, and operations involving multiple waveforms (such as subtracting one wave from another). You can even chain multiple functions together to form complex equations.

Visit the online support center at [www.biopac.com](http://www.biopac.com)
**Annotation**

*AcqKnowledge* has a Journal you can use to append comments concerning your input data, either on-line or after the fact. This is especially useful for noting the characteristics of an acquisition (what was involved, what manipulations took place, and the like) for future reference.

**Triggering**

If you need to measure response times or start data collection only after some event has occurred, the MP System allows you to trigger an acquisition in a number of different ways. You can trigger on the level of a signal, or with an external synchronizing trigger.

**Event marker**

Many times, especially during a long acquisition or in a laboratory setting, it is useful to make a note of when specific events occurred so that these events (such as when a manipulation occurred) can be recorded and any changes in the data can be noted. The marker function allows you to insert symbols in the record and add text for each marker. These can be added either while data is being collected or after the fact.

**File compatibility**

You can save your data in a number of different formats. Save data to a word processor program like Microsoft Word®, spreadsheet software like Microsoft Excel®, a drawing program such as Aldus Intellidraw®, or a desktop publishing program like Aldus PageMaker®. You can output your data in either text or graphical form, and *AcqKnowledge* can even read-in raw data from a text file.

**Pattern recognition**

Using an advanced pattern search/recognition algorithm, the MP System can automatically find a specific pattern within waveforms. This is useful for finding abnormal waveforms (such as irregular ECG waves) within a data file.

**Peak detection**

*AcqKnowledge* has a built in algorithm to find either positive or negative peaks from any size data file. You can even search for all the peaks with one command and automatically log statistics like peak time and area to the journal.

**Printing**

The MP System provides a range of printing options, and allows you to fit your data on one page or many. You can also print several graphs per page, even if you only have one-channel recordings. Since the MP System runs on the Macintosh or under Windows, no special printer drivers are required.

**User support**

Whether you have a question about compatibility with your existing equipment or you need to develop a specialized measurement device, BIOPAC’s Applications Department can address the problem.
Application Features

Use your MP System with AcqKnowledge software for a wide array of applications, such as:

- Active Electrodes
- Allergies
- Amplitude Histogram
- Anaerobic Threshold
- Animal studies
- Auditory Evoked Response (AER)
- Automatic Acquisition Protocols
- Automated Data Analysis
- Automatic Data Reduction
- Autonomic Nervous System Studies
- Biomechanics Measurements
- Blood Flow / Blood Pressure / Blood Volume
- Body Composition Analysis
- Breath-By-Breath Respiratory Gas Analysis
- Cardiac Output
- Cardiology Research
- Cell Transport
- Cerebral Blood Flow
- Chaos Plots
- Common Interface Connections
- Connect to MP Systems
- Control Pumps and Valves
- Cross- and Auto-correlation
- Current Clamping
- Defibrillation & Electrocautery
- Dividing EEG into Specific Epochs
- ECG Analysis
- ECG Recordings, 12-Lead
- ECG Recordings, 6-Lead
- EEG Spectral Analysis
- Einthoven’s Triangle
- EMG and Force
- EMG Power Spectrum Analysis
- End-tidal CO2
- Epilepsy Counting
- Ergonomics Evaluation
- Event-related Potentials
- Evoked Response
- Exercise Physiology
- External equipment, controlling
- Extra-cellular Spike Recording
- Facial EMG
- FFT & Histograms
- FFT for Frequency Analysis
- Field Potential Measurements
- Fine Wire EMG
- Forced Expiratory Flow & Volume
- Gait Analysis
- Gastric Myoelectric Activity
- Gastric Slow Wave Propagation
- Gastrointestinal Motility Analysis
- Hardware Flexibility
- Heart Rate Variability
- Heart Sounds
- Histogram Analysis
- Imaging Equipment, Interfacing
- Indirect Blood Pressure Recordings
- Integrated (RMS) EMG
- Interface with Existing Equipment
- Interface with Third-party transducer
- Invasive Electrode Measurements
- Ion-selective Micro-electrode Interfacing
- Iontophoresis
- Irritants & Inflammation
- Isolated Inputs & Outputs
- Isolated Lung Studies
- Isometric Contraction
- Isotonic Contraction
- Jewett Sequence
- Langendorf Heart Preparations
- Laser Doppler Flowmetry
- Left Cardiac Work
- Long-term Monitoring
- Lung Volume Measurement
- LVP
- Median & Mean Frequency Analysis
- Micro-electrode signal amplification
- Migrating Myoelectric Complex
- Motor Unit Action Potential
- Movement Analysis
- MRI Applications
- Multi-Channel Sleep Recording
- Nerve Conduction Studies
- Neurology Research
- Noninvasive Cardiac Output
- Noninvasive Electrode Measurements
- Nystagmus Investigation
- Oculomotor Research
- Off-line ECG Averaging
- On-line Analysis
- On-line ECG Analysis
- Orthostatic Testing
- Peripheral Blood Flow
- Peristaltic (Slow Wave) Propagation
- Planted Tissue
- Pressure Volume Loops
- Psychophysiology
- Pulsatile Tissue Studies
- Pulse Rate Measurement
- Pulse Transit Time
- Range of Motion
- Real-time EEG Filtering
- Real-time EEG Filtering
- Recurrent Patterns
- Regional Blood Flow
- Relative BP Measurement
- Remote Monitoring
- Respiratory Monitoring
- Respiratory Exchange Ratio
- Rheumatology
- Saccadic Eye Movements
- Sexual Arousal Studies
- Signal Averaging
- Simultaneous Monitoring
- Single Channel Analysis
- Single-fiber EMG
- Software-controlled Stimulator
- Somatosensory Evoked Response
- Spectral Analysis
- Spike Counting
- SpO2 Analysis
- Stand Alone Amplifiers
- Standard Operating Procedures
- Startle Eye Blink Tests
- Startle Response
- Stimulator, software-controlled
- Systemic Vascular Resistance
- Template Analysis
- Tissue Bath Monitoring
- Tissue Conductance Measurement
- Tissue Magnitude & Phase Modeling
- Tissue Resistance & Reactance
- Using Chamber Measurements
- Ventricular Late Potentials
- Vestibular Function
- Video Capture, Synchronous
- Visual Attention
- Visual Evoked Response
- VO2 Consumption
- Volume/Flow Loop Relationships
- Working Heart Preparations

See Appendix G on page 246 for basic descriptions of these Application Features.

Visit the online support center at www.biopac.com
**MP System Application Notes**

BIOPAC has prepared a wide variety of application notes as a useful source of information concerning certain operations and procedures. The notes are static pages that provide detailed technical information about either a product or application. A partial list of Application Notes follows.

You can view or print application notes directly from the “Support” section of the BIOPAC web site [www.biopac.com](http://www.biopac.com).

<table>
<thead>
<tr>
<th>APP NOTE</th>
<th>Application</th>
</tr>
</thead>
<tbody>
<tr>
<td>#AH101</td>
<td>Transducer Calibration and Signal Re-Scaling</td>
</tr>
<tr>
<td>#AH102</td>
<td>Biopotential Amplifier Testing w/ CBLCAL</td>
</tr>
<tr>
<td>#AH103</td>
<td>Remote Monitoring System (TEL100C)</td>
</tr>
<tr>
<td>#AS105</td>
<td>Auditory Brainstem Response (ABR) Testing</td>
</tr>
<tr>
<td>#AS105b</td>
<td>ABR Testing for Jewett Sequence</td>
</tr>
<tr>
<td>#AS108</td>
<td>Data Reduction of Large Files</td>
</tr>
<tr>
<td>#AS109</td>
<td>3-, 6-, and 12-Lead ECG</td>
</tr>
<tr>
<td>#AH110</td>
<td>Amplifier Baseline (Offset) Adjustment</td>
</tr>
<tr>
<td>#AS111</td>
<td>Nerve Conduction Velocity</td>
</tr>
<tr>
<td>#AH114</td>
<td>TSD107A* Pneumotach Transducer</td>
</tr>
<tr>
<td>#AH114b</td>
<td>TSD107B* Pneumotach Transducer</td>
</tr>
<tr>
<td>#AS115</td>
<td>Hemodynamic Measurements — Part I</td>
</tr>
<tr>
<td>#AS116</td>
<td>Hemodynamic Measurements — Part II</td>
</tr>
<tr>
<td>#AS117</td>
<td>Pulse Transit Time and Velocity Calculation</td>
</tr>
<tr>
<td>#AS118</td>
<td>EMG Signal Analysis</td>
</tr>
<tr>
<td>#AS119</td>
<td>EMG Power Spectrum Analysis</td>
</tr>
<tr>
<td>#AS120</td>
<td>X/Y Loop Area Analysis</td>
</tr>
<tr>
<td>#AS121</td>
<td>Waveform Data Reduction</td>
</tr>
<tr>
<td>#AS122</td>
<td>Power Spectrum Analysis</td>
</tr>
<tr>
<td>#AH125</td>
<td>Pulse Oximeter Module Operation</td>
</tr>
<tr>
<td>#AH127</td>
<td>Precision Force Transducers</td>
</tr>
<tr>
<td>#AH128</td>
<td>Active Electrode Specifications and Usage</td>
</tr>
<tr>
<td>#AS129</td>
<td>Heart Rate Variability</td>
</tr>
</tbody>
</table>

continues…
<table>
<thead>
<tr>
<th>APP NOTE</th>
<th>Application</th>
</tr>
</thead>
<tbody>
<tr>
<td>#AH130</td>
<td>Blood Pressure Measurement</td>
</tr>
<tr>
<td>#AS131</td>
<td>Averaging Mode</td>
</tr>
<tr>
<td>#AH132</td>
<td>TSD105A Variable Force Transducer</td>
</tr>
<tr>
<td>#AH135</td>
<td>TSD117 Pneumotach Transducer</td>
</tr>
<tr>
<td>#AH136</td>
<td>BAT100 Instructions</td>
</tr>
<tr>
<td>#AH140</td>
<td>Angular Measurements with Goniometers</td>
</tr>
<tr>
<td>#AH141</td>
<td>Tri-Axial Accelerometer Calibration</td>
</tr>
<tr>
<td>#AS142</td>
<td>AcqKnowledge Rate Detector Algorithm</td>
</tr>
<tr>
<td>#AS143</td>
<td>Importing AcqKnowledge Data Into Excel</td>
</tr>
<tr>
<td>#AH144</td>
<td>Hand Dynamometer Calibration</td>
</tr>
<tr>
<td>#AH145</td>
<td>TSD101B Respiratory Effort Transducer</td>
</tr>
<tr>
<td>#AS148</td>
<td>Automated ECG Analysis</td>
</tr>
<tr>
<td>#AH149</td>
<td>O2100C Module</td>
</tr>
<tr>
<td>#AH150</td>
<td>O2100C Module — Sample application</td>
</tr>
<tr>
<td>#AH151</td>
<td>CO2100C Module</td>
</tr>
<tr>
<td>#AH152</td>
<td>CO2100C Module — Sample Application</td>
</tr>
<tr>
<td>#AH153</td>
<td>Physiological Sounds Microphone</td>
</tr>
<tr>
<td>#AH154</td>
<td>HLT100C High Level Transducer</td>
</tr>
<tr>
<td>#AS158</td>
<td>Analysis of Inspired and Expired Lung Volume</td>
</tr>
<tr>
<td>#AH159</td>
<td>TSD116 Series Hand Switch and Foot Switch</td>
</tr>
<tr>
<td>#AH160</td>
<td>Gas Analysis Module Response Time</td>
</tr>
<tr>
<td>#AS161</td>
<td>Automated Tissue Bath Analysis</td>
</tr>
<tr>
<td>#AH162</td>
<td>Stimulation Features</td>
</tr>
<tr>
<td>#AS168</td>
<td>Analysis of Intraventricular Pressure Wave Data (LVP Analysis)</td>
</tr>
<tr>
<td>#AS169</td>
<td>Speech Motor Control</td>
</tr>
<tr>
<td>#AH170</td>
<td>LDF100A Laser Doppler Flow Module</td>
</tr>
<tr>
<td>#AH175</td>
<td>Using the STMISOC Stimulus Isolator</td>
</tr>
<tr>
<td>#AS177</td>
<td>ECG Analysis using the Offline Averaging Mode</td>
</tr>
<tr>
<td>#AS183</td>
<td>VO₂ Measurement</td>
</tr>
<tr>
<td>#AH186</td>
<td>Psychological Assessment using the TSD115</td>
</tr>
<tr>
<td>#AH187</td>
<td>Electrodermal Response (EDR) using the GSR100 or TEL100</td>
</tr>
<tr>
<td>#AH190</td>
<td>Using the MCE100C Micro-electrode Amplifier</td>
</tr>
<tr>
<td>#AS191</td>
<td>Cardiac Output Measurement using the EBI100C and AcqKnowledge</td>
</tr>
</tbody>
</table>

Visit the online support center at www.biopac.com
Chapter 2  Working in AcqKnowledge

The MP System software is called “AcqKnowledge” and performs two basic functions: acquisition and analysis. The acquisition settings determine the basic nature of the data to be collected, such as the amount of time data will be collected for and at what rate data will be collected. All of the acquisition parameters can be found under the MP menu. The other menu commands pertain to analysis functions such as viewing, editing, and transforming data.

Note: Some very minor differences exist between the Macintosh and the PC-compatible screen displays and keystroke/mouse functionality. These differences are noted throughout this section.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Functionality</th>
<th>See Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>MP150 or MP100</td>
<td>Setup Channels, Setup Acquisition, Setup Triggering, Setup Stimulator, Show Input Values, Manual Control, Auto Plot, Scroll, Warn on Overwrite, Organize Presets. Select Network Adapter, MP150 Serial Number, About MP150</td>
<td>45</td>
</tr>
<tr>
<td>File</td>
<td>New, Open, Close, Save/Save As, Print, Printer Setup, Exit</td>
<td>149</td>
</tr>
<tr>
<td>Edit</td>
<td>Undo, Cut, Copy, Paste, Clear/Clear All, Select All, Insert Waveform, Duplicate Waveform, Remove Waveform, Clipboard (copy measurement, copy wave data, copy graph), Journal (paste measurements, paste wave data)</td>
<td>158</td>
</tr>
<tr>
<td>Transform</td>
<td>Digital Filters, Math Functions, Template Functions, Integral, Derivative, Integrate, Smoothing, Difference, Histogram, Resample, Equation Generator (Expression), Waveform Math, FFT, Find Peak, Find Rate</td>
<td>165</td>
</tr>
<tr>
<td>Display</td>
<td>Tile Waveforms, Autoscale Waveform, Overlap Waveforms, Compare Waveforms, Autoscale Horizontal, Zoom, Reset, Set Wave position, Wave color, Horizontal Axis, Show, Statistics, Preferences, Size Window, Set Font</td>
<td>214</td>
</tr>
<tr>
<td>Window</td>
<td>PC only—controls the position of windows on the monitor</td>
<td>228</td>
</tr>
<tr>
<td>Help</td>
<td>Open PDF files and the web for support information about software functionality</td>
<td>228</td>
</tr>
</tbody>
</table>
**Launching the AcqKnowledge software**

The first step is to launch the software by double-clicking on the AcqKnowledge icon. You may receive a message regarding the hardware.

**PC users:**

If you receive the above warning when you launch AcqKnowledge, there are two possibilities: You have not properly connected everything and/or you have not powered up the MP System.

- **NOTE:** To use AcqKnowledge without the MP acquisition unit hardware, press the “Cancel” button.

When AcqKnowledge is first launched, the user must pick an available MP150A unit from the “MP150 Serial number” dialog. The dialog lists all MP150A units that are powered ON and sitting on the same local area network. If you are using more than one MP150A unit or working across a network, you will need to lock/unlock an MP150A to acquire data. See Appendix E on page 241 for details.

**Macintosh USB users:**

You may receive a message similar to the following. Use the pull-down menu to select a connection port, or choose the **No Hardware** option. Options are generated based on your system configuration (printer port, modem port, USB port, etc.). If hardware is not detected, check all connections and power sources. Unplug the USB adapter, wait a few minutes, then replug the adapter or try a different USB port.

Visit the online support center at www.biopac.com
Assuming everything is properly connected and there are no conflicts, AcqKnowledge will open as follows:

- **PC MPWSW System:** an empty AcqKnowledge graph window will come up.
  
  A “window” is the term used for the area on your computer’s screen where data is displayed and/or manipulated. The graph window on the screen is designed to provide you with a powerful yet easy-to-use interface for working with data.

  At this point, you can use this window, create a new window, or open an existing window.

- **To create a new graph window,** access the **File** menu and select **New**. It’s a good idea to create a new graph window for each acquisition.

**Journal**

The MP System comes with an “electronic notepad”, or journal, which allows you to record notes and data in the same file. Each graph window has its own “embedded” journal so that you can take notes at the same time you are acquiring data.

To display the journal, select the journal icon from the toolbar or pull down the **Display** menu, select **Show**, and then choose **Journal**. The journal will appear at the bottom of the graph window.

Once a journal is open, you can enter text, data or both. Every graph file has a journal file permanently linked to it. To enter text, just click the cursor in the journal area and begin typing. AcqKnowledge will automatically “wrap” the text to fit the screen width. This is especially useful for noting the date and time of a recording, what was involved, and so forth. You may also paste measurements and waveform data into the journal.

To paste measurements into an open journal, select the desired area or point and choose **Paste measurements** from the **Edit>Journal** menu. This will paste all visible measurement window data into the journal. To paste waveform data into the journal, select the desired area and choose **Paste Wave Data** from the **Edit>Journal** menu. This will insert a text file of your waveform into the journal, where points and trends can be analyzed.

**Acquisition**

Once you have connected your system setup and input devices, try a sample acquisition. The most basic and commonly used options are under the **MP** menu. For any acquisition, you will need to specify:

- How many channels there are and which channels contain data (**Setup Channels**).
- At what rate the MP will acquire the data (**Sampling rate**).
- How long the acquisition will last (**Acquisition length**).
Setting up channels

To tell the MP System how many channels will be acquired (or collected), select **Setup Channels** from the **MP** menu. This will generate the **Input Channels** dialog.

![Input Channels dialog](image)

<table>
<thead>
<tr>
<th>Acquire</th>
<th>When the <strong>Acquire</strong> box is checked for a given channel that means data will be collected on that channel.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plot</td>
<td>Determines if data will be plotted in real-time during the acquisition. If the plot box is unchecked, data will still be recorded for that channel, but the waveforms can only be plotted after the acquisition is over.</td>
</tr>
<tr>
<td>Values</td>
<td>Enables you to bring up a window that will display (numerically and/or graphically) the values for each channel in real time. These values are displayed in a separate window from the main graph window. The default is to collect one channel of data on channel A1, and to plot and list values for this channel. Usually, you will want to check all three boxes for each channel you acquire data on.</td>
</tr>
<tr>
<td>Channel</td>
<td>This is a dynamic alpha-numeric heading, based on the type of channel selected: <strong>Analog</strong> (or continuous), Calculation, or Digital. In the sample above, “A1” indicates Analog channel one. <strong>Calculation</strong> channels are used for on-line computations and transformations of other channels. These channels are set up just as analog and digital channels but also have additional dialog boxes for you to specify what types of transformations and computations you would like to perform. For a detailed summary of Calculation channel options, see the <strong>Calculation Channel</strong> section beginning on page 54. In contrast to analog data, <strong>Digital</strong> channels collect binary data that represent when a measuring instrument is “on” or “off.” An example of when this could be useful is for recording whether a switch is open or closed, as in reaction time studies or control applications. You can control whether digital channels are acquired, plotted, and have values listed the same way you do for analog channels.</td>
</tr>
<tr>
<td>Label</td>
<td>To the right of each channel number is an editable label for each channel, where you can type in a label (up to 38 characters) that identifies what each channel is measuring.</td>
</tr>
<tr>
<td>Presets</td>
<td>Calculation channels include <strong>Preset</strong>s as a quick way to get started — choose a preset and the software automatically sets the gain, offset, etc. appropriate for the selected application. See page 48 for details and a list of available presets.</td>
</tr>
<tr>
<td>Channel Sample Rate</td>
<td>The channel sample rate is a function of the acquisition sample rate — all channel sample rate options are equal to or less than the acquisition sample rate (as established via “MP150&gt;Setup Acquisition”). Use the pull-down menu to set the channel sample rate; the options are a specific power of 2 less than the acquisition sample rate. Channel sample rate info is included in the Display&gt;Statistics dialog. See page 50 for more details.</td>
</tr>
</tbody>
</table>

Visit the online support center at www.biopac.com
Setting up acquisitions

Once you have set up the channel parameters, the next step is to specify the acquisition settings. You can do this by choosing **Setup Acquisition** from the MP menu. This generates a dialog box that will describe the type of acquisition about to be performed. There are a number of options here, but the basic parameters involve specifying:

a) How data should be collected and stored
b) The data collection rate
c) The acquisition duration (total length)

**Storage**

**Record** and **Save once to Memory** is the default acquisition option. Under this option, the MP System automatically records data into a single continuous file, and stores the data in computer memory (RAM) during the acquisition.

The third popup menu at the top of the dialog (which defaults to **Memory**) allows you to specify where the data should be stored during the acquisition. You will probably want to choose **Memory** or **Disk** storage. Computer memory (RAM) is usually faster (but less abundant) than disk space. If your system uses any virtual memory, AcqKnowledge will use as much as possible. You may also store data directly to the MP acquisition unit, which is capable of storing up to 16,367 samples of data.

- The advantage of storing to the MP acquisition unit is that much faster sampling rates may be obtained.
- The disadvantages of saving data to the MP acquisition unit are that there is limited storage space and that data is not displayed on the screen while it is being collected. When the acquisition has stopped, however, the data will be automatically displayed on the screen.

The other option under storage is **Averaging**, which allows you to take repeated trials of the same data. For more information on this feature, see the averaging section on page 84.

**Rate**

**Acquisition Sample Rate** is analogous to “mm/sec” on a chart recorder, and refers to how many samples the MP System should take each second. As the MP System takes more and more samples per second, the representation of the signal becomes more accurate. However, as the sampling rate increases, so does the demand for system resources (memory, disk space, etc.). There is a “point of diminishing return” in terms of sampling rate for almost all types of analog signals, where sampling above a given threshold adds relatively little information.

The MP System’s sampling rate has a lower bound of 2 samples per hour, and an upper bound of 400 kHz aggregate for the MP150 or 70 kHz aggregate for the MP100.

Choose the best acquisition sample rate from the pop-up list.

*Note:* Channel sample rates are variable based on the acquisition sample rate. All channel sample rate options are equal to or a specific power of 2 less than the acquisition sample rate.

**Duration**

The final acquisition parameter is **Acquisition Length (Total Length)**, which controls how long an acquisition will last. This can be scaled in seconds, minutes, hours, milliseconds or number of samples. You can set this value either by entering a number in the acquisition length box, or by moving the scroll box left or right.
**Starting an acquisition**

Once you have specified which channels will contain data and have defined the channel characteristics, the next step is to start the acquisition. If a file window is not already open, choose **File > New** (or **File > New > Graph** on a Mac) and a window similar to the following should be generated:

![AcqKnowledge Interface](image)

**Status**

In the lower right corner of the screen, next to the Start button, you should see a circular status light. The status light indicates the communication link between your computer and the MP acquisition unit.

- If the MP acquisition unit is properly connected to the computer and is turned on, the circle will be solid and **green** (on monochrome displays, the circle will appear solid).
- If the MP acquisition unit is not properly connected or not communicating with the computer, the circle will be solid and **gray** (on monochrome displays, the circle will appear unfilled).

**Start**

To start an acquisition, position the cursor over the **Start** button and click the mouse button, or select “⌘ + Spacebar” on the Mac or “Alt + Spacebar” on the PC. If there are no input devices (e.g., electrodes or transducers) connected to the MP System, it will collect a small value of random signal “noise” with a mean of about 0.0 Volts.

- For information on how to connect measurement devices to the MP System, see the *BIOPAC MP Hardware Guide.pdf*.
- You may also start an acquisition using a variety of “triggers,” which are discussed on page 90.

Once an acquisition has started, the Start button in the acquisition window will change to Stop, and two opposing arrows will blink, indicating that data is being collected. Also, the “BUSY” indicator light on the front of the MP acquisition unit will illuminate, showing that data is being collected.

**Stopping an Acquisition**

To stop an acquisition at any time, click on the **Stop** button in the lower right corner of the screen or select “⌘ + Spacebar” on the Mac, or “Alt + spacebar” on the PC.

An acquisition will stop automatically when it has recorded an amount of data equal to that indicated in the **Total Length** box. To save this data file, choose the **Save** command from the **File** menu.

Visit the online support center at www.biopac.com
**Display modes**

The three main display modes are Chart mode, Scope mode, and X/Y mode. Data can be displayed in a number of different modes. You may change the way data appears on the screen at any time, even during an acquisition. To change the display mode, click on the corresponding icon in the toolbar.

### Chart mode

*Chart mode is the default display mode.*

Chart mode plots data much as it might appear on a chart recorder, with time on the horizontal axis. Each channel of data is in its own “track” across the screen, with borders between channels. The waveforms will not cross boundaries into the tracks of adjacent channels.

If a waveform is plotted off the scale of the channel track, choose **autoscale waveforms** and AcqKnowledge will select the “best fit” for waveforms to their tracks.

### Scope mode

Scope mode plots data much as it might appear on an oscilloscope, with time on the horizontal axis. Scope mode is similar to Chart mode, except that there are no borders between different channels.

Waveforms can overlap. The **autoscale waveforms** command will automatically separate the waveforms in the graph window.

*Note:* When only one waveform is present, the **scope** and **chart** modes are identical.

### X/Y mode

X/Y mode plots data from two channels against each other, with the values from one channel on the horizontal axis and the values from another channel on the vertical axis. Plotting a channel against itself displays a straight line.

X/Y mode can be useful for chaos investigations and respiration studies.

*Note:* You can select **Display > Show > Last dot only** to plot only the most recently acquired data point. This is most useful when viewing data as it is being collected and when this data is displayed in X/Y mode.
X-Y mode continued

Plotting channels
To change the channel being plotted along the X-axis, click in the channel label area above the waveform. To change the channel being plotted along the Y-axis, click in the channel label area left of the waveform. A popup menu of all currently plotted channels will be generated. Choose a channel from the list to plot it on the selected axis.

Toolbar icons
The center cluster of toolbar items is specific to X/Y mode. The left two buttons in this group are shortcuts for the Autoscale vertical and Autoscale horizontal functions. Adjacent to these buttons are two buttons that perform the center vertical and center horizontal functions.

Tools
In X/Y mode, the I-beam tool in the lower right hand corner of the graph window changes into a crosshair. When the crosshair is moved into the graph window, the coordinates of the crosshair are displayed in the upper left corner of the graph window. The X value refers to the coordinate of the crosshair in terms of the horizontal axis, and the Y value describes the location of the cursor in terms of the vertical scale.

X/Y plot with BPM on X-axis and lagged BPM on Y-axis

Autoscale
In X/Y mode, the Autoscale waveform function changes to read Autoscale vertical, which plots the vertical channel so that it takes up two-thirds of the vertical channel space. This function controls the “height” of the data being plotted in the graph window.

Similarly, the Autoscale horizontal function plots the waveform so that the waveform is plotted in the center two-thirds of the window. This function controls the “width” of the data being plotted in the graph window.

Autoscale commands adjust the center point and the range of data displayed. To manually change the scale, click in either the horizontal or vertical scale area. In this case, the scale at the bottom edge of the graph windows (which usually reflects time) is the scale for the X variable, and the vertical scale controls the scale for the channel plotted on the Y-axis.

Center
In X/Y mode, since only two channels can be displayed at a time, tile waveforms and compare waveform are replaced with Center horizontal and Center vertical. These two Center commands change the midpoint of the horizontal and vertical scales (respectively) so that the midpoint of the scale is equal to the mean value (average) for that channel. These features are useful for centering the display so that it is easier to interpret.

Ch. # Box
In X/Y mode, the channel numbering boxes are disabled.

Meas. Menu
In X/Y mode, the measurement popup menus are disabled.

Visit the online support center at www.biopac.com
**Toolbars**

Many of the most commonly used features in AcqKnowledge can easily be executed with a mouse click. The toolbar contains shortcuts for some of the most frequently used AcqKnowledge commands; icons are grayed out when they are not applicable. Click **Display > Show > Tool Bar** to view the icons.

Icons vary slightly between PC and Mac but functionality is the same. Click on an icon to activate it.

<table>
<thead>
<tr>
<th>PC</th>
<th>MAC</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td><img src="image" alt="Icon" /></td>
<td>Change display to scope mode.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td><img src="image" alt="Icon" /></td>
<td>Change display to chart mode (default).</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td><img src="image" alt="Icon" /></td>
<td>Change display to X/Y mode.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td><img src="image" alt="Icon" /></td>
<td>Autoscale selected waveform only.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td><img src="image" alt="Icon" /></td>
<td>Autoscale waveforms along the horizontal axis.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td><img src="image" alt="Icon" /></td>
<td>Center waveforms vertically in the active window.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td><img src="image" alt="Icon" /></td>
<td>Center waveforms horizontally in the active window (X/Y mode only).</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td><img src="image" alt="Icon" /></td>
<td>Find the peak of a selected area.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td><img src="image" alt="Icon" /></td>
<td>Find the next peak (after peak has been defined).</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td><img src="image" alt="Icon" /></td>
<td>Show/Hide gridlines in the graph window.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td><img src="image" alt="Icon" /></td>
<td>Show/Hide measurement pop-up windows.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td><img src="image" alt="Icon" /></td>
<td>Show/Hide channel selection boxes.</td>
</tr>
</tbody>
</table>

Channel selection boxes ![Icon](image) appear above the data window and indicate the channel(s) being used to record data.

- **To select a channel**, depress the corresponding channel number box (CH 1 is selected here).
- **To hide a channel**, Ctrl-click (PC) or Option-click (Mac). A slash mark will cover the channel box and the channel will be hidden.

<table>
<thead>
<tr>
<th>PC</th>
<th>MAC</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td><img src="image" alt="Icon" /></td>
<td>Show/Hide markers and marker menu icons.</td>
</tr>
</tbody>
</table>

Marker menu icons:

- **PC** — ![Icon](image)  
- **Mac** — ![Icon](image)

<table>
<thead>
<tr>
<th>PC</th>
<th>MAC</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td><img src="image" alt="Icon" /></td>
<td>Show/Hide journal.</td>
</tr>
</tbody>
</table>

**Mac** — Journal must be open for icon to work.

<table>
<thead>
<tr>
<th>PC</th>
<th>MAC</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td><img src="image" alt="Icon" /></td>
<td>Produce a list of Student Lab-type files in the current folder.</td>
</tr>
</tbody>
</table>

Other folders can be selected by:

- **PC** — choosing “Browse” from top of the list.
- **Mac** — choosing the “Select” folder.
Analysis

For purposes of illustration, you should open an existing file that contains actual data. Sample files were installed with the software. Select **File > Open** and choose a file from the list in the dialog box.

- If you have the MPWS (Mac), open the file called **4chData**
- If you have the MPWSW (PC), open the file called **4chData.acq**

The screen should resemble the following sample file display.

**Sample File Display**

The sample graph displays four different types of data, and there is a border between the waveforms.

To the left of each waveform is a vertical strip containing a text string that can be used to help identify each waveform.

The time scale along the bottom denotes when the data was recorded relative to the beginning of the acquisition.

- Only the last eight seconds of the total data record are visible, although the file contains the complete record.
- The data displayed on the left edge of the graph represent events that occurred about 22 seconds into the record, and the data displayed at the right edge of the screen represent events that occurred about 30 seconds after the acquisition was started.

The maximum vertical scale range is from +10 to -10 Volts.

- This reflects the maximum input voltage the MP can accept and is a greater range than you will usually encounter.
- The display scale can be adjusted to virtually any value range, as demonstrated in the graph window above.
As indicated by the horizontal scale, only a few seconds of data are displayed on the screen. If you choose Statistics from the Display menu (on the menu bar), you can determine the total length of the record.

To view data that was collected earlier in the record, you can use the horizontal scroll bar to move to different points in the record. The horizontal scroll bar allows you to move around in a data file, just as the scroll bar in a word processor allows you to move to different points in a document.

Alternatively, you can position the cursor in the horizontal scale area (where the numerical values are listed) and click the mouse button. This will bring up the following dialog box:

The (Time) Scale box allows you to change the amount of data that appears on the screen at any given time. In the sample dialog box, this is set to 2 seconds per division. The divisions on the screen are indicated by the four vertical lines, thus displaying eight seconds at a time (two seconds per division times four divisions). By entering a larger value in this box, more of the record will be displayed on the screen at any given time. Conversely, entering a smaller value in this box will cause a shorter segment of data to be displayed on the screen.

➢ To display the entire waveform (in terms of duration), a shortcut is to choose Autoscale horizontal from the Display menu. The Autoscale horizontal command fits the entire data file into the window, regardless of the total length of the acquisition.

The Initial Offset box lets you “jump” to a different point in the time display. Changing the value in this box allows you to display data beginning at a certain point in the record.

For instance, if you want to see the data at the beginning of this record, you would tell AcqKnowledge to display data with an initial offset of 0 seconds, which would result in the following:

As you can tell from the time scale, the first data displayed (at the left edge of the screen) was collected at the beginning of the acquisition. Also, the scroll box has moved to the left, indicating that the data on the screen represents data collected earlier in the record.
If you click in the horizontal scale area again, the same dialog will appear, and this time the value in the start box should have changed to reflect the new section of data being displayed on the screen.

All of the options described thus far describe ways to change the time scale of data in one way or another. AcqKnowledge also allows you to change the vertical scaling, or amplitude of each waveform. Clicking on the vertical scale area produces a dialog box similar to the horizontal scaling dialog box.

The vertical scale dialog box allows you to change the range of amplitude values displayed (scale) and set the value that appears in the center of the vertical scale (midpoint).

**Scale** — In the sample dialog box, the units are set to 3 mVolts per division. As with the horizontal scale, there are four divisions on the vertical axis, so this setting should show 12 mVolts range of data.

**Midpoint** — The box below this controls the midpoint of this range. In this case, the midpoint is set to 2 mVolts, which means that this channel will display the range from -4 mVolts to +8 mVolts.

You can vary the midpoint and apparent magnitude of each waveform by changing the values in each box. By changing the value in the scale box, a smaller value has the effect of increasing the apparent amplitude. Entering a number about half the current value will cause the amplitude of the wave to appear to double.

As with the time scale, you can have AcqKnowledge automatically come up with the best fit in terms of midpoint and units per division. To do this, select the **Autoscale waveform** command from the Display menu, and the amplitude and offset of each wave will be adjusted to fit their sections.

Any changes you make in terms of rescaling (either horizontal or vertical) will only affect the way data is displayed, and will not change the basic characteristics of your data file.

Visit the online support center at www.biopac.com
Selecting a waveform

Although all four waves are displayed at once, you may want to operate on only one channel at a time. To do this, you need to select the channel you wish to work with. Selecting a channel allows you to highlight all or part of that waveform, and enables you to perform transformations on a given channel.

In the upper left corner of the graph window there is a series of boxes that represent each channel of data. The numbers in the boxes correspond to the channel used to acquire the data (the specifics of setting up channels are discussed on page 30). In the sample waveforms shown previously, ECG channels are represented by channels 1 and 2, with respiration on channel 4 and blood pressure on channel 5.

To select one of these channels, position the cursor over the box that corresponds to the channel you wish to select and click the mouse button.

You can also select a channel by positioning the cursor on the waveform of interest and clicking the mouse button.

Hide a Channel

To “hide” a waveform, hold down the appropriate key and click on the channel box:

- Hold down CTRL key on PCs
- Hold down OPTION key on Macs

You may view a hidden waveform by keeping the appropriate key pressed and clicking on the channel box again.

Zoom

Another way to examine data is to use the “zoom” tool. The zoom tool allows you to select any portion of any wave and magnify it as much as possible. To use the zoom tool, click on the icon in the lower right portion of the screen. As you move the mouse into the graph area, you will see it change from an arrow to a crosshair (+). Start by positioning the cursor in one corner of the box, holding down the left mouse button, and dragging the crosshair horizontally, vertically, or diagonally to form a “box” which encompasses the area you need to zoom in on. When you release the mouse button, AcqKnowledge will automatically adjust the horizontal and vertical scales. To “unzoom,” choose Zoom back from the Display menu.

Selecting an area

Once you have selected a channel, you can “edit” parts of that channel by selecting a section of the waveform. The options available to you include cutting, copying, and pasting sections of waveforms. You can also transform and analyze entire waveforms or specific sections of waveforms.

For any of these functions, you will need to select (or highlight) an area to be operated on. If you want to select a section of a waveform, position the cursor over the icon in the lower right hand corner of the screen and click the mouse button. Now move the cursor to the first point in the area that you wish to select. As you move the cursor into the graph area, you will see it change from an arrow cursor to a standard I-beam editing tool.

To highlight a section of a waveform, position the cursor at the left edge of the area you wish to select and hold down the mouse button. Now move the mouse to the right until you have selected the desired area.
To select more than one screen of data, position the cursor at the left edge of the section to be highlighted, then click and hold the mouse button. Use the scroll bars to move to a different point in the record, and when you reach the desired endpoint (right edge) of the selected area, hold down the Shift key while you position the cursor and click the mouse button. Selecting an area this way will also allow you to “fine tune” the selected area to include only a specific range of data.

Once a channel has been selected and a section of that area highlighted, you can operate on and edit that section of the waveform. The editing commands behave much the same way as the editing functions in a word processor. You can cut, copy, delete or paste sections of data as defined by the selected area. In most cases (depending on available memory) you may undo an edit by choosing **Undo** from the **Edit** menu, or by using the shortcuts of +Z on Macs (MPWS) or CTRL + Z on PCs (MPWSW).

Selecting a portion of a waveform also allows you to apply transformations to a particular area, rather than the entire area or all waveforms. Selecting an area also allows you to take snap measurements for parameters such as delta T, mean, standard deviation, frequency, and so forth. The measurement options are discussed in the next section.

**Transforming data**

**AcqKnowledge** includes a vast library of functions, which can transform data or perform mathematical Calculations on waveform data. All of these options can be found under the **Transform** menu, and are discussed in detail in the **Transform Menu Commands** section beginning on page 165.

When performing transformations, keep in mind that when a section of a waveform is highlighted, the transformation will apply to that section. Also, if no area is defined, **AcqKnowledge** will always select a single data point. Some transformations (spectral analysis and digital filtering, for instance) can only be performed on a selected area, so if a single point is selected the entire waveform will be transformed.

**Measurements**

Once you have selected a channel to work with, you can quickly and easily take measurements on each wave. The measurements appear in the row of boxes across the top of the graph window. You can specify the number of measurement boxes to show and the display precision in the “Preferences” dialog of the **Display** menu. Each measurement consists of three parts: (a) the channel selection, (b) the measurement function, and (c) the result or actual measurement value.

The pull-down channel selection allows you to calculate a measurement either for the selected channel (SC) or from a numbered channel in the record. To switch between the channel options, click in the channel window. The pull-down menu shows the channel numbers and labels for all channels in the file. By default, each measurement will reflect the contents of the selected channel.

Visit the online support center at [www.biopac.com](http://www.biopac.com)
The **pull-down measurement menu** allows you to choose between different types of measurements. To choose a measurement, click on the measurement popup menu and select a measurement from the list.

- Some measurements (such as Time or Value) look at only a single data point whereas other measurements (such as mean and delta T) examine a range of data on the selected channel.
- Some of the measurements that depend on a selected area (such as delta T) look at differences in the horizontal axis measurement whereas other range measurements (such as peak-peak) use the vertical scale information in calculating measurements.
- For a complete description of each of the measurement functions, turn to page 124.

The final component of a measurement window is the measurement **result**.

When an area is selected (or if the selected area is changed) the measurement result automatically updates to reflect the change.

In the example above, results for the selected channel (SC) are:

- **Time** 17.28 sec
- **delta t** 0.00000 sec
- **freq** 0.10157 Hz
- **bpm** 6.09446 BPM.
Markers
You may insert a marker either during an acquisition or after the fact. You can automatically insert markers during an acquisition by pressing the **ESC key** on the Mac or the **F9** key for the PC. This will insert a marker at the exact time the key is pressed and will activate the text line entry so you can immediately enter a comment to be associated with the marker.

AcqKnowledge allows you to insert “markers” into a record that act as bookmarks to record when an event occurs during the record. For instance, you may want to note when a treatment began or when an external event occurred so you can examine any possible reaction.

These markers appear as downward pointing triangles at the top of the graph window, and can be edited, displayed, or hidden from view.

When **Markers** is selected, the marker area at the top of the graph windows will be displayed, along with any markers associated with the data being displayed. To view the text associated with a given marker, position the cursor arrow over the marker and click the mouse button.

See page 139 for more information about using and printing markers.

Grids

**Grid** superimposes a set of horizontal and vertical lines on the graph window. The grid is designed to allow for easy measurements, since the grid lines correspond to horizontal and vertical scale divisions. The grid can be locked (analysis, printing) or unlocked (visual aid).

To activate the grid display, choose **Display > Show > Grid** or click on the toolbar icon.

- To display minor grid lines, use **Ctrl**.
- To customize grid line and color and optimize the display and print features, choose **Display > Show > Grid Options**.

See page 140 for more information about using and printing grids.

*Note:* The Scale dialogs change when grid lines are locked. See page 120 for details on Horizontal Scale and page 121 for details on Vertical Scale.
Journals

The Journal is a general-purpose text editor built into AcqKnowledge. Using the journal, you can save text and/or numeric values. One common function of a journal is to save comments and other similar information about an acquisition in a text file, so that this information can be referenced later.

The Journal works like an “electronic notepad” that allows you to record notes and data in the same file. To display the Journal, choose Journal from the Show item of the Display menu or select the icon. On the MPWS (Mac system), a new Journal window will have to be opened under the File menu. The Journal will appear at the bottom of the graph window.

Once a Journal is open, you can enter text, data, or both. To enter text, just begin typing when the journal is open. AcqKnowledge will automatically “wrap” the text to fit the screen width.

There are Time Stamp, Date Stamp and Auto Time functions available in the journal window. The Time and Date stamps refer to the computer’s clock to record the time and date, respectively, directly into the Journal. The Auto Time function records the time at the instant the carriage return is pressed, which is useful for tagging commands as data is collected.

You may also paste measurements and data into the Journal. To paste measurements into an open Journal, select an area and choose “Paste measurements” from the Edit>Journal menu. The measurements in the measurement windows are copied into the Journal. Additionally, by changing the Journal Preferences, you can simultaneously record measurement name and units.

To paste waveform data into a Journal, select an area and choose “Paste Wave Data” from the Edit>Journal menu. Allow several seconds for the text file to be written. The result is a text file of your wave data pasted into your active journal.

A useful feature of the Journal is that it works in connection with the Peak Detector and other measurement functions to paste in values from waveform data for further analysis.

In the example above, the peak-to-peak and delta t measurements were pasted from the open graph window to the Journal. See the Journal paste section on page 164 for more information on how to paste information to Journal files.
Saving data

Once data has been collected, it can be saved as a file and opened later. The data file can be moved, copied, duplicated and deleted just like any other computer file. By default, files are saved as AcqKnowledge files, which are a proprietary format designed to store information in a format as compact as possible. Although these files can only be opened from within AcqKnowledge, the data in these files can be exported either as a text file or as a graphic image.

Exporting data to a text file allows you to examine the data using other programs, such as a spreadsheet or statistical analysis package. Saving data as a graphic (.WMF for MPWSW or PICT for MPWS) enables you to work with the data in graphic format.

One of the most useful applications of this is the ability to edit and place AcqKnowledge data as it appears on the screen. You can use this feature to paste graphs into word processors, drawing programs, and page layout programs. To learn more about these options, turn to the Save As section beginning on page 154.

Printing

In some cases, it is important to have a hard copy of the data. AcqKnowledge allows you to produce high-resolution plots of graphs much as they appear on-screen. To print a file, choose Print from the File menu. This will print the contents of the screen on the selected printer. To print the entire file, choose Autoscale Horizontal from the Display menu first.

An example of the print dialog is shown here. Often, you may want to instruct AcqKnowledge to print the contents of a file across several pages. To do that, change the value in the Total pages box. Entering “4” in this box, for instance, will place the length of the page evenly across four pages when printing.

To find out more about the print command, turn to the Print section beginning on page 157.
Part B — Acquisition Functions: The MP Menu

Overview
The AcqKnowledge software adds acquisition and control capability to the complete MP System. This section describes the commands and procedures used to establish the various acquisition parameters for the MP System, including how to:

- Setup channels for data acquisitions
- Control acquisition parameters such as sampling rate and duration
- Perform on-line calculations and digital filters
- Set acquisitions to begin on command from a mouse click or external trigger
- Display values numerically and graphically during an acquisition
- Output waveforms and digital signals during an acquisition
- Control the on-screen waveform display characteristics

Some of the basic functions involved in setting up an acquisition were covered in Part A — Getting Started, but this section will cover them in more detail, as well as describe some additional features. All the commands covered here can be found under the MP menu.
Acquisitions

Acquisition is defined as data collection from an external source (such as electrodes connected to an amplifier).

- Before you begin an acquisition, make sure the MP acquisition unit is turned on and connected to your computer. Please refer to the BIOPAC Installation Guide for more information on installation and connections.

To begin collecting data:

1. Launch the AcqKnowledge application (you can double click on the AcqKnowledge icon).
2. Open a new graph window that will display data as it is being collected.
   - To do this on the MPWSW (PC), choose New from the File menu.
   - To do this on the MPWS (Mac), choose New from the File menu and then select the Graph Window option.
3. You should see a window similar to the following:
4. After you have opened up a new graph window, you must setup the specific channels you want to acquire before starting the acquisition.
   - See the Setup Channels chapter (page 47) for details.
5. In addition to setting up channels, you must setup the acquisition parameters (such as sampling rate, acquisition length, and data storage options).
   - See the Setup Acquisition chapter (page 78) for details.

Visit the online support center at www.biopac.com
Chapter 3  Setup Channels

Setup Channels – The Basics

Before you collect data, you need to specify how many channels you will be collecting data on, and at what rate data is to be collected. Both of these functions are accomplished through menu items and dialog boxes. To enable collection on a given channel, select Setup Channels from the MP menu.

Notice that the checkboxes next to Analog channel 1 are already selected. This is the default at startup. For each additional channel you wish to collect data on, there are three options for channel setup: acquire, plot, and values. These options appear as boxes on the left side of the Input Channels dialog box. There are 16 rows of boxes, which correspond to the 16 Analog inputs the MP System can accept. To change the options for any channel, click in either the channel label box or the acquire/plot/values boxes. As you do this, a solid circle will appear between the Values box and the label area. This indicates that the options for that particular channel can be edited.

Channel Type

To specify the channel type—Analog, Calculation or Digital—click in the circle next to its name.

Acquire

The first option is whether or not you wish to collect data on that channel. Unless you specify otherwise, the MP System will only collect data on channel 1. To collect data on other channels, position the cursor over the Acquire box (on the far left) and click the left mouse button.

With the MP System, it is possible to leave hardware connected to the MP acquisition unit, but have the software essentially “ignore” the channel by leaving the acquire box unchecked. Thus, if an input device (such as an ECG100C amplifier) is set to channel 7, data from that channel will not be collected unless the Acquire box is checked.

Plot

The second option is for plotting data. You will need to specify a Plot option for each channel. The Plot option determines whether or not data will be plotted on the screen for each channel. Checking this option instructs the software to plot data on your computer’s screen.

When this box is left unchecked, data will still be collected (assuming the Acquire box is checked) but it will not be displayed during the acquisition.

In most cases, you will want to check this option. However, in large-scale acquisitions (i.e., many channels and/or high sampling rates) you may want to uncheck this option for some channels to allow for faster display rates (see Appendix B – Hints for working with large files).
**Values**

The third option enables incoming data values to be displayed either numerically and/or in a “bar chart” format in a separate window during an acquisition. Checking this option allows you to open a window (by selecting **Show Input Values...** under the **MP** menu) that displays the numeric value for each input with the “Values” option checked. This option is especially useful for tracking slowly changing values such as heart rate, respiration rate, or concentrations of chemicals in a substance. For more information on how input values are displayed, please turn to page 103.

**Channel**

Click in the circle next to the channel designation (i.e. A1) to make that channel active (“selected”).

**Label**

You may attach an editable “label” to each channel. These labels allow you to provide a brief name for each channel. To change the label for any channel, position the cursor in the area to the right of the channel numbers (A1 through A16) under the label heading and enter a text label. You may key up to 38 characters and these labels will appear next to the channel label boxes in the graph window. You can change the label in the Setup Channel dialog at any time, or right-click on the active channel label in the graph window to generate the Assign Channel Label dialog.

**Presets**

Calculation Presets are like “templates” for calculation channels. Each Preset stores:

a) Calculation channel type  
b) parameters for that Calculation  
c) channel-specific scaling  
d) channel-specific sampling rate  
e) channel name.

**Calculation Presets** establish settings to target application-specific analysis. Presets exist for a broad range of analysis functions. Start with existing presets for a specific species or protocol—for example, human vs. small animal, or stationary vs. exercising measurements.

Just click on the icon under the Presets head and scroll to select the desired preset.

The Channel Setup dialog contains a “Preset” pop-up menu by each channel that lists the current Preset or, if no Preset has been selected for that channel, the Calculation type (Integrate, Difference, etc.). When you select a Preset for a particular channel, the channel is configured with the settings associated with that Preset.

The Setup dialog has a “Presets” pop-up menu that contains all of the Presets for the Calculation type being configured. For instance, if a Difference Calculation channel is being configured, all Presets for the Difference...
When you select a Preset, the Setup dialog is updated with the corresponding information.

- The Setup dialog reads “none” if the channel configuration doesn’t match any Preset. The menu will flip to “none” when the settings for a channel are changed such that they no longer match a Preset.

You can create a new Preset from existing Calculation channels. Click on “Setup” to display the Calculation Setup dialog and click on the “New Preset” button. The settings will be applied to the current channel, and you will be prompted to enter a name for the new Preset. You cannot duplicate a Preset name, which also means that you cannot use the default name of a Calculation channel type (Integrate, Difference, etc.). The new Preset will be included in the pop-up menus and saved with the file.

- To reorder channel Presets (by type, use, etc.), choose “Organize Channel Presets” from the MP150/100 menu. A dialog will be generated and you can drag items to the desired position or use the up/down and top/bottom buttons as appropriate (see page 111).

- Presets are not applicable to and therefore not selectable on Analog or Digital channels.

---

**AcqKnowledge QUICK STARTS**

**Quick Start** templates (.gtl graph template files) were installed to the Sample folder for PC users. You can use a Quick Start file to establish the settings required for a particular application or as a good starting point for customized applications. See Open As Graph Template on page 150 for details.

<table>
<thead>
<tr>
<th>Q##</th>
<th>Application(s)</th>
<th>Feature</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>EEG Sleep Studies</td>
<td>Real-time EEG Filtering</td>
</tr>
<tr>
<td>2</td>
<td>EEG Sleep Studies</td>
<td>Real-time EEG Filtering</td>
</tr>
<tr>
<td>3</td>
<td>EEG Evoked Response</td>
<td>Evoked Responses</td>
</tr>
<tr>
<td>4</td>
<td>EEG Evoked Response</td>
<td>Event-related Potentials</td>
</tr>
<tr>
<td>5</td>
<td>EEG Evoked Response</td>
<td>Event-related Potentials</td>
</tr>
<tr>
<td>6</td>
<td>EEG Evoked Response</td>
<td>Nerve Conduction Studies</td>
</tr>
<tr>
<td>7</td>
<td>EEG Evoked Response</td>
<td>Auditory Evoked response &amp; Jewett Sequence</td>
</tr>
<tr>
<td>8</td>
<td>EEG Evoked Response</td>
<td>Visual Evoked Response</td>
</tr>
<tr>
<td>9</td>
<td>EEG Evoked Response</td>
<td>Somatosensory Evoked Response</td>
</tr>
<tr>
<td>10</td>
<td>EEG Evoked Response</td>
<td>Extra-cellular Spike Recording</td>
</tr>
<tr>
<td>11</td>
<td>EEG Evoked Response</td>
<td>Autonomic Nervous System Studies</td>
</tr>
<tr>
<td>12</td>
<td>EEG Evoked Response</td>
<td>Sexual Arousal Studies</td>
</tr>
<tr>
<td>13</td>
<td>EEG Cardiovasc. Hemodynamics</td>
<td>Cardiac Output</td>
</tr>
<tr>
<td>14</td>
<td>EEG Cardiovasc. Exercise Physiology</td>
<td>Noninvasive Cardiac Output Measurement</td>
</tr>
<tr>
<td>15</td>
<td>EEG Cardiovasc. Hemodynamics</td>
<td>Noninvasive Cardiac Output</td>
</tr>
<tr>
<td>16</td>
<td>EEG Cardiovasc. Hemodynamics</td>
<td>Nystagnus Investigation</td>
</tr>
<tr>
<td>17</td>
<td>EEG Cardiovasc. Hemodynamics</td>
<td>Saccadic Eye Movements</td>
</tr>
<tr>
<td>18</td>
<td>EEG Cardiovasc. Hemodynamics</td>
<td>Indirect Blood Pressure Recordings</td>
</tr>
<tr>
<td>19</td>
<td>EEG Cardiovasc. Hemodynamics</td>
<td>Multiple-channel Sleep Recording</td>
</tr>
<tr>
<td>20</td>
<td>Sleep Studies ECG Cardiovasc. Hemodynamics</td>
<td>On-line ECG Analysis</td>
</tr>
<tr>
<td>21</td>
<td>Sleep Studies ECG Cardiovasc. Hemodynamics</td>
<td>On-line ECG Analysis</td>
</tr>
<tr>
<td>22</td>
<td>Sleep Studies ECG Cardiovasc. Hemodynamics</td>
<td>ECG Analysis</td>
</tr>
<tr>
<td>23</td>
<td>Sleep Studies ECG Cardiovasc. Hemodynamics</td>
<td>SpO2 Analysis</td>
</tr>
<tr>
<td>24</td>
<td>Sleep Studies ECG Cardiovasc. Hemodynamics</td>
<td>Einthoven’s Triangle &amp; 6-lead ECG</td>
</tr>
<tr>
<td>25</td>
<td>Sleep Studies ECG Cardiovasc. Hemodynamics</td>
<td>12-lead ECG Recordings</td>
</tr>
<tr>
<td>26</td>
<td>Sleep Studies ECG Cardiovasc. Hemodynamics</td>
<td>Heart Sounds</td>
</tr>
<tr>
<td>27</td>
<td>Sleep Studies ECG Cardiovasc. Hemodynamics</td>
<td>On-line Analysis</td>
</tr>
<tr>
<td>28</td>
<td>Sleep Studies ECG Cardiovasc. Hemodynamics</td>
<td>Blood Pressure</td>
</tr>
<tr>
<td>29</td>
<td>Sleep Studies ECG Cardiovasc. Hemodynamics</td>
<td>Blood Flow</td>
</tr>
<tr>
<td>30</td>
<td>Sleep Studies ECG Cardiovasc. Hemodynamics</td>
<td>LVP</td>
</tr>
<tr>
<td>Q##</td>
<td>Application(s)</td>
<td>Feature</td>
</tr>
<tr>
<td>-----</td>
<td>----------------------</td>
<td>----------------------------------------------</td>
</tr>
<tr>
<td>31</td>
<td>NIBP</td>
<td>Pyschophysiology</td>
</tr>
<tr>
<td>32</td>
<td><em>In vitro</em> Pharmacology</td>
<td>Tissue Bath Monitoring</td>
</tr>
<tr>
<td>33</td>
<td><em>In vitro</em> Pharmacology</td>
<td>Pulsatile Tissue Studies</td>
</tr>
<tr>
<td>34</td>
<td><em>In vitro</em> Pharmacology</td>
<td>Langendorff &amp; Working Heart Preparations</td>
</tr>
<tr>
<td>35</td>
<td><em>In vitro</em> Pharmacology Pulmonary Function</td>
<td>Isolated Lung Studies</td>
</tr>
<tr>
<td>38</td>
<td>Pulmonary Function</td>
<td>Lung Volume Measurement</td>
</tr>
<tr>
<td>39</td>
<td>Exercise Physiology</td>
<td>Respiratory Exchange Ratio</td>
</tr>
<tr>
<td>40</td>
<td>EMG</td>
<td>Integrated (RMS) EMG</td>
</tr>
<tr>
<td>41</td>
<td>EMG</td>
<td>EMG and Force</td>
</tr>
<tr>
<td>42</td>
<td>Biomechanics</td>
<td>Gait Analysis</td>
</tr>
<tr>
<td>43</td>
<td>Remote Monitoring</td>
<td>Biomechanics Measurements</td>
</tr>
<tr>
<td>44</td>
<td>Biomechanics</td>
<td>Range of Motion</td>
</tr>
</tbody>
</table>

See Appendix G on page 246 for descriptions of a wide array of applications and features

**Channel Sample Rate**

The Variable Sampling Rate feature allows different channels of data to be down-sampled from the acquisition sampling rate. Choosing lower sampling rates for signals where meaningful data falls below the Nyquist frequency of the acquisition sampling rate allows more data to be stored in memory or on disk.

- Calculation channels are determined from data acquired at the acquisition sampling rate, so online and offline Calculations will differ.

- Offline operations that involve multiple channels must use the same sampling rate for all Source and Destination channels. These operations include waveform editing, Waveform math, Expression calculations and Template functions; notable exceptions are “Off-line Averaging” under Find Peak and “Reset via a Control Channel” under Integrate.

- When wave data is copied to the clipboard or journal, data values will be inserted at the highest sampling rate (channels with a lower sampling rate will snap to the left).

- There is no restriction on the acquisition length when using Variable Sampling Rates on a Macintosh.

- When Variable Sampling Rates are used in conjunction with the Append mode, and the mode is started and stopped manually, it is statistically possible that, prior to the next pass of the Append, extra data points may be inserted in various data channels to “line up” the data (see sample at right). These extra data points simply replicate the last sample in any affected channel.

To minimize the impact of the extra data points:

a) Make sure the lowest sampling rate is on the order of 10Hz or higher, or

b) Don’t use Variable Sampling Rates.
**Setup Channels – Advanced**

The previous section covered the basic options used in almost all acquisitions. In addition to the features described above, a number of other options are available in terms of setting up channels. These advanced features are also found under the Setup Channels menu item.

Most acquisitions involve collecting analog signals and then displaying them on screen. It is frequently useful, however, to collect other types of data (digital data, for instance) or to perform transformations on analog data as it is being acquired. Channels containing digital signals and transformed analog signals can be collected in addition to the 16 analog channels.

In the upper right hand corner of the Setup Channels dialog box, you will see the words Analog, Digital, and Calc. These refer to (respectively) analog channels, digital channels, and Calculation channels. The general features (acquiring, plotting, and the like) are the same for each type of channel, although there are considerable differences between the type of data each channel is designed to handle. You may acquire up to 16 channels each of analog, digital, and Calculation channels. Analog and digital channels may be acquired in any combination, and the only requirement for Calculation channels is that you have at least one input channel (either analog or digital).

**Analog channels**

Analog channels are the most common type of acquired channel and should be used to acquire any data with “continuous” values. Examples of this include nearly all physiological applications where input devices (transducers and electrodes) produce a continuous stream of varying data. The range of values for analog channels is ±10 Volts.

AcqKnowledge also allows you to rescale the signal on analog channels to more meaningful numbers. As an example, imagine a temperature transducer is connected to an SKT100C amplifier with a gain setting of 5°/Volt, and output set to channel 1. Ordinarily, the values from the amplifier would be read in as Volts or milliVolts. For this acquisition, you need to express the signal from the transducer in terms of degrees Fahrenheit. To calibrate the transducer, bring it to two known temperatures. At the first temperature, take a voltage reading by selecting Show input values from the MP menu (see page 103 for a description of the Show Input Values options). At 90° F, you will get a reading of 0 Volts. The transducer is then brought to a temperature of 95° F, and you will get a reading of +1 Volts.

To have AcqKnowledge map the incoming signal to degrees F, click in the Scaling button in the Input Channels dialog box (on the Macintosh, click on the Setup button).

![Scaling dialog box set up to rescale Volts to degrees Fahrenheit](image)

AcqKnowledge Software Guide
The **Input Volts** and **Scale value** boxes reflect the value of the incoming signal and how it will be plotted on the screen, respectively. Thus, an incoming signal of +1 Volts would be plotted as 95° F, whereas a signal of 0 Volts would be plotted as 90° F. **AcqKnowledge** will perform linear extrapolation for signal levels falling outside this range (i.e., -2 Volts will be scaled to 80 ° F), as well as perform similar interpolation for values between this range. Enter these numbers in the **Change scaling** box, type in “degrees F” for **Units**, and click the **OK** button.

As a shortcut for scaling channels, use the **Cal 1** and **Cal 2** buttons. Clicking on either one of these buttons will read the current voltage for the channel you have selected. In the above example, you could have simply set the transducer to a known temperature, clicked on the **Cal 1** button, and then entered the temperature in the **Scale value** box for Cal 1.

You would then need to bring the transducer to another known temperature that is considerably higher or lower than the first and click **Cal 2** and again enter the new known temperature in the **Scale value** box for **Cal 2**. **AcqKnowledge** calculates the slope and offset from the two points entered. Each data sample from channel 1 will now be scaled according to the slope and offset calculations previously made. When an acquisition is performed, the amplitude scale (vertical axis) will reflect the rescaled units.

*It is important to note* that **Cal 1** and **Cal 2** cannot be used when data is being acquired. In other words, a channel must be calibrated before it can be acquired. To set the calibration for a given channel, connect the input device to the MP acquisition unit and power up the MP System, and then perform your calibration before starting data acquisition.

The **Calibrate all channels at the same time option** is used when identical types of transducers or signals are being simultaneously recorded on two or more channels. If this option is selected, when **Cal 1** or **Cal 2** is pressed, the “Input Volts” box will be updated for all active channels.

- For example, if recording from 10 force transducers, all 10 transducers could be loaded with a specific weight, and then all the channels could be simultaneously calibrated by pressing the **Cal 1** or **Cal 2** button.

The **Use mean value** option is useful if the input voltage signal is noisy around a mean value. The “Input Volt” value returned will be the mean value over the specified number of samples. When this option is selected, a **Settings…** button is activated, which leads to an entry for the number of samples.

The data is sampled at approximately 10,000 Hz. If 100 samples are selected, it will take about a second to collect that number of samples. It may be helpful to use a larger number of samples as long as the signal has a Gaussian distribution around a mean value. If the signal is drifting slowly or otherwise unstable, a larger number of samples in the mean may result in an inaccurate sampling.

Visit the online support center at www.biopac.com
**Digital channels**

In contrast to analog channels, digital channels are designed to collect data from a signal source with only two values (0 and 1). This type of data can be useful in recording whether a switch is open or closed, and ascertaining if a device is on or off. Input values for digital channels have two values, +5 Volts and 0 Volts. The MP interprets +5 Volts as a digital 1 and interprets 0 Volts as a digital 0. Since digital channels have a fixed value, the scaling option is disabled for these channels. The main function of digital channels is to track on/off devices such as push-button switches and/or to receive digital signals output by timing devices. Similarly, these channels are also used to log signals from devices that output auditory/visual stimulus for examination of stimulus response patterns.

![Diagram showing positive and negative edges with +5 volts (binary "1") and 0 volts (binary "0")](image)

**AcqKnowledge Software Guide**
Calculation channels

Compared to either analog or digital channels, Calculation channels do not collect external data, but transform incoming data in some way. These channels do not alter the original data, but create new channels (with channel numbers starting at CH40) that contain the modified data.

You can use Calculation channels to compute a host of new variables by using transformations (including BPM, integration calculations, and math functions). The channels are set up in much the same way (using Acquire/Plot/Values boxes) as analog or digital channels, with the exception of the pull-down menu next to the Calc button and the Setup dialog.

To acquire a Calculation channel, click on the Calc button and check the Acquire box for each Calculation channel you want to compute (the Plot and Value boxes are optional). By default, all Calculation channels have the label “Calculation” and entering more descriptive channel labels might prove useful, especially when multiple Calculation channels are being acquired.

Each of these functions requires some additional parameters to be specified, and these options can be set by clicking on the Setup button in the Input Channels dialog box. For any Calculation channel, you will (minimally) need to specify the source channel to be transformed and the nature of the transformation.

Up to 16 Calculation channels can be acquired, and you may use the output of one Calculation channel as the input for another channel, as long as the output channel has a higher channel number than the input channel. In other words, it is possible for Calculation channel 3 to include the result of Calculation channel 1, but not the other way around. This allows for complex Calculations to be performed that involve two or more Calculation channels such as filtering ECG data then computing BPM.

Although Calculation channels can be useful in many cases and indispensable in others, each Calculation channel acquired will somewhat reduce the maximum possible sampling rate, and add to the amount of memory required to store data both during and after an acquisition. Thus, you may want to consider performing some of these functions after the fact if high sampling rates are needed for your particular application.

TIP: All of the operations that can be performed on-line can also be performed after an acquisition has been completed. These options are available under the Transform menu.

Visit the online support center at www.biopac.com
**Integrate Calculation**

The on-line **Integrate** Calculation offers two basic operations:

1. Perform a moving average (and associated processing) over a fixed number of sample points. This option is useful for:
   a) Smoothing noisy data
   b) Real-time “integration” of EMG
   c) Real-time “root mean square” evaluation of EMG.

2. Perform a real-time integration over a potentially variable number of sample points. This option is useful for:
   a) Real-time conversion of flow signals into volume signals (i.e., Blood flow → Blood volume; Air flow → Air volume).
   b) Any processing involving a need for a cyclic, continuous integral calculated in real time. For example: Acceleration → Velocity; Velocity → Distance; Frequency → Number of cycles; Power → Energy.

![Integrate setup window](image)

*Calculation channel set to integrate across 3 samples*

**Destination**

Determined by the calculation channel selected when the Scaling button was pressed.

**Source**

The source channel is selected from a popup menu that includes any channels being acquired and any enabled Calculation channels.

**Sample rate**

Provides the sample rate for the selected channel (may be different than the acquisition sample rate).
Option

As mentioned previously, the **Integrate setup** dialog is divided into two sections:

1. **Average over samples** will calculate the moving average (mean) of the specified number of samples. Additional parameters (Rectify; Root mean square) add further functionality. Used typically, these features allow you to process EMG signals and will display the integrated (rectified, then sample averaged) or Root mean square calculation on the original raw EMG data.

2. **Reset via channel** permits real-time integration of input data over a data-defined time interval. This feature is extremely useful for converting flow signals into volumetric equivalents. The integral of flow is volume. For example, when recording airflow with a pneumotach, volume can be precisely calculated as the flow varies in a cyclic fashion.

**Average over samples option**

On-line sample averaging can be useful when there is a high degree of noise present in the data. At least some of this noise can be “averaged out” by pooling some number of adjacent data points together, taking the average of these points, and replacing the original values with the new averaged values. This process creates a “window” of moving averages that moves across the waveform smoothing the data.

Since an average represents the sum of a series of data points divided by the number of data points present, you can use the **Average over samples** calculation to provide the information needed to create a moving average.

**Samples**

To specify the number of data points to average across, enter a value in the **Samples** box. The number you select will depend in large part on the sampling rate you select and the type of noise present. All things being equal, for slower sampling rates you will probably want to mean average across a smaller number of samples. As you increase the sampling rate, you will probably want to integrate across more and more samples. As the number of samples specified in the samples box increases, the amount of high frequency information contained in the data will decrease.

**Parameters**

**Rectify** — The **Average over samples** calculation can also be used for producing an envelope of modulated data. For instance, EMG waveforms frequently contain high frequency information, which is often of little interest compared to the low frequency information also contained in the data. When the **Rectify** option is checked, **AcqKnowledge** will take the absolute value of the input data prior to summing and a plot of the waveform’s mean envelope over a specified number of samples will be obtained. Typically, this option is only used for processing raw EMG and similar types of applications.

Visit the online support center at www.biopac.com
On-line “Average over samples” feature used as an envelope detector

**Root mean square** — This feature provides the exact root mean square (RMS) of the input data (typically EMG) over the specified number of samples.

**Remove baseline** — This feature provides the exact standard deviation of the input data (typically EMG) over the specified number of samples. When the mean of the input data equals 0-0, the standard deviation and the RMS will be equivalent.

**Scaling… button**

Since the integration values are going to be on a different scale than the original units, you need to change the scale of the integration channel to reflect the new units. When you click on the **Scaling…** button, a **Change Scaling Parameters** dialog will be generated.

The rescaling involves multiplying the “Input volts” values by a factor determined by the sampling rate and number of samples mean averaged across. Specifically, the values in the **Scale value** box should reflect **Input volts** (held constant at 10) multiplied by the product of the following equation:

\[
\frac{\text{Sampling rate}}{\text{Number of samples to be mean averaged}}
\]

As an example, if data were being acquired at 75 samples per second, and you wanted to integrate across an interval of 10 samples, you would set the Integration Setup Scaling parameters so that +10 Volts corresponded to a Scale value of 75 and a Scale values entry of –75 reflected an Input value of –10 Volts.

- It is important to note that this rescaling should be performed independent of any rescaling performed on analog channels themselves. Even if an analog channel is being rescaled to some other units, the input values in the integration scaling should be set to +10 Volts (next to Cal 1) and –10 Volts (next to Cal 2).

*AcqKnowledge Software Guide*
Integrate Calculation and Scaling dialog boxes for 10 point averaging

When data is averaged in this way, a portion of the data at the beginning of the record (equivalent to the number of samples being integrated) should be ignored, as they will reflect a number of zero values being averaged in with the first few samples of data.
**Reset via channel option**

This feature is used to integrate data over a data-dependent interval. Either the source channel or a different channel can control the integration process.

![Integrate setup dialog box](image)

**Control channel**

Allows user to select any active channel as the integration control channel.

**Reset Thresholds**

The threshold is to be set at points surrounding the flow level.

- **LOW** is typically a negative value close to 0.00
- **HIGH** is typically a positive value close to 0.00

In the case of airflow conversion to volume, the flow signal will vary positively and negatively around zero flow.

**Reset trigger**

The **Reset trigger** polarity determines on which slope (Positive ↑ or Negative ↓) the integration process will begin and end.
**Mean Subtraction**

This option will subtract the mean from the data evaluated during the integration period. If this option is selected, the integration will only proceed after all the data in the integration period has been collected. When collected, the mean value of all the data is subtracted from each data point in the integration period. In this fashion, the integral of the corrected data points will result in the integral returning to exactly zero at the end of the integration interval. Although this option will result in “well-behaved” integrations, the integrated data will be delayed by a fixed amount of time, as specified by the max cycle period.

**Max cycle period**

The max cycle period should be set to a value that is longer than the maximum time expected from trigger event to trigger event in the control data channel.

**Scaling button**

Typically, the default scaling settings for cyclic integrated data will be fine. However, the units may need to be changed (i.e., liters/sec to liters).
**Smoothing Calculation**

The **Smoothing** Calculation functions on-line and permits Median or Mean smoothing. (Smoothing can also be performed off-line using the smoothing option of the “Transform” menu). This function is very useful if you are trying to remove noise of varying types from a data set.

**Source** — Source is a pull-down menu of the available channels.

**Sample rate** — provides the sample rate for the selected channel (may be different than the acquisition sample rate).

**Smoothing factor** — enter the number of samples to use as a smoothing factor.

**Mean value smoothing** — The default is mean value smoothing. Use Mean value smoothing when noise appears in a Gaussian distribution around the mean of the signal.

**Use Median value** — click in the box to activate **Median value smoothing** if some data points appear completely aberrant and seem to be “wild flyers” in the data set.

**Scaling** — click on the **Scaling** button for access to options that allow you to modify the units or linearly scale the output.
Difference Calculation

The Difference calculation returns the difference between two data samples over a specified number of intervals and divides the Difference by the time interval spanned by the data values. The Difference Calculation is useful for calculating an approximation of the derivative of a data set in real time.

To have AcqKnowledge perform a Difference calculation in real time, click on the button next to Calc in the Input Channels dialog box. A popup menu will appear with Integrate at the top of the list. Scroll to choose Difference and then check an Acquire box for the Calculation channel you wish to contain the difference data. You may also check the Plot and Values boxes as appropriate for each channel.

The Difference Calculation dialog allows you to specify the source channel and the number of intervals between samples over which the difference is to be taken, and also includes the option of rescaling the channel to reflect different units.

Click on the Setup button in the Input Channels dialog box to generate the Difference dialog box:

Source
When the Source channel contains relatively high frequency data, the Difference Calculation may result in a very noisy response, so it’s best to use Difference on relatively smooth data.

Sample rate
This line provides the sample rate for the selected channel (may be different than the acquisition sample rate).

Intervals
Difference is calculated with respect to the number of intervals between points (rather than the number of sample points). For instance, two sample intervals span three sample points:

POINT<interval>POINT<interval>POINT

A 1-interval difference transformation applied to a blood pressure (or similar) waveform will result in the widely used “dP/dT” waveform.

See page 184 for a complete description of the on-line Difference function.

Visit the online support center at www.biopac.com
The Rate Calculation is used to extract information about the interval between a series of peaks in a waveform. This interval can be scaled in terms of BPM (the default), frequency (Hz), or time interval between peaks.

- The BPM (or beats-per-minute) Rate function is used as a measure of peaks or events that occur in a sixty-second period.
- The frequency rate function is commonly used to describe the periodicity of data, or the amount of time it takes for data to complete a full cycle (from one peak to the next peak).
- The Interval Rate function returns the raw time interval between each adjacent pair of peaks, which is essentially the inter-beat interval (IBI), frequently used in cardiology research.

These three functions essentially provide the same information in different formats, since a frequency of 2Hz is equal to an inter-peak interval of 0.5 seconds, both of which are equivalent to a BPM of 120. Other options allow you to record the maximum or minimum value of all peaks (the peak max/min option), or to count the aggregate number of peaks (the count peaks option).

In order to calculate Rate information, you have the option of specifying the threshold manually or having AcqKnowledge automatically compute the threshold value (which is the default). This section describes the basic parameter settings for typical on-line Rate Calculations.

**NOTE**: Parallel functions can be performed after data has been acquired. A detailed description of the Rate Calculation options can be found in the Find Rate section on page 207.

To perform a Rate Calculation in real time, click on the button next to Calc in the Input Channels dialog box. A popup menu will appear with Integrate at the top of the list. Scroll to select Rate and then check an “Acquire” checkbox for the Calculation channel you wish to contain the rate data. You may also check the “Plot” and “Values” checkboxes as appropriate for each channel. To further specify the calculation parameters, click on the Setup button in the Input Channels dialog box to produce the following dialog box:
**Destination** — the Destination channel is determined by the Calculation channel that was selected when the “Setup” button was pressed.

**Source** — The source channel is selected from the Source popup menu at the top of the dialog box.

**Sample rate** — provides the sample rate for the selected channel (may be different than the acquisition sample rate).

**Function** — The Function popup menu includes options to scale the rate in terms of Hz, BPM, Interval, Peak Time, Count Peaks, Peak Minimum/Maximum, Peak-to-Peak, Mean Value, or Area.

- For more information on each of these functions, see the Calculation Channels section beginning on page 207.
- Calculate systolic using the peak maximum Function, diastolic using the peak minimum Function, and mean blood pressure using the mean value Function.
- **NOTE:** All of these Function options are available in the post-acquisition mode through the Transform>Find rate function

**Remove baseline** — This feature provides the exact standard deviation of the input data (typically EMG) over the specified number of samples. When the mean of the input data equals 0-0, the standard deviation and the RMS will be equivalent.

**Auto Threshold detect** — The most convenient way to calculate a Rate channel on-line is to have AcqKnowledge automatically compute the threshold value (the “cutoff” value used to discern peaks from the baseline). This is done by checking the **Auto Threshold detect** box.

**Polarity** — For Rate Calculations involving data with positive peaks (such as the R-wave in ECG data), you will want to click on the button next to “Positive” in the **Polarity** section of the dialog box.

**Noise rejection** — AcqKnowledge constructs an interval around the threshold level when **Noise rejection** is checked. The size of the interval is equal to the value in the noise rejection text box, which by default is equal to 5% of the peak-to-peak range. Checking this option helps prevent noise “spikes” from being counted as peaks.

Visit the online support center at [www.biopac.com](http://www.biopac.com)
**Peak Interval Window** — When the Rate Calculation is set to automatic, you should also specify a minimum rate and a maximum rate. These parameters define the range of expected values for the Rate Calculation. By default, these are set to 40 BPM on the low end and 180 BPM on the high end. The **Windowing units** option is only activated when the selected function can have variable units (i.e., count peaks, mean value, area).

The **Rate** Calculation will use these values to find and track the signal of interest, assuming the input BPM range is reasonably well bracketed by these values. Depending on the shape of the input cycle waveform, the Rate window settings may be closer or further from the expected rates.

- For ECG-type data (where the waveform peak is narrow with respect to the waveform period), the Rate window values will closely bracket the expected values.
- For more sinusoidal data, with the waveform energy distributed over the waveform period (as with blood pressure or respiration), the Rate window will closely bracket the expected rate on the high-end, but can be up to twice the actual measured rate at the low-end.

One of the most frequent applications of the Rate Calculation is to compute BPM on-line for ECG, pulse, or respiration data. For more information on optimizing ECG amplifiers for on-line calculation of heart rate, see the ECG100C section of the *MP Hardware Guide*.

**Show Threshold** — Plots the threshold used by the Rate calculation function. This feature is useful to help the rate detector performance on any given data.

**Show Modified** — Plots the modified data as processed by the Rate Detector. Typically, the modified data is a differential version of the original input data. The data will be modified if the “remove baseline” feature is checked in the Rate Detector Setup dialog.
Math Calculation

The Math Calculation performs standard arithmetic calculations using two waveforms or one waveform and a constant. It is also possible to use other Calculation channels (such as a Rate Calculation channel) as an input channel for a Math Calculation channel, as long as the Calculation channel used as a source channel has a lower channel number than the Math Calculation channel.

Use the pull-down Source menus to select the source channels (Source 1 and Source 2).

The Sample rate line provides the sample rate for the channel selected as Source; the channel sample rate may be different than the acquisition sample rate.

Use the pull-down Operand menu to select a function. In the example below, analog channel 1 (Source: A1) is added to analog channel 2 (Source: A2). It is possible to use this summed waveform as an input for another Math Calculation channel. One useful application would be to divide this waveform (C0) by K, where K=2, thus producing an arithmetic average of source channels A1 and A2.

The “Constant” entry is activated when “K” is selected as a Source.

As an alternative to creating an additional Calculation channel for dividing the summed waveform, you can use the scaling function to perform the same task. To do this, click on Scaling... button and then set the Scale values for the summed waveform equal to +5 and –5 (to correspond to Input Volts values of +10 and –10 respectively). This will effectively plot the sum of channels A1 and A2 as the arithmetic mean of the two waveforms.

For additional libraries of on-line Calculation options, consult the sections on Function Calculation channels and the on-line Equation Generator (page 70). These types of Calculation channels can be used to perform more complex operations on waveforms. Although Calculation channels can be “chained” together (so that the output from one serves as the input for another) to form more complex calculations, a separate channel must be used for each function. Since only sixteen Calculation channels are available, not all calculations can be performed. Additionally, chaining more than three or four channels together can require considerable system resources.

For complex calculations (such as squaring a waveform then adding it to the average of two other waveforms) the Equation Generator is a more efficient solution. All of the features available online in the Math Calculation channels can also be computed after an acquisition using the Waveform Math option (see page 189), which will eliminate the problem of system overload.

Visit the online support center at www.biopac.com
Function Calculation

The Function calculation can be used to perform a variety of mathematical functions using two waveforms or a waveform and a constant. Function Calculation channels compute new waveforms in a manner similar to the math Calculation functions, but provide access to higher order functions. Like math Calculation channels, function Calculations can be chained together to produce complex functions (such as taking the absolute value of a waveform on one channel and calculating the square root of the transformed waveform on another channel). These same functions are also available under the transform menu in AcqKnowledge for post-hoc operations. Many of these functions can also found in the on-line Equation Generator (see page 70 for details on this feature).

To have AcqKnowledge perform a Function Calculation in real time, click on the button next to Calc in the Input Channels dialog box. A popup menu will appear with Integrate at the top of the list. Scroll to choose Function and then check an “Acquire” box for the Calculation channel you want to contain the function Calculation data. You may also check the “Plot” and “Values” boxes as appropriate for each channel. To further specify the Calculation parameters, click on the Setup button in the Input Channels dialog box to produce the following dialog box:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abs</td>
<td>Returns the absolute value of each data point</td>
</tr>
<tr>
<td>Atan</td>
<td>Computes the arc tangent of each data point</td>
</tr>
<tr>
<td>Exp</td>
<td>Takes the e^x power of each data point</td>
</tr>
<tr>
<td>Limit</td>
<td>Limits or “clips” data values that fall outside specified boundaries</td>
</tr>
<tr>
<td>Ln</td>
<td>Computes the base e logarithm for each data point</td>
</tr>
<tr>
<td>Log</td>
<td>Returns the base 10 logarithm of each value</td>
</tr>
<tr>
<td>Noise</td>
<td>Creates a channel of random noise with a range of ±1 Volt</td>
</tr>
<tr>
<td>Sin</td>
<td>Calculates the sine (in radians) of each data point</td>
</tr>
<tr>
<td>Sqrt</td>
<td>Takes the square root of each data point</td>
</tr>
<tr>
<td>Threshold</td>
<td>Converts above an upper threshold to +1 while converting data below a lower threshold to 0.</td>
</tr>
</tbody>
</table>

As with Math calculations, other Functions are available in the on-line Equation Generator. Function Calculations can be chained together to produce more complex Calculations, although it is more efficient to program complex functions using the Equation Generator (see page 70).

The Sample rate line provides the sample rate for the selected channel (may be different than the acquisition sample rate).
**Filter Calculation**

The **Filter** Calculation channel allows you to perform real-time digital filtering on analog, digital, or calculation channels. To have AcqKnowledge apply a digital **Filter** Calculation in real-time, click on the button next to **Calc** in the Input Channels dialog box. A popup menu will appear with Integrate at the top of the list. Scroll to choose **Filter** and then check an “Acquire” box for the Calculation channel you want to contain the filtered data. You may also check the “Plot” and “Values” boxes as appropriate for each channel. To further specify the type of filter, click on the **Setup** button in the Input Channels dialog box to produce the following dialog box:

![Filter Setup Dialog Box](image)

### On-line (IIR) filter options

In the dialog box above, the signal on analog channel one (A1) is run through a low-pass filter that attenuates data above 50Hz. The “Q” for this filter is 0.707, which is the default.

One possible application of the on-line filtering option is in conjunction with the **Show Input Values** option (see page 103). Raw EEG data, for instance, can be filtered into distinct bandwidths (alpha, theta, and so forth) using one source channel and multiple filter Calculation channels. The filtered data can then be displayed in a bar chart format during the acquisition using the **Show Input Values** option.

The **Sample rate** line provides the sample rate for the selected channel (may be different than the acquisition sample rate).

The **Type** pull-down menu lists the four general types of filters: low pass, high pass, band pass and band stop. While the technical aspects of digital filtering can be quite complex, the principle behind these types of filters is relatively simple. Each of these filters allows you to set a cutoff point (for the low and high pass filters) or a range of frequencies (for the band pass and band stop filters).

- **A Low Pass filter** allows you to specify a frequency cutoff that will “pass” or retain all frequencies below this point, while attenuating data with frequencies above the cutoff point.
- **High pass filters** perform the opposite function, by retaining only data with frequencies above the cutoff, and removing data that has a frequency below the specified cutoff.
- There are two types of **Band Pass filter** and each is optimized for a slightly different type of task.
The **Band pass (low + high)** filter is designed to allow a variable range of data to pass through the filter. For this filter, you need to specify a low frequency cutoff as well as a high frequency cutoff. This defines a range or “band” of data that will pass through the filter. Frequencies outside this range are attenuated. The Band pass (low + high) is actually a combination of a low pass and a high pass filter, which emulate the behavior of a band pass filter. This type of filter is best suited for applications where a fairly broad range of data is to be passed through the filter. For example, this filter can be applied to EEG data in order to retain only a particular band of data, such as alpha wave activity.

The alternative **Band pass** filter requires only a single frequency setting, which specifies the center frequency of the band to be passed through the filter. When this type of filter is selected, the “width” of the band is determined by the **Q** setting of the filter (discussed in detail below). Larger values for q result in narrower bandwidths, whereas smaller **Q** values are associated with a wider band of data that will be passed through the filter. This filter has a bandwidth equal to Fo/Q, so the bandwidth of this filter centered on 50Hz (with the default Q=5) would be 10Hz. This type of filter, although functionally equivalent to the band pass (low + high) filter, is most effective when passing a single frequency or narrow band of data, and to attenuate data around this center frequency.

The final type of filter is a **Band stop**, which performs the opposite function of a band pass. A Band stop filter defines a range (or band) of data and attenuates data within that band. In this case, the Band stop filter is implemented in much the same way as the standard Band pass, whereby a center frequency is defined and the **Q** value determines the width of the band of frequencies that will be attenuated.

**Q coefficient**
The on-line filters are implemented as IIR (Infinite Impulse Response) filters, which have a variable **Q** coefficient. The **Q** value entered in the filter setup box determines the frequency response patterns of the filter. This value ranges from zero to infinity, and the “optimal” (critically damped) value is 0.707 for the Low pass and High pass filters, and 5.000 for the Band pass and Band stop filters. If you wish, you may change the **Q**. A more detailed explanation of this parameter, and digital filters in general, can be found in Appendix D.

**Off-line filtering**
Apart from these on-line filter options, similar filters can be applied after an acquisition is terminated. Many of the biopotential amplifiers available from BIOPAC have selectable filters, which allow you to filter certain frequencies (including 50Hz or 60Hz electrical noise) and possibly reduce the need for on-line filters.

Digital filtering can also be performed after an acquisition using the same types of filters. You can choose from the different filter types by selecting **Digital filters** from the *Transform* menu. The filters available after the acquisition use a different algorithm but operate in essentially the same way.

*For more information* on digital filters and filters that can be applied after an acquisition, turn to the Digital Filtering section on page 166 or Appendix B.
The on-line **Equation Generator** is available for performing computations more complex than possible in the Math and Function Calculation options. The **Equation Generator** will symbolically evaluate complex equations involving multiple channels and multiple operations. Unlike the Math and Function Calculations—which can only operate on one or two channels at a time—the **Equation Generator** can combine data from multiple analog channels, and allows you to specify other Calculation channels as input channels for **Equation** channels.

Also, computations performed by the **Equation Generator** eliminate the need for “chaining” multiple channels together to produce a single output channel. A number of functions that are not available in either the Math Calculation or Function Calculation channels can be accessed using **Equation**.

While the **Equation Generator** is more powerful than other Calculation channels, each **Equation** Calculation requires more system resources than other Calculation channels do. This essentially means that acquisitions that utilize **Equation** Calculations are limited to a lower maximum sampling rate than acquisitions without on-line Expression functions.

The same features that are available in on-line Calculation channels are also available under the **Transform** menu for evaluation of complex equations after acquisition. Thus, simple Calculations such as summing two channels or dividing one channel by another (and so forth) are best performed in either the Math Calculation channels or the Function Calculation channels.

On the other hand, for complex Calculation channels, such as squaring one channel, multiplying it by the sum of two other channels, and dividing the product by the absolute value of another waveform, a single Expression Calculation channel is more efficient than chaining five Math and Function Calculation channels together.
Note for variable sample rate processing:
The Equation Generator and Waveform Math functions will constrain operations between waves of
different rates as follows:
If an equation is operating on two or more waves of different sample rates, the result of the operation will
always be output at the lowest sampling rate from the waves (F low). If the destination channel for the
result has an assigned rate other than (F low), the operation will not be permitted. If the destination channel
is set to a new channel, the operation will always be permitted.

To have AcqKnowledge evaluate an expression and save the result to a Calculation channel in real time:
1. Click on the MP menu and select Setup Channels.
2. Click on the button next to Calc in the Input Channels dialog box. A popup menu will appear with
   “Integrate” at the top of the list.
3. Scroll to choose the Equation Calculation.
4. Check an Acquire box for the Calculation channel you want to contain the filtered data. You may
   also check the Plot and Values boxes as appropriate for each channel.
5. Click on the Setup button in the Input Channels dialog box. This will produce a dialog box, where
   you can enter the expression to be evaluated:

The different components of each expression can be entered either by double-clicking buttons from the
button rows (sources, functions, and operators) in the setup expression dialog box, or by typing commands
directly into the Equation box.

For each expression, you need to specify at least one source, the function(s) to be performed, and any
operators to be used. Sources are typically analog channels, although you may also select Time from the
source button row and AcqKnowledge will return the value of the horizontal axis (usually time) for each
sample point. When the horizontal axis is set to frequency (in the Display>Horizontal axis dialog), the
“time” item in the source button row will switch to “frequency.”

The Equation Generator uses standard mathematical notation, as shown in the sample dialog. The equation
takes the sum of analog channels 1, 2 and 3, and divides by three to return a mean value for the three
channels. The result of this is then arcsine transformed and saved on channel C0.

When using the Equation Generator, it is important to keep in mind that while different channels, functions,
and operators can be referenced, this Calculation cannot reference past or future sample points. That is,
data from waveform one can be transformed or combined in some way with data from waveform two at the
same point in time, although data from one point in time (on any channel) cannot be combined with data
from another point in time (on any channel). See the section on post-acquisition expression commands
(begining on page 187) for ways around this limitation.
The **Equation Generator** allows you to perform the following:

<table>
<thead>
<tr>
<th>EXPRESSION</th>
<th>RESULT</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABS</td>
<td>Returns the absolute value of each data point.</td>
</tr>
<tr>
<td>ACOS</td>
<td>Computes the arc cosine of each data point in radians.</td>
</tr>
<tr>
<td>ASIN</td>
<td>Calculates the arc sine of each value in radians.</td>
</tr>
<tr>
<td>ATAN</td>
<td>Computes the arc tangent of each sample point.</td>
</tr>
<tr>
<td>COS</td>
<td>Returns the cosine of each data point.</td>
</tr>
<tr>
<td>COSH</td>
<td>Computes the hyperbolic cosine of each selected value.</td>
</tr>
<tr>
<td>EXP</td>
<td>Takes the $e^x$ power of each data point.</td>
</tr>
<tr>
<td>LOG</td>
<td>Computes the natural logarithm of each value.</td>
</tr>
<tr>
<td>LOG10</td>
<td>Returns the base 10 logarithm of each value.</td>
</tr>
<tr>
<td>ROUND</td>
<td>Rounds each sample point the number of digits specified in the parentheses.</td>
</tr>
<tr>
<td>SIN</td>
<td>Calculates the sine (in radians) of each data point.</td>
</tr>
<tr>
<td>SINH</td>
<td>Computes the hyperbolic sine for each sample point.</td>
</tr>
<tr>
<td>SQR</td>
<td>Squares each data point.</td>
</tr>
<tr>
<td>SQRT</td>
<td>Takes the square root of each data point.</td>
</tr>
<tr>
<td>TAN</td>
<td>Computes the tangent of each sample point.</td>
</tr>
<tr>
<td>TANH</td>
<td>Calculates the hyperbolic tangent of each sample point.</td>
</tr>
<tr>
<td>TRUNC</td>
<td>Truncates each sample point the number of digits specified in the parentheses.</td>
</tr>
</tbody>
</table>

The following operators are available in the **Equation Generator**:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>Addition</td>
</tr>
<tr>
<td>-</td>
<td>Subtraction</td>
</tr>
<tr>
<td>*</td>
<td>Multiplication</td>
</tr>
<tr>
<td>/</td>
<td>Division</td>
</tr>
<tr>
<td>^</td>
<td>Power</td>
</tr>
<tr>
<td>(</td>
<td>Open parentheses</td>
</tr>
<tr>
<td>)</td>
<td>Close parentheses</td>
</tr>
</tbody>
</table>
Delay

Delay setup dialog and resulting graph window

This option allows you to use a Calculation channel to plot another channel lagged (delayed) by an arbitrary interval. The delay interval can be specified either in terms of samples or seconds. These types of plots are useful for producing non-linear ("chaos") plots in AcqKnowledge’s X/Y display mode (see pages 33-34 for a description).

When a delay channel is recorded, there is a segment at the beginning of the Calculation channel (equal to the value of the delay) that will read as 0 Volts. This is normal and occurs because the delay channel is waiting to “catch up” with the original signal. AcqKnowledge fills this buffer with zeros until the delay channel begins to plot actual data. In the example below, the delay channel contains a 0.25-second interval of zeros at the beginning of data file.

Although there is not a parallel function in post-processing mode, the same effect can be obtained by selecting a section of one waveform equal to the desired delay interval and choosing the Edit>Cut function or the Edit>Clear command to remove a section of the waveform.

The Sample rate line provides the sample rate for the selected channel (may be different than the acquisition sample rate).
Control

The Control function is used to output a digital pulse when the value for a specified input channel exceeds a certain level, falls inside a given range, or falls outside a given range. This feature is unique in that the output is on a digital channel (which ranges from I/O 0 through I/O 15) rather than a Calculation channel. Also, unlike other Calculation channels, this Control Calculation can only be performed in real time (i.e., while data is being acquired) and cannot be performed in post acquisition mode.

In addition to outputting a signal on a digital channel, the Control Calculation will also plot an analog version of the digital signal on the Calculation channel you specify. For instance, in the example below, Calculation channel C0 is used to perform a control function using analog channel 1 (A1) as an input and digital channel 0 (D0) as an output. In addition to outputting a pulse on D0, the setup below will also produce a plot on channel 40 (the first Calculation channel) that emulates the signal being output on digital channel 0. Since Calculations are analog channels, the Calculation channel does not contain a “true” digital signal, but is a reasonably good approximation.

There are four parameters that need to be specified for each Control channel:

a) Source channel  

b) Output channel  

c) Type of threshold function  

d) Threshold level values

“Source” refers to the input channel to be used for the Control function. As with other Calculation channels, the Control function can use either an analog channel or another (lower) Calculation channel as an input. In the previous example, analog channel 1 (A1) is used as the input channel. It is not possible to use a digital channel as an input channel for a Control Calculation.

The Sample rate line provides the sample rate for the selected channel (may be different than the acquisition sample rate).

The channel selected in the Output Channel section determines which digital channel the pulse will be sent to. The digital channels range from 0 to 15 (D0 through D15) and external devices can be connected as described in the section on UIM100A connections in the MP System Hardware Guide. In the sample dialog box shown, the digital pulse is sent over I/O line D0.

Visit the online support center at www.biopac.com
Digital channels have two levels, 0 Volts and +5 Volts. When the signal transits from 0 Volts to 5 Volts, an “edge” is created and since the signal is going from low to high, this is referred to as a positive edge. Similarly, as the signal transits back from 5 Volts to 0, a negative edge is created. These transitions or edges can be used to trigger external devices when an analog signal level meets certain threshold criteria.

The **Threshold Function** option sets the criteria for the **Control** channel. You can specify threshold conditions such that the digital I/O line goes to +5 Volts when the conditions are met, or you can program the digital line to go to 0 Volts when the threshold conditions are met. Threshold conditions can be set so that either (a) the digital line is switched when the value of an analog channel exceeds a specified value or (b) the digital line is switched when an analog channel falls within a given range. **AcqKnowledge** also allows you to create a single level threshold or a “wide” threshold.

For example, suppose you want to set a **Control** channel to switch digital line 5 from low to high whenever the signal for Calculation channel one (C0) exceeds 85 BPM. Set the source channel to C0 and the output to D5. Select the upper left graph in the control dialog box and set L2 and L1 to 85, as shown:

As you can tell from the above graph, there are a number of instances where C0 (heart rate) exceeds 85, usually for a short period of time. When it does drop below 85, it appears to return to a value greater than 85 within a second or two. In instances such as this, it might be useful to “widen” the threshold so that the digital line is triggered whenever the input value is greater than 85, but the signal must drop significantly below the threshold value before the threshold is reset.

As another example, the upper threshold value (L2) is set to 85 and the lower threshold (L1) is set to 83, which means that the threshold will not reset until the signal from the source channel drops below 83. In the following example, the digital line is switched from low to high (from zero to +5 Volts) when the heart rate channel exceeds 85, and stays at +5 Volts for several seconds even though the source channel drops below 85 (but above 83). The digital line does not switch back to zero until the heart rate channel drops below 83 (towards the end of the record). Once this occurs, the threshold is reset and the digital line will switch again the next time the source channel exceeds 85 BPM.
It is also possible to have the digital line switch when the source channel drops below a certain value. In the example below, a simple threshold is used to switch the digital line high each time the source channel drops below 50 BPM. Since L2 and L1 are set to the same value, this is not a "wide" threshold (as above) and the threshold resets each time the source channel goes above 50 BPM.

These examples are only a few of the possible applications of the control channel using the two threshold icons on the left-hand side of the Control Setup dialog. You can construct variations of these (i.e., switching the digital line from low to high using a wide threshold whenever the source channel drops below a given channel) that are not discussed above. Moreover, each of the options can be construed somewhat differently than they have been presented here. For example, the previous example switches the digital line from low to high each time the signal on the source channel drops below 50 BPM. Conversely, it also switches from high to low each time the source channel value is greater than 50 BPM. This allows you to vary the default setting for the digital channels (whether the default is zero or +5 Volts) depending on what types of devices are connected.

(For a description of how to connect various digital devices, see the section on UIM100A connections in the MP System Hardware Guide.)

Visit the online support center at www.biopac.com
In addition to setting “above and below” type thresholds, you can program the Control channel such that the digital line is switched whenever the source channel falls within a given range or outside a specified range. In the example that follows, digital line 15 is set to switch from zero to +5 Volts whenever the source channel signal falls between the values entered in the L1 and L2 boxes. In this case, I/O is switched to +5 Volts whenever the heart rate is greater than 60 BPM but less than 80 BPM.

**Control dialog and graph showing control channel switching from low to high when source channel is between 60 BPM and 80 BPM**

You can also program the digital line to switch from high to low when the signal on the source channel falls within a given range. This is equivalent to setting the digital line to shift from low to high when the source channel values fall outside a given range (as shown below).

**Control dialog and graph showing control channel switching from high to low when source channel is between 60 BPM and 80 BPM**
Chapter 4  Setup Acquisition

Setup Acquisition – The Basics

Once you have selected the channels to be acquired, the next step is to set up the acquisition parameters. Among other things, these options control the data collection rate, where data will be stored during an acquisition, and the duration of each acquisition. The dialog box that allows these options to be set is found under the Setup Acquisition menu item of the MP menu.

Storage Mode

At the top of the dialog are three popup menus that allow you to control a number of aspects for storing the data from each acquisition.

The first option, Record/Record last allows you to control whether the software saves all the data or only the most recent segment of the data.

- When Record is selected, the MP System will store data for the amount of time that is specified in the acquisition length box. This is the default and is appropriate for almost all types of acquisitions.

- When Record last is selected, the MP System will acquire data continuously, but will only store the most recent segment of data equivalent to the duration in the acquisition length dialog box. That is, if the value in the acquisition length box is 30 seconds and record last is selected, the MP System will acquire data ad infinitum, but will only store the most recent 30 seconds of the data.

The second option, Save once/Autosave file/Append allows you to vary how the data is saved to a file. By default, AcqKnowledge will save the data to a single continuous file.

- When Save once is selected, AcqKnowledge will begin an acquisition when the mouse is clicked on the start button, and will stop either when the acquisition length has been reached or when the stop button is clicked with the mouse.

- Autosave file mode allows you to perform several acquisitions one after another, and save the data from each acquisition in a separate file. When the Autosave option is selected, a File button will appear to the left of the sample rate dialog box. Clicking on the File button generates a modified Save dialog that allows you to choose the root file name for the data from each acquisition.

- Append mode is similar to the Save Once mode, except that the Append mode allows you stop and restart acquisitions at arbitrary intervals. Append mode is unique in that clicking on the Stop button only pauses the acquisition, which can then be restarted by clicking on the Start button.

Visit the online support center at www.biopac.com
In **Append** mode, each time an acquisition is restarted, a marker is inserted into the record showing the time (hh:mm:ss) at which the MP System started acquiring data; see page 139 for marker details. Although you can pause for any period of time, the MP System will only acquire data for the amount of time indicated in the Acquisition Length box. Data can be acquired in **Append** mode while being saved to computer memory, disk, or the MP acquisition unit (but not in Averaging mode).

When **Append** is used in conjunction with the external trigger, it creates a very useful acquisition tool. An acquisition that takes place over a long period of time with brief events which are few and far between can be set up in the following manner: the researcher watches for these events, triggers the acquisition to start, and then lets the pre-defined acquisition length run out. When another event of interest occurs, the researcher triggers the next acquisition. This acquisition will be “appended” onto the end of the first acquisition. Memory is the only limit as to how many “appendages” can be added.

When **Append** is used in conjunction with Variable Sampling Rates, and the mode is started and stopped manually, it is statistically possible that, prior to the next pass of the Append, extra data points may be inserted in various data channels to “line up” the data (see sample on page 50). These extra data points simply replicate the last sample in any affected channel. To minimize the impact of the extra data points, make sure the lowest sampling rate is on the order of 10Hz or higher, or don’t use Variable Sampling Rates.

Appended segments can be stored to disk or to memory.

- **Append to Disk**: In this mode, it is usually best to record all channels at the same rate. If the user stops the acquisition, the length will be the same for all channels—so the next segment of appended data will neatly link onto the end of the existing record. If channels are sampled at different rates, append to disk operation will cause the software to rewrite all data files in the graph and add “extra” data to the “uneven” waves. This extra data will be a continuation of the same data point at the end of each uneven wave. This operation may take some time to complete for very long data files.

  - You can append to existing files—just open them, change the storage mode to “Append to Disk” and Start the acquisition.

  - On the Macintosh, Append functions only work on AcqKnowledge 3.7 Macintosh format files. If you open any other file format, you will be prompted to translate the file.

- **Append to Memory**: In this mode, data is appended to the “uneven” waves in the same manner as described for Append to Disk. When channels are sampled at different rates, this mode will respond faster than Append to Disk because the data files are already in memory so the software does not have to rewrite all the data files in the graph.

When Append is selected, a **Reset** button is generated in the Setup Acquisition dialog. Click on the **Reset** button to erase the acquired data file and “continue” the acquisition (this is essentially the same as saying yes to an “Overwrite existing data?” prompt).

**Sample data Acquired in “Append” mode.**
Markers indicate where Acquisition was paused.
The third option in the popup menu tells AcqKnowledge where to store data during an acquisition. The options here are Disk/Memory/MP/Averaging.

Once data has been acquired and is stored in a file, it is stored on a hard disk or other similar device. There are a number of options for storing data during an acquisition. The best choice as to where data should be stored during an acquisition depends in large part on the nature of the acquisition itself, and the type of computer being used.

- **Memory** stores data in computer memory (RAM) during an acquisition. After the acquisition is finished you will have to select Save As... from the File menu to permanently save this to your computer’s hard disk. This usually allows for faster acquisition rates, although most computers have less available RAM than disk space.

- **Disk** saves data directly to the computer’s hard disk during an acquisition. Disk mode is fast enough (in terms of maximum sampling rate) for many applications, especially when only a few channels are being acquired. Saving data to Disk also allows for longer acquisitions, since most computers have more hard disk space free than free RAM. A final advantage of saving data directly to Disk is that if there is a system failure (including power outage), all the data collected up to that point is saved on disk and can be recovered, whereas the data is deleted if it is being saved to computer memory.

**IMPORTANT**

If you are saving files in **Disk** mode, always be sure to save your files under a different name BEFORE you start each acquisition. Otherwise, any previous data in that file will be overwritten. In **Memory** mode, you simply go through the standard procedure of saving the file after the acquisition.

- **MP** stores a small amount of data on the MP acquisition unit itself. This storage option allows you to save up to 16,000 samples of data in the MP acquisition unit, with the advantage of being able to obtain very fast sampling rates (up to 70,000 samples per second). Obviously, data cannot be sampled this fast for a very long period of time if it is to be stored in the MP acquisition unit. Also, as more and more channels are acquired, the duration of acquisition to the MP acquisition unit will shorten. Another drawback of storing data to the MP acquisition unit is that the data is not plotted on the screen as it is being acquired, but will automatically be plotted on the screen as soon as the acquisition is terminated.

- **Averaging** is used exclusively for acquisitions involving repeated trials and is discussed in detail on page 84.
**Acquisition Sample Rate**

The value in the box labeled “Sample rate” indicates how many samples the MP System should take per channel during each second of data acquisition. The sample rate can be changed by clicking on the pull-down menu which says “50” (MPWSW) or “200” (MPWS) by default. New sample rates can be chosen at increments between 1Hz and 2000Hz. To allow for variable sample rates, the rate options are constrained so that channel sample rates are equal to or a specific power of 2 less than the acquisition rate.

![Sample Rate pull-down menu](image)

**MP150 rate options (High-speed options)**

**MP100 rate options**

Depending on the nature of the data being acquired, the “best” choice in terms of sampling rate will vary. Technically speaking, the minimum sampling rate should be at least twice the highest frequency component of interest. This means that if the phenomenon you are interested in observing has frequency components (which are of interest) of 100Hz, you should sample at least 200 times per second. Fourier analysis (FFT) can be used to determine what frequency components are present in the data (see page 191 for a more detailed description of the FFT function).

**TIP**: A good rule of thumb is to set the sampling rate to at least three to four times the highest frequency component of interest.

In less technical terms, slower sampling rates can be used for data with slowly changing values (respiration, GSR, and the like), whereas higher sampling rates should be set for data where values change markedly (either in magnitude or direction). Applications that typically involve higher sampling rates are ECG, EEG and evoked response acquisitions. The sample ECG waveforms on page 82 illustrate the effect of different sampling rates on obtaining varying levels of fidelity when reproducing the data.

In the first sample waveform, the data is sampled relatively slowly, and it is difficult to make out the shape of the waveform. In the second waveform (sampled at the faster rate), more samples are taken in the same period of time that allows for higher resolution of some components of the waveform.

As shown, under-sampling completely misses the QRS complex of this waveform, although it might detect components of the QRS in subsequent beats. Although this is an extreme example of how under-sampling can affect digitally processed data, it is important to note that the rate at which data is sampled has important implications for the interpretation and analysis of data.

The third waveform illustrates the advantage of sampling data at relatively high rates, namely increased resolution of the waveform. Waveform components that were obscured at slow sampling rates are now well defined, and measurements taken on this waveform would be able to better establish the maximum amplitude, time interval between different wavelets, etc.
The disadvantage of acquiring data at high sampling rates is that each sample point takes up memory, whether it is RAM or disk space or MP memory. Moreover, once the file is saved, it will require more disk space than a file of similar duration sampled at a slower rate.

The maximum allowable sampling rate will automatically adjust itself according to the storage mode, how many channels are being acquired in the channel setup window and the type of computer being used. You can try this by entering a large value (say 99,999) in the sample rate box. Now click the mouse button or press return and AcqKnowledge will automatically return the maximum allowable sample rate given the computer’s throughput and the acquisition parameters.

If data is being stored to disk or computer memory (RAM) during an acquisition, it is possible to set a sample rate that is too high. The acquisition will begin normally, but AcqKnowledge will stop the acquisition and display a message indicating that the acquisition buffer has overflowed. The data up to this point has been saved, and the sample rate must be set to a smaller value if you wish to complete an entire acquisition.

**Note for variable sample rate processing:**
The Equation Generator and Waveform Math functions will constrain operations between waves of different rates as follows:

If an equation is operating on two or more waves of different sample rates, the result of the operation will always be output at the lowest sampling rate from the waves (F low). If the destination channel for the result has an assigned rate other than (F low), the operation will not be permitted. If the destination channel is set to a new channel, the operation will always be permitted.
**Acquisition length**

To set the duration of an acquisition, enter a number in the acquisition length box. By default, 30 seconds of data will be recorded. The popup menu right of the length box allows you to scale the duration of the acquisition in terms of milliseconds, seconds, minutes, hours, or samples. Changing this option will not change the length of the acquisition, only the units used to describe it. Thus you can describe the same acquisition as lasting 30 seconds, or 0.5 minutes, or 30,000 milliseconds. Scaling the duration of an acquisition in terms of samples is essentially the same as the time scaling options, except the length of the acquisition will be expressed in the total number of samples to be collected on one channel.

Regardless of what scale you use to determine the length of acquisition, AcqKnowledge will end an acquisition when the value in the total length box is reached. You may also stop the acquisition at any time by clicking on the stop button in the lower right hand corner of the graph window.

The MP will automatically limit the maximum recording length to the amount of available memory on the target storage device (memory, disk, or MP). The default is to record one acquisition of the duration specified in the acquisition length box. The acquisition length parameter has a somewhat different interpretation in the *Record Last* (page 78) and *Averaging* (page 84) modes.
Setup Acquisition – Advanced

Averaging Mode

Each of the different types of acquisitions described thus far examines fairly pronounced signals acquired across a given period of time. This approach assumes that the signal(s) of interest stand out against the background or ambient noise. In some instances, the level of ambient noise exceeds the signal produced by the object of interest, and the only way to detect these kinds of signals is to perform repeated trials as part of one acquisition, and average the trials together. Since the “noise” associated with the signal is assumed to be random, and the “signal” is assumed to be systematic, the noise should approach zero as the individual trials are averaged together.

![Signal (top) measured in the presence of noise (middle), which results in the bottom waveform when measured in standard Acquisition mode.](image)

Same signal averaged in the presence of noise over 2,000 trials to produce the lower waveform.

Visit the online support center at www.biopac.com
Any averaging acquisition consists of three general components:

(a) the stimulus signal
(b) the duration of the acquired data, and
(c) a small amount of processing time (or overhead) that takes place between acquisitions.

The duration of the stimulus signal and the duration of data to be acquired can be set by the user. The amount of overhead required is a function of the acquisition length component, the sampling rate, and the number of channels being averaged.

**Stimulus signal** usually some sort of pure tone or pulse; occurs at the beginning of each trial.

**Acquisition length** refers to the amount of data to be acquired during each trial.

**Overhead** refers to a period of time after data has been acquired that is needed to perform the mathematical averaging.

**Latency** refers to the total time elapsed between the start of one trial and the start of the subsequent trial.

**Latency**

The individual components of stimulus signal, acquisition length, and overhead are, in sum, equal to the latency of the acquisition. As a rule, you should set the latency to at least three times the acquisition length. In some cases — such as when you want to allow a subject to return to a baseline state or condition — you may want to set the latency to a value much larger than this. By default, each trial is initiated when the latency value is reached (in the sample dialog box below, a new trial is initiated every 150 msec). If the latency is set to a value too short to allow for averaging to take place, an Acquisition Warning dialog box be generated.
Press the **Adj Latency** button for AcqKnowledge to automatically adjust the latency to the shortest possible value that still allows for data to be acquired and processed.

Press the **Adj Length** button to reduce the amount of data acquired without changing the latency.

Press the **Abort** button to return to the graph window without any data being collected.

It is also possible to initiate a trial on a signal from an external trigger. To enable this option, check the **External trigger** box in the Averaging Options dialog box. When this option is checked, a new trial will be acquired each time a trigger circuit is closed.

For more information on setting up triggers, turn to page 90.
Stimulus types

Although AcqKnowledge does not require a stimulus signal to be output during an averaging trial, most applications that use signal averaging make use of a stimulus signal. During an acquisition, either digital stimuli (i.e., clicks) or analog stimuli (i.e., tones, pulses, and arbitrary waveforms) may be output. The stimulator window, which can be selected by choosing Setup Stimulator from the MP menu, handles all of the stimulus output functions. Some of the features in the Stimulator Setup window are modified when data is to be acquired in the averaging mode.

In almost all cases, the most convenient way to output a stimulus signal is to output a predefined wave through one of the analog output channels (either Out 0 or Out 1). The first step in creating an output waveform is to set the duration of the stimulus. To do this, choose Setup stimulator from the MP menu. When the stimulator setup window appears, click the mouse in the box just above the start of acquisition marker. This box indicates the length of the stimulus section of the acquisition. To edit the stimulus duration, click in the dialog box and type in a new value. In the following sample box, the total length of the stimulus waveform is 20 msec.

**Stimulator setup for averaging Acquisition**

Once the overall length of the stimulus has been set, you can then adjust the length of the individual segments. In the sample setup above, the stimulus wave consists of a 5 msec pulse (segment 2 width) followed by a 3 msec pulse (segment 4 width). Segments 1, 3, and 5 have amplitudes of zero, allowing variable spacing at the beginning, middle, and end of the stimulus waveform. Although the stimulus shown is a pulse waveform, you can also use the stimulator in a similar manner to create tone waveforms, ramp waveforms, and arbitrarily shaped analog waveforms. See the section on Arbitrary Waveforms on page 98 for a detailed description of how to create output waveforms.

AcqKnowledge Software Guide
Although outputting stimuli through analog channels allows for a wide variety of signals to be output with relatively little effort, the maximum resolution of a signal output through an analog channel is 22 microseconds. This means that the shortest segment in the stimulus signal must be at least 22 µsec long. For most applications this is more than sufficient, however, some acquisitions do require shorter duration pulses. AcqKnowledge allows you to output a single digital pulse through digital channel I/O 15, with a resolution of 1 µsec. To do this, go to the Output menu in the bottom left corner of the dialog box and choose PW, which stands for pulse width. Since this is a true digital channel, the output has only two levels (0 Volts and +5 Volts), which cannot be edited. The segment that can be edited is the pulse duration (width), which can be set to any value greater than 1 µsec.

Artifact rejection

Occasionally during an acquisition, extreme levels of artifact will be present for one reason or another. Checking artifact rejection allows you to determine what signal levels constitute artifact, and have the MP System reject these trials. To set these parameters, you need to set a high threshold and a low threshold. Both thresholds refer to the scale limits (normally ± 10 Volts). If the high and low artifact rejection thresholds are set to 80% and 30% (respectively), the MP System will reject any trial where the signal exceeds +8 Volts or −3 Volts.

When the channel scaling feature is used to change the range of scale values to something other than ± 10 Volts, then the artifact rejection thresholds reference the map value associated with +10 Volts (for the high threshold) or with −10 Volts (for the low threshold). If the channel scaling for a particular channel is set so that +10 Volts maps to 400 mVolts, and the artifact rejection is set to 80%, then the MP System will reject any trial which contains a value greater than the equivalent of 320 mVolts or less than the equivalent of −320 mVolts. When artifact rejection is enabled, the MP System will ignore any trials that contain signals exceeding those with the artifact rejection thresholds, keep track of how many trials have been rejected, and add that number of trials to the total number of trials to be acquired. This allows you to “re-try” a trial that was rejected due to the presence of artifact.

Visit the online support center at www.biopac.com
Repeat

The **Repeat** mode allows you to acquire data from repeated trials using the same parameters for each trial. When the **Repeat every** box at the bottom of the acquisition setup box is checked, a series of dialog boxes and popup menus at the bottom of the dialog box become enabled. These allow you to control how many times an acquisition will repeat as well as the interval between trials. When this is unchecked, the acquisitions will repeat as soon as possible (usually instantaneously, but slightly longer if data must be saved to a file between trials).

**Interval**

The entry to the right of the “Repeat every” checkbox tells AcqKnowledge how long to pause between the start of one acquisition and the beginning of the next acquisition. This can be scaled in terms of seconds, minutes, or hours using the second popup menu.

**It is important to note** that this value measures the interval between the start of two adjacent trials, rather than the interval between the end of one trial and the start of the subsequent trial. If the repeat interval is set for 15 minutes and the acquisition length is set to 60 seconds, then there will be a 14-minute pause between the end of the one trial and the beginning of the next.

**Trials**

In the lower corner of the Acquisition Setup dialog box, there are two options that control how many trials should be acquired. The two general options are to perform a finite number of trials, or to perform an infinite number of trials.

To acquire a fixed number of trials, choose for from the popup menu and enter the number of trials you wish to acquire in the box to the right.

To acquire an infinite number of trials, by choose forever from the popup menu. This selection will cause trials to be repeated at the specified interval until the acquisition is stopped either by clicking on the stop button in the graph window or if there is not enough free memory on the target storage device.

Regardless of which options are checked, data for each trial is acquired according to the acquisition parameters specified in the dialog box. In the above example, each trial of data will be sampled at 50Hz and will last 1 minute; the trials will be repeated every 15 minutes for a total of 8 trials.

By default, each acquisition will delete the data from the previous acquisition. You can change this by selecting the **Autosave file** option from the **Save once/Autosave file/Append** option at the top of the acquisition setup dialog box. When the repeating option is checked and Autosave is selected, AcqKnowledge will save the data from each trial using the file name and extension indicated by the autosave feature. See page 78 for a more detailed description of Autosave.
Chapter 5  Setup Triggering

During a normal acquisition, the MP System will begin collecting data following a mouse click on the start button. It is also possible to begin acquiring data by using a trigger. Using a trigger allows you to start an acquisition “on cue” from a variety of different trigger sources. All trigger options are set in the Setup Triggering dialog box, which can be selected from the MP menu. By default, the trigger is set to the off position, and acquisitions are started by clicking on the start button in the lower right hand corner of the screen. Other options can be selected from the popup menu in the setup triggering dialog box. To begin an acquisition with a trigger, first choose the trigger options most appropriate for your application. When that has been set up, click the start button. Once the start button has been pressed, the acquisition will begin as soon as the trigger is activated. There are two general types of trigger sources: digital channels and analog channels.

Digital Triggers

Digital channels are channels that contain binary (either/or) data as typified by a switch being either open or closed. This type of data can be acquired from a push-button switch or other device that produces an on/off pulse. For instance, it is sometimes useful to have an acquisition begin when a subject presses a button or when a signal generator sends out a pulse. These are typical digital signals and the trigger devices that emit these signals can be connected via the UIM100A. Most stimulus generators are equipped to output a digital pulse simultaneously with the stimulus signal.

In a simple trigger design, an external switch is connected to the TRIG and GND D input as shown above. Since this switch will be either open or closed, the data will be digital and have two levels, +5 Volts and 0 Volts. A value of +5 Volts is interpreted as a binary 1, and a level of 0 Volts is interpreted as a binary 0. In the setup above, when the switch is closed (i.e., the button is pressed) the signal changed from +5 Volts to 0 Volts, creating a transition or “edge.” When the signal level changes from 0 to 1, a positive edge is created. As the signal changes back from 1 to 0, a negative edge results. You may use either edge as a trigger by clicking on the pos edge/neg edge box to the right of the trigger box.

If the trigger is set to external, and the edge is set to positive, the acquisition will begin as soon as the push-button is pressed anytime after the start button in the graph window is pressed. Once the button is pressed, the acquisition will proceed according to the acquisition parameters you have set (acquisition length, sampling rate, and the like).
When using a trigger, the default setting is for the acquisition to begin immediately after the trigger pulse or level occurs. You can change the default by using the Delay option in the Trigger Setup dialog box. This feature allows an acquisition to begin a specified period after the trigger level is reached. If you want to start an acquisition one second after a switch closes, set the trigger to external and enter 1.00 in the box next to Delay. The default scale for Delay is seconds, meaning that the acquisition will begin a specified number of seconds after the trigger has been initiated. The scale of the delay can be changed from seconds to samples, milliseconds, or minutes.

During normal triggered acquisitions, data is collected only after the trigger has been activated (or after some delay). For some applications, it is useful to collect data on events that occur just prior to the trigger event. As an example, if an acquisition was set to begin when a device (such as a tone generator or flash) sends an output pulse, it might also be important to collect information on the subject’s state just before the stimulus. To do this, select the Pretrigger option from the Delay/Pretrigger popup menu in the Trigger Setup dialog box.

When the Pretrigger function is enabled, you start an acquisition by clicking on the Start button. The MP System will begin collecting data once you click the mouse on the start button. When the internal memory in the MP acquisition unit is full, the MP System will start replacing the oldest data with the newest data (similar to the record last feature). This process continues until the trigger event occurs. Following the trigger, the MP System will collect data until the total length is reached. The acquisition now contains data from both before and after the trigger.

The amount of data collected before the trigger event is determined by the value in the box next to the Pretrigger popup menu. As with Delay, scaling can be set in terms of samples, milliseconds, seconds, or minutes. The duration of the Pretrigger may also be adjusted using the scroll box to the right of the Pretrigger dialog box.

It is important to note that when the Pretrigger has been selected, the total length of the acquisition includes the duration of the Pretrigger. If the acquisition length is set to 120 seconds and the Pretrigger is set to 20 seconds, only 100 seconds of data will be collected after the trigger event occurs. Also, since the total length of the acquisition includes the length of the Pretrigger, the duration of the Pretrigger may not exceed the duration of the acquisition itself. The Pretrigger feature can only be enabled when data is being stored to the MP acquisition unit (as opposed to disk, memory, or averaging). Since the Pretrigger is part of the Delay/Pretrigger popup menu, Delay and Pretrigger cannot be selected at the same time.
Analog Triggers

In addition to using a digital pulse as a trigger for an acquisition, it is also possible to initiate an acquisition when an analog channel reaches a certain level. To enable the analog trigger feature, data must be acquired to either memory (RAM) or disk, and a value must be entered in the Mode Delay box (although the delay may be set to zero). The channel containing the data to be used as a trigger does not require the acquire/plot/values boxes to be checked in the Setup Channels dialog box. Leaving these boxes unchecked will allow the incoming data to trigger an acquisition but will not cause the trigger channel to be acquired or plotted.

The process of using an analog channel as a trigger is generally similar to using a digital trigger, except that you need to specify which channel of analog data contains the trigger information and what voltage level will initiate the trigger. When you select Setup Trigger from the MP menu, the following dialog box will appear:

Source : Channel
The purpose of using an analog channel as a trigger is to begin an acquisition once the data on a specified channel has reached a critical value. For example, if you are interested in triggering an acquisition when an ECG wave on analog channel 1 reaches a certain voltage or value, you would first set the trigger to CH 1 using the popup menu next to “Source” in the Trigger Setup dialog box.

Source : Edge
As with digital signals, analog signals also have a positive edge and a negative edge. In this case, a positive edge is created anytime an analog signal transitions from a baseline to a peak, and a negative edge is created as the signal level crosses from a peak back to a baseline.

- For ECG data (and other types of data with peaks of relatively short duration) there will be only minor differences between the two edges, although the positive and negative edges can be widely separated in time for data with slowly changing values (such as GSR or skin temperature data).

Level
If the ECG wave peaks at 3 Volts, the trigger level should be set to just under three volts.

Mode
Once the trigger channel and level have been specified, the final parameter is the delay. Delay can be measured in terms of samples, milliseconds, seconds, or minutes, and may be set to zero if desired. The delay option instructs the MP System to wait a specified period after the trigger level is reached before beginning the acquisition.

Visit the online support center at www.biopac.com
Chapter 6  Setup Stimulator

Although data acquisition is the primary function of the MP System, you may also output a signal through one of two analog channels while data is being acquired. This is handled through a window similar to the standard AcqKnowledge graph window. Four types of signals can be output by the MP System: square waves; pure tones; ramp waveforms; and arbitrary waveforms. In addition, each of these waveform types can be set to output a signal either Once or Continuously, and parameters can be set to either Relative or Absolute time scales.

To set the type of waveform to be output, select Setup stimulator from the MP menu. This generates a window that allows you to control the type of signal output by the MP System. Like the standard graph window, this plots time on the horizontal axis and amplitude on the vertical axis. You can use this window to create and shape waveforms to be output.

![Stimulator setup window](image)

For any waveform (or stimulus) to be output, you need to specify the type of stimulus, the “shape” of the signal, the output channel to be used, and how many times the stimulus should be output. All of these parameters can be set from within the setup stimulator window. Regardless of the type of waveform you select, stimulus signals will normally be output when an acquisition is initiated, either as a result of clicking on the start button or a trigger being activated.

**Stimulator Sample Rate — MP150 only**

A very powerful feature intrinsic to the MP150 unit is the ability to set a stimulation signal output rate that is different than the acquisition rate, thus permitting considerable flexibility for a variety of physiological applications. Use the pull-down menu to select a unique sample rate for the stimulator.
**Stimulator Icons**

**Waveforms:**
- Square wave
- Tone (sine) wave
- Ramp wave
- Arbitrary wave

**Parameters:**
- Reset the display (use after adjusting the time scale)
- Copy a stimulus waveform from the Stimulator Setup window to the Graph window
- Scaling (rescale Stimulus signals to different units)
- Set time base to relative
- Set time base to absolute

**Output:**
- Toggle Stimulator output ON and OFF
- Output to Analog Output channel 0 (default)
- Output to Analog Output channel 1
- Pulse width

**Repeats:**
- Output stimulus signal once
- Output stimulus signal for duration of acquisition

**Trigger:**
- Toggles between “Off” and “Wait for”
  - Off — Output stimulus signal when Start button is pressed
  - Wait for — Output stimulus signal when trigger is initiated

Visit the online support center at www.biopac.com
**Square waves**

Square waveforms are useful for generating pulse waveforms, which can be used as stimuli or to trigger a stimulus-generating device (such as a flash device or a tone generator).

![Stimulator Setup for square wave with segments labeled](image)

To output a square wave, click on the icon in the “Waveform” section of the Stimulator Setup window. Next choose the icon in the “Repeats” section. You should see a rectangular wave appear in the window. You can control the shape of the wave by manipulating the various segments of the wave. A square wave has five segments, and AcqKnowledge allows you to set the amplitude and duration of each segment.

- When the time base is set to relative, AcqKnowledge allows you to set the width of each interval.
- When the time scale is set to absolute, the settings are adjusted to reflect the time associated with the last sample point of each segment (rather than the duration of the segment itself).

In a square wave, each of the editable segments is oriented horizontally, with vertical segments connecting the adjacent sections of the wave. The first segment of a pulse waveform is the segment that appears at the far left of the waveform section. By positioning the cursor on this segment of the waveform, you can tell from the box at the bottom of the screen that the amplitude (vertical offset) of the first segment is 0 Volts, and the width of the first segment is 500 msec.

---

**AcqKnowledge Software Guide**
To adjust the amplitude of the first segment, either
a) enter the desired amplitude in the box that says Seg #1 Ampl; or
b) position the cursor on the first segment of the waveform and drag it up or down using the mouse.

To change the duration of the first segment, you may either:

a) Enter a value in the Seg #1 Width box at the bottom of the Stimulator Setup window; or
b) Position the cursor on the first vertical segment in the setup window, click the mouse button, and drag the vertical segment left or right. Moving the first vertical segment left shortens the duration of the first segment, whereas moving the first vertical segment right lengthens it.

Each of the segments in the pulse wave can be “edited” in this way.

**Tone Stimuli**

This option outputs a pure sine wave, which is useful for audiological and stimulus response testing. Tone waveforms allow you to create pure tone signals of any duration, magnitude, and frequency.

To create a tone waveform, click on the sine wave button in the Stimulator Setup window. A tone waveform is composed of two segments, with only the second segment being the actual tone itself. This allows you to include a pre-signal delay (by setting the amplitude for Segment #1 to 0 Volts and the duration to a desired value).
To set the duration of the tone, adjust the length of segment #2 (by changing the **Seg #2 Width** value). As with a pulse waveform, segments can be edited either by changing the values in the corresponding boxes or by clicking and dragging the segments within the window. In the previous example, a 2Hz tone is output for 2000 msec., after a 500-msec delay. As shown, there is an additional (editable) section of the waveform *after* the second section. This segment returns the last value from segment two, and continues to output that signal level until the acquisition is terminated (if the stimulator is set to output once) or until another signal is output (if the MP System is set to output continuously).

There are three additional parameters for Tone waveforms: frequency; magnitude; and tone phase.

- **Tone frequency** refers to the frequency of the second segment of the waveform. This can be set to any value, although the most common settings are between 20Hz and 20,000Hz.

- **Magnitude** refers to the peak-to-peak range of the signal, which can range from ± 0 to ± 10 Volts. You can adjust the phase of the stimulus signal to any value equal to or greater than 0 degrees.

- **Phase** settings of more than 359 degrees will be rescaled to fit the 0°-359° range. In other words, setting the phase to 360° or 720° has the same effect as setting the phase to zero degrees.

### Ramp Waves
Ramp waveforms are useful when you need to construct a monotonically increasing or decreasing stimulus signal. Ramp waves are composed of three segments and the amplitude and duration can be set for all three sections.

![Stimulator Setup window for Ramp Waveform](image)

To create a Ramp waveform, click on the ramp wave button ![waveform icon] in the **Stimulator Setup** window.
**Arbitrary Waveforms**

Arbitrary waveforms are useful for creating output other than pure tones, pulses, or ramp waves. This option allows you to create a waveform of virtually any shape. This is done through the standard AcqKnowledge editing functions (see Part C — Analysis Functions for information on editing and transforming waveforms).

**Stimulator Setup window for Arbitrary Waveform**

Unlike the other types of waveforms, the arbitrary waveforms have no segments, so the “shape” of the waveform is determined by selecting an existing waveform from an AcqKnowledge graph window.

To output an arbitrary waveform, you must have a waveform open in a standard graph window. Select the section of the waveform you wish to output and then return to the Stimulator Setup window — the selected area will automatically be pasted into the window.

Since an arbitrary waveform has no segments, the only parameters that can be set for this type of signal are the Repeats Once/Continuously and the Trigger options (descriptions of both follow).
You can also construct an Arbitrary waveform by copying and pasting predefined stimulus waveforms (e.g., square waves or ramp waves) into a standard graph window. This is useful when a pure signal needs to be modified by adding noise or modifying waveform parameters such as rise time or decay. It also allows you to combine complex sequences of existing stimulus waveforms, such as a pulse followed by a tone. To create waveforms such as these, create a waveform in the stimulator setup (as described above) of the desired duration and shape. Next choose **Edit>Copy** and switch to an empty graph window. Now choose either **Insert waveform** or **Paste** from the **Edit** menu. This will place the contents of the stimulator window in the graph window, where the waveform characteristics can be modified and later pasted back into the Stimulator Setup window and output as an arbitrary waveform.

**Outputting continuously.** In some cases, you may want to output a signal more than once during an acquisition. To do this, select the [∞] icon from the “Repeats” menu at the bottom of the Stimulator Setup window. Choosing this option tells AcqKnowledge to repeatedly output the stimulus signal for the duration of the acquisition. When output continuously is selected, a vertical line will appear at the end of the first section of the waveform in the stimulator window. This line indicates where the first output signal ends and the second begins, and can be dragged left or right like a vertical segment in a stimulus waveform. By moving this segment left or right, you can control the duration of the waveform as it is continuously output.
Outputting on other channels. The MP System allows you to output on either one of two analog output channels, referenced as A0 or A1. Although output devices can be connected to each of these channels, you can only output on one channel at a time. By default, the output channel is set to Analog 0, labeled Analog Output 0 on the UIM100C. Select A1 from the Output menu to change this to Analog 1 (labeled Analog Output 1 on the UIM100C).

Trigger options. When a trigger option is selected (in the Trigger Setup window), AcqKnowledge allows you to select from additional menu items with respect to when the signal is output. By default, the stimulus signal will be output when you click on the start button. When a trigger is enabled, however, you have the option of either outputting the signal when the start button is pressed or when the trigger is initiated. The trigger option is added to the stimulator window when a trigger is enabled in the Setup Trigger box (described on page 90).
Parameters

Reset  The reset button is used to refresh the display, and should be used after the time scale has been adjusted.

Copy  The copy button is used to copy a stimulus waveform from the Stimulator Setup window to the Graph window. Use in any situation where you might want a square wave or tone wave to be inserted into a Graph window. To use this feature, simply click on the icon when you have the desired waveform and it will automatically be copied to a clipboard where it can then be pasted into a graph window using the Edit>Paste command.

Scaling  Stimulus signals can be rescaled to different units. To change the vertical scale to read in units other than Volts, click on the icon. This produces a dialog box similar to the Scaling dialog used for analog channels.

In the following example, an output signal of +10 Volts is rescaled to +128 dB, while an output signal of –10 Volts is rescaled to reflect 0 dB. Although this type of rescaling does not change the amplification of the signal, it is useful for recalibrating the output signal to more meaningful units.

Stimulator output rescaled to reflect dB rather than Volts

Relative  Time scale for the output waveform is set to relative with the button.

When the time base is scaled in relative terms, AcqKnowledge allows you to set the duration of each segment of the output waveforms.

- Relative mode would describe one waveform as having two segments of 250 msec each.

Absolute  Time scale for the output waveform is set to absolute with the button.

When the waveform is scaled in absolute terms, the time scale reflects the value of the last sample point of the segment.

- Absolute mode would describe a waveform as having one segment ending at 250 msec and another segment ending at 500 msec into the acquisition.
The next two windows illustrate the same wave displayed in **Relative mode** and **Absolute mode**. Note the differences in the width data for Seg #2 through Seg #5.

**Output signal scaled in Relative mode**

**Same output signal as above scaled in Absolute mode**

Visit the online support center at www.biopac.com
Chapter 7  Other MP Menu Commands

Show Input Values

EEG data filtered into four bands using on-line filtering option

Spectra displayed using Show Input Values

The Show Input Values option of the MP menu generates an Input Values window, which displays channel values in real time, whether an acquisition is in progress or not—which allows you to display values prior to or after an acquisition.

- In the example above, a single channel of EEG data was passed through four different on-line band pass filters. This created four new Calculation channels, each designed to retain data only within a given range. The Input Values window displays a spectral plot in real time.

The Input Values display can be set to numeric, horizontal or vertical bar graph format, and it can be resized and moved to any position on the screen. To set the display mode on a PC, use the icons under the Input Values title bar; on a Macintosh, use the “Mode” menu generated via the “Options” button.

Note: The Input Values window only displays values for channels that were set up with the “Values” box checked (see page 48 for more information on the “Values” checkbox).
Display options: PC:

<table>
<thead>
<tr>
<th>MODE</th>
<th>ICON</th>
<th>EXPLANATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hold</td>
<td></td>
<td>Regardless of the display options selected, the display can be “frozen” at any point in time by clicking on the hand icon (PC) or the Hold button (Mac). Clicking this icon will hold the values at their level(s) when the icon was pressed. The window will remain frozen until the icon is clicked again. Once the values are “unfrozen,” the values will return to the standard real time display mode.</td>
</tr>
<tr>
<td>Numeric</td>
<td></td>
<td>When data are displayed in numeric value mode, the voltages of the appropriate channels are displayed numerically.</td>
</tr>
<tr>
<td>Bar chart</td>
<td></td>
<td>Data can be displayed in either Horizontal or Vertical bar chart formats. The range of values of the bar graphs corresponds to the range for that channel in the graph window. To see the bar “bounce” less for a particular channel, increase the units per division in the graph window for that channel. Conversely, to have a bar take up more of the window space, decrease the units per division in the graph window.</td>
</tr>
</tbody>
</table>

Options

PC

Options...

Macintosh

Hold

Options...

Mode (on the Macintosh) controls the format of the values display.

Precision — On a PC, Precision controls how many significant digits of data are displayed after the decimal place (a setting of 5 digits might display data from one channel as 1206.70425 and data from another channel as -.97159).

Visit the online support center at www.biopac.com
On a Macintosh, Precision controls the total number of digits displayed.

**Show** controls the amount and type of information displayed regarding each channel. Click in the box next to each option to activate it.

- **Channel Numbers** will display the channel numbers (A1 for the first analog channel, for example).
- **Labels** will display the channel labels (ECG 1, Respiration, etc.) along with the input values. This feature is especially useful when values from multiple channels are being displayed simultaneously.
- **Units** will display the units for each channel (as indicated in the main graph window). By default, each channel’s display units are scaled in terms of Volts, but this can be changed by clicking in the amplitude scale units area in the graph window.
- **Min/Max** will display the range of values associated with the data. This range corresponds to the upper and lower display limits for each channel as it appears in the graph window.
- **Values** will display number values along with the horizontal or vertical bar chart.

The **Font** button will generate a standard font control dialog.

---

### Sound

On the Mac, the **Sound** option is accessible under the **MP** menu.

See page 106 for Sound Control details.

---

The **Sound** button generates a “Sound Setup” dialog, which allows you to turn sound on or off, select the sound source channel, control the volume, and assign the **High Frequency** and **Low Frequency** values to establish the desired sound output.

You can also use calculation channels to control the sound patterns.
Sound Feedback

Sound Feedback can be used to generate an audio signal based on a channel’s data values. Use the Sound dialog to turn sound on or off, select the sound source channel, control the volume, and assign the High Frequency and Low Frequency values to establish the desired sound output. On the Macintosh, you can also control the output sampling rate.

A sine wave is generated that ranges between user-specified frequencies. As the input value changes, the generated tone shifts in response to the input value. On the Macintosh, the audio signal is generated with 16 bits of resolution, providing a frequency resolution equivalent to CD.

The amount of change in the tone is dependent on the channel scale and mirrors the percentage of change of the gauges in the Input Values dialog “bar” display mode. The sound frequency and sampling rate for generation can both be adjusted. Lower sampling rates require less processing time to generate, while higher sampling rates can generate higher frequency tones.

There is an option to silence the tone if the input signal falls out of specified range (if the value would not be plotted, no sound is emitted).

You can use Calculation channels to control the sound patterns. Begin in the MP > Setup Channels dialog. Select a calculation channel Preset and make sure the “Values” option is checked for each channel you want to use sound on.
After you've selected a Preset, click on **Setup...** and then establish the desired settings. One possible set up is demonstrated on the following page.

When you click on the “Start” button, the Calculation channels will display the sound pattern.
Note: When the channel level falls out of the established Display Range, the sound turns off for that time period.
The **Manual Control** dialog box allows you to monitor and/or output pulses through the digital input/output (I/O) channels, as well as manually set the magnitude of the signal on either of the analog output channels. You can manually control the output options if the wide range of waveform output options available in the Setup Stimulator dialog box cannot match your specifications.

The 16 digital channels are sectioned off into two blocks, with the first block consisting of I/O channels 0 through 7, and the second block consists of I/O 8 through I/O 15. All the channels within a given block are programmed together and can be set as either inputs or outputs; the two blocks can be set independently. In other words, the lower block can be set to input data while the upper block outputs data. You can set channels in the lower block to either read in data or do nothing (as opposed to outputting data) while channels in the upper block either output data or do nothing (as opposed to reading data).

To read incoming values for a given block of digital channels, click on the **Input** button below the row of channels for which you wish to have input values displayed. This enables a block of digital channels to receive incoming data. To read the values for the entire block simultaneously, click the Read button to the left of the channel boxes for that block. Since these are digital channels, the values on the individual channel boxes will toggle between 0 and 1.

When the **Read Continuously** box is checked (below the Input button), the values will be read in real time. When unchecked, the displayed values correspond to the values for that block of channels as of the last time the Read button was depressed. This mode provides much the same information as the Show Input Values mode.

To output values for a given channel, the block containing that channel must first be enabled to output data. To do this, click on the bar below the channel boxes so the button reads “Output.” You can then program the individual channels within that block. These channels will toggle between 0 and 1, with a 0 corresponding to zero Volts and a 1 corresponding to +5 Volts. To output a digital 1 on I/O channel 3, the dialog box would be setup as shown above:

The function buttons toggle as follows:

- **Input** toggles to **Output**
- **Set** toggles to **Read**

To output a signal on Channel 3, click on the **Set** button to the left of the channel box. If the **Set immediately** box is checked, the signal will be output when the channel button is clicked.

**IMPORTANT**

Potential use conflicts can arise between the parameters set in the **Manual Control** window and those set for digital channels in the **Setup Channels** window.
When the STM100C stimulator module is connected to an MP System, the output level can be controlled via the the **Stim 100** option of the **Manual Control** dialog.

**Attenuation**  
Attenuate the output signal by a given number of decibels (dB) for controlled stimulus applications. To output a signal with no attenuation, simply set the “Stim 100 Attenuation” to 0 dB. 

Manually outputting a value on a digital channel can stop an acquisition if data is being collected at very high speeds (greater than 10,000 samples per second aggregate).

**Invert output**  
Check this box to invert the polarity of the signal output through the STM100C.  
This function can also be achieved by flipping the polarity switch on the STM100C from positive (POS) to negative (NEG).

For more information on the STM100C stimulator output module, see the *MP Hardware Guide.pdf*.
**Autoplot and Scroll**

Both Autoplot and Scroll control how data appears on the screen. By default, AcqKnowledge displays the most recently collected data first, and if more than one screen of data is to be collected, then the time scale will “scroll” so that the newest data is always on the right edge of the screen.

When Scroll is deselected and Autoplot is checked, the screen will be cleared when the data reaches the right edge of the screen, and plotting continues from the left again.

When both Scroll and Autoplot are unchecked, the incoming data will be plotted until the screen is full. Once the screen is full, data will continue to be collected, but only the first screen is displayed. By default, the MP will display the first eight seconds of the data record, but this can be reset manually by changing the horizontal scale. To turn Autoplot ON or OFF in the middle of an acquisition:

- For the MPWSW (PC) — select Ctrl+T on the keyboard to toggle Autoplot.
- For the MPWS (Mac) — pull down the MP menu and check “Autoplot” ON or OFF or use the keyboard shortcut Command+T

**Warn on Overwrite**

Selecting the “Warn on overwrite” option from the MP menu will cause the following dialog box to appear each time you start a new acquisition:

If you click on **Yes,** then AcqKnowledge will erase your current file and overwrite with a new acquisition. If you don’t want to erase the file you’re working in, click on **No** and then open up a new file to work in.

This prompt will appear at the beginning of each acquisition when the MP System is in Repeating/Autosave mode, so you will probably want to uncheck the “Warn on Overwrite” under the MP menu.

**Organize Channel Presets (MP150 only)**

The Organize Channel Presets option controls the channel presets (established or new) in the MP150 > Setup Channels dialog; you can rename, rearrange or delete Presets. You might use this option to place the most frequently selected Presets at the top of the menu or group related Presets, such as established ECG Presets and new channel Presets you’ve created.

Click on a Preset description to select it, and then use the buttons to organize the Presets. The **up** and **down** arrows will move your selection one space at a time, and the **Top** and **Bottom** buttons will jump to the start or end of the list.

Macintosh users can drag items to reorder them on the Presets list.
To delete or rename a Preset, select the Preset name from the listing and click on the **Delete** or **Rename** button. Or, click the right mouse button to select the Preset from the listing and scroll to the desired option.

Visit the online support center at www.biopac.com
Rename a Preset by typing in a new description and clicking OK.

- You cannot use any name currently used by a Preset or any name that matches a Calculation type (Integrate, Rate, etc.).

Delete a Preset by selecting that option. You cannot delete the Default Analog Input preset. When you delete a Preset, you will be asked to confirm the request because it is an irreversible action.

Select Network Adapter (MP150 only)
The Select Network Adapter option generates the Ethernet card configure dialog, which prompts you to select an Ethernet adapter to use with the MP System.

MP150 Serial Number (MP150 only)
The pull-down menu lists all MP150A units that are powered ON and sitting on the same local area network. The software can’t determine the lock status until a user attempts to communicate directly to a MP150A unit — each MP150A unit needs to be tried to determine if it is locked or unlocked.

The fact that MAC (Ethernet) addresses appear in the user’s “Select MP150” dialog does not imply that the MP150A unit is, in fact, unlocked and available. If a user attempts to connect to a locked MP150A, an error message will be generated to advise that the MP150 unit is locked to a different computer.

When “No Hardware mode” is selected, the menu of available MP150A units is grayed out and becomes unselectable.

See also: Appendix E — Locking/Unlocking the MP150A (page 241)

AcqKnowledge Software Guide
About MP

Selecting About MP from the MP menu displays a dialog box with information about the software and firmware versions being used by AcqKnowledge:

![About MP dialog box]

Note: For information about AcqKnowledge software, click on the About menu.
Part C — Analysis Functions

Overview

This part describes how to analyze data; in most cases, analysis is performed after the data has been collected. This involves creating, managing, and saving files, as well as editing data, performing mathematical transformations, and displaying data in various ways. Many of the functions covered here are also discussed in Part A—Getting Started. Features that can be computed during an acquisition (primarily transformations and calculations) are discussed in Part B—Acquisition Functions.

For general information about sections of the graph window, and to become familiar with the “look and feel” of AcqKnowledge, turn to the Editing and Analysis Features chapter that follows. Descriptions of functions can be found in the chapters describing each menu. All of the commands discussed here can be found under the File, Edit, Transform, or Display menu items.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Chapter</th>
<th>Type of Commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>Ch. 9</td>
<td>General file management commands, including opening, saving, and closing files. Export data files.</td>
</tr>
<tr>
<td></td>
<td>Page 149</td>
<td></td>
</tr>
<tr>
<td>Edit</td>
<td>Ch. 10</td>
<td>Cut, copy, and paste between and within files. Export data files.</td>
</tr>
<tr>
<td></td>
<td>Page 158</td>
<td></td>
</tr>
<tr>
<td>Transform</td>
<td>Ch. 11</td>
<td>Mathematical transformations and functions, from simple arithmetic to digital filtering and spectral analysis.</td>
</tr>
<tr>
<td></td>
<td>Page 165</td>
<td></td>
</tr>
<tr>
<td>Display</td>
<td>Ch. 12</td>
<td>Control how data appears on the screen either during or after an acquisition.</td>
</tr>
<tr>
<td></td>
<td>Page 214</td>
<td></td>
</tr>
</tbody>
</table>
### Keyboard shortcuts

<table>
<thead>
<tr>
<th>Menu</th>
<th>Macintosh Shortcut</th>
<th>PC Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File menu</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>New</td>
<td>N</td>
<td>Ctrl-N</td>
</tr>
<tr>
<td>Open</td>
<td>O</td>
<td>Ctrl-O</td>
</tr>
<tr>
<td>Close</td>
<td></td>
<td>Ctrl-W</td>
</tr>
<tr>
<td>Save (graph)</td>
<td>S</td>
<td>Ctrl-S</td>
</tr>
<tr>
<td>Print</td>
<td>P</td>
<td>Ctrl-P</td>
</tr>
<tr>
<td>Exit / Quit</td>
<td>Q</td>
<td>Ctrl-Q</td>
</tr>
<tr>
<td><strong>Edit menu</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Undo</td>
<td>Z</td>
<td>Ctrl-Z (only shows when applicable)</td>
</tr>
<tr>
<td>Cut</td>
<td>X</td>
<td>Ctrl-X</td>
</tr>
<tr>
<td>Copy</td>
<td>C</td>
<td>Ctrl-C</td>
</tr>
<tr>
<td>Paste</td>
<td>V</td>
<td>Ctrl-V</td>
</tr>
<tr>
<td>Clear</td>
<td>none</td>
<td>del</td>
</tr>
<tr>
<td>Duplicate Waveform</td>
<td>D</td>
<td>none</td>
</tr>
<tr>
<td>Select All</td>
<td>A</td>
<td>none</td>
</tr>
<tr>
<td>Journal&gt;Paste meas.</td>
<td>M</td>
<td>Ctrl-M</td>
</tr>
<tr>
<td>Journal&gt;Paste wave</td>
<td>W</td>
<td>Ctrl-D</td>
</tr>
<tr>
<td><strong>Transform menu</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Find peak</td>
<td>F</td>
<td>Ctrl-F</td>
</tr>
<tr>
<td>Find next peak</td>
<td>E</td>
<td>Ctrl-E</td>
</tr>
<tr>
<td>Find all peaks</td>
<td>R</td>
<td>Ctrl-R</td>
</tr>
<tr>
<td>Find rate</td>
<td>none</td>
<td>Ctrl-A</td>
</tr>
<tr>
<td><strong>Display menu</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Zoom back</td>
<td>-</td>
<td>Ctrl-(minus key)</td>
</tr>
<tr>
<td>Zoom forward</td>
<td>+</td>
<td>Ctrl-(plus key)</td>
</tr>
<tr>
<td><strong>Start/Stop Acquisition</strong></td>
<td></td>
<td>Alt-spacebar</td>
</tr>
<tr>
<td><strong>MP menu</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Autoplot data on screen</td>
<td>T</td>
<td>Ctrl-T</td>
</tr>
<tr>
<td><strong>Cursors</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>I-beam</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>Arrow (pointer)</td>
<td>B</td>
<td></td>
</tr>
<tr>
<td>Zoom</td>
<td>G</td>
<td></td>
</tr>
</tbody>
</table>

Visit the online support center at www.biopac.com
Right Mouse Shortcuts — Windows® only

The following options can also be located via the right mouse button.

Graph window:
- Grid
- Zoom Back
- Zoom Forward
- Autoscale
- Color
  - Line Plot
  - Step Plot
  - Dot Plot
  - Dot Size
- Duplicate
- Grid Options
- Statistics...

Journal window:
- Undo
- Cut
- Copy
- Paste
- Delete
- Select All
- Change Font
- Wrap Text

Horizontal scale:
- Full page scroll
- Half a page scroll
- Quarter of a page scroll

(Update screen interval options)

Contextual Menu — Macintosh only

On Macintoshes that have the Contextual Menu Manager installed (usually Mac OS 8.1 and above), the graph window has contextual menus (similar to right-click functionality on the PC). To access these menus, hold down the Control key and click the mouse button.

If the mouse is over a portion of the graph that has a context menu available, the cursor will change to an arrow with a menu.

The contextual menus available are:

- **Waveforms**: Set plot mode, select transformations, show Statistics
- **Measurements**: Copy to clipboard or journal, toggle interpolation on/off
- **Markers**: Insert, delete, paste summary to Journal
- **Horizontal Scroll**: Change update interval

Contextual menu items correspond to the AcqKnowledge main menu state.

Application menu customization has a corresponding effect on contextual menu display. If a contextual menu item does not have a corresponding application menu item, the menu customization file identifier will begin with “IDM_CM.”

Due to operating system limitations, Balloon Help is not available for context sensitive menus.
Toolbars
Many of the most commonly used features in AcqKnowledge can easily be executed with a mouse click. The toolbar contains shortcuts for some of the most frequently used AcqKnowledge commands; icons are grayed out when they are not applicable. Click **Display >Show >Tool Bar** to view the icons.

Icons vary slightly between PC and Mac but functionality is the same. Click on an icon to activate it.

<table>
<thead>
<tr>
<th>PC</th>
<th>MAC</th>
<th>FUNCTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>![icon]</td>
<td>![icon]</td>
<td>Change display to scope mode.</td>
</tr>
<tr>
<td>![icon]</td>
<td>![icon]</td>
<td>Change display to chart mode (default).</td>
</tr>
<tr>
<td>![icon]</td>
<td>![icon]</td>
<td>Change display to X/Y mode.</td>
</tr>
<tr>
<td>![icon]</td>
<td>![icon]</td>
<td>Autoscale selected waveform only.</td>
</tr>
<tr>
<td>![icon]</td>
<td>![icon]</td>
<td>Autoscale waveforms along the horizontal axis.</td>
</tr>
<tr>
<td>![icon]</td>
<td>![icon]</td>
<td>Center waveforms vertically in the active window.</td>
</tr>
<tr>
<td>![icon]</td>
<td>![icon]</td>
<td>Center waveforms horizontally in the active window (X/Y mode only).</td>
</tr>
<tr>
<td>![icon]</td>
<td>![icon]</td>
<td>Find the peak of a selected area.</td>
</tr>
<tr>
<td>![icon]</td>
<td>![icon]</td>
<td>Find the next peak (after peak has been defined).</td>
</tr>
<tr>
<td>![icon]</td>
<td>![icon]</td>
<td>Show/Hide gridlines in the graph window.</td>
</tr>
<tr>
<td>![icon]</td>
<td>![icon]</td>
<td>Show/Hide measurement pop-up windows.</td>
</tr>
<tr>
<td>![icon]</td>
<td>![icon]</td>
<td>Show/Hide channel selection boxes.</td>
</tr>
</tbody>
</table>

Channel selection boxes ![icon] appear above the data window and indicate the channel(s) being used to record data.

- **To select a channel**, depress the corresponding channel number box (CH 1 is selected here).
- **To hide a channel**, Ctrl-click (PC) or Option-click (Mac). A slash mark will cover the channel box and the channel will be hidden.

| ![icon] | ![icon] | Show/Hide markers and marker menu icons. |

Marker menu icons:

**PC** — ![icon]  
**MAC** — ![icon]

| ![icon] | ![icon] | Show/Hide journal. |

**MAC** — Journal must be open for icon to work.

| ![icon] | ![icon] | Produce a list of Student Lab-type files in the current folder. Other folders can be selected by: |

**PC** — choosing “Browse” from top of the list.  
**MAC** — choosing the “Select” folder.

Visit the online support center at www.biopac.com
Chapter 8  Editing and Analysis Features

Overview

This section provides a brief overview of some of the most frequently used AcqKnowledge features and functions. For more detailed information about specific features, turn to Chapters 9 through 13.

If you are not currently running AcqKnowledge, double click on the AcqKnowledge icon to start it. Choose Open from the File menu and select the file called “4chData.acq” (or “4chData” for MPWS). Your screen should look like this:

Using the scroll bars

As you can see, there are four channels of data in this file (BP, Resp, Lead 1, Lead 2). Although this record is 30 seconds long, only a few seconds are displayed on the screen at one time. You can move to different locations in the record by moving the scroll box at the bottom of the screen. Dragging the box left moves you to earlier points in time, and moving right displays events closer to the end of the record. Clicking on the arrows at either end of the horizontal scroll bar allows you to move to different points in time at smaller increments.

A vertical scroll bar is on the right side of the screen, and, if you click on the scroll arrow at the top of the box, you’ll see that one waveform appears to move down within its “track” on the screen. Moving this scroll box changes the amplitude offset of a selected channel. As with the horizontal scroll bar, you may either move the box or click on the arrows.
Changing the scale

Horizontal scale

As an alternative to the scroll bar, you can click the mouse button with the cursor in the area just above the horizontal scroll bar or just left of the vertical scroll bar. Clicking in the horizontal scale area (where it says “seconds”) generates a dialog box that allows you to enter a value for units per division and horizontal scale offset. This dialog varies based on the lock status of the grid, which is established in the Display > Show > Grid Options dialog.

Unlocked

Scale refers to the time interval (units per division) between the on-screen grid marks. There are four vertical divisions per screen, and the default is 2.00 seconds per division, so eight seconds of data will be displayed on the screen display. Entering a larger value will display more of the record, and entering a smaller value will display less.

Initial offset refers to the time corresponding with the first data point displayed. For example, to display the middle 1/3 of the data file (assuming the record is 30 seconds long), set the offset to 10 seconds and the seconds per division to 2.5 seconds.

Locked

Scale Range determines the limits of the viewable scale. Horizontal scale parameters can be established with Start/End values or Range/Midpoint values. You can not enter a value less than 0 for the horizontal scale.

The Grid... button generates a Grid line parameters dialog. Use this to establish the scale for the Major Division and the Grid reference, which is the point from which the first grid line will be drawn.
Amplitude (vertical) scale

Clicking the mouse in the vertical scale area (where the amplitude of each channel is displayed) generates a similar dialog box. This dialog varies based on the lock status of the grid, which is established in the Display > Show > Grid Options dialog.

**Unlocked**

Scale determines how many units (usually Volts) are displayed for each division. As with the horizontal scale, AcqKnowledge divides each channel into four vertical divisions. When data is displayed in chart mode, each “track” is divided into four divisions. When data is displayed in scope mode (or if there is only one channel of data) the entire screen is divided into four intervals. To increase the apparent amplitude for a given channel, set this value to a smaller number; entering a larger number will cause the waveform to appear to have less variability.

Midpoint refers to median displayed value for a particular channel. A checkbox to the left of each of these options allows you to apply these scaling options to all channels. By default, the scaling options you choose will only apply to the channel indicated in the dialog box. If you want to apply these to all channels, click all the checkboxes.

**Locked**

Scale Range determines the limits of the viewable scale on the vertical axis.

Start/End is normally used for data not centered on 0.00 (i.e. data falls from 0-50 grams).

Range/Midpoint is normally used for data that is centered on 0.00 (i.e. AC-coupled data).

The Grid... button generates a Grid line parameters dialog. Use this to establish scale for the Major Division and the Grid reference, which is the point from which the first grid line will be drawn. Check the “All Channels” box to use these parameters on all channels.

Visit the online support center at www.biopac.com
**Selecting a waveform / channel**

Although multiple waveforms can be displayed, only one waveform at a time is considered “active.” Most software functions only apply to the active waveform, which is also referred to as the selected channel. Selecting a channel allows you to highlight all or part of that waveform, and enables you to perform transformations on a given channel.

In the upper left corner of the graph window there is a series of numbered boxes that represent each channel of data. The numbers in the boxes correspond to the channel used to acquire the data (the specifics of setting up channels are discussed on page 30). In the sample file, ECG channels are represented by channels 1 and 2, with respiration on channel 3 and blood pressure on channel 4.

To select a channel, position the cursor over the channel box that corresponds to the desired channel and click the mouse button or position the cursor on the waveform of interest and click the mouse button. Note that the selected channel box appears depressed and the channel label to the right of the channel boxes changes to correspond to the selected channel. Additionally, the channel label in the display (on the left edge of the track) will be highlighted for the active channel.

**Channel Labels**

Each channel has a label on the left and right edge of the graph window. The box on the far left is used to identify the contents of each channel (ECG, Respiration, etc.), and the box on the far right is used to denote the units for each channel’s amplitude scale (usually scaled in terms of Volts).

When a channel is active, its label is highlighted and also appears by the channel boxes. To change the label for a given channel, click in the area on the left and enter the desired label in the dialog box.

To change the label for a given channel, double-click on the track label. A dialog will be generated so you can change the text. You can also change the Label entry in the MP30 > Setup Channel dialog. When you change the Label this way, the change will not take effect until you start an acquisition.
**Hide a channel**

You can “hide” a waveform display without changing the data file. To hide a channel, hold down the **Ctrl** key and click in the channel box. When a channel is hidden, the channel box will have a slash through it. You may view a hidden channel by holding down the **Ctrl** key and clicking in the channel box again. Channels 2 and 4 are hidden in the following display:

![Waveform display showing hidden channels](image)

**Cursor Tools**

In the lower right area of the screen, you should see the following icons: 

- ![Cursor tool](image) These “cursor tools” are used in many of the on-screen functions described below, including editing, measurements, and the amount of data displayed.

- ![I-beam tool](image) This is a general-purpose cursor tool, used for selecting waveforms, scrolling through data, and resizing the chart boundaries between waveforms when in chart mode. All other cursors default to this mode when the cursors are moved outside the graph area.

- ![Zoom tool](image) This is a standard “I-beam” editing tool. This tool is used to select an area of a waveform (or waveforms) to be edited or transformed. To select it, click on the middle button in the lower right hand corner of the screen. Now move the cursor towards the waveform. You’ll notice that the cursor changes from an arrow to an I-beam when it is placed over the graph area. Using this tool to edit data is analogous to editing text with a word processor.

  When this cursor appears, you can select an area of data by holding down the mouse button and dragging the mouse to either the left or right. You can extend the selected area to include data that is not on the screen by positioning the cursor at the left edge of the area to be selected and clicking the mouse button. Next, use the scroll bars to scroll through the data until the desired data appears on the screen. Hold down the shift key while you position the cursor to select the right edge of the area to be selected. Click the mouse button to select the area.

- ![Zoom tool](image) This is a standard “zoom” tool. The zoom tool lets you select and magnify any portion of any wave. Click on the ![Zoom tool](image) icon (in the lower right portion of the screen) to use the zoom tool. As you move the mouse into the graph area, it will change from an arrow to a crosshair (+). Start by positioning the cursor in one corner of the box, then hold down the (left) mouse button and drag the crosshair horizontally, vertically, or diagonally to form a “box” that encompasses the area you need to zoom in on. When you release the mouse button, AcqKnowledge will automatically adjust the horizontal and vertical scales. To “unzoom,” choose **Zoom back** from the **Display** menu.
**Measurements**

A convenient feature in AcqKnowledge is the popup measurement windows. A variety of different measurements can be taken, and you can display different measurements from the same channel and/or similar measurements from different waveforms. AcqKnowledge can display measurements for the selected channel or for any other channel. By default, AcqKnowledge displays measurements from the selected channel (as denoted by the “SC” in the measurement boxes).

To **select a channel** for measurement, position the cursor over the part of the measurement window that reads “SC.” Click the mouse button and choose a channel number from the pull-down menu. The channel numbers in the pull-down menu correspond to the numbers in the channel boxes in the upper left corner of the graph window.

To **select a measurement**, position the cursor on a measurement box and click the mouse button. Choose a measurement from the pull-down menu. The measurements in the upper half of the menu reflect amplitude measurements, or measurements which contain information about the vertical (amplitude) scale. Other measurements use information taken from the horizontal axis (usually) and are found on the section of the pull-down menu below the dividing line. Some of the measurement options change (or are disabled) if units are selected for the horizontal scale.

Some of the values are single point measurements while others require at least two points to be selected. In some cases, the computations involved in the measurement can produce nonsensical results (such as dividing by zero, or calculating a BPM from a single point). In those cases, you may get a measurement value like INF (for infinite). This means that the result was undefined at this point.

For a complete description of each of the measurement functions and the minimum samples for each, turn to page 131.

*Mac OS X only:* Measurement menus are tinted to match the color of the corresponding waveform.

Visit the online support center at www.biopac.com
**Measurement Display**

The number of measurement windows depends on (a) the width of the screen and (b) the number of rows selected in the **Display > Preferences** dialog box.

As the screen gets wider, more measurement windows will be displayed in the area above the graph windows. By default, only one row of measurement windows is displayed. To display more than one row of measurements, select a number from the measurement rows popup menu in the **Display > Preferences** dialog box.

**Measurement Area**

It is important to remember that **AcqKnowledge** is always selecting either a single point or an area spanning multiple sample points. If an area is defined and a single point measurement (such as Time) is selected, the measurement will reflect the last selected point.

- **Single-point measurements**
  
  When a single point is selected, the cursor will “blink.” The graph on the left shows how the I-beam is used to select a single point for measurements.

- **Selected range measurements**
  
  Drag the cursor to select an area; the selected area will be highlighted. The graph on the right shows how the I-beam is used to select an area for measurement.
**IMPORTANT!**
The first data point is “plotted” at zero (on the left edge of the graph); the first visible data point is sample point 2. The selected areas below demonstrate this concept.

Visit the online support center at www.biopac.com
Measurement Validation

You can validate measurements with the ValidateMeasurements.acq sample file that was included with the software. Pay attention to the “Sample data file” section of the measurement definitions that begin on page 129, and where included, note which sample points to use for validation (i.e., the first four sample points are used to validate the Correlate measurement using the ValidateMeasurements.acq file).

Measurement Interpolation — Macintosh only

On a down-sampled channel, the cursor can fall on a point between physical samples. In such cases, in the Line Plot mode only, some measurements will display interpolated values; the value is obtained by linear interpolation with respect to the two adjoining samples.

- To disable measurement interpolation, uncheck the “Use linear interpolation” option in the Display>Preferences dialog.
- If interpolation is disabled for Line Plot, or any time Step Plot or Dot Plot is selected, measurements take on the value of the first physical sample immediately to the left of the cursor or edge of the selection.
- When measurements are pasted to the Journal, there is no indication of interpolated measurements.
- A Calculation measurement can be an interpolated value. When a measurement uses an interpolated value, the background behind the measurement changes color from gray to a light purple.
- The “Delta S” and “Samples” measurements are never interpolated.
- Measurements will not be interpolated if all measurements are set to “SC” (selected channel); the cursor will snap to the left for the measurements.
- Balloon help will reflect interpolation.
Exporting measurements

One of the most important reasons to take measurements is to save them; AcqKnowledge allows you to store and export these measurements in different formats.

- **Copying measurements to the journal.**

  One of the most useful options is to paste measurements to the journal. The journal is a general-purpose text editor that comes with AcqKnowledge and allows you to open, edit, and save standard text files. You can also “paste” measurements into the journal as they appear in the graph window.

  You can copy measurements exactly as they appear in the measurement windows by selecting Edit>Journal>Paste measurement. Under the default settings, only the values themselves are copied to the journal; you can change the settings to allow the measurement name and other options to be included.

  - For the MPWSW (PC) — Change the settings under Display>Preferences>Journal
  - For the MPWS (Mac) — Change the settings under File>Preferences>Journal

- **Copying measurements to the clipboard.**

  In addition to being able to copy measurements to the journal, you can copy measurements to the clipboard, where they are available for other applications. This means you can copy measurements (as they appear on the screen) to the clipboard and then paste the data into a word processor or other application. To do this, select Edit>Clipboard>Copy measurements and the values in the measurement windows will be copied to the clipboard. As with measurements that are copied to the journal, only the measurement values are copied to the clipboard.

  To include other information, change the settings.

  - For the MPWSW (PC) — Change the settings under Display>Preferences
  - For the MPWS (Mac) — Change the settings under File>Preferences
### Measurement Definitions

The table below explains the measurement options available and the range required for each. The default option is for time to be displayed on the horizontal axis, although it can be set to display frequency or arbitrary units (see page 219 for details on how to change the horizontal scaling options). Unless otherwise noted, all of the measurements described here relate to those displayed when the horizontal scale reflects time.

<table>
<thead>
<tr>
<th>Measurement</th>
<th>Area</th>
<th>Explanation</th>
</tr>
</thead>
</table>
| **Area**    | 3 samples | **Area** computes the total area among the waveform and the straight line that is drawn between the endpoints. **Area** is expressed in terms of (amplitude units multiplied by horizontal units) and calculated using the formula: 

\[
Area = \sum_{i=1}^{n-1} [(f(x_i) - y(x_i)) + |f(x_{i+1}) - y(x_{i+1})|] \Delta x_i / 2
\]

Where:
- \( n \) – number of samples; 
- \( i \) – index (\( i = 1, n-1 \));
- \( x_i, x_{i+1} \) - values of two neighboring points at horizontal axis (\( x_i \) – the first point, \( x_n \) – the last point);
- \( f(x_i), f(x_{i+1}) \) - values of two neighboring points of a curve (vertical axis);
- \( y(x_i), y(x_{i+1}) \) - values of two neighboring points of a straight line (vertical axis).

At the endpoints \( y(x_1) = f(x_1) \) and \( y(x_n) = f(x_n) \).

\[
\Delta x_i = \frac{\Delta X}{n-1} \quad \text{horizontal sample interval;}
\]

The value of a straight line can be found by formula:

\[
y(x_i) = m \cdot x_i + b
\]

\[
b = f(x_1) - m \cdot x_1 \quad \text{intercept;}
\]

\[
m = \frac{\Delta Y}{\Delta X} \quad \text{slope of the straight line;}
\]

\[
\Delta Y = f(x_n) - f(x_1) \quad \text{vertical distance of increase at vertical axis;}
\]

\[
\Delta X = x_n - x_1 \quad \text{horizontal distance of increase at horizontal axis.}
\]

**Sample plot:**

The area of the shaded portion is the result.

**Note:** The **Area** measurement is similar to the **Integral** measurement except that a straight line is used (instead of zero) as the baseline for integration.
<table>
<thead>
<tr>
<th>Measurement</th>
<th>Area</th>
<th>Explanation</th>
</tr>
</thead>
</table>
| **BPM** (Time domain only) | Minimum area: 2 samples | **BPM** (beats per minute) computes the time difference between the first and last points and extrapolates BPM by computing the reciprocal of this difference, getting the absolute value of it and multiplying by 60 (60 sec). The formula for calculation of **BPM** is: 

\[
BPM = \frac{1}{|x_n - x_1|} \times 60
\]

*Where:* 

\(x_1, x_n\) - values of the horizontal axis at the endpoints of selected area. 

*Note:* As mentioned, this measurement provides essentially the same information as the Delta T and Freq measurement. 

*Results:* Only a positive value. 

*Units:* BPM. |
| **Calculate** | Minimum area: 2 sources | **Calculate** can be used to perform a calculation using the other measurement results. For example, you can divide the mean pressure by the mean flow. When **Calculate** is selected, the channel selection box disappears. 

The result box will read “Off” until a calculation is performed, and then it will display the result of the calculation. As you change the selected area, the calculation will update automatically. 

To perform a calculation, Ctrl-Click (or on PC, right mouse button click) on the **Calculate** measurement type box to generate the “Waveform Arithmetic” dialog. 

Use the pull-down menus to select **Sources** and **Operand**. Measurements are listed by their position in the measurement display grid. |
(i.e., the top left measurement is Row A: Col 1). Only active, available channels appear in the **Source** menu.

**Mac users:** Calculation measurement Source operands are updated before a Calculation is performed, which means that Calculations can be based on measurements that are located after them in the measurement row/column ordering.

Also, Calculation measurements can include other Calculation measurements as their operands.

- If a cyclic dependency is introduced, the measurement result reads “Error.”
- When interpolation is being used, a Calculation measurement can also be an interpolated value.
- If either of the operands of a Calculation is interpolated, the result will be displayed as an interpolated value (with a light purple background).

**PC users:** You cannot perform a calculation using the result of another calculation, so calculated measurement channels are not available in the **Source** menu.

The **Operand** pull-down menu includes: Addition, Subtraction, Multiplication, Division, Exponential.

The **Constant** entry box is activated when you select “Source: K, constant” and it allows you to define the constant value to be used in the calculation.

To add units to the calculation result, select the **Units** entry box and define the unit’s abbreviation.

Click **OK** to see the calculation result in the calculation measurement box.

<table>
<thead>
<tr>
<th>Measurement</th>
<th>Area</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Correlate</td>
<td>Minimum area: 2 samples</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Uses: All points of selected area</td>
<td></td>
</tr>
</tbody>
</table>

**Correlate** provides the *Pearson* product moment correlation coefficient, \( r \), over the selected area and reflects the extent of a linear relationship between two data sets: \( x_i \) - values of horizontal axis and \( f(x_i) \) - values of a curve (vertical axis).

You can use Correlate to determine whether two ranges of data move together.

<table>
<thead>
<tr>
<th>Association</th>
<th>Correlation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Large values with large values</td>
<td>Positive correlation</td>
</tr>
<tr>
<td>Small values with large values</td>
<td>Negative correlation</td>
</tr>
<tr>
<td>Unrelated</td>
<td>Correlation near zero</td>
</tr>
</tbody>
</table>

The formula for the correlation coefficient is:

\[
\text{Correlate} = \sqrt{\frac{n \sum (x_i)^2 - \left( \sum x_i \right)^2}{n \sum (f(x_i))^2 - \left( \sum f(x_i) \right)^2}} \times \frac{n \sum (x_i f(x_i)) - \left( \sum x_i \right) \left( \sum f(x_i) \right)}{\left( n \sum (x_i)^2 - \left( \sum x_i \right)^2 \right) \times \left( n \sum (f(x_i))^2 - \left( \sum f(x_i) \right)^2 \right)}
\]

**AcqKnowledge Software Guide**
<table>
<thead>
<tr>
<th>Measurement</th>
<th>Area</th>
<th>Explanation</th>
</tr>
</thead>
</table>
| **Delta**  | Minimum area: 2 samples | **Delta** returns the difference between the amplitude values at the endpoints of the selected area.  
\[ \text{Delta} = f(x_n) - f(x_1) \]  
**Results:**  
If the data value at the starting location is greater than the data value at the ending location of the cursor, then a negative delta will result. Otherwise, a positive delta will result.  
**Units:** Volts  
**Sample data file:** “ValidateMeasurements.ACQ”  
*Result:* -2 Volts (for whole wave). This result shows the absolute value of change of amplitude (2) and the minus sign means a decrease of amplitude. |
| **Delta S** | Minimum area: 1 sample | **Delta S** returns the difference in sample points between the end and beginning of the selected area.  
**Results:** This calculation will always return a positive result.  
**Units:** Samples |
| **Delta T** (time)  
**Delta F** (frequency)  
**Delta X** (arbitrary unit) | Minimum area: 2 samples | The **Delta T/F/X** measurement shows the relative distance in horizontal units between the endpoints of the selected area. Only one of these three units will be displayed in the pop-up menu at a given time, as determined by the horizontal scale settings.  
**Measurement**  
**Delta T**  
**Delta F**  
**Delta X**  
**Horizontal Axis**  
Time  
Frequency (FFT)  
Arbitrary units (Histogram Bins)  
The formula for **Delta T/F/X** is:  
\[ \text{Delta } T = x_n - x_1 \]  
**Where:**  
x_1, x_n - values of horizontal axis at the endpoints of selected area. |
### Measurement | Area | Explanation
--- | --- | ---

**Results:**

If the data value at the starting location is greater than the data value at the ending location of the cursor, then a negative delta will result. Otherwise, a positive delta will result.

For **Delta T** measurements with the horizontal axis format set to HH:MM:SS.

For values less than 60 seconds, you will get a value in decimal seconds.

For values greater than 60 seconds, you will see an HH:MM:SS format value

(See page 219 for details on how to change the horizontal axis).

**Units:**

- **Delta T:** Seconds (sec.)
- **Delta X:** “arbitrary unit”
- **Delta F:** Hz

**Sample data file:** “ValidateMeasurements.ACQ”

**Result:** 0.12 sec. (for whole wave).

**Freq (time domain only)**

**Minimum area:**

2 samples

**Uses:**

Endpoints of selected area

**Freq** computes the frequency in Hz between the endpoints of the selected area by computing the reciprocal of the absolute value of time difference in that area.

The formula for **Freq** is:

\[
Freq = \frac{1}{|x_n - x_1|}
\]

**Where:**

\(x_1, x_n\) - values of horizontal axis at the endpoints of selected area.

The information provided by this measurement is directly related to the **Delta T** and **BPM** measurements, and is related to a lesser extent to **Delta S** measurement. That is, if the **Delta T** interval between two adjacent peaks is calculated, the **BPM** and **Freq** measurement can be extrapolated.

If the sampling rate is known, the **Delta S** can also be derived.

In this example, the selected area and measurements describe the same interval in different terms. You can see **Delta T**, **Freq** and **BPM** measurements for the selected area. The **Delta S** can also be derived.
<table>
<thead>
<tr>
<th>Measurement</th>
<th>Area</th>
<th>Explanation</th>
</tr>
</thead>
</table>
| **Integral** | Minimum area: 2 samples | **Integral** computes the integral value of the data samples between the endpoints of the selected area. This is essentially a running summation of the data. **Integral** is expressed in terms of (amplitude units multiplied by horizontal units) and calculated using the following formula. \[
\text{Integral} = \sum_{i=1}^{n-1} \left[ f(x_i) + f(x_{i+1}) \right] \frac{\Delta x_i}{2}
\]

Where:
- \( n \) – number of samples;
- \( i \) – index \( i = 1 \ldots n-1 \);
- \( x_i, x_{i+1} \) - values of two neighboring points at horizontal axis (\( x_1 \) – the first point, \( x_n \) – the last point);
- \( f(x_i), f(x_{i+1}) \) - values of two neighboring points of a curve (vertical axis);
- \( \Delta x_i = \frac{\Delta X}{n-1} \) - horizontal sample interval;
- \( \Delta X = x_n - x_1 \) - horizontal distance of increase at horizontal axis.

The following plot graphically represents the Integral calculation.

![Integral Calculation Diagram](image)

**Results:** The **Integral** calculation can return a negative value if the selected area of the waveform extends below zero.

**Units:** Volts – sec.

**Sample data file:** “ValidateMeasurements.ACQ”

**Result:** 0.300 Volts - sec. (for first 6 sample points) and –0.155 Volts - sec. (for last 6 sample points – the wave below zero).

Visit the online support center at www.biopac.com
<table>
<thead>
<tr>
<th>Measurement</th>
<th>Area</th>
<th>Explanation</th>
</tr>
</thead>
</table>
| Lin_reg     | Minimum area: 2 samples | **Linear regression** is a better method to calculate the slope when you have noisy, erratic data. Lin_reg computes the non-standard regression coefficient, which describes the unit change in \( f(x) \) (vertical axis values) per unit change in \( x \) (horizontal axis). For the selected area, Lin_reg computes the linear regression of the line drawn as a best fit for all selected data points using the following formula:  
\[
\text{Lin}_\text{reg} = \frac{n \sum_{i=1}^{n} (x_i \cdot f(x_i)) - \left( \sum_{i=1}^{n} x_i \right) \cdot \left( \sum_{i=1}^{n} f(x_i) \right)}{n \sum_{i=1}^{n} (x_i)^2 - \left( \sum_{i=1}^{n} x_i \right)^2}
\]
Where:  
n – number of samples;  
i – index (\( i = 1 \cdot n \));  
x_i – values of points at horizontal axis (\( x_1 \) – the first point, \( x_n \) – the last point);  
f(x_i) – values of points of a curve (vertical axis).  
**Note:** For a single point, Lin_reg computes the linear regression of the line drawn between the two samples on either side of the cursor.  
**Results:**  
If the data value at the starting location is greater than the data value at the ending location of the cursor, then a negative delta will result. Otherwise, a positive delta will result.  
**Units:** Volts/sec.  
This value is normally expressed in unit change per second (time rather than samples points) since high sampling rates can artificially deflate the value of the slope. If the horizontal axis is set to display Frequency or Arbitrary units, the slope will be expressed as unit change in corresponding vertical axis values (frequency or arbitrary units, respectively).  
**Sample data file:** “ValidateMeasurements.ACQ”  
**Result:** 230.00 Volts/sec. (for 1-4 samples) and –170.00 Volts/sec. (for samples 4-7). |
| Max         | Minimum area: 1 sample | **Max** (maximum) shows the maximum amplitude value of the data samples between the endpoints of the selected area. To compare peak heights, select each peak — you can easily see the maximum peak values or paste the results to the journal. Also, since you can simultaneously obtain measurements for different channels, you can easily compare maximum values for different channels.  
**Note:** For a single point, Max shows the amplitude value in this point.  
**Units:** Volts |
<table>
<thead>
<tr>
<th>Measurement</th>
<th>Area</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max T</td>
<td>Minimum area: 1 sample</td>
<td>Max T shows the time of the data point that represents the maximum value of the data samples between the endpoints of the selected area.</td>
</tr>
<tr>
<td></td>
<td>Uses: All points of</td>
<td><strong>Note:</strong> For a single point, Max T shows the time value in this point.</td>
</tr>
<tr>
<td></td>
<td>selected area</td>
<td><strong>Units:</strong> Seconds</td>
</tr>
<tr>
<td>Mean</td>
<td>Minimum area: 2 samples</td>
<td>Mean computes the mean amplitude value of the data samples between the endpoints of the selected area, according to the formula:</td>
</tr>
<tr>
<td></td>
<td>Uses: All points of</td>
<td>[ \text{Mean} = \frac{1}{n} \sum_{i=1}^{n} f(x_i) ]</td>
</tr>
<tr>
<td></td>
<td>selected area</td>
<td><strong>Where:</strong> ( n ) – number of samples; ( i ) – index ((i = 1,n)); ( x_i ) – values of points at horizontal axis; ( x_1 ) – the first point, ( x_n ) – the last point); ( f(x_i) ) – values of points of a curve (vertical axis).</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Units:</strong> Volts</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Sample data file:</strong> “ValidateMeasurements.ACQ”</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Result:</strong> 1.538462 Volts (for whole wave).</td>
</tr>
<tr>
<td>Median</td>
<td>Minimum area: 2 samples</td>
<td>Median shows the median value from the selected area.</td>
</tr>
<tr>
<td></td>
<td>Uses: All points of</td>
<td><strong>Note:</strong> The median and calculation is processor-intensive and can take a long time, so you should only select this measurement option when you are actually ready to calculate. Until then, set the measurement to “none.”</td>
</tr>
<tr>
<td></td>
<td>selected area</td>
<td><strong>Units:</strong> Volts</td>
</tr>
<tr>
<td>Median T</td>
<td>Minimum area: 2 samples</td>
<td>Median T shows the time of the data point that represents the median value of the data samples between the endpoints of the selected area.</td>
</tr>
<tr>
<td></td>
<td>Uses: All points of</td>
<td><strong>Note:</strong> The median and calculation is processor-intensive and can take a long time, so you should only select this measurement option when you are actually ready to calculate. Until then, set the measurement to “none.”</td>
</tr>
<tr>
<td></td>
<td>selected area</td>
<td><strong>Units:</strong> Seconds</td>
</tr>
<tr>
<td>Min</td>
<td>Minimum area: 1 sample</td>
<td>Min (minimum) shows the minimum amplitude value of the data samples between the endpoints of the selected area.</td>
</tr>
<tr>
<td></td>
<td>Uses: All points of</td>
<td><strong>Note:</strong> For a single point, Min shows the amplitude value in this point.</td>
</tr>
<tr>
<td></td>
<td>selected area</td>
<td><strong>Units:</strong> Volts</td>
</tr>
<tr>
<td>Min T</td>
<td>Minimum area: 1 sample</td>
<td>Min T shows the time of the data point that represent the minimum value of the data samples between the endpoints of the selected area.</td>
</tr>
<tr>
<td></td>
<td>Uses: All points of</td>
<td><strong>Note:</strong> For a single point, Min T shows the time value in this point.</td>
</tr>
<tr>
<td></td>
<td>selected area</td>
<td><strong>Units:</strong> Seconds</td>
</tr>
</tbody>
</table>

Visit the online support center at www.biopac.com
<table>
<thead>
<tr>
<th>Measurement</th>
<th>Area</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>n/a</td>
<td>None does not produce a measurement value. It's useful if you are copying a measurement to the clipboard or journal with a window size such that several measurements are shown and you don't want them all copied.</td>
</tr>
<tr>
<td>P-P</td>
<td>Minimum area: 2 samples</td>
<td><strong>P-P</strong> (peak-to-peak) shows the difference between the maximum amplitude value and the minimum amplitude in the selected area. <strong>Results:</strong> The result is always a positive value or zero. <strong>Units:</strong> Volts <strong>Sample data file:</strong> “ValidateMeasurements.ACQ” <strong>Result:</strong> 13 Volts (for whole wave).</td>
</tr>
<tr>
<td>Samples</td>
<td>Minimum area: 1 sample</td>
<td><strong>Samples</strong> shows the exact sample number of the selected waveform at the cursor position—the first data point is not displayed, but is plotted at zero. See pages 126-127 for examples of selected area Samples. <strong>Note:</strong> When an area is selected, the measurement will indicate the sample number at the last position of the cursor. <strong>Units:</strong> Samples.</td>
</tr>
</tbody>
</table>
| Slope       | Minimum area: 2 samples | **Slope** computes the non-standard regression coefficient, which describes the unit change in \( f(x) \) (vertical axis values) per unit change in \( x \) (horizontal axis). **For the selected area,** **Slope** computes the slope of the straight line that intersects the endpoints of the selected area, using the formula: \[
\text{Slope} = \frac{f(x_n) - f(x_1)}{x_n - x_1}
\] Where: \( f(x_1), f(x_n) \) – values of a curve at the endpoints of selected area. \( x_1, x_n \) – values of horizontal axis at the endpoints of selected area. This value is normally expressed in unit change per second (time rather then samples points) since high sampling rates can artificially deflate the value of the slope. **Note:** Lin_reg (linear regression) is a better method to calculate the slope when you have noisy, erratic data. **For a single point,** **Slope** computes the slope of the line drawn between the two samples: the selected sample point and the sample point to its left. **Results:** If the data value at the starting location is greater than the data value at the ending location of the cursor, a negative delta will result. Otherwise, a positive delta will result. **Units:** Volts/sec. (or corresponding to Freq or Arbitrary setting) **Sample data file:** “ValidateMeasurements.ACQ” **Result:** 233.33333 Volts/sec. (for samples 1-4) -166.66667 Volts/sec. (for samples 4-7) and -16. 66667 Volts/sec. (for whole wave). |
<table>
<thead>
<tr>
<th>Measurement</th>
<th>Area</th>
<th>Explanation</th>
</tr>
</thead>
</table>
| **Stddev** | **Minimum area:** 2 samples | **Stddev** computes the standard deviation value of the data samples between the endpoints of the selected area. Variance estimates can be calculated by squaring the standard deviation value. The formula used to compute standard deviation is: 

\[ \text{Stddev} = \sqrt{\frac{1}{n-1} \sum_{i=1}^{n} (f(x_i) - \bar{f})^2} \]  
\[ \text{Where:} \]
\[ n \rightarrow \text{number of samples;} \]
\[ i \rightarrow \text{index (} i = 1..n \text{);} \]
\[ x_i \rightarrow \text{values of points at horizontal axis (} x_i \rightarrow \text{the first point,} \ x_n \rightarrow \text{the last point);} \]
\[ f(x_i) \rightarrow \text{values of points of a curve (vertical axis);} \]
\[ \bar{f} = \frac{1}{n} \sum_{i=1}^{n} f(x_i) \rightarrow \text{the mean amplitude value of the data samples between the endpoints of the selected area.} \]  
**Results:** The result is always a positive value or zero.  
**Units:** Volts  
**Sample data file:** “ValidateMeasurements.ACQ”  
**Result:** 3.09570 Volts (for samples 1-4), 1.000 Volts (for samples 10-12). |
| **Time** | **Minimum area:** 1 samples | See the **X-axis:** **T** measurement for explanation. |
| **Value** | **Minimum area:** 1 sample | **Value** shows the exact amplitude of the waveform at the cursor position.  
*For the selected area, Value* indicates the value at the last position of the cursor, corresponding to the direction the cursor was moved (the value will be the left-most sample point if the cursor was moved from right to left).  
**Units:** Volts |
| **X-axis:** **T/F/X**  
(horizontal units) | **Minimum area:** 1 sample | The **X-axis** measurement is the exact value of the selected waveform at the cursor position, based on the Horizontal Axis setting:  
<table>
<thead>
<tr>
<th>Measurement</th>
<th>Horizontal Axis Setting</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>X-axis: T</td>
<td>Time</td>
<td>Sec.</td>
</tr>
<tr>
<td>X-axis: F</td>
<td>Frequency</td>
<td>Hz.</td>
</tr>
<tr>
<td>X-axis: X</td>
<td>Arbitrary units</td>
<td>Arb. units</td>
</tr>
</tbody>
</table>

For **X-axis:** **T** measurements, the time value is relative to the absolute time offset, which is the time of the first sample point.  
The **X-axis:** **F** measurement applies to frequency domain windows only (such as FFT of frequency response plots). The Freq function for time domain windows is described on page 135.  
**Note:** If a range of values is selected; the measurement will indicate the horizontal value at the last position of the cursor.  
**Results:** This calculation will always return a positive result. |
Markers

In many instances it is useful to have AcqKnowledge “remember” an occurrence or event during an acquisition so it can be referenced later. For instance, you may want to note when a treatment began or when an external event occurred so you can examine any possible reaction. AcqKnowledge allows you to insert “markers” into a record that act as bookmarks to record when an event occurs during the record.

The Markers flag icon on the toolbar toggles the marker display on/off. Visual markers appear as downward pointing triangles at the top of the graph window, and associated text is displayed a line above them. To view text associated with a given marker, position the cursor arrow over the marker and click the mouse button. You can also activate Marker display via the Display > Show > Markers menu option.

You can automatically insert markers during an acquisition by pressing ESC (Mac) or F9 (PC). This will insert a marker at the exact time the key is pressed and will activate the text line entry so you can immediately enter a comment to be associated with the marker. To enter a marker after acquisition, activate the marker display, and use the cursor to click on the marker display line (below the marker text line). Marker text can be up to 80 characters on the PC and is unlimited on the Macintosh.

In Append mode, markers (hh:mm:ss) are automatically inserted each time the acquisition is restarted.

You can move from marker to marker by using the arrow buttons in the marker area or dragging to a marker label on the pull-down list.

- Finds the previous marker
- Finds the next marker
- Generates the marker popup menu, which lists all markers in the current graph window. To move to a given marker, select the label associated with the desired marker and release the mouse button.

Find

Prompts you to enter marker text and then locates the marker in the file.

Clear marker and Clear all markers

These delete functions remove the marker tag and associated text from the file.

Summary to Journal

copies marker information to the Journal. The marker number (Index), time (axis info), and label for all markers in the entire graph are copied to the Journal. This option is disabled (grayed-out) when there are no markers or if a Journal is not open. To print the summary, paste it to the Journal and then use the Journal print icon.

Printing markers on the graph

Markers will be printed with the graph when the marker display is enabled. Hide markers before printing if you don’t want them printed. If the display is compressed, marker labels and/or indicators may be overlapped when printed. To correct this, adjust the window display before printing (and print the graph across several pages). Another option is to print the Marker Summary from the Journal instead of with the graph.
**Grids on the PC**

Grid functionality varies between PC and Macintosh. See page 145 for Grids on the Macintosh.

*Grid* superimposes a set of horizontal and vertical lines on the graph window. The grid is designed to allow for easy measurements, since the grid lines correspond to horizontal and vertical scale divisions.

To activate a grid display, click on the icon in the toolbar or select **Display > Show > Grids**.

To include minor grid lines in the display, use **Ctrl** or select **Display > Show > Grid Options** and check the “Show minor grid” box.

The horizontal scale grid is always four vertical lines, whether the horizontal scale is set to represent time, frequency or an arbitrary amplitude value.

---

**Grid Display Off**

**Grid Display On (unlocked)**

The grid can be **locked** (analysis, printing) or **unlocked** (visual aid), as checked in the **Grid Options** dialog (Display > Show > Grid Options).

---

**Unlocked Grid with Scale increased 2x**

**Locked Grid with Scale increased 2x**

You are encouraged to experiment with grid settings to familiarize yourself with the effect each option has on the data display.

---

Visit the online support center at www.biopac.com
Unlocked Grids

*Unlocked grids are more of a visual aid than an analysis tool.*

Set the lock status in the “Grid Options” dialog (Display > Show > Grid Options).

Unlocked grids help you view the data display on the monitor. The unlocked grid setting displays four grid divisions across the horizontal and vertical axes, and will generate interval numbers as needed to match the zoom factor.

- **Horizontal grid:** The grid always cuts the horizontal scale into four segments (using four vertical grid lines), regardless of the lower scale (axis) setting, which can be set to represent time, frequency, or an arbitrary amplitude value.

- **Vertical grid:** In Chart mode, the unlocked grid cuts the vertical scale of *each track* into four sections (using four horizontal grid lines *per waveform channel*). In Scope mode or X/Y mode, the unlocked grid cuts the vertical scale into four sections (four horizontal grid lines across the *graph*).

**Beware!** Although the unlocked grid will be retained if the waveform is printed, saved as a graphic image (WMF or PICT) or copied to the clipboard, the nature of the grid changes. When a graph is printed, saved, or pasted, AcqKnowledge will dynamically adjust the number of vertical divisions. In effect, this will “round” the vertical scale value so that anywhere from two to nine lines are displayed. Although the number of divisions changes, the process does not affect the nature of the data, only the scale used to plot it.

Locked Grids

*Locked grids help more with analysis and printing.*

Set the lock status in the “Grid Options” dialog (Display > Show > Grid Options).

The locked grid setting locks the grid to the data for all functions. It’s easy to set the grid interval using locked grids. Interval parameters (start/end or middle point/range) for the horizontal and vertical scales are determined in the Scale dialogs.

- The Scale dialogs change when grid lines are locked. See page 120 for details on Horizontal Scale and page 121 for details on Vertical Scale.
Visit the online support center at www.biopac.com
Grid Options on the PC

To control the style and functionality of the grid display, select Display > Show > Grid Options. The Grid Options control grid format (line type, style, width and color), grid lock, and grid adjustment.

**Major grid lines** Use the pull-down menus to set the major grid line style, width and color. A sample of the grid line settings is generated within the dialog.

**Minor grid lines** Check whether or not to “Show minor division” grid lines, and set the minor grid line style, width and color. A sample of the grid line settings is generated within the dialog.

**Lock grid lines** Check this option to lock the grid to the data for all functions. Locking grid lines can be useful for analysis and printing:

- See page 141 for details on locked grids.
- The Scale dialogs change when grid lines are locked. See page 120 for details on Horizontal Scale and page 121 for details on Vertical Scale.

Using the Scale and Print Options on a locked grid, you can very closely match chart recorder output:

*Note:* Standard clinical grids use major grid divisions of .5 mV vertically and .2 sec. horizontally.
Grid functionality varies between PC and Macintosh. See page 140 for Grids on the PC.

**Grids on the Macintosh**

You can customize the grid behind the waveforms displayed in graph windows in a number of ways.

---

**Grid Lock/Unlock**

Each scale has a small padlock in the lower right hand corner that displays the current state of the grid lock for that axis and channel. Click the padlock to change the lock state.

- **Unlocked grid** — the number of grid lines and their pixel spacing on screen is kept constant through zoom and scaling operations.
- **Locked grid** — the grid lines themselves are maintained at constant values through zoom operations, e.g. a grid line which is located at .753 volts when the grid is locked will continue to be located at .753 volts regardless of changes in scale.

Grids can be locked and unlocked on individual channels.

- The lock for the horizontal axis is shared by all channels.
- The vertical scale can be locked and unlocked independently.

The lock state of the grid can also be changed through the axis dialogs displayed when the mouse is clicked on the axis scale values in the graph window.

- Click the “Lock units/div” checkboxes.
  - **Lock units/div**
**Grid Scaling**

When the grid is locked, the scaling factors controlling how much data is visible on the screen (the distance between consecutive major lines of the grid and a fixed location for one of the lines of the grid) are specified differently. When the grid is unlocked, these scaling factors do not affect the grid.

The button in the axis setup dialogs is activated when the grid is locked. Click it to generate a dialog that allows you to specify the scaling factors and whether or not to “Show minor divisions” on that grid display. Changing these values only affects the grid display, not how the waveform is scaled.

- **Horizontally**: the scaling factors are specified in how many seconds of data should be visible on the screen (Major division) and the time offset of the left hand side of the display (First grid line).

![Adjust grid settings](image)

- **Vertically**: the total range of vertical units displayed per track is specified (Major division) along with the first value that should be displayed (First grid line).

![Adjust grid settings](image)

**Adjust Grid Spacing**

To modify the horizontal and/or vertical grid spacing, choose “Display > Adjust grid spacing.” This will generate a dialog for you to modify the locked axes of the selected waveform.

- This menu item functions identically to holding down the “Option” key and clicking the selected waveform when the grid tool is active.

- This menu option is disabled when the selected channel has no grids locked.

Visit the online support center at www.biopac.com
The Grid Tool allows divisions of the grid to be specified with the mouse. This tool has four states:

- **Inactive**
  - The cursor changes to a circle with a line running through it. The grid cannot be adjusted since both the horizontal and vertical axes are unlocked.

- **Horizontal axis locked**
  - The cursor changes to a horizontal line. A mouse click and drag will change the location of the horizontal lines of the grid.

- **Vertical axis locked**
  - The cursor changes to a vertical line. The tool can be used to adjust the vertical spacing of the grid.

- **Both axes locked**
  - The cursor changes to a crosshair. The rectangle of a full grid division can be drawn over the data.

If the “Option” key is held down for the Grid Tool in any of the active modes, an ellipsis will appear under the cursor. After a mouse click or drag, a Grid Settings dialog will be generated. This dialog is functionally similar to the grid dialogs accessible via the axis settings dialogs.

- Based on lock status, the dialog will allow you to adjust Horizontal, Vertical or combined settings.
- The values displayed in the dialog correspond to the grid ranges that were just drawn out on the screen with the grid tool if a mouse drag occurred.
- If the mouse was simply clicked, the current grid settings are displayed.
- This dialog allows the grid drawn out with the grid tool to be made more precise.

**Grid Reset**

To return to the original grid, choose “Display > Reset grid.”

This will reconstruct the default, unlocked grid of four divisions per screen with solid light grey grid lines.
Grid Options on the Macintosh

The major and minor grid lines can be further customized with different colors and dashing styles. These are modified under the dialog generated via Display > Show > Grid options…

**Line color**
Click the color well to generate a color chooser.

**Line width**
Adjust the corresponding slider.

**Dash style**
Select a style (solid or broken) from the pop-up menu.

**Dash length**
Adjust the corresponding slider (for any dash mode that is not a solid line).

**Spacing**
Adjust the corresponding slider (for any dash mode that is not a solid line).

**# of Divisions**
Enter a value in the text field to set the maximum number of minor grid lines to be displayed in a single major grid division.

To undo your selections and return to the original grid, choose “Display > Reset grid.” This will reconstruct the default, unlocked grid of four divisions per screen with solid light grey grid lines.

Visit the online support center at www.biopac.com
Chapter 9  File menu commands

Overview

Most of the items in the File menu are standard menu items and follow the standard Windows conventions (for MPWSW) or Macintosh conventions (for MPWS). By default, all files are created and saved in the AcqKnowledge file format, a proprietary format used to store binary data. Data can be read in from either text files or AcqKnowledge files, and can be saved in text, graphic, or binary format. As a rule, storing data in the AcqKnowledge format saves information in the most compact format possible and takes up less disk space than other file formats. In most cases, you will probably be working with graph windows and saving data in the AcqKnowledge format.

AcqKnowledge also supports an on-line journal that can be used to store waveform data (in numeric format) or to make notations and comments in a text file.

New

In almost all cases, you will need to create a new graph window before beginning an acquisition so that the data may be displayed on the screen. To create a new file, choose New from the File menu. When a new graph window is created you should see the following:

You can modify any of the window parameters, including horizontal scale, vertical scale, window size and position. In addition, you can also set the acquisition parameters for sampling rate, number of channels, and acquisition length. These settings take effect once an acquisition begins.
Open

The **File>Open** command generates the standard file open menu, and allows you to open a variety of different file formats from the popup menu at the bottom of the dialog box.

<table>
<thead>
<tr>
<th>Files of type:</th>
</tr>
</thead>
<tbody>
<tr>
<td>AcqKnowledge (*.ACQ)</td>
</tr>
<tr>
<td>ACQ Knowledge (.ACQ)</td>
</tr>
<tr>
<td>BSL Lesson files (*.Ldd)</td>
</tr>
<tr>
<td>Text file (*.TXT)</td>
</tr>
<tr>
<td>Graph Template (*.GTL)</td>
</tr>
<tr>
<td>All Files (*)</td>
</tr>
</tbody>
</table>

**PC-File Compatibility** AcqKnowledge 3.7 for the Macintosh can open and create PC-compatible Graph (*.acq) and Graph Template (*.gtl) files. Variable sampling rate information and hardware settings are retained, and Journals can be read from and written to PC files. Show type “Graph (Windows).”

**Multiple files** To open multiple files in a single dialog on a Mac, hold the Shift key down and select multiple files. The Command-A key combination will “Select All” files in the dialog. AcqKnowledge can only recognize one Journal file at a time, so multiple selection is disabled when the file type is set to Journal or Journal Template.

**ACQ**  
AcqKnowledge files  
The default file formats (Graph and .ACQ) are referred to as “AcqKnowledge” files. The AcqKnowledge file format is the standard way of displaying waveforms in AcqKnowledge. These files are stored in a compact format that retains information about how the data was collected (i.e., for how long and at what rate) and takes relatively little time to read in (compared to text files, for instance). AcqKnowledge files are editable and can be modified and saved, or exported to other formats using the **Save as** command.

**LDD**  
Biopac Lesson Files  
This file format is from files created using the Biopac Student Lab software.

**GTL**  
Graph Template files (*.GTL)  
This powerful feature allows you to open a template file with predefined experiment parameters, then simply click “Start” to run the experiment.

The **Graph Template** option allows you to open a copy of a master file so you can maintain the master settings. **Graph template** files open to previously saved window positions and setup parameters (as established under the MP menu).

This feature can be especially useful for recreating protocols in the laboratory. You can set up an experiment and save it as a Graph template, then simply open the Graph template file and click the Start button to acquire data under the same settings.

When a Graph template file is opened:

- a) The graph window will not contain any data. (Since no data is saved in the template, arbitrary waveform output setups, which require a source date file, will not function in a template.)
- b) The journal window will contain text you entered and saved with the template — this is a handy way for you to place instructions or information about the experiment for yourself or others.

Visit the online support center at www.biopac.com
AcqKnowledge “Quick Start” (*.gtl graph template) files are available for over 40 applications. Just open the graph template file to establish appropriate settings for the selected application, and then click Start. Quick Start files were installed to the Sample folder and can be used to establish the settings required for a particular application or as a good starting point for customized applications.

<table>
<thead>
<tr>
<th>Q##</th>
<th>Application(s)</th>
<th>Feature</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>EEG</td>
<td>Real-time EEG Filtering</td>
</tr>
<tr>
<td></td>
<td>Sleep Studies</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>EEG</td>
<td>Evoked Responses</td>
</tr>
<tr>
<td>3</td>
<td>EEG</td>
<td>Event-related Potentials</td>
</tr>
<tr>
<td></td>
<td>Evoked Response</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Evoked Response</td>
<td>Nerve Conduction Studies</td>
</tr>
<tr>
<td>5</td>
<td>Evoked Response</td>
<td>Auditory Evoked response &amp; Jewett Sequence</td>
</tr>
<tr>
<td>6</td>
<td>Evoked Response</td>
<td>Visual Evoked Response</td>
</tr>
<tr>
<td>7</td>
<td>Evoked Response</td>
<td>Somatosensory Evoked Response</td>
</tr>
<tr>
<td>8</td>
<td>Evoked Response</td>
<td>Extra-cellular Spike Recording</td>
</tr>
<tr>
<td>9</td>
<td>Psychophysiology</td>
<td>Autonomic Nervous System Studies</td>
</tr>
<tr>
<td>10</td>
<td>Psychophysiology</td>
<td>Sexual Arousal Studies</td>
</tr>
<tr>
<td>11</td>
<td>EBI</td>
<td>Cardiac Output</td>
</tr>
<tr>
<td></td>
<td>Cardiovasc. Hemodynamics</td>
<td>Noninvasive Cardiac Output Measurement</td>
</tr>
<tr>
<td></td>
<td>Exercise Physiology</td>
<td>Noninvasive Cardiac Output</td>
</tr>
<tr>
<td>12</td>
<td>EOG</td>
<td>Nystagmus Investigation</td>
</tr>
<tr>
<td>13</td>
<td>EOG</td>
<td>Saccadic Eye Movements</td>
</tr>
<tr>
<td>14</td>
<td>Plethysmography</td>
<td>Indirect Blood Pressure Recordings</td>
</tr>
<tr>
<td>15</td>
<td>Sleep Studies</td>
<td>Multiple-channel Sleep Recording</td>
</tr>
<tr>
<td>16</td>
<td>Sleep Studies</td>
<td>On-line ECG Analysis</td>
</tr>
<tr>
<td></td>
<td>ECG</td>
<td>On-line ECG Analysis</td>
</tr>
<tr>
<td>17</td>
<td>Sleep Studies</td>
<td>ECG Analysis</td>
</tr>
<tr>
<td>18</td>
<td>Sleep Studies</td>
<td>SpO2 Analysis</td>
</tr>
<tr>
<td>19</td>
<td>ECG</td>
<td>Einthoven’s Triangle &amp; 6-lead ECG</td>
</tr>
<tr>
<td>20</td>
<td>ECG</td>
<td>12-lead ECG Recordings</td>
</tr>
<tr>
<td>21</td>
<td>ECG</td>
<td>Heart Sounds</td>
</tr>
<tr>
<td>22</td>
<td>Cardiovasc. Hemodynamics</td>
<td>On-line Analysis</td>
</tr>
<tr>
<td>23</td>
<td>Cardiovasc. Hemodynamics</td>
<td>Blood Pressure</td>
</tr>
<tr>
<td>24</td>
<td>Cardiovasc. Hemodynamics</td>
<td>Blood Flow</td>
</tr>
<tr>
<td>25</td>
<td>Cardiovasc. Hemodynamics</td>
<td>LVP</td>
</tr>
<tr>
<td>26</td>
<td>NIBP</td>
<td>Psychophysiology</td>
</tr>
<tr>
<td>27</td>
<td>Pulmonary Function</td>
<td>Isolated Lung Studies</td>
</tr>
<tr>
<td>28</td>
<td>Pulmonary Function</td>
<td>Animal Studies</td>
</tr>
<tr>
<td>29</td>
<td>Lung Volume Measurement</td>
<td></td>
</tr>
<tr>
<td>30</td>
<td>Respiratory Exchange Ratio</td>
<td></td>
</tr>
<tr>
<td>31</td>
<td>EMG</td>
<td>Integrated (RMS) EMG</td>
</tr>
<tr>
<td></td>
<td>Biomechanics</td>
<td>Gait Analysis</td>
</tr>
<tr>
<td>32</td>
<td>Biomechanics</td>
<td>Biomechanics Measurements</td>
</tr>
<tr>
<td>33</td>
<td>Biomechanics</td>
<td>Range of Motion</td>
</tr>
<tr>
<td>34</td>
<td>Remote Monitoring</td>
<td></td>
</tr>
<tr>
<td>35</td>
<td>Remote Monitoring</td>
<td></td>
</tr>
<tr>
<td>36</td>
<td>Remote Monitoring</td>
<td></td>
</tr>
<tr>
<td>37</td>
<td>Remote Monitoring</td>
<td></td>
</tr>
</tbody>
</table>

See Appendix G on page 246 for descriptions of a wide array of applications and features.
**TXT**

*Text or .TXT.* Text files are a convenient way of transferring information between applications, and most spreadsheet and statistics programs are capable of importing or exporting data in a text file format. AcqKnowledge assumes that the text file contains numeric data laid out in columns and rows, and that there is some delimiter between each column. It also assumes that each column represents a distinct variable or channel of data. Normally, the values in each row represent the state of each variable at different points in time. When a text file is opened, the numeric values will be plotted as waveform data in a standard graph window and non-numeric values will be ignored. Each column of data is read in as a separate channel.

**Options**

When the **Files of type: Text** option is select, an **Options** button is activated. Clicking on this button generates another dialog box that allows you to control the amount and type of data to be read in, as well as the time scale for data display.

![](image)

**Read Line**

To control how much data is read in, enter a value in the **read line** box at the top of the dialog box. This tells AcqKnowledge which row contains the first data point in the series. By default, this is set to 1, although you may want to set it to another value since some applications (usually spreadsheets) generate a “header,” or text information at the top of a file. You can also read in a limited amount of data by entering a value in the box to the right of the **read line** box. The value in this box indicates the last line to be read in as data. By default, text files will be read in starting at line one and data will continue being read in until the end of the file is reached.

**Interval**

To control the horizontal scale (usually time) for the text file after it is displayed in the graph window, change the **Interval** between sample points, which can be expressed either in terms of time or frequency. For example, if data were collected at 50 samples per second, there is an interval between sample points of 0.02 seconds. AcqKnowledge would then assume that there is a 0.02 second “gap” between the data point in row two and the data point in row three (and all subsequent pairs of adjacent rows). Likewise, if you have a data file that spans 10 seconds and has 100 rows of data, the interval between sample points will be 0.01 seconds.

Most files contain time domain data, although some applications generate frequency domain data (the results of a spectral analysis, for example). The principle here is the same as with time data, that there is some interval between different frequencies. If a text file contains 20 sample points covering the range between 0 and 60Hz, then the interval would be set to 3Hz per sample.

Visit the online support center at www.biopac.com
### Column Delimiter

The final parameter for importing text files is the **column delimiter**. This setting tells AcqKnowledge what characters indicate a “gap” between two columns. This can be set to tab, comma, or space. All text files must have some sort of column delimiter, unless there is only one channel of data present.

- **Tab delimited** text files — the most common type — have a tab between each column for every row of data. These files are most often generated by spreadsheets and similar packages.

- **Comma delimited** files place a comma between each column of data for each row, much the same way as a tab delimited file. Statistics programs such as BMDP and SAS frequently create these types of files.

- **Space delimited** files are also commonly created by statistics packages, and place some number of spaces (usually two) between each column of data for every row which contains information.

- **None.** If you are not sure which delimiter to use, select auto and AcqKnowledge will automatically select a delimiter.

When either tab or comma is selected, AcqKnowledge will read in a new column each time it sees a delimiter, even if there are no numeric values between delimiters. For example, the following text file will read in three channels of data, although the channels will be of different lengths.

```
0.301424, 0.276737, 0.045015
0.338723, 0.808811, 0.542627
0.354271, 0.506313, 0.715995
0.001325, 0.762115
946207, 0.894992
0.926409,
```

**Sample text file**

The first channel will contain six data points, the first being 0.301424 and the last value being 0.926409. The next channel will contain three data points, starting with 0.276737 and continuing through 0.506313. The software considers that there is no other data values for channel two. The third channel starts with the entry 0.045015 and the last data point for this channel is 0.894992. There are only five data points in the last channel.

**Close**

This menu item will close the active file window and prompt you to save if necessary.

**Save**

This menu item will save any changes you have made to a file. If more than one file is open, this command only applies to the active window. For untitled files, you will be prompted to name the file you wish the data to be saved in. The file will remain open after you have saved it, allowing you to continue working. To close a file without saving changes:

- For the MPWSW (PC) — click on the \[
\] in the upper right corner of the file window
- For the MPWS (Mac) — click on the \[
\] in the upper left corner of the file window

Click “No” when AcqKnowledge asks you if you want to save the changes. To save data in another format (such as a text file), see the **File>Save As** section which follows.
Save As

Choosing File Sa ve As produces a standard dialog box that allows you to save data in a variety of different formats and to any location. As with all save last dialog boxes, you can use this to save a file to a different file name or directory than the default settings.

PC-File Compatibility

AcqKnowledge 3.7 for the Macintosh can create PC-compatible Graph (*.acq) and Graph Template (*.gtl) files. Variable sampling rate information and hardware settings are retained, and Journals can be read from and written to PC files.

- Files must end on a multiple of the lowest channel sampling rate to be fully PC compatible.

ACQ

The default file format for the File Sa ve as command is to save files as an AcqKnowledge file. Selecting Graph (MPWS) or .ACQ (MPWSW) from the popup menu in the Save As dialog box will save a file as an AcqKnowledge file, which is designed to be as compact as possible. These files can only be opened by AcqKnowledge, but data can be exported to other formats once it has been read in.

The Options button generates a dialog box that allows you to save only a portion of your file. When the “Selected Section only” option is enabled, only the data that has been selected with the I-beam tool will be saved. This option saves the selected area to another file and does not affect the current file that you are working in.

TXT

Data from AcqKnowledge graphs can also be saved as text files through the File Sa ve As dialog box.

When data is saved as Text, an Options button appears in the dialog box. Clicking on this button generates a smaller dialog box that allows you to control how much data is saved and the format it is saved in.

Visit the online support center at www.biopac.com
**Header**

When the first box is checked, a “header” is included at the top of the text file that contains information about the sampling rate, number of channels, date created, and other information relating to the data. This information is frequently useful, but some programs will attempt to read in the header information as data, which could result in nonsensical results. You may wish to include the header as it can always be edited out later using a text editor or the journal.

**Selected Section**

Checking the second box instructs AcqKnowledge to save only the selected section of the file. This is useful for saving a brief segment of a long file. When this option is checked, the highlighted area of data will be saved from all channels. When only one data point is selected, the entire file will be saved. If you want to save only a portion of the selected channel, you can either remove other channels or copy the data through the clipboard. See page 162 for more information on how to copy data through the clipboard.

**Horizontal Scale**

The third checkbox allows you to include the horizontal scale (usually time) values in the text file, along with the data to be saved. This allows you to produce time series plots in other applications, as well as correlating events to time indexes in graphing and statistical packages. Since a separate row is generated for each sample point, it is possible to exceed the limitations of programs if data is collected at a fast sampling rate (many spreadsheet programs are limited to about 16,000 rows). You may wish to consult the section on resampling data after an acquisition is completed (page 186).

**Column Delimiter**

When data is saved as a text file, each channel of data is saved as a separate column, with the number values for each data point saved in rows. Use the pop-up menu to select the delimiter to separate the columns of data in the text file. By default, a tab is placed between each column for every row of data; this format is called a tab-delimited text file and almost all applications will read in tab-delimited text files. However, you may also save data in a comma-delimited format or a space-delimited format.

**Metafile (.WMF) for the MPWSW or PICT for the MPWS.**

AcqKnowledge also supports formats for saving graphical information. Most drawing, page layout, and word processing programs can read .WMF or PICT files. This is particularly useful for writing reports. A WMF or PICT file can be opened in any standard drawing program and can then be embellished or used to highlight any particular phenomena of interest.

The following graph image is an example of a .WMF file that was copied to the clipboard, pasted in this document and resized to better fit the page.
When data is saved as a graphic, only the data currently on the screen is saved. So, if you have a data file that spans eight hours but only two minutes is displayed on the screen, only two minutes of data will be converted to a graphic file. Since AcqKnowledge uses information about the computer screen in creating the graphic file, the default resolution of the file will be the same as the window. Most word processors and graphics packages allow for some way to resize and scale graphics.

**GTL**

**Graph Template**

This feature can be especially useful for recreating protocols in the laboratory. You can set up an experiment and save it as a Graph template, then simply open the Graph template file and click the Start button to acquire data under the same settings.

**TIP:** PC users — Check the existing Quick Start template files listed on page 152 before creating or saving a new template. With over 40 templates provided, you may find one to establish the settings required for your particular application or to use as a good starting point for customized applications.

The Save As Graph template option saves the setup parameters established under the MP menu and window positions. Any window (including the Journal window, Input values, Stimulator, or Manual Control) that was active when the file was saved as a Graph Template will come up with the exact same position and settings when the Graph Template is reopened.

When a file is saved as a Graph Template:

a) No graph data will be saved.

- Since no data is saved in the template, arbitrary waveform output setups, which require a source date file, will not function in a template.
- You must select Save / Save as and select “File of type .ACQ” to save the graph data.

b) Journal text will be preserved. Any text you entered will be saved to the Journal window and stored with the template — this is a handy way for you to place instructions or information about the experiment for yourself or others.

When this feature is used with the menu.dsc customization feature it is easy to comply with GSL standards and save your protocol as an SOP. When you change the menu.dsc file for a graph template file, save the “menu.dsc” file with the exact same name but save it to the new lesson folder you have created.
Print

The File>Print menu AcqKnowledge uses is similar to the standard computer print dialog box, however, there are two additional box options that add functionality.

- **Plots per page** — Control how many plots appear per page when the file is printed. Printing more than one plot per page has the effect of “snaking” graphs on a page much the same way text appears in a newspaper. For example, if this option was selected so that two plots were printed per page, AcqKnowledge would divide the amount of data to be printed on that page into two graphs — one graph printing at the top of the page, the second graph printing at the bottom of the page. This option allows you to print records on considerably fewer pages than standard printouts, and is most effective when only a few channels of data are being printed.

- **Total pages (Fit to pages on a Mac)** — Print the contents of a window across multiple pages. When a record is printed over multiple pages, the amount of data on the screen (the amount of data to be printed) is divided by the number of pages entered in the dialog box. The graph on the screen is then printed across the number of pages specified in the Total pages box at the bottom of the File>Print dialog. These two options apply only to graph windows, and do not apply to Journals.

**Printer setup (MPWSW) or Page Setup (MPWS)**

Choosing File>Printer Setup on the MPWSW (PC) or File: Page setup on the MPWS (Mac) produces a standard printer setup dialog box that allows you to setup any available printers. All the options in this dialog box function as described in your system manual. There is also an options button that allows you to make several printing adjustments with respect to fonts, image orientation, and graphics presentation.

**Exit (MPWSW) or Quit (MPWS)**

Selecting Exit or Quit from the File menu exits AcqKnowledge and prompts you to save any open graph files that have been modified since they were last saved.

**Preferences — Macintosh only**

The Preferences commands are functionally equivalent for the MPWS and the MPWSW, but they are in a different location on each system.

- MPWSW (PC) — Preferences commands are under the Display menu.
- MPWS (Mac) — Preferences commands are under the File menu.

For detailed information on the Preferences commands for both systems, refer to the Display menu section in this manual.
Chapter 10  Edit menu commands

Overview

<table>
<thead>
<tr>
<th>Edit</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Can't Undo</td>
<td>Ctrl+X</td>
</tr>
<tr>
<td>Cut</td>
<td>Ctrl+C</td>
</tr>
<tr>
<td>Copy</td>
<td>Ctrl+V</td>
</tr>
<tr>
<td>Paste</td>
<td>Del</td>
</tr>
<tr>
<td>Clear</td>
<td></td>
</tr>
<tr>
<td>Clear All</td>
<td></td>
</tr>
<tr>
<td>Select All</td>
<td></td>
</tr>
<tr>
<td>Insert waveform</td>
<td></td>
</tr>
<tr>
<td>Duplicate waveform</td>
<td></td>
</tr>
<tr>
<td>Remove waveform</td>
<td></td>
</tr>
<tr>
<td>Clipboard</td>
<td></td>
</tr>
<tr>
<td>Journal</td>
<td></td>
</tr>
</tbody>
</table>

One of the most useful features in AcqKnowledge is the ability to edit and work with data by cutting sections and copying sections from one window to another. In this sense, the MP System allows you to work with data much as a word processor lets you work with text. When working with data, you will usually want to select a section of data to work with.

To select a section of data, use the editing tool to highlight an area. The selection tool is used for a variety of purposes including cutting and pasting waveform data, making measurements and determining which portion of a waveform to save as text values. To select the tool, click on its icon in the lower right hand corner. You will notice that the cursor changes into the familiar “I-beam” cursor when you move it within the graph area. Click the mouse and drag to select a portion of the waveform.

**IMPORTANT**

When multiple waveforms are present, the highlighted area appears to include all of the waveforms, but most modifications and transformations apply only to the selected channel.

Once you have selected a section of a waveform, you can perform such as editing, transformations, saving data to the journal, saving as text, and using the measurement functions on the selected area. The cursor always selects at least one sample point; when there is no defined area, a single sample point will be selected, and the cursor will blink.

You can highlight a larger area by positioning the cursor over the first point you are interested in, holding down the mouse button, and dragging the cursor either left or right to highlight an area. This is similar to highlighting a series of letters or words in a word processor.

You can modify the selected area by placing the cursor anywhere on the graph, then holding down the shift key and clicking the mouse. This feature is useful for fine-tuning the selected area. To fine tune, first coarsely select an area. By zooming in (with the zoom tool) on either edge, you can then use the shift key to precisely align the edges of the selected area.

Visit the online support center at www.biopac.com
AcqKnowledge also allows you to select an area that spans multiple screens. To do this, first select an area that contains the leading edge of the portion of the graph that you are interested in. Next, use the horizontal scroll bar to scroll to the end of the area that you are interested in. Then place the mouse near the area of interest and click on the button while holding down the shift key. While still depressing the mouse button, move the cursor to the exact position desired.

By using the selection tool to select areas of the waveform. The Cut, Copy, Paste and Clear functions are designed to work in much the same manner as a word processor. These functions operate only on areas selected by the selection tool.

** Undo / Can’t undo  

With some exceptions, the Edit>Undo command will undo the last command carried out by AcqKnowledge. This allows you to restore data that was unintentionally deleted or modified. The Undo command applies not only to editing commands, but also to transformations (such as digital filtering and mathematical operations).

There are some important exceptions to the Undo command. First, neither Edit>Clear all nor Edit>Remove waveform can be undone. It is a good idea to make backup files before performing any editing, especially when using these commands.

Second, changes in the display options (i.e., changing the horizontal scale or changing the color of a waveform) cannot be undone, since they are easier to manipulate and less drastic than cutting data out of a waveform. If you modify the screen scale (or other display parameters) you will still be able to undo your latest data modification, which is much more difficult to recover than a screen parameter change.

** TIP: ** If you accidentally remove a waveform or choose clear all, one way to recover the data is to close the file without saving the changes. The data file can now be reopened, as it was when it was last saved; any changes made since it was last saved will be lost.

** Cut  

When Cut is selected from the Edit menu, the highlighted portion of the active window (Graph, Journal, entry prompt or dialog) is removed and copied to a clipboard, where it is available for pasting into other windows.

- When a selected area is removed from a waveform, the data will shift left to “fill in” the deleted area. So, if ten sample points are deleted, all data after the selected area will be shifted over ten sample points. Since this alters the relationship of events to the time base, you might want to consider alternatives to cutting sections of data—such as using smoothing, digital filtering, or the connect endpoints functions to transform the section of data.
Copy

Choosing Edit>Copy will copy the selected area of the active window (Graph, Journal, entry prompt or dialog) to the clipboard without modifying the text/waveform on the screen.

- Once the area has been copied, it can be inserted in another window using the Edit>Paste command or, for waveforms, the Edit>Insert waveform command.
- To copy a waveform to another channel in the same graph window, choose the Edit>Duplicate waveform command.

Paste

The Edit>Paste command will take the contents of the clipboard and paste it into the currently selected area of the active window (Graph, Journal, entry prompt or dialog).

- If no area is selected, the data is pasted at the beginning of the waveform in a Graph window or the end of the text a Journal window.
Clear

The **Edit>Clear** command works much the same way as the **Cut** command, with the key difference being that data is not copied to the clipboard. This function deletes the selected area from the selected channel only. If the entire waveform is selected (as with the **Edit>Select all** command), the clear command will delete all the waveform data and leave an empty channel.

- As with the cut command, the clear function operates on only one channel, and when a portion of the waveform is deleted, the remaining data will shift left. If multiple channels of data are present, one channel will be “shorter” than the others.
- To remove a selected area of data from multiple channels, use the **Edit>Clear all** command.

Clear all

Choosing **Edit>Clear all** will delete the selected area from all channels. This is similar to the clear function in that data is removed and is not copied to the clipboard. The Clear all command, however, removes a section of data from all waveforms, whereas the clear command applies only to the selected channel.

- When **Edit>Select all** is chosen prior to performing the **Clear all** function, all waveform data for all channels will be deleted.
- The **Edit>Undo** command does not work for **Clear all**.

Select All

When **Select all** is chosen from the **Edit** menu, the entire selected channel becomes highlighted. For almost all commands, when a waveform is selected using **Select all**, subsequent operations apply to the selected channel only.

- The exception is when **Edit>Clear all** is chosen after **Edit>Select all**. When this occurs, all data from all waveforms will be deleted.

Insert waveform

The **Edit>Insert waveform** command is useful for copying a waveform (or a section of a waveform) from one window to another. To do this, first select the area to be copied using the cursor and the **Edit>Copy** command. Next open the graph window you wish to insert the waveform into. It is possible to insert the waveform into the same graph it was copied from, although the **Edit>Duplicate waveform** is a much more straightforward way to do this.

Once you have selected the graph you wish to insert the waveform into, choose **Insert waveform** from the **Edit** menu. A new (empty) channel will then be created and the data will be copied into the empty channel. The new channel will always take on the lowest channel number available (including zero).

- This command cannot be undone directly, although selecting the inserted channel and choosing **Remove waveform** from the **Edit** menu effectively undoes this operation.
Duplicate waveform

Choosing **Edit>Duplicate waveform** will create a new channel in a graph window and copy an entire waveform (or a selected area) to the new channel. When a portion of the waveform is selected, only the highlighted area will be duplicated.

- To duplicate the entire waveform, choose **Edit>Select all** and then select **Duplicate** from the **Edit** menu or click the right mouse button and select **Duplicate** from the pull-down menu.

Remove waveform

The **Edit>Remove waveform** command deletes the entire selected waveform, regardless of what other options are selected.

- The **Edit>Undo** command does not work for **Remove waveform**.

Clipboard

![Clipboard Image](image)

All of the clipboard commands involve copying data from AcqKnowledge to the standard Windows clipboard, where the contents of the clipboard are made available for other applications. Transferring data through the clipboard allows you to copy data from AcqKnowledge to other applications even after you have closed the graph window and/or quit AcqKnowledge.

Data can be copied to the clipboard in two formats:

**Text/Alphanumeric**  
**Copy Measurement** and **Copy Wave Data** save information to the clipboard in text/numeric format.

**Graphic format**  
**Copy Graph** transfers the image on the screen to the clipboard in WMF (MPWSW) or PICT (MPWS) format.

- **Copy Measurement**

  Copies the contents of all visible measurement popup menus, along with the values associated with these windows. By default, three windows are displayed (on most monitors); you can change this by increasing or decreasing the width of the window. Once the measurements have been copied, they can be pasted into any application that allows paste functions, including word processors, drawing packages, and page layout programs. A sample of measurements pasted from AcqKnowledge into a word processor follows:

  \[ \text{BPM} = 85.714 \text{ BPM} \quad \text{delta T} = 0.700 \text{ sec} \quad p-p = 0.8170 \text{ Volts} \]

Visit the online support center at www.biopac.com
- **Copy Wave Data**

  Copies the data (in numeric form) for all channels from the AcqKnowledge graph into the clipboard. When an area is selected, only the data in the highlighted area will be copied to the clipboard. As with the copy measurement command, once the data is stored in the clipboard, it can be pasted into virtually any application.

  When multiple channels of data are copied to the clipboard, the data is stored in columns and rows, with data from each channel stored in a separate column. For a four-channel record, four columns of data will be copied to the clipboard. As with a text file, AcqKnowledge will insert a delimiter between each column of data. The default delimiter is a tab; you can change the delimiter to either a space or tab in the options dialog box in the **File>Save as** dialog box. See page 153 for more detailed instructions on how to set the column delimiter. Transferring data through the clipboard performs essentially the same function as saving data as a text file (using the **File>Save As** command), with the obvious exception that transferring data through the clipboard does not save data to disk.

- **Copy graph**

  Copies the graph window as it appears on the screen to the clipboard, where it is stored in Windows Metafile (PC) or PICT (Mac) format. You can then place the graphic into a number of different types of documents, including word processors, drawing programs, and page layout programs. Windows Metafile and/or PICT are common to almost all applications, and images saved in these formats can be edited in most graphics packages and many word processors.

  Using the **copy graph** function is similar to saving a graph window as a Windows Metafile or PICT file (using the **File>Save As** command), except that using the file save command writes a file to disk, whereas transferring data through the clipboard does not save a file.
Journal

The **Edit>Journal** sub-menu has two options: paste measurement and paste wave data.

Both options are similar to those found in the **Edit>Clipboard** menu. The key difference is that data (whether measurements or raw data) is pasted directly into the journal rather than copied to the clipboard.

- **Paste measurement**
  
  Choosing **Paste measurement** from the **Edit>Journal** menu will cause all visible measurement windows to be pasted into the journal. Each time this is selected, the measurements and values are pasted into the journal using the precision specified in the **Display>Preferences** dialog box. You can also change the total number of measurements displayed by adding more rows of measurements. Use the **Preferences** menu (see page 224) to change the number of measurement rows or the measurement precision displayed on the screen.

- **Paste wave data**
  
  Converts, the selected area of the waveform to numeric format and paste it into the journal in standard text file format. As with the copy wave data command (in the **Edit>Clipboard** submenu) this will paste the selected area from all channels, not just the selected channel, and will place a delimiter between the columns when two or more channels are being pasted to the journal. By default, tab characters are used to separate columns; you can change to comma or space delimiters in the **File>Save As>Options** dialog box. See the **Save As** section on page 154-155 for more information on how to change the column delimiter.

**Show Journal** — Macintosh only

To display the Journal on a Macintosh, select the “Show Journal” option of Edit menu.
Chapter 11  Transform menu commands

Overview

**AcqKnowledge** provides a number of options for post-acquisition analysis and transformations. These transformations allow you to perform a range of operations on your data, from digital filtering and Fourier analysis to math functions and histograms. All of these options can be found under the **Transform** menu, and are disabled while an acquisition is in progress. Unless otherwise noted, all of the transformations described here apply to the selected channel only. Some options (the expression and math functions) allow you to specify a channel (or channels) to be transformed.

It is important to remember that **AcqKnowledge** is always selecting at least one point, and the cursor will flash whenever only one point is selected. Some of the transformation functions (e.g., math function, waveform math) can operate on a single sample point, and will transform a single sample point when only one is selected.

There are two ways to apply a transformation to an entire waveform.

a) The first method involves selecting an entire waveform using the **Edit>Select all** command prior to selecting the transformation. This will work for all of the transformation functions, and is the only way to apply a transformation to an entire waveform for functions that do not produce a dialog box (e.g., math functions, integral).

b) The second method can be used for any transformation that does produce a dialog box (e.g., digital filtering, Equation Generator, FFT). These dialog boxes allow you to check a box (located towards the bottom of each dialog box) that will transform the entire waveform (regardless of whether a single point, area, or the entire waveform is selected).
The table below groups all of the transformation functions into four general families or clusters. The first set of functions performs “data cleaning,” in that they perform some sort of filtering or data reduction tasks. The second set of transformations performs calculations or other mathematical operations on the data. The third set of functions allows you to search through the data, either for peaks or patterns of data. The fourth set of functions provides graphical summaries of the data, either in terms of the frequency spectra of the data or the measures of central tendency and dispersion of waveform data.

<table>
<thead>
<tr>
<th>RAW DATA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Isolate data</td>
</tr>
<tr>
<td>Smoothing</td>
</tr>
<tr>
<td>Digital Filtering</td>
</tr>
<tr>
<td>Resample</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

**AcqKnowledge transformation functions**

**Digital filtering**

There is a fair amount of arcane terminology and theory surrounding the use and implementation of digital filters. Two types of post-processing filters are available under the Transform > Digital filters selection: finite impulse response (FIR) filters and infinite impulse response (IIR).

FIR filters are linear phase filters, which means that there is no phase distortion between the original signal and filtered waveforms.

IIR filters are not phase linear filters, but are much more efficient than FIR filters in processing data. The IIR filters are useful for approximating the results of standard biquadric filters of the form:

\[
(as^2 + bs + c) \div (xs^2 + ys + z)
\]

These types of filters are commonly implemented in electronic analog circuitry. IIR filters are also used for on-line filtering (discussed on page 68).

➤ See Appendix B for more information about the differences between these types of filters.

To understand how digital filters work, it is important to understand the nature of analog signals and their frequency components. All analog signals are composed of signals of various frequencies. A commonly used analogy is that of the color spectra. Just as white light is made up of a variety of colors that have different wavelengths (frequencies), physiological signals are composed of specific signals with unique frequency signatures.

Visit the online support center at www.biopac.com
For example, an electroencephalogram (EEG) recording is composed of several different types of signals, each of which has a different frequency signature. Alpha waves (one of the most studied EEG signals) have a frequency range of about 8 to 13Hz. This means that alpha waves go through a complete cycle (from peak to peak or trough to trough) anywhere from eight to 13 times a second.

There are, of course, signals that have other frequency signatures in EEG data. Most types of physiological data have a number of different frequency signatures present in the overall signal. In addition, frequency components besides the signal(s) of interest are often present. In the U.S., it is not uncommon for 60Hz electrical noise to be acquired along with physiological signals (in other countries, AC interference is present at either 60Hz or 50Hz).

Through digital filtering, it is possible to retain only the frequency components you are interested in and remove other data (whether it is “noise” or merely physiological signals) that are not of interest. **It is important to note** that the way in which data is filtered depends in large part on the sampling rate at which the original data was acquired. For instance, if data was collected at 50 samples per second (50Hz), it is not possible to filter out 60Hz signals.

In fact, data must be sampled at a rate equal to at least twice the frequency of the signal to be removed. So, if data is to be collected and the information between 80Hz and 120Hz is to be removed, the data must be sampled at 120Hz*2, or 240 samples per second (or faster). Also, each channel of data is filtered separately, so removing one type of data from one channel will not affect any other channels.

Digital filters can be divided into four general classes:

1) low pass
2) high pass
3) band pass
4) band stop

Descriptions of these four classes of filters follow, with visual examples of how these filters work. In each of the four examples, a single channel of data containing frequency components in three ranges (low frequency, mid-range, and high frequency) is acquired.

- Low frequency data, by definition, has slowly changing values, much like respiration patterns or core temperature variations.

- High frequency data, compared to low frequency data, is noticeably more “spiked,” much like an EMG signal. As you can tell, the high frequency wave repeats itself about five times in the time it takes the low frequency wave to repeat once.

- Mid-range data falls somewhere in between these two extremes.

In the examples that follow, one possible way that these data could have been collected is if respiration were measured, but the measurement was contaminated with high-frequency muscle movement and mid-frequency signal coming from AC interference. The data is then passed through a filter, where some of the frequency components are removed.
Low pass filtering

In the example below, a **low pass filter** attenuates the data above a given threshold, allowing only lower frequency data to “pass” through the filter.

![Diagram of low pass filtering](image)

High pass filtering

In the example below, a **high pass filter** removes the low and middle range data, but allows the high frequency data to pass through the filter.

![Diagram of high pass filtering](image)
Whereas the low pass and high pass filters retain data either above or below a given threshold, the next two types of filters work with a range, or band, of data.

**Band pass filter**

The band pass filter, allows only the data within the specified range to pass through the filter. A band pass filter is useful when you want to retain only specific waves from an EEG record. For instance, to retain alpha waves, you can set the filter to only pass data between 8Hz and 13Hz.

**Band stop filter**

The band stop filter allows data to pass above and below the specified range. This type of filter is typically applied to remove extraneous 60Hz or 50Hz noise from a data record.
Digital filter dialog box

**FIR Filters**

To access the FIR filter dialog box, click on the Transform menu, scroll to select Digital Filters, drag right to FIR and drag right again for the filter options.

When you select an FIR filter type, the corresponding Digital Filter dialog box will pop up, allowing you to specify a number of different filtering options.

1. **Window.** The Window popup menu allows you to choose from a variety of filtering algorithms. The filter default is set to a “Blackman” type. These different Windows (described in detail in Appendix D) allow you to “fine tune” the filter response.

2. **Cutoff Frequency (Hz) (or threshold).**
   - **Low Pass Filter** — data with frequency components below the cutoff will pass through the filter, whereas frequency components above the threshold will be removed. For low pass filters, the default cutoff frequency is the waveform sampling rate divided by eight and can be set to any value between 0.000001Hz and 0.5 times the sampling rate.
   - **High Pass Filter** — data with frequency components above the cutoff will pass through the filter, whereas frequency components below the threshold will be removed. For high pass filters, the default threshold is the waveform sampling rate divided by four and can be set to any value between 0.000001Hz and 0.5 times the sampling rate.
   - **Band-type Filters** — To define the band of data (the frequency range) that is either passed or stopped (depending on whether it is a Band Pass or Band Stop filter), a low threshold and a high threshold must be specified:

   - **Low Frequency (Hz):** The default for the low threshold is the waveform sampling rate divided by eight.
   - **High Frequency (Hz):** The default for the high threshold is the waveform sampling rate divided by four.

   The threshold settings can take on any value from 0.000001Hz and 0.5 times the sampling rate, but the two thresholds cannot be set to the same value and the high threshold must be greater than the low threshold.

Visit the online support center at www.biopac.com
3. **Number of Coefficients.** This determines how well the filter will match the desired cutoff frequency (or range). The minimum number of coefficients is 3 and the maximum must be less than the total number of sample points in the selected area. The software will truncate the maximum number of coefficients to the highest odd number less than the total.

### TIP:
A good rule of thumb is to use a number of coefficients greater than or equal to two times the sampling rate divided by the lowest cutoff frequency specified. For example, if running a low pass filter at 1Hz on data sampled at 100Hz, choose at least (2 x 100/1) or 200 coefficients in the filter. Additional coefficients will improve the response.

Filters that use a small number of coefficients tend to be less accurate than filters that use a large number of coefficients. Entering a larger value will result in a more accurate filter; however, as the number of coefficients increases, so does the processing time required to filter the data. To see how changing this value affects the way data is filtered, it can be useful to examine the filter response patterns.

The default number of coefficients is \((4 \times \text{waveform sampling rate}) / \text{lowest frequency cutoff}\) for the filter. For every filter except the band pass, the lowest frequency cutoff is equal to the specified cutoff frequency for the filter; for the band pass filter, the lowest frequency cutoff is the low frequency cutoff setting.

![Comparison of 39 coefficient and 250 coefficient band stop FIR filters](image)

*Comparison of 39 coefficient and 250 coefficient band stop FIR filters*

In this example, the same data was band stop filtered using a coefficient of either 39 (upper waveform) or 250 (lower waveform). The data was collected at 500Hz, and the band stop filter was designed to remove 60Hz noise using a low cutoff of 55Hz and a high cutoff of 65Hz.

Along the horizontal axis, the units are scaled in terms of frequency, with lower frequencies at the left of the screen. The values along the vertical axis are scaled in terms of dB/V and indicate the extent to which various frequencies have been attenuated. In both filter response waveforms, there is a downward-pointing spike that is centered on 60Hz. The baseline of the filter response corresponds to a value of approximately 0 on the vertical axis, indicating that the signals significantly above or below 60Hz were not attenuated to any measurable extent. As you can tell, however, the filter does not “chop” the data at either 55Hz or 65Hz, but gradually attenuates the data as it approaches 60Hz.

For example, the upper waveform in the filter response plot represents data that was filtered using a value of 39 coefficients. The slope is relatively shallow when compared to the lower waveform, which represents a filter response performed with 250 coefficients. Although the filter that used 250 coefficients took slightly longer to transform the data, the filter response pattern indicates that the data around 60Hz is attenuated to a greater degree. Also, the 250-coefficient filter started to attenuate data considerably closer to the 55Hz and 65Hz cutoffs, whereas the default filter began to attenuate data below 55Hz and above 65Hz.
4. **Show Filter Response.** When checked, this option generates a plot of the filter response in a new window, labeled “Frequency Response” (see example on page 171).

5. **Don’t modify waveform.** This option is useful in conjunction with the “Show Filter Response” option. When both boxes are checked, AcqKnowledge will produce a plot showing the filter response, but will not modify the waveform. This allows you to repeatedly specify different filter options (without modifying the waveform) until the desired frequency response is achieved.

6. **Filter entire wave.** If this option is checked, AcqKnowledge will filter the entire wave and replace the original. If you want to keep the original, you need to duplicate it prior to filtering.

Visit the online support center at www.biopac.com
**IIR Filters**

To access the IIR filter dialog box, click on the **Transform** menu, scroll to select **Digital Filters**, drag right to **IIR** and drag right again for the filter options. For all filter types, the software will limit the frequency setting so it cannot exceed one-half the channel sampling rate.

**Low Pass and High pass**

These filters pass data that falls below or above the specified standard. The Low Pass default is 0.125 times the waveform sample rate; The High pass default is 0.25 times the waveform sample rate.

**Band Pass (low + high)**

This filter passes a variable range of data through the filter. You need to specify a low frequency cutoff and a high frequency cutoff to define the range or “band” of data that will pass through the filter; frequencies outside this range are attenuated. For the Band Pass (low + high) filter, the low default is 0.125 times the waveform sample rate and the high default is 0.25 times the waveform sample rate.

**Band Pass (low + high)**

This filter is actually a combination of a low pass and a high pass filter, which emulates the behavior of a band pass filter. This type of filter is best suited for applications where a fairly broad range of data is to be passed through the filter. For example, this filter can be applied to EEG data in order to retain only a particular band of data, such as alpha wave activity.

**Band Pass (single freq)**

This filter requires only a single frequency setting, which specifies the center frequency of the band to be passed through the filter. The “width” of the band is determined by the Q setting of the filter (discussed in detail below). Larger Q values result in narrower bandwidths, whereas smaller Q values are associated with a wider band of data that will be passed through the filter. This filter has a bandwidth equal to Fo/Q, so the bandwidth of this filter centered on 50Hz (with the default Q=5) would be 10Hz. Although functionally equivalent to the Band Pass (low + high) filter, this filter is most effective when passing a single frequency or narrow band of data, and to attenuate data around this center frequency. The Band Pass (single frequency) default is 0.125 times the waveform sample rate.

**Band stop (single freq)**

This filter defines a range (or band) of data and attenuates data within that band (the opposite function of a band pass). The Band stop filter is implemented in much the same way as the standard Band Pass, whereby a center frequency is defined and the Q value determines the width of the band of frequencies that will be attenuated. The Band stop (single frequency) default is 0.125 times the waveform sample rate.
Q coefficient

The on-line filters are implemented as IIR (Infinite Impulse Response) filters, which have a variable Q coefficient. The Q value entered in the filter setup box determines, in part, the frequency response of the filter. This value ranges from zero to infinity, and the “optimal” (critically damped) value is 0.707 for the Low Pass, High pass and Band Pass filters. A Q of .707 for any of these filters will result in a second order Butterworth response. The Q is set to a default of 5.000 for the single frequency Band Pass and Band stop filters. For more details about the Q setting, see Appendix B.
Math Functions

AcqKnowledge allows you to perform a wide range of mathematical and computational transformations after an acquisition has been completed. Unless otherwise noted, each of these functions applies only to the selected area of the selected channel. If no area is selected (i.e., a single data point is selected) the cursor will blink and the transformations will apply only to the selected point. To perform a math function on an entire waveform, select a channel and choose Edit>Select all. Also, it is possible that in some circumstances a math function will attempt to divide by zero; when this occurs, a zero will be returned.

For complex transformations involving multiple functions, you may want to use the Equation Generator (see page 187 for more information on this feature). Many of the same functions found in the Math functions menu can also be found in the Equation Generator.

The following table describes the commands available in the Transform>Math functions menu:
<table>
<thead>
<tr>
<th>Transform&gt;Math Command</th>
<th>Explanation of Command</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Abs (Absolute Value)</strong></td>
<td>Computes the absolute value of the data. All negative data values are made positive, with no change in magnitude. This function can be used to rectify data.</td>
</tr>
<tr>
<td><strong>Atan (Arc Tangent)</strong></td>
<td>Returns the arc tangent of each data point in radians. This rescales the data such that the range is from $-\pi/2$ to $\pi/2$.</td>
</tr>
<tr>
<td><strong>Connect endpoints (Connect the endpoints)</strong></td>
<td>Draws a line from the first selected sample point to the last selected sample point and interpolates the values on this line to replace the original data. The connect endpoints function is very useful for removing artifacts in the data or in generating waveforms. In the example below, the “noise spike” in the data is an undesired measurement artifact that should be removed. You could cut the section of data, but then all subsequent data points would shift left. In order to preserve the time series of the data, you could use the connect endpoints command to draw a straight line (although not necessarily flat) that connects the two extreme sample points of the selected area.</td>
</tr>
<tr>
<td><strong>Exp (Exponential)</strong></td>
<td>Computes the function $e^x$, where $x$ is the waveform data and $e$ is 2.718281828. This is the base of the natural logarithms.</td>
</tr>
</tbody>
</table>

Visit the online support center at www.biopac.com
<table>
<thead>
<tr>
<th>Transform&gt;Math Command</th>
<th>Explanation of Command</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Limit</strong> <em>(Limit data values).</em></td>
<td>“Clips” data outside the range specified by the set of thresholds in the limit dialog box. This function will prompt you for an upper and lower limit. Any data values outside these limits will be clipped at the closer limit. Although both a high and low threshold must be entered, it is possible to limit only one extreme (high or low) while leaving the other extreme unaffected. For instance, if you wanted to limit data so that all negative values were set to zero but the positive values were left unchanged, you would set the low threshold to zero and the high threshold to 99 (or some other large positive value that exceeds the maximum value for that channel).</td>
</tr>
<tr>
<td><strong>Ln</strong> <em>(Natural Logarithm).</em></td>
<td>Computes the natural logarithm of the selected section. The inverse of this function is the exponential function, <em>Exp</em>.*</td>
</tr>
<tr>
<td><strong>Log</strong> <em>(Base 10 Logarithm).</em></td>
<td>Computes the base 10 logarithm of the selected section. In order to perform the inverse of this function, which would be $10^x$, use the Waveform Math power operator with the constant $k=10$ as the first operand and the waveform data as the second operand.</td>
</tr>
<tr>
<td><strong>Noise</strong></td>
<td>Converts the selected section into random data values between –1.0 and +1.0. This is mainly useful for creating stimulus signals and other waveforms.</td>
</tr>
<tr>
<td><strong>Sin</strong> <em>(Sine).</em></td>
<td>Calculates the sine of the selected section. The data is assumed to be in radians.</td>
</tr>
<tr>
<td><strong>Sqrt</strong> <em>(Square Root).</em></td>
<td>Takes the square root ($\sqrt{\cdot}$) of each data point in the selected section.</td>
</tr>
<tr>
<td><strong>Threshold</strong> <em>(Threshold data values).</em></td>
<td>Transforms all data points above the threshold to +1 units, and converts all values below the lower threshold to 0 units. Once the data crosses a threshold it will continue to be set to +1 for the upper cutoff and 0 for the lower cutoff, until it crosses the opposite threshold. The most common application of this function is to serve as a simple peak detector, the results of which can be used in rate or phase calculations.</td>
</tr>
</tbody>
</table>
Template Functions

| Template functions |  
|--------------------|---|
| Set template       |  
| Remove mean        |  
| Correlation        |  
| Convolution        |  
| Mean square error  |  
| Inverse Mean square error |

The Template Functions are useful for comparing waveforms. Technically, the template functions provide correlation, convolution and mean square error transformations of a template waveform against another waveform.

**NOTE:** To determine a level of comparison between two waveforms, you should use the Correlation function.

All the template functions perform a mathematical operation of the template waveform on the waveform to be compared, move one sample forward, and repeat the multiplication until the end of the longer waveform is reached.

**Set Template**

Use the following ECG waveform as an example. An abnormality exists in the record. After detecting an abnormality, you should find out if there are other (similar) abnormalities in the record. To do that, you need to select the pattern you’d like to search for, and then compare that pattern to other data sets in the file.

**Selecting a section of a wave to be used as a template:**

1) Highlight the section to be used as a pattern.

![Highlighted area to be used as pattern](highlighted_area.png)
2) Click on the **Transform** menu and choose **Set template** from the **Template functions** submenu. This copies the selected portion into a buffer for subsequent template functions.

3) Select the waveform and position the cursor at the beginning of the data.

4) Choose **Correlation** from the **Template functions** submenu. The center waveform in the graph below shows the result of the correlation.

   Note the higher amplitude peaks where the template data more closely matches the waveform. The lower waveform illustrates the mean square error function, which is similar to the correlation function. This indicates that there are two abnormal beats in the record. The first one appears at about 3 seconds and is the one used as a template, the second one appears at about 11 seconds.

5) Use the zoom tool to inspect the abnormalities more closely.
**Remove mean**

A drifting baseline can be a problem in comparing waveforms. If you perform a Template function and the template or the waveform has a slowly moving baseline, you can increase the effectiveness of the comparison by choosing Remove mean from the submenu of the Template function. The remove mean option causes the mean amplitude value of the template and the compared section of the waveform to be subtracted from each other before the sections are compared. This way, a large baseline offset will have very little effect on the comparison. This option is toggled every time it is selected and is enabled when a check mark is present.

For example, the following graph shows the original waveform at the top, the correlated waveform with mean removal in the middle, and the same correlation without mean removal at the bottom. Note how the mean removal effectively compensates for the drifting baseline in the original waveform.

![Correlation with and without mean removal](image-url)
**Template algorithms**

The template functions employ four algorithms: correlation, convolution, mean square error, and inverse mean square error.

a) The first algorithm, **Correlation**, is a simple multiplication and sum operation (as shown in the preceding example.). The template is first positioned at the cursor position in the waveform to be correlated. Each point in the template waveform is multiplied by the corresponding point in the data waveform (the waveform to be correlated) and summed to produce the resulting data point. The template is then moved one data sample forward and the operation is repeated to produce the next resulting data point. The resulting data points replace the waveform to be correlated.

The **correlation** function algorithm can be expressed by the following formula, where \( f_{\text{output}}(n) \) is the resulting data point, \( f_{\text{template}}(k) \) is the template waveform data points, and \( K \) is the number of data points in the template:

\[
f_{\text{output}}(n) = \sum_{k=1}^{K} f_{\text{template}}(k) \times f_{\text{waveform}}(n)
\]

b) The second function is **Convolution**. This function is identical to the correlation function except that the template waveform is reversed during the operation. This function is not generally useful by itself, but can be used as a building block for more sophisticated transformations. The convolution function algorithm can be expressed by the following formula, where \( f_{\text{output}}(n) \) is the resulting data point, \( f_{\text{template}}(k) \) is the template waveform data points, and \( N \) is the number of data points in the template:

\[
f_{\text{output}}(n) = \sum_{k=-N/2}^{N/2-1} f_{\text{template}}(-k) \times f_{\text{waveform}}(n + k)
\]

c) The third algorithm is **Mean square error**. For this function, the template is first positioned at the cursor position in the waveform to be compared. Each point in the template waveform is subtracted from the corresponding point in the waveform to be compared. The result is squared and summed to produce the resulting data point. The template is then moved one data sample forward and the operation is repeated to produce the next resulting data point. The resulting data points replace the waveform.

The **mean square error** function tends to amplify the error (or difference) between the template and the waveform, which makes it useful when you are looking for an extremely close match rather than a general comparison. When a match is found, the **mean square error** algorithm returns a value close to zero.

The **mean square error** function algorithm can be expressed by the following formula, where \( f_{\text{output}}(n) \) is the resulting data point, \( f_{\text{template}}(k) \) is the template waveform data points, and \( K \) is the number of data points in the template:

\[
f_{\text{output}}(n) = \sum_{k=1}^{K} [f_{\text{template}}(k) - f_{\text{waveform}}(n)]^2
\]

d) The fourth algorithm is **Inverse Mean square error**. This function simply inverts the result of the **mean square error** algorithm. Accordingly, when this algorithm finds a match between the template and the data, the algorithm returns the inverse of a value close to zero and, typically, a large positive spike will occur at the point of the match.
Integral

The integral function is essentially a running summation of the data. Each point of the integral is equal to the sum of all the points up to that point in time, exclusive of the endpoints, which are weighted by half. The exact formula is shown below, where \( f(\cdot) \) is the data values and \( \Delta Ts \) is the horizontal sampling interval:

\[
 f_{\text{output}}(n) = \sum_{k = 1}^{n - 1} f_{\text{input}}(k) + \left[ f_{\text{input}}(n - 1) + f_{\text{input}}(n) / 2 \right] \cdot \Delta Ts
\]

The units will be (amplitude units • horizontal units). The integral function can be used to compute the area under the curve in a continuous fashion. For instance, if you had data acquired by an accelerometer, the integral of the data would be the velocity, and the integral of the velocity would be the distance. As with all transformations, this function can be applied to either a selected area or to the entire waveform.

Derivative

Transform>Derivative dialog box and Filter Response graph

The Derivative function calculates the derivative of the selected area of a waveform (or the entire waveform if it has been highlighted using Edit>Select all). Since high frequency components will give you nonsensical results in a derivative, a low pass filtering function is included in the Derivative function (see page 168 for more information on low pass filters).

The Derivative function is based on an FIR filter implementation. The Derivative FIR filter frequency response will appear as a linearly increasing magnitude up to the point of the specified cutoff frequency, at which point, the filter magnitude will drop off sharply.

When performing derivatives, this implementation can provide a more meaningful result than the Difference function (which often has a higher than required frequency response, thus processing potentially undesirable data).

Cutoff Frequency

The value entered in the cutoff frequency box should be roughly equivalent to the highest frequency component of interest present in the time series data. The default cutoff frequency is 0.125 times the waveform sampling rate.

# of Coefficients

The default number of coefficients is \( (4 \times \text{waveform sampling rate}) / \text{Cutoff Frequency} \). As the number of coefficients (Q) increases, the Derivative becomes more accurate.

TIP: A good rule of thumb is to use a number of coefficients greater than or equal to two times the sampling rate divided by the lowest cutoff frequency specified. For example, if running a low pass filter at 1Hz on data sampled at 100Hz, choose at least \( (2 \times 100/1) \) or 200 coefficients in the filter. Additional coefficients will improve the response.

Note: If your data is already “well behaved” (i.e., low pass filtered or contains little or no high frequency information), you can use the Difference transformation with a 2-sample interval. This will give you results very similar to the Derivative, but will work much faster.

Visit the online support center at www.biopac.com
Integrate

The **Integrate** transformation operates the same as the Integrate calculation—see page 55.

### Smoothing

The **smoothing** function is a transformation that computes the moving average of a series of data points and replaces each value with the mean value of the moving average “window.” This has the same effect as a crude low pass filter, with the advantage being that smoothing is typically faster than digital filtering.

**Samples**

*AcqKnowledge* allows you to set the width of the moving average window (the number of sample points used to compute the mean) to any value larger than three. By default, this is set to three samples, meaning that *AcqKnowledge* will compute the average of three adjacent samples and replace the value of each sample with the mean before moving on to the next sample. For data acquired at relatively high sampling rates, you will probably want to set the smoothing factor to a higher value, since smoothing three sample points when data is collected at 1000Hz will only average across three milliseconds of data, and will typically do little to filter out noise. To set the size of the window, enter a value in the **Transform > Smoothing** dialog box.

This function is most effective on data with slowly changing values (e.g., respiration, heart rate, GSR) when there is noise apparent in the data record.

**Mean value smoothing**

Mean value smoothing is the default and should be uses when noise appears in a Gaussian distribution around the mean of the signal. The Mean value smoothing formula is shown below, where “m” is the number of points in the window and “n” is the sample number:

\[
    f_{output}(n) = \sum_{k=n-(m/2)}^{k=n+[m-1]/2} f_{input}(k) / m
\]

**Median value smoothing**

Use **Median value smoothing** if some data points appear completely aberrant and seem to be “wild flyers” in the data set. The Median value smoothing formula is shown below, where “m” is the number of points in the window and “n” is the sample number:

\[
    f_{output}(n) = \text{median } (n - \lfloor m/2 \rfloor; n + \lceil m/2 \rceil)
\]

**Scaling**

Generates the Scaling Parameters dialog.
The **Difference** function measures the difference (in amplitude) of two sample points separated by an arbitrary number of intervals. The difference is then divided by the total interval between the first selected sample and the last selected sample.

When you select the difference transformation, a difference interval dialog box will be generated and you can enter the number of intervals between samples (default of 1).

For data with no high frequency components, a 1-interval difference transformation approximates a differentiator.

Since it is not implemented as a convolution, Difference is much faster than the derivative function.

The formula for the difference transformation is shown below, where “m” is the number of intervals difference, [ ] rounds the integer down, “n” is the sample number, and $\Delta T_s$ is the horizontal sampling interval:

$$f_{output}(n) = f_{input}(n + \lfloor m/2 \rfloor) - f_{input}(n - \lfloor (m+1)/2 \rfloor)$$

$$\frac{(\Delta T_s \times m)}{}$$

Example for boundary values when $m = 3$:

$$f_{output}(0) = (f_{input}(1) - f_{input}(0)) / (\Delta T_s \times m)$$

$$f_{output}(1) = (f_{input}(2) - f_{input}(0)) / (\Delta T_s \times m)$$

$$f_{output}(2) = (f_{input}(3) - f_{input}(0)) / (\Delta T_s \times m)$$

If you enter an odd number ($K = \text{odd}$):

$$f_{output}(K) = (f_{input}(K+1) - f_{input}(K-2)) / (\Delta T_s \times m)$$

If you enter an even number ($K = \text{even}$):

$$f_{output}(K) = (f_{input}(K+2) - f_{input}(K-2)) / (\Delta T_s \times m)$$

**Note:** The on-line (real-time) Difference calculation is calculated differently because projected values are not available. The on-line Difference formula is:

$$f_{output}(n) = f_{input}(n - m) - f_{input}(n) / (\Delta T_s \times m)$$

Using the default difference setting of 1 interval will produce a “$\Delta P/\Delta T$” waveform when the transformation is applied to a blood pressure or similar waveform.
The **Histogram** function produces a histogram plot of the selected area. When a histogram is created, the sample points are sorted into “bins” along the horizontal axis that contain ranges of amplitude values. These bins divide the range of amplitude values into equal intervals (by default, ten bins) and the individual sample points are sorted into the appropriate bin based on their amplitude value.

For instance, if a waveform had a range from 65 BPM to 85 BPM, the lowest bin would contain all data points with a value from 65 BPM to 67 BPM. The second lowest bin would hold all data points between 67 BPM and 69 BPM, and so on, until the tenth bin was created. AcqKnowledge then counts the number of “hits” (the number of data points) in each bin and plots this number on the vertical axis.

The **Transform>Histogram Options** dialog box has these options:

- **bins**
  - Determines how many bins the data will be divided into; the default is ten bins.

- **Autorange**
  - Fits all the data selected into a bin; the bin sizes are determined by the extent of the data and the desired number of lines. Automatically sets the center of the lowest bin equal to the minimum value of the waveform (or the selected area, if a section is highlighted), and centers the highest bin on the maximum value of the waveform (or selected area, if any).

- **Manual**
  - Use to fix the bin sizes. Enter values for the **Highest Bin** and **Lowest Bin**.

When you click OK, a histogram plot will be generated in a new window. By default, AcqKnowledge displays the frequency of occurrence for each bin on the vertical axis. To calculate the cumulative frequency, select the entire histogram waveform and choose **Integrate** from the **Transform** menu.

Since the histogram function sorts sample points into a relatively small number of categories, the histogram window is likely to display a large number of “hits” in each bin, especially if data was collected at a relatively fast sampling rate. If this is the case, you may want to resample the data at a lower rate (using the **Transform>Resample** function). The caveat to this is that resampling the data may cause a bias, unless the data was filtered to remove all frequency components that are more than 0.5 the resampling rate.
Resample

This function **resamples** the active channel to another rate, which can be used to “compress” data files by saving the data at a lower sampling rate. By resampling data, you can maintain the same time scale but reduce the number of samples per second. For instance, a 4-channel data file sampled at 250 samples per second for 15 minutes takes up about 1.8 MB of disk space. If these channels are resampled to 100 samples per second, the size of the file on disk is about 720 KB, a considerable reduction. Keep in mind that whenever data is resampled to a lower rate, information is lost.

**TIP**: A good rule of thumb is that data should be sampled anywhere from two to ten times the highest frequency component of interest.

The alpha component of an EEG signal has a frequency signature of 8-13Hz, so (assuming you have isolated the alpha component using a band pass filter) you would probably want to sample the data (in this case, isolated alpha waves) at a rate of at least 26Hz and probably no more than 130Hz.

You can also use the resample function to increase the number of sample points per interval (usually samples per second). When this is done, AcqKnowledge will interpolate between sample points to adjust to the new rate. This will add data points, although not necessarily more information.

If data is resampled to a lower rate and then resampled again at a higher rate, the waveform will maintain the resolution of the lower sampling rate, only with more data points.

The highest sampling rate that a channel can be resampled to is the file acquisition rate (MP menu > Setup Acquisition).
Equation Generator (Expression)

Equation dialog boxes (PC on left, Mac on right)

The post-acquisition Equation Generator (Equation Generator) is available for performing computations more complex than available with the Math and Function calculations. The post-acquisition version of the Equation Generator includes all the same features as the on-line version described on page 70. The Equation Generator will symbolically evaluate complex equations involving multiple channels and multiple operations. Unlike the Math and Function calculations, which can only operate on one or two channels at a time, the Equation Generator can combine data from multiple analog channels, or specify other calculation channels as input channels for expression channels. Also, computations performed by the Equation Generator eliminate the need for “chaining” multiple channels together to produce a single output channel. A number of functions that are not available in either the Math calculation or Function calculation channels can be accessed in the Equation Generator.

To have AcqKnowledge solve an expression and save the result to a new channel, choose Equation Generator from the Transform menu. A dialog box will be generated, allowing you to select input source channels, operators, and output channels from pop-up menus. The different components of each expression can be entered either by double-clicking items from the pop-up menus (sources, functions, and operators) in the setup expression dialog box, or by typing commands directly into the expression box. For each expression, you need to specify a source channel (or channels), the function(s) to be performed, and any operators to be used. The expression solver uses standard mathematical notation.

You can divide a complex equation into several steps and perform each part of the equation with a separate channel. With up to 60 channels, almost any calculation can be performed.

When using the Equation Generator, it is important to keep in mind that while different channels, functions, and operators can be referenced, this Calculation cannot directly reference past or future sample points. That is, data from a given point in time on waveform one can be transformed or combined in some way with data from the corresponding time index on waveform two.

However, data from one point in time (on any channel) cannot be combined with data from another point in time (on any channel). You can operate on waveforms that are lagged in time by an arbitrary number of sample points by duplicating a waveform, and removing some number of sample points from the beginning of the record. This will create two channels that are offset by a constant time interval.
Note for variable sample rate processing:

The Equation Generator and Waveform Math functions will constrain operations between waves of different rates as follows:

If an equation is operating on two or more waves of different sample rates, the result of the operation will always be output at the lowest sampling rate from the waves (F_low). If the destination channel for the result has an assigned rate other than (F_low), the operation will not be permitted. If the destination channel is set to a new channel, the operation will always be permitted.

<table>
<thead>
<tr>
<th>Function</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABS</td>
<td>Returns the absolute value of each data point.</td>
</tr>
<tr>
<td>ACOS</td>
<td>Computes the arc cosine of each data point in radians.</td>
</tr>
<tr>
<td>ASIN</td>
<td>Calculates the arcsine of each value in radians.</td>
</tr>
<tr>
<td>ATAN</td>
<td>Computes the arc tangent of each sample point.</td>
</tr>
<tr>
<td>COS</td>
<td>Returns the cosine of each data point.</td>
</tr>
<tr>
<td>COSH</td>
<td>Computes the hyperbolic cosine of each selected value.</td>
</tr>
<tr>
<td>EXP</td>
<td>Takes the $e^x$ power of each data point.</td>
</tr>
<tr>
<td>LOG</td>
<td>Computes the natural logarithm of each value.</td>
</tr>
<tr>
<td>LOG10</td>
<td>Returns the base 10 logarithm of each value.</td>
</tr>
<tr>
<td>ROUND</td>
<td>Rounds each sample point the number of digits specified in the parentheses.</td>
</tr>
<tr>
<td>SIN</td>
<td>Calculates the sine (in radians) of each data point.</td>
</tr>
<tr>
<td>SINH</td>
<td>Computes the hyperbolic sine for each sample point.</td>
</tr>
<tr>
<td>SQI</td>
<td>Squares each data point.</td>
</tr>
<tr>
<td>SQRT</td>
<td>Takes the square root of each data point.</td>
</tr>
<tr>
<td>TAN</td>
<td>Computes the tangent of each sample point.</td>
</tr>
<tr>
<td>TANH</td>
<td>Calculates the hyperbolic tangent of each sample point.</td>
</tr>
<tr>
<td>TRUNC</td>
<td>Truncates each sample point the number of digits specified in the parentheses.</td>
</tr>
</tbody>
</table>

Table of Equation generator Functions

<table>
<thead>
<tr>
<th>Operator</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>Addition</td>
</tr>
<tr>
<td>-</td>
<td>Subtraction</td>
</tr>
<tr>
<td>*</td>
<td>Multiplication</td>
</tr>
<tr>
<td>/</td>
<td>Division</td>
</tr>
<tr>
<td>^</td>
<td>Power</td>
</tr>
<tr>
<td>(</td>
<td>Open parentheses</td>
</tr>
<tr>
<td>)</td>
<td>Close parentheses</td>
</tr>
</tbody>
</table>

Table of Operators

Visit the online support center at www.biopac.com
Waveform math

The Waveform math transformation allows arithmetic manipulation of waveforms. Waveforms can be added together, subtracted, multiplied, divided or raised to a power. These operations can be performed using either two waveforms or one waveform and an arbitrarily defined constant. You can operate on the entire waveform by choosing Edit>Select all, or operate on portions of the waveform that have been selected using the cursor tool. If there is no selected area, only one sample point (the one selected by the cursor) will be transformed.

When you select Transform>Waveform Math, the Waveform Arithmetic dialog will be generated.

All of the main components of a waveform math calculation can be selected from pop-up menus in the Waveform Arithmetic dialog box.

Source
The channels to be used in the transformation are referred to as source channels (Source 1 and Source 2), and can be combined using any of the operators in the pop-up menu. Source channels allow you to select any of the existing channels in the current window, or a constant (defined by K).

Constant
The “Constant =” entry box is activated when a Source is set to “K, Constant.”

Operand
The pop-up menu allows selection of addition, subtraction, multiplication, division or power functions.

Destination
You can save the results to an active channel, or create a new channel to store the results. Choose an existing channel from the pop-up menu or select the “New” option, which will create a new channel (using the next available channel).

Result sample rate
When using variable sample rate processing, the Equation Generator and Waveform Math functions will constrain operations between waves of different rates as follows:

- If an equation is operating on two or more waves of different sample rates, the result of the operation will always be output at the lowest sampling rate from the waves (F low).
- If the destination channel for the result has an assigned rate other than (F low), the operation will not be permitted.
- If the destination channel is set to a new channel, the operation will always be permitted.

Scaling…
Generates the scaling parameters dialog.
Waveform math can be used many ways. As one example, two waveforms can be added together. The screen below shows a sine wave in channel 14 and a triangle wave in channel 16.

To add these two waves, select **Transform>Waveform Math** and set source 1 to channel 14, the operator to addition “+”, source 2 to channel 16, and destination to New as shown here:

![Waveform Math Configuration](image)

Click **OK** to perform the transformation. The following screen shows the sum of CH14 and CH16 on a new channel.

![Waveform Sum](image)

**NOTE:** If you select two waveforms of unequal length as sources, the length of the resulting waveform will be equal to that of the shortest one. Likewise, if one of the source waveforms extends only into a portion of the selected area, the resultant waveform will only be as long as the shortest source portion. If waveform math is performed on a selected area and output to an existing waveform that does not extend into the selected area, the resultant waveform is appended to the destination waveform.
The FFT algorithm requires that the length of your data be an exact power of two (i.e., 256 points, 512 points, 1024 points, and so on).

The Fast Fourier Transformation (FFT) is an algorithm that produces a description of time series data in terms of its frequency components. This is related to the frequency spectrum. The FFT displays the magnitude and phase of the time series data selected and displays only the DC and positive frequency components; the FFT does not display negative frequency components. To reconstruct a signal from additive sines or cosines, you need to include both the positive and negative frequency components. Since it’s not physically possible to generate a negative frequency signal, you need to double the amplitude of the corresponding positive frequency component.

The output from an FFT appears in a graph window with magnitude (vertical axis) plotted against various frequencies (horizontal axis). A large component for a given frequency appears as a positive (upward-pointing) peak. The range of frequencies plotted is from 0Hz to 1/2 the sampling frequency. Thus, if data was collected at 200 samples per seconds, AcqKnowledge will plot the frequency components from 0Hz to 100Hz.

Fourier analysis can yield important information about the frequency components in a data set, and can be useful in making determinations regarding appropriate data cleaning techniques (e.g., digital filtering). The FFT algorithm assumes that data is an infinitely repeating periodic signal with the end points wrapping around. Thus, to the extent that the amplitude of the first point differs from the last point, the resulting frequency spectrum is likely to be distorted as result of this startpoint to endpoint discontinuity. This can be overcome by “windowing” the data during the transformation. For more information on the windowing feature, see the window section that follows.

The FFT transformation cannot be performed in real time (i.e., during an acquisition). However, it is possible to emulate an on-line spectral analysis using several on-line filters and the Input Values window. See page 103 for more information on how to display frequency information in real time.

**Pad**

If a section of data is selected that is not a power of two, AcqKnowledge will always “pad” data up to the next power of two, filling in the remaining data point with either zeros or with the last data point in the selected area.

In other words, if 511 data points are selected, AcqKnowledge will use a modified version of the waveform as input. The modified waveform will have 512 points, and the last point in the modified wave will be either:

a) a zero, if the Pad with zeros option is checked, or
b) equal to the $511^{th}$ point of the original data, if the **Pad with endpoint** option is checked.

**Show Mod.** To view the modified waveform being used as input for the FFT, check the **Show modified input** box. Whenever possible, it is best to use an input waveform (select an area) that is an exact power of two.

**Window** The FFT algorithm treats the data as an infinitely repeating signal with a period equal to the length of the waveform. Therefore, if the endpoint values are unequal, you will get a frequency spectrum with larger than expected high frequency components due to the discontinuity. Windowing these data minimizes this phenomenon. For example, to apply a window transformation to a sine wave whose endpoints do not match up, check the box next to **Window** and choose a type of window from the pop-up menu. Each of the windows has slightly different characteristics, although in practice each provides similar results within measurement error.

As shown here, the frequency spectra of the windowed and non-windowed data differ significantly when the endpoints are unequal. When data are not windowed, the very low and very high frequencies are not attenuated to the same extent as when windowed.

**Remove Trend** Sometimes, data contains a positive or negative trend that can cause extraneous frequency components to “leak” into the frequency spectrum. In this case, you could select **remove trend** when you perform the FFT, which will draw a line through the endpoints, and then subtract the trend from the waveform.

For example, the following sine wave has an upward trend through the data (positive trend component). The lower graph shows FFTs of the skewed sine wave data with and without the trend removed.

Note that the spectrum of the data without the trend removal has gradually decreasing frequency components, while the data with the trend removed has far fewer frequency components except for

Visit the online support center at www.biopac.com
the single spike due to the sine wave.

**Remove Mean**  Remove mean calculates the mean of all the points in the selected area and then subtracts it from the waveform. This is generally useful for windowing a waveform that has a large DC offset.

As an example, you might start with a sine wave with a 10-volt DC offset (with a little noise added to broaden the spectrum), and perform spectral analysis with and without mean removal:

Note the large spectral components at the beginning of the top plot, without mean removal. This is due to the offset of the original data. The bottom plot is with mean removal.

Since the offset of the waveform is often an artifact of the way it was generated, the remove mean option provides a more accurate indication of the true spectral components. This is especially true for applications where low frequency components are of interest. If your data has a large DC offset and you plan on windowing the data, you will generally get a more meaningful spectrum if you remove the mean prior to windowing (which is the same order the FFT uses).

**Linear**  By default, the FFT output is described in terms of frequency along the horizontal axis and dBV on the vertical axis. The Bell scale (from which dB are derived) is logarithmic, and in some cases it may be useful to have the output scaled in linear units. To do this, click on the button next to linear and check OK. The other options in the dialog box work as they normally do when the dB scaling option is selected. The relationship between log and linear units is: \( \text{d}BV_{\text{out}} = 20 \log \text{VIN} \).
Phase

The standard FFT produces a plot with frequency on the horizontal axis and either dB/V or linear units (usually Volts) on the vertical axis. In some cases, it may be useful to obtain phase plots of the waveform (as opposed to the default magnitude plots). Phase plots display frequency along the horizontal axis, and the phase of the waveform (scaled in degrees) on the vertical axis. This option functions exclusive of the magnitude option — you can check either independently, or if you check both, two plots will be produced (a magnitude plot and a phase plot).
To perform an FFT, you might start with an electroencephalogram (EEG) signal acquired when the subject alternated between eyes open and eyes closed. Typical results suggest that higher levels of alpha activity (activity with frequency components between 8Hz and 13Hz) are to be expected when a subject’s eyes are closed.

1. The raw data, prior to FFT, is shown here:

2. Select Transform>FFT from the menu.

   The FFT Parameters dialog will be generated; in this example, the Window function chosen is Kaiser Bessel:

3. Click OK.

   A frequency domain window (a graph window which places frequency along the horizontal axis rather than time) will be created and displayed, showing the spectrum of the input data.

   The window is named “Spectral of (the original window name)” and ends with the channel number, as shown here:

   The resulting magnitude value for each component is equal to the peak value of the sine wave contributing to that component.

   The entire pattern of frequency components is known as the frequency spectrum of the data. The somewhat erratic appearance of the spectrum is usually due to small-scale variations in the original waveform.

4. Optional — This “noise” can be removed by applying a smoothing transformation to the FFT output. In the graph shown, there is a pronounced frequency component centered on 8Hz, which corresponds to the alpha wave frequency band (8Hz – 13Hz). The frequency spectrum (0-20Hz shown) used 20-point smoothing.
**Inverse FFT**

- The Transform>IFFT menu option is generated after an FFT is performed.

An Inverse FFT (Transform>IFFT) converts spectral values back to a time series waveform to reverse the FFT transformation. To accurately recreate the time series waveform, both the Magnitude and Phase channels must be selected from the associated pull-down menus. Any modifications to the original data (such as windowing or padding) will be shown in the resulting time series data.

To obtain a meaningful IFFT result you must have a graph window open with at least one magnitude channel and at least one phase channel. With the window open, choose IFFT from the Transform menu to generate the Inverse FFT dialog box, as shown below:

![Inverse FFT dialog box](image)

The Magnitude and Phase pop-up menus select the source channels for the inverse FFT transformation. The linear and dB buttons indicate whether the source magnitude waveform is logarithmically scaled (dB) or linearly scaled (linear). The phase waveform must be in degrees.

Click **OK** to perform the IFFT. The result be generated in a new time domain window, labeled “IFFT of Spectral…”

Click **Cancel** to abort the IFFT.

Visit the online support center at www.biopac.com
Find Peak (Peak Detector)

Overview

The Find Peak (Peak Detector) function is a software analysis tool that automates measurement tasks. The Peak Detector provides a variety of mechanisms to automatically control the I-beam selection tool to automatically perform specific measurements on data in an AcqKnowledge data file which otherwise would have to be performed manually using the I-beam selection tool and the respective pop-up measurements. It is the primary tool used for waveform data extraction or reduction. The Peak Detector can perform automatic measurements on multiple channels simultaneously. The resultant measurements can be printed directly to the Journal or plotted, in graphical form, to a new channel in the AcqKnowledge data file.

Peak Detector Measurement Modes

In both of the operational modes, the Peak Detector advances (step-by-step) a single master cursor forward in time. The time jumps made by this master cursor are determined by the operational mode:

1) **Data driven** — The cursor (or selected area) is placed at a specified time offset to locate Positive peaks or thresholds or Negative peaks (valleys) in the data file. The master cursor jumps forward to the next point as defined by the data stream and the kind of feature (Positive peak or Negative peak) identified.
   - A good example of a data driven measurement is the determination of R-R interval in an ECG recording.

2) **User-defined interval** — The master cursor jumps forward by the pre-specified, user-defined interval.
   - A good example of a user-defined interval measurement is the determination of mean blood pressure values over ongoing, consecutive, 1-minute intervals.
The Peak Detector also employs sub-cursors. Sub-cursors can be set to fixed positions, in time, related to the master cursor. For example, the master cursor could be set up to move through the data at 30-second intervals, while the sub-cursors could be configured so that a data measurement would be performed several seconds before and several seconds after the location of each 30-second jump point.

**Data Driven Measurements**

Use this mode when you want the waveform data itself to drive the waveform data reduction process. In this mode, the algorithm will find positive or negative peaks or thresholds and move the I-beam to that found peak or threshold, offset in time by some fixed time delta. If the pop-up measurements are set to certain functions, the value returned by those functions will be present in the respective pop-up measurement result box.

In this mode, data is extracted from the waveform as mediated by the form of the data itself. In typical physiological recordings, data is often quite cyclic in nature. Data driven measurements are those that employ characteristics of the data cycles themselves to determine the interval over which the measurement is performed. The Peak Detector will simply “hop” from the peak of one R-wave to the next and, in the process of doing so, will automatically extract all the cyclic R-R intervals present in the ECG recording. When performing data driven measurements, the user can specify whether the software should look for positive peaks or negative peaks in the record. If “Positive peak” is selected, the Peak Detector will advance a master cursor, step-by-step, through all the positive peaks in the data file or selected area.

**User-defined Measurements**

Use this mode when the waveform data reduction requirements necessitate examining the data around many equally sized data segments. The algorithm will reference the I-beam to pre-selected time intervals that can be set to “chop” the waveform data into equal chunks.

In this mode, data is extracted from the waveform as mediated by a pre-defined time interval. The Peak Detector will simply “hop” to the next fixed point in time as indicated by the user-defined time interval. In all user defined interval measurements, the Peak Detector will advance a master cursor, step-by-step, through specific (fixed) time intervals, until the end of the file or selected area is reached.

**Averaging**

- A good example of this feature is assembling a representative or average blood pressure cycle from a larger collection of cycles.

A special feature of the Peak Detector is the ability to perform averages of data when performing data driven or user-defined measurements. As one example, the Peak detector might automatically identify the high (positive) or low (negative) points of a selected series of blood pressure cycles. The Peak Detector would be set up to look “before” and “after” each positive or negative blood pressure peak. After all the peaks were found, the AcqKnowledge software would automatically assemble the identified data to create the averaged beat.
**Peak Detector Controls**

**Data-driven Mode**

**Find Peak**

In data driven mode, the Peak Detector can look for Positive peaks or Negative peaks.

- **Positive peak** — the highest valued point in the data between crossings when data crosses a Fixed threshold, first positively and then negatively.
- **Negative peak** — the least valued point in the data between the crossings when data crosses a Fixed threshold, first negatively and then positively.

**Fixed mode**

In the simplest mode of data driven operation, the user can identify a Fixed value as the threshold point.

**Threshold**

The next simplest mode of data driven operation employs a **Tracking threshold**, which adjusts the threshold level each time another peak (Positive or Negative) is found.

![Tracking threshold options dialog]

**Level**

If an area is selected before the dialog is opened, the software will determine the optimum Level based on that area (the units are those of the waveform to be peak detected).

You can manually enter a threshold parameter in the threshold Level box to overwrite the software. If an area is selected when you reopen the dialog, the software will overwrite your manual Level entry. To refer back to manual Level entries, you need to note each manual entry before closing the dialog, or make sure only one data point is selected before reopening the dialog.

**Tracking mode**

The Tracking threshold mode modifies the threshold after it finds a peak, depending upon the value of the new peak, and will compensate for a slowly drifting baseline.

- **% of previous peak** — The value entered here determines the amount that the Tracking mode changes the threshold.
- The **Options** button generates a dialog with two tracking threshold options:
  - “Peaks reference”
  - “Means reference”

**Hints regarding the use of Tracking Threshold Options**

- If data has a very consistent cyclical nature, **either Tracking Option** will work.
- If data has spurious positive or negative peak values present, the **Means Reference** Tracking Option is probably a better choice.
- If data has an erratic baseline, but consistently sized, positive and negative peaks, the **Peaks Reference** Tracking Option is probably a better choice.
Means Reference

The default option for Tracking threshold operation employs a **Means reference**. This option will cause the software to determine the Mean Value of all the data, from peak to peak. This Mean Value establishes a variable reference upon which the tracking threshold operates. The software will determine the new threshold (NT) as follows:

For Positive Peaks

\[ NT = \text{Mean Value} + (\text{Positive Peak Value} - \text{Mean Value}) \times (\% \text{ factor}) \]

For Negative Peaks

\[ NT = \text{Mean Value} - (\text{Mean Value} - \text{Negative Peak Value}) \times (\% \text{ factor}) \]

Peaks Reference

An alternate option for Tracking threshold operation employs a **Peaks reference**. This option will cause the software to determine the Positive Peak Value and Negative Peak Value of all the data, from peak to peak. The Positive and Negative Peak Values establish a variable reference upon which the tracking threshold operates. The software will determine the new threshold (NT) as follows:

For Positive Peaks

\[ NT = \text{Neg. Peak Value} + (\text{Pos. Peak Value} – \text{Neg. Peak Value}) \times (\% \text{ factor}) \]

For Negative Peaks

\[ NT = \text{Pos. Peak Value} - (\text{Pos. Peak Value} – \text{Neg. Peak Value}) \times (\% \text{ factor}) \]

Set first cursor to

The selection area can be modified by the user for a fixed-distance and offset from the reference point. In data-driven mode, the first cursor can be set to any one of the following four options, plus a positive or negative fixed-interval of time:

a) Previous peak  c) Previous Threshold
b) Peak  d) Threshold

Set Second cursor to

The second cursor can be set to a threshold plus a positive fixed-interval of time only, as long as the first cursor is also referenced to a threshold.

User-defined Interval Mode

Find Peak

The Start Point can be specified at either the existing cursor (I-beam) location or at a specified time.

Interval

The Interval is the reference point of the cursor (I-beam). The cursor will move by the specified time Interval as the Peak Detector algorithm automatically moves the cursor.

Set first cursor

The selection area can be modified by the user for a fixed-distance and offset from the reference point. In user-defined mode, the first cursor can be set to either of the following options, plus a positive or negative fixed-interval of time:

a) Previous peak  b) Peak

Set second cursor

The second cursor can be set to peak plus a positive fixed-interval of time only. In user-defined mode, “peak” refers to the location of the next user-defined interval.

Visit the online support center at www.biopac.com
Off-line Averaging

The Off-line Averaging option works with both Find Peak modes. This option lets the user average waveform data together from different reference points in the complete data record. For instance, when evaluating an ECG record, Off-line Averaging can be used with Find peak: Positive peak to generate a composite ECG cycle—the “average looking” cycle of a specified number of separate ECG cycles.

Control Channel

The Control Channel option lets you detect events in one channel while averaging the response from another channel. Using the Control Channel function, you can perform averaging on one data channel even though the master cursor is synchronized (controlled) by another channel. This means that the average value of one signal can be computed around events in another signal, which is useful for ERP and P300 studies.

When Averaging is selected, a pop-up menu is activated for Control Channel selection. The default Control channel is the Source channel.

A good example of this feature revolves around P300 measurements, where two or more Control Channels are used to sequentially average data. Using the SuperLab® presentation system, the average response can be determined based on when stimuli were presented to the subject. One Control Channel can correlate to stimulus A, and other Control Channels can correlate to stimuli B, C, D, etc. In this fashion, averaged responses to different types of sequentially presented stimuli can be compared and analyzed.

Setup Averaging

Averaging Range

- Entire Waveform — The average is generated with relevant data from the entire waveform.
- Selected Area — The average is generated with relevant data from only the selected area.
- From start point for Number of averages — The averaging algorithm collects relevant data from the start point and continues until the specified number of averages is reached.
- From start point until end — The averaging algorithm collects relevant data from the start point and continues until the end of the data file is reached.

Artifact rejection

Artifact rejection eliminates suspect data from the averaging process. Suspect data is identified as any sample value in a relevant data block that is higher or lower than the respective Reject high and Reject Low levels.

Ave Start — Starts the average procedure per the established settings.
**Paste Measurements into Journal**

To automatically write values to the Journal, click in the box next to “Paste Measurements into Journal.”

**Display Measurements as Graph**

This option will plot the measurements as a graph in a new channel. Each measurement is assigned its own channel. As each measurement is calculated, the results can be pasted to the Journal or displayed as a new channel. This function provides a powerful way to summarize large data files for further analysis. For instance, starting with a 24-hour recording, you could use the data reduction tools to take the Mean every 20 minutes and then display the Mean as a graph.

- Measurements are inserted for all Find Peak operations, including Find All Peaks and Find Next Peak.
- A new channel is created for the measurement when:
  a) a measurement changes between successive Find Peak operations
  b) the Source channel for a measurement changes between successive Find Peak operations
  c) a measurement channel is removed from the graph (Edit> Remove waveform)
- Display Measurements as Graph is not available with Off-line Averaging.

**Don’t Find**

Lets you exit the Peak Detection dialog box and still retain the peak parameters (peak value, valence, and so forth). This is useful for setting parameters using an area of a waveform and then repositioning the cursor at another point in the record.

**Cancel**

Does not make or save any settings changes.

Visit the online support center at www.biopac.com
**Find Next Peak**

When you select **Find next peak** from the **Transform** menu (or select the toolbar icon), both cursors will move one peak to the right while staying above the threshold.

**Find All Peaks**

When you select **Find all peaks** from the **Transform** menu, the software will find all peaks through the end of the file. If your data file is very large, it may take some time to find all the peaks, since AcqKnowledge loads data from disk while it scans for the peaks.

If the “Paste measurement to Journal” option is selected, measurement values will be pasted into the Journal each time a peak is found, as shown above. Each column corresponds to a measurement value (in this case, Value and BPM).

**Cursor functions**

The process uses the default cursor settings to select the area between two adjacent peaks. In this mode, one cursor tracks the current peak location while the other cursor marks the location of the previous peak (these “cursors” are internal to the software and do not appear in the graph window).

A cursor can be based on:

(a) a currently selected peak  
(b) a peak found immediately prior to the currently selected peak  
(c) the current peak threshold  
(d) the threshold used for the previously selected peak.

To select areas other than the inter-peak interval, enter an offset for these cursors.
The following example details how to detect the positive spike in the QRS complex — a typical use of the **Find Peak** (peak detection) function.

1. Select the area around a peak.

2. Select **Find Peak**.
   The Peak Detection dialog will be generated and will automatically compute a threshold value.

   ![Image](image1.png)

   - If you don’t want the Peak Detector to automatically set the threshold, then make sure that no portion of the waveform is selected prior to choosing **Find Peak**.

3. Select **Find all peaks** or **Find next peak**.
   You will see one cursor move to the next peak value above the threshold and the other cursor remain at the current location, as shown here:

   ![Image](image2.png)

4. Select **Find next peak**. Both cursors will move one peak to the right while staying above the threshold. Note that the measurement values reflect the peak time and the BPM value. You can use any of the other measurements and they will automatically update when each new peak is found.

5. Select the first peak and choose **Find peak**.

Visit the online support center at www.biopac.com
6. Check the **Paste measurements into journal** option and click **OK**. The journal will be updated with the measurement values from the new peak.

7. Choose **Find all peaks**. This will find all peaks through the end of the file, and paste the measurement values into the journal each time a peak is found.

8. Choose **Find peak**.

9. Enter a value in the text box next to **Set first cursor to** to change the time offset of the first cursor.

The preceding examples used the **Find peak** function with the first cursor set to the “Previous peak” and the second cursor set to the current “Peak.” One measurement option is to change the time offset of the first cursor.

Entering a value of –0.5 will result in the first cursor being set to a point 0.5 seconds **prior** to the previous peak, and when the **Find next peak** command is selected, the graph should look somewhat like this:

Likewise, setting the offset of the first cursor to a positive value will result in a selected area similar to that shown here:

10. Define an interval around the peak by locating both cursors at the found peak.

To do this, go to the **Set first cursor to** portion of the Find Peak dialog, and select **Peak** from the Previous peak/Peak popup menu. This causes the options for the second cursor to change by adding a time offset option. When both cursors are set to the found peak and the offsets are each set to zero seconds, the **Find peak** command will select a single point at the peak maxima of the next found peak.
11. Include a time offset for the first cursor.

This offset may be either positive or negative, and can be set to an arbitrary time value, such as zero. In the following example, the second cursor was set at the found peak, while the first cursor was set 0.5 seconds prior to the peak.

12. Add a time offset to the second cursor, which allows for areas around a peak to be selected.

The time offset associated with the second cursor must be either zero or positive.
13. Highlight an area based on the location of a peak found on one channel and take measurements from other channels (this is possible since a selected area covers all channels).

For example, suppose ECG data was acquired and the Derivative of the data was calculated on channel 0. The **Find peak** command could be used to locate peaks on the ECG channel, and measurement windows could display a value for the corresponding area on the Derivative channel, as shown in the following graph:

14. Paste data from other channels using only data within the selected area.

In the example shown, an area of +/- 0.5 seconds was selected based on the location of the peak found on the ECG channel. Measurements were displayed for the slope and max of the Derivative channel. Data from both channels was then pasted to the Journal along with the horizontal scale values.
Find Rate

The AcqKnowledge Rate Detector is critical to AcqKnowledge’s ability to extract information from physiological data that has a degree of periodicity. Physiological data that can be investigated using the AcqKnowledge Rate Detector includes:

- ECG (e.g. Heart Rate or Inter-Beat-Interval recording)
- Blood Pressure (e.g. Systolic, Diastolic, Mean, dP/dt Max, dP/dt Min)
- Respiration (Respiration Rate measurement)
- EMG (Zero Crossing or Mean Frequency analysis)

The Find Rate function allows you to compute rate calculations (including BPM) for data that has already been collected. Although this function uses the same algorithm as the on-line rate detector (which uses a Calculation channel), it can be advantageous to perform rate calculations after the data has been acquired. One benefit is that off-line rate computations do not require that a separate channel (i.e., a Calculation channel) be acquired. Since the number of acquired channels is reduced, other data can be collected and/or data can be sampled at a higher rate.

Modes of Operation

The AcqKnowledge Rate Detector incorporates a significant amount of flexibility to optimize performance when extracting data from periodic physiological waveforms. There are three basic modes of operation for the Rate Detector:

1) Fixed threshold detect mode
2) Auto threshold detect mode (enables Noise rejection)
3) Remove baseline and Auto threshold detect mode

The Rate Detector will eliminate certain options when selecting different modes of operation. For example:

- The Remove baseline function always uses the Auto threshold detect mode.
- Any cyclic measurement relating to amplitude (e.g. Peak-Peak, Maximum, Minimum, Area, Mean) automatically turns off the Remove baseline function.
- If the measurement pertains directly to time (e.g. Hz, BPM, Interval, Peak Time, Count Peaks) the Remove baseline and Auto threshold detect modes are both operational.

Generally, it’s best to use the simplest Rate Detector mode that is suitable for your application. If the simplest mode doesn’t work, add layers of sophistication, one at a time. For example:

- If the Fixed threshold mode can’t or will not work, use the Auto threshold detect mode.
- If the Auto threshold detect mode is similarly unavailable, adjust the Noise rejection or add the Remove baseline option (if possible).

Visit the online support center at www.biopac.com
1) **Fixed threshold detect mode:**

Fixed threshold detect mode is the simplest mode of operation for the Rate Detector. As shown here, the **Threshold Level** has been set to 0.00 Volts. If the waveform crosses 0 Volts, the Detector will begin to look for Positive or Negative peaks (based on the Peak detect setting).

**Not available in Fixed mode:**
- Noise rejection
- Windowing options

2) **Auto threshold detect mode:**

Auto threshold detect mode is a more advanced and flexible mode of operation for the Rate Detector. In this case, the Rate Detector will create a variable threshold defined as:

- **Positive peak search**
  \[ 0.75 \times (\text{Old Peak Maximum} - \text{Old Peak Minimum}) \]

- **Negative peak search**
  \[ 0.25 \times (\text{Old Peak Maximum} - \text{Old Peak Minimum}) \]

Furthermore, the Rate Detector will construct a moving file of data points defined by 1.5 times the number of samples that can be placed in the largest rate window size (defined by the Window settings). If the Rate Detector loses sync (no trigger event inside the window), the threshold is changed to the mean value of the moving file of data points. This operation permits successful recovery in the event of spurious waveform data values.

The **Noise rejection** setting creates Hysteresis around the variable threshold. The Hysteresis level is defined as:

\[ \text{Hysteresis} = \text{Noise rejection (\%)} \times (\text{Old Peak Maximum} - \text{Old Peak Minimum}) \]
3) **Remove baseline and Auto threshold detect mode:**

Remove baseline and Auto threshold detect mode is an advanced and flexible mode of operation for the Rate Detector. Primarily, the Rate Detector performs an automatic (and hidden) moving difference function on the waveform data. The difference function is performed over a variable number of samples defined by:

\[
\text{Number of points over which difference is performed} = 0.025 \times \text{Sampling Rate}
\]

This difference waveform is then passed through the variable threshold defined as:

- **Positive peak search**
  \[
  0.75 \times (\text{Old Peak Maximum} - \text{Old Peak Minimum})
  \]

- **Negative peak search**
  \[
  0.25 \times (\text{Old Peak Maximum} - \text{Old Peak Minimum})
  \]

Furthermore, the Rate Detector will construct a moving file of data points defined by 1.5 times the number of samples that can be placed in the largest rate window size (defined by the Window settings). If the Rate Detector loses sync (no trigger event inside the window), the threshold is changed to the mean value of the moving file of data points. This operation permits successful recovery in the event of spurious waveform data values.

## FIND RATE OPERATIONAL SUGGESTIONS

<table>
<thead>
<tr>
<th>Option</th>
<th>Waveform Characteristics</th>
</tr>
</thead>
</table>
| **Fixed threshold option**                  | • waveform data has clearly defined positive or negative peaks (like respiratory or air flow data), which are consistently higher (in magnitude) than the rest of the waveform.  
• waveform data has clearly defined zero-crossings (like EMG), and you wish to determine the rate of these crossings  |
| **Auto threshold detect option**            | • waveform data has a moving baseline, but the peaks are otherwise larger in magnitude than other parts of the waveform (blood pressure).  
*You may need to adjust the Noise rejection (Hysteresis) to optimize performance.*  |
| **Remove baseline and Auto threshold detect options** | • waveform data has high narrow peaks (like most ECG leads), which may or may not be larger in magnitude than other (slow moving) parts of the waveform.  
*You may need to adjust the Noise rejection (Hysteresis) to optimize performance.*  |
Part C — Analysis Functions

Dialog Settings

The Rate Detector Function menu lists a variety of calculations, which are discussed below.

**Rate (Hz), Rate (BPM), Interval (sec)**

The most commonly used function is the **Rate (BPM)** option, which calculates a rate in terms of beats per minute or BPM. Rate calculations can also be performed that return a rate value scaled in terms of frequency (Hz) or time interval (sec). When rate is reflected in terms of a time interval, the time difference (delta T) between the two peaks is returned. This is sometimes referred to as the *inter-beat interval* or IBI. The frequency calculation returns the rate in Hertz (Hz), which is computed by dividing 1 by delta T. These measurements are perfectly correlated with the BPM calculation, since BPM is equal to 60 times the frequency calculation, or 60 divided by delta T.

**Peak time**

Returns the time (in seconds) at which the peak occurred. Like the other Rate functions (e.g., BPM and Hz), the value of the last peak time will be plotted until a subsequent peak is detected. The resulting plot will resemble a monotonically increasing “staircase” plot.

**Count peaks**

Produces a plot of the number of peaks (on the vertical axis) vs. time on the horizontal axis. When used with the delta measurements (in the measurement windows), this is a convenient way to calculate how many peaks occur within a selected area.

**Peak maximum/minimum**

Tracks the maximum value of the peak (the ECG R-wave). This correlates to the systolic pressure in blood pressure readings. To search for minimum peak values, select negative from the **Peak detect** section of the dialog box.

**Peak-to-peak**

Looks at the vertical difference between the maximum and minimum values of the waveform on a cyclical basis—useful when you want to determine the amplitude of your pulsatile signal.

**Mean value**

Computes the mean of a pulsatile signal on a cycle-by-cycle basis between two peaks; produces a staircase plot.

**Area**

Computes the area of the signal between two peaks, on a cycle-by-cycle basis.
Peak Detect

By default, the Peak Detector searches for Positive peaks (upward pointing, such as the R-wave of an ECG signal) to calculate the rate of a waveform. In some instances, however, you may have to base the rate calculation on negative peaks (downward pointing). To do this, select Negative peak.

Remove baseline

The Remove baseline option applies the optimal high pass filter based on the other settings. This option is useful when signals have a slowly fluctuating baseline.

Auto Threshold Detect

When the Auto threshold detect box is selected in the Find Rate dialog, AcqKnowledge automatically computes the threshold value using an algorithm that accentuates peaks and uses information about the previous peak to estimate when and where the next peak is likely to occur. This threshold detector is typically more accurate than a simple absolute value rate calculation function, and is able to compute a rate from data with a drifting baseline and when noise is present in the signal. (For a detailed description of how the calculation is performed, contact BIOPAC Systems, Inc. for the complete Application Note.)

- When Auto threshold detect is enabled, the Noise rejection and Window options are enabled.

Threshold level

This option (activated when “Auto threshold detect” is not selected) lets you enter a threshold level to be used for a simple absolute value rate calculation function.

- The Auto threshold detect option is typically more accurate.

Noise Rejection

Noise rejection (activated when “Auto threshold detect” is enabled) constructs an interval around the threshold level. The size of the interval is equal to the value in the “Noise rejection” text box. Checking this option helps prevent noise “spikes” from being counted as peaks.

- The default is equal to 5% of the peak-to-peak range.

Window (Peak Interval)

Window (activated when “Auto threshold detect” is enabled) is used to specify an upper and lower limit for the Rate calculation. Windowing Units (activated only when the selected Function can have variable units) is a pull-down menu of applicable units to choose from.

Setting the upper and lower bounds for the “window” tells AcqKnowledge when to start looking for a peak.

AcqKnowledge will try to locate a peak that matches the automatic threshold criteria within the specified window. If no peak is found, the area outside the envelope will be searched and the criteria (in terms of peak value) will be relaxed until the next peak is found.

For instance, once the first peak is found, AcqKnowledge will look for the next peak in an interval that corresponds to the range set by the upper and lower bounds of the window. The interval associated with the upper band of 180 BPM is 0.33 seconds (60 seconds ÷ 180 BPM), and the interval for the lower band is 1.5 seconds (1 minute ÷ 40 BPM). If a second peak is not found between .33 seconds and 1.5 seconds after the first peak, then AcqKnowledge will look in the area after 1.5 seconds for a “smaller” peak (i.e., one of lesser amplitude).
For those rate functions that require a window interval in seconds, you will probably want to enter numbers like .33 seconds and 1.5 seconds (which correspond to the BPM defaults of 40 and 180). These numbers will be suitable for detecting the heart rate of an average subject.

A simple peak detector uses what is called a threshold-crossing algorithm, whereby each time the amplitude (vertical scale) value exceeds a given value, the peak detector “remembers” that point and begins searching for the next event where the channel crosses the threshold. The interval between the two occurrences is then computed and usually rescaled in terms of BPM or Hz. This is how the AcqKnowledge rate Calculation functions when all options are unchecked.

In the sample waveform shown here, the threshold was set to 390 mVolts to detect the peaks of the waveform and provide an accurate rate calculation. Since it only recognizes signals greater than 390 mVolts as a peak, this 390-mVolt threshold is referred to as an “absolute threshold.”

Most waveforms are not so well behaved, however, and artifact can be introduced as a result of movement, electrical interference, and so forth. Combined with actual variability in the signal of interest, this can result in “noise” being included with the signal, as well as baseline “drift” which can render absolute threshold algorithms useless.

**Put Result in New Graph**

When this option is checked, the results from the find rate calculation are plotted in a new graph window with data displayed in X/Y format, with time on the horizontal axis. By default, this option is unchecked and the resulting transformation is placed in the lowest available channel of the current graph.

**Find Rate of Entire Wave**

When this option is checked, the rate (or other function from the **Find rate** command) will be calculated for the entire wave (other than the selected area, if any).

**Don’t Find**

The **Don’t Find** button is useful when you realize you have not selected an area to perform the Find Rate function on, or when you want to change the selected area. When you click on Don’t Find, the dialog settings will be saved so that you can close out of the dialog and select an area. When you reopen the dialog, the settings will be established as before you closed out, and you can click on the OK button to perform the Find Rate function. This is useful for setting parameters using an area of a waveform and then repositioning the cursor at another point in the record.
Chapter 12  Display menu commands

Overview
The Display menu includes a number of features that control how the waveforms appear on the screen and how much data is displayed at a time.

Although these options change the appearance of the data, they do not change the data itself. In other words, changing the color of a waveform or showing only a portion of the data on the screen will not alter the data stored in the file.
Right Mouse Shortcuts — Windows® only

The following options can also be located via the right mouse button.

**Graph window:**
- Grid
- Zoom Back
- Zoom Forward
- Autoscale
- Color
  - Line Plot
  - Step Plot
  - Dot Plot
- Dot Size
- Last Dot Size
- Duplicate
- Grid Options
- Statistics

**Journal window:**
- Undo
- Cut
- Copy
- Paste
- Delete
- Select All
- Change Font
- Wrap Text
  - No Wrap
  - Wrap To Window

**Horizontal scale:**
- Full page scroll
- Half page scroll
- Quarter of a page scroll

(Update screen interval options)

Contextual Menus — Macintosh only

On Macintoshes that have the Contextual Menu Manager installed (usually Mac OS 8.1 and above), the graph window has contextual menus (similar to right-click functionality on the PC). To access these menus, hold down the Control key and click the mouse button.

- If the mouse is over a portion of the graph that has a context menu available, the cursor will change to an arrow with a menu.

The contextual menus available are:

- **Waveforms**
  - Set plot mode, select transformations, show Statistics

- **Measurements**
  - Copy to clipboard or journal, toggle interpolation on/off

- **Markers**
  - Insert, delete, paste summary to Journal

- **Horizontal Scroll**
  - Change update interval

Contextual menu items correspond to the AcqKnowledge main menu state.

Application menu customization has a corresponding effect on contextual menu display. If a contextual menu item does not have a corresponding application menu item, the menu customization file identifier will begin with “IDM_CM.”

Due to operating system limitations, Balloon Help is not available for context sensitive menus.
**Tile waveforms**

Choosing **tile waveforms** will center the waveform in the display by adjusting the vertical offset of the selected waveform. If there are multiple waveforms displayed in chart mode, the waveforms will be centered in their “tracks.” By holding the **CTRL** key down before selecting **Tile waveforms**, you will cause the tiling to apply only to the selected waveform. In **scope** mode, waveforms are spaced evenly along the vertical axis of the screen, and each waveform is centered vertically in its division. Tiling does not affect the vertical scale factor previously set for each channel (whereas Autoscale may affect the vertical scale factor).

**Autoscale waveforms**

When **Autoscale waveforms** is selected, AcqKnowledge determines what the “best fit” is for each waveform. The software adjusts the vertical offset so that each channel is centered in the window (or within the channel tracks in chart mode) and adjusts the units per division on the vertical axis so that the waveform fills approximately two-thirds of the available area. In **chart** mode, the waveforms are autoscaled to fit their sections. In scope mode, the screen is evenly divided into horizontal “bands” and each waveform is scaled to fit the division without overlapping.

**Overlap waveforms**

In **scope** mode, when **Overlap waveforms** is selected, the waveforms are “overlapped” into one screen. The waveforms are arranged in the graph window with the same vertical scale, however their magnitude reflects their size relative to the other waveforms.

**Compare waveforms**

It is often useful to compare multiple waveforms by placing them all on the same amplitude scale. The menu selection **Display>Compare waveforms** will automatically set the scale to be the same for all channels. The following example shows two waveforms that appear to have approximately the same magnitude before **compare waveforms** is performed.

![Waveform Comparison Example](image)

After using **compare waveforms**, you can easily see that the magnitude is not actually the same — one waveform (the sine wave) has a significantly greater baseline and range relative to the other (noise) waveform.

Visit the online support center at www.biopac.com
**Autoscale horizontal**

The **autoscale horizontal** command is a convenient way to display the entire data file (in terms of duration) on the screen. When this is selected, the display will be adjusted so that the duration of the entire waveform fits in the graph window. For long waveforms, this can take some time to redraw. You can cancel plotting at any time by pressing:

- For the MPWSW (PC) — the escape key (Esc)
- For the MPWS (Mac) — **⌘ + “.”**

You cannot undo the autoscale horizontal function with **Edit>Undo**, but you can use the **Display>Zoom back** command to revert to the previous display settings.

**Zoom Forward / Back**

Zoom functions can affect the horizontal scale, the vertical scale, or both. Zoom restoration is functional for the Zoom tool, Autoscaling, and the Tile, Overlap, and Compare Waveform options. Zoom scales are stored until another zoom function is performed. For instance, you cannot Zoom back and then use the Zoom tool and expect Zoom back to take you back two scale levels.

- **Zoom Forward** will redo a zoom function after it has been undone; you can repeat this selection to restore the latest zoom scales.
- **Zoom Back** will restore settings one level at a time; you can repeat this selection to restore the original zoom scales. Essentially, Zoom back acts as an “undo” command for the zoom forward command and any other function that changes the amount of data displayed (either in terms of time or amplitude).

Zoom functions will work for five iterations on a PC and without limitation on a Mac, until another Zoom is performed.

**Reset chart display**

The **Reset chart display** option will redistribute the chart displays evenly after you have changed the boundaries so that each channel’s vertical size is the same. This function, which only works in **Chart Mode**, can be useful if you need to expand a display region for analysis and then return to the original display.

![Before Reset Chart Display](image1.png) ![…and after](image2.png)
**Reset Grid — Macintosh only**

To return to the original grid, choose “Display > Reset grid.” This will reconstruct the default, unlocked grid of four divisions per screen with solid light grey grid lines.

**Adjust Grid Spacing — Macintosh only**

To modify the horizontal and/or vertical grid spacing, choose “Display > Adjust grid spacing.” This will generate a dialog for you to modify the locked axes of the selected waveform. See page 146 for details.

**Set wave positions...**

By default, channels are arranged on the screen based on their channel numbers, with the lower number channels being displayed at the top of the screen. You can change the ordering so that waveforms are placed in an arbitrary order.

- In **chart** mode this will result in vertical ordering of the individual waveforms.
- In **scope** mode this will result in vertical ordering of the individual waveforms after a tiling or autoscaling operation.

In addition, in the waveform positioning function, you can set any waveform to ignore the autoscaling and tiling functions. This can be important if you have some waveforms which you don’t want autoscaled with others.

The waveform positioning function is selected through the **Set Wave Position** in the **Display** menu. The following dialog box will then appear, with a scrolling list of all stored channels:

![Set Waveform Order Dialog](image)

If you have more channels than displayed, you can scroll through the list by clicking on the vertical scroll bar at the right. The list will scroll if you move past the top or bottom when clicking and dragging the waveform positions.

The **Tile** checkbox to the left of each channel enables tiling and autoscaling for each channel when checked. Click on the checkbox to toggle the enable.

The on-screen position of the waveforms is the same as the ordering shown in the above dialog (from top to bottom). You can reposition the waveforms by reordering the channel labels as they appear in this dialog box. To change the order of any waveform, click on the channel label (e.g., Ch. 4 Respiration), hold down the mouse button, and drag the highlighted label to the desired position. Repeat this operation until the waveforms are ordered the way you want.

- Click **OK** to apply your selected order to the display screen.
- **Cancel** will revert all waveform positions to those set before the dialog was opened.

Visit the online support center at www.biopac.com
**Wave color**

Selecting **Wave color** lets you use color to discriminate between waveforms. In **scope** mode, you can easily tell which waveform is currently selected because the vertical scale, channel text, channel units, and measurement popup menus take on the same color as the selected waveform. When adding new waveforms, AcqKnowledge assigns waveform colors in the following order: black, red, blue, green, cyan, and magenta.

You can assign new colors to waveforms by choosing the menu selection **Display>Wave Color** and then selecting the desired color.

Or, you can click the right mouse button to bring up a menu, select **Color**, and then select the desired waveform color from the color palette menu. Depending on the type of graphics adapter on your computer, you may or may not be able to choose “Other” to display a palette of color options.

**Wave color** is disabled on computers with grayscale monitors or when the monitor is set to display in black and white mode.

**Horizontal axis...**

You can change the sample offset and horizontal sample interval (the amount of time between two sample points) by selecting **Horizontal axis** from the **Display** menu, which will bring up the following dialog box:

The horizontal scale can be set in terms of time, frequency, or arbitrary units. Time domain scaling has two options, which allow you to store and display data either in terms of absolute seconds (ss.sss) or hours:minutes:seconds (HH:MM:SS). By default, AcqKnowledge displays data in the ss.sss mode; however, you can change this by checking the HH:MM:SS button in the horizontal scaling dialog box. When data is displayed in the ss.sss mode, the time scale corresponding with an event occurring 30 seconds into the record would be 30.00 seconds. The time scale for the same event in HH:MM:SS mode would be 00:00:30.
This feature is generally useful for changing the time base (or other horizontal scale) of data that has been imported into AcqKnowledge as a text file. For instance, if you want to analyze data imported from a text file that contains 30 seconds of data that was collected at 100 samples per second (100Hz), the first step would be to open the file (following the directions on page 152). By default, AcqKnowledge assumes that the data was collected at 50Hz, and would therefore plot the data so that a 60 second record was displayed that appeared to be collected at 50 samples per second. To change this to reflect the rate at which data was actually collected, you would change the sample interval box in the horizontal scaling dialog. When data are displayed on a 50Hz time base, the sample interval will read 0.0200000 seconds per sample. This means that there is a 0.02-second “gap” between sample points in the record. To display data at 100 samples per second, change the interval to 0.01 seconds per sample.

To determine the sample interval for other sampling intervals, divide 1 by the rate at which data was sampled (in terms of samples per second). Thus, a sampling rate of 0.5Hz would translate into a sample interval of 2.00 seconds between samples, and data collected at 100,000Hz (100 kHz) would have an interval between sample points of 0.00001000 seconds.

**TIP:** To confirm that AcqKnowledge is storing data in the same time base it was collected in, choose Statistics from the Display menu. This will generate a dialog box that describes (among other things) the sampling rate AcqKnowledge uses in analyzing the data. Once data has been saved as an AcqKnowledge file, time base information is automatically saved along with the data.

Setting the **horizontal scale in terms of frequency** allows output from a spectrum analyzer or plots data from a Fourier analysis or other data with a frequency base (rather than a time base). As with the time options, this feature is typically used for importing text files from other applications. For instance, if you were importing a text file with 1,000 sample points that covered a frequency range from 0Hz to 100Hz, you would want to set the interval to 1000Hz / 100 samples, or 0.1Hz per sample in the box to the left of the interval text box. Similarly, if the frequency range was 20Hz to 100Hz, you could set the offset to 20Hz.

You can attach **arbitrary base units** to the data (rather than a time or frequency base). This might be useful for data collected from a gas chromatograph. When the horizontal axis corresponds to wavelength, and the data consists of 100 samples covering a range from 1 to 10 Angstroms, the interval should be 0.1 units per sample.

When arbitrary units are selected, two additional text boxes appear at the bottom of the dialog box. The upper **Units text** box is used to provide a name for the horizontal scale units (in this case, Angstroms), and the lower **Units text** box is used to provide an abbreviated label for the horizontal units (i.e., Ang).

Visit the online support center at www.biopac.com
**Show**

Selecting **Show** from the **Display** menu generates a submenu that allows you to control a number of data display options and what additional information is displayed in the graph window. To enable an option, select it from the submenu; a bullet (•) or checkmark appears next to the menu item when it is enabled. The three display modes and the two plotting modes are mutually exclusive, but the remaining items can be enabled independently.

<table>
<thead>
<tr>
<th>Show Option</th>
<th>Shortcut</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel numbers</td>
<td>PC or Mac</td>
<td>When the <strong>Channel numbers</strong> option is selected, the channel boxes appear just above and below the graph area.</td>
</tr>
<tr>
<td>Chart</td>
<td></td>
<td>Activates the <strong>Chart</strong> display mode (see page 33).</td>
</tr>
<tr>
<td>Dot plot</td>
<td></td>
<td><strong>Dot Plot</strong> allows you to view data in a “dot” format. The software will create user-defined, discrete points that map out the selected waveform. This is often useful for demonstrating the concept of discrete digital sampling by dividing the waveform up into data points or “dots.”</td>
</tr>
<tr>
<td>Dot size</td>
<td></td>
<td><strong>Dot size</strong> lets you specify how large each dot will be. Each dot is measured by the number of monitor pixels it occupies.</td>
</tr>
</tbody>
</table>

![Show Menu Diagram](image)
<table>
<thead>
<tr>
<th>Show Option</th>
<th>Shortcut</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grid</td>
<td>![Grid Icon]</td>
<td>Superimposes a <strong>Grid</strong> on the graph window (see page 140). To increase grid precision, click Ctrl-``.</td>
</tr>
<tr>
<td>Grid Options</td>
<td></td>
<td>Activate the Grid Options dialog (see page 142)</td>
</tr>
<tr>
<td>Journal</td>
<td>![Journal Icon]</td>
<td>Activates the <strong>Journal</strong> (see page 43).</td>
</tr>
<tr>
<td>Last dot only</td>
<td></td>
<td>For data that is plotted in dot mode, you have the option of plotting only the last dot. When <strong>Last dot only</strong> is selected, only the most recently acquired data point will be plotted. This is most useful when viewing data as it is being collected and when this data is displayed in X/Y mode.</td>
</tr>
<tr>
<td>Line plot</td>
<td><code>right mouse button</code></td>
<td>When <strong>Line plot</strong> is selected, each sample point is connected with a line to create the waveform. This is the default display mode for most waveforms, except histogram plots, which are displayed in step plot mode (see 185). Waveforms that are displayed in <strong>line plot</strong> mode match a true analog plot (as closely as possible). You can change line options by clicking the <strong>right mouse button</strong>, which will bring up a menu displaying several commonly used features.</td>
</tr>
<tr>
<td>Markers</td>
<td>![Markers Icon]</td>
<td>When <strong>Markers</strong> is selected, the marker area at the top of the graph windows will be displayed, along with any markers associated with the data being displayed and the marker tools (see page 139).</td>
</tr>
<tr>
<td>Measurements</td>
<td>![Measurements Icon]</td>
<td>When <strong>Measurements</strong> is enabled, the measurement popup menus and windows are displayed above the graph window (see pages 40 and 124).</td>
</tr>
<tr>
<td>Scope</td>
<td>![Scope Icon]</td>
<td>Activates the <strong>scope</strong> display mode (see page 33).</td>
</tr>
</tbody>
</table>
| Step plot      |           | The **step plot** mode displays waveforms in a “step” plot, meaning that the lines connecting sample points are drawn either vertically or horizontally. **Step plot** is most useful for displaying histograms and similar plots, but since it displays data much as it appears to a digital processor (like the MP), it can also be useful for examining the effects of various sampling rates.  

**NOTE:** **Step plot** is mutually exclusive of **line plot**. |
| Toolbar        |           | Displays the toolbar (shortcut) icons across the top of the display (see page 35). |
| X – Y          | ![X-Y Icon] | Activates the **X/Y** display mode (see page 33). |
Statistics...

The Display>Statistics command generates an information dialog for the selected channel.

![Waveform Statistics]

Channel This box displays the channel number, channel label (if any).

Interval Indicates the acquisition sampling rate. The sampling rate specified reflects the sampling interval AcqKnowledge uses to store the data, which is not necessarily the same rate at which it was collected. The sampling rate can be modified by using the resample function (described on page 186), by changing the interval horizontal scale (see page 219), or by pasting data collected at one sample rate into a graph containing data sampled at a different rate.

Length Indicates the overall length of the channel in samples per second and time. Generally, the waveform length information is the same for all channels, although this is not always the case. It is possible to shorten waveforms by editing out sections of the waveform (using Edit>Cut and/or Edit>Clear functions).

Divider The divider indicates the ratio between the acquisition rate and the channel sample rate.

\[
\text{Divider} = \frac{\text{Acquisition Rate}}{\text{Channel sample rate}}
\]

Included with the divider ratio (after the comma) is the sample rate for the selected channel.

Min Provides the minimum value for the waveform data.

Max Provides the maximum value for the waveform data.

Mean Provides the mean value for the waveform data.
Preferences...

Choosing **Display>Preferences** on the MPWSW generates the general preferences dialog box, which allows you to control measurement options, how waveforms are displayed, and other AcqKnowledge features. Clicking the **Journal...** button will bring up a separate Journal preferences dialog box, and the options in each dialog can be set independent of other options. In the MPWS System, the Journal option is located under the **File** menu.

![Preferences Dialog Box](image)

**Measurement Options**

The top two rows in the dialog box control options relating to the measurement items at the top of the graph window. (You can use the options in the **Display>Show>Measurements** menu to hide the measurements altogether. See page 221 for more information on this option.)

- The first option controls how many **measurement rows** should be displayed in the window at any one time. By default, this is set to one, but may be set to any value between 1 and 8 by choosing a number from the popup menu.

- The second option, **digits of precision**, allows you to control the precision with which the measurements are displayed. This can be set to any value between 1 and 8 using the measurement precision popup menu. This option controls the accuracy of digits displayed right of the decimal place for all visible measurement windows. For instance, if this value is set to 3, one measurement window might show 125.187 while another reads 0.475.

**All Time/Frequency Measurements**

Select the measurement unit to use for time and frequency pop-up measurements. This locks the units for the measurement result display (i.e., if seconds is selected, a result of 70 seconds will display as “70 seconds” rather than “1.16667 minutes”).

Visit the online support center at www.biopac.com
Waveform Display Options

In the center of the dialog box are two options that control how waveforms are displayed on the screen.

- The first display option, **Gray non-selected waves**, is enabled only when a monochrome monitor is used (or when a color monitor is set to run in black and white). When this option is checked, the selected waveform appears black and all non-selected waves appear gray, making it easier to tell which channel is selected.

- The second display option, **draft mode for compressed waves**, allows for some (“compressed”) waveforms to be plotted in “draft” mode, which results in faster plotting time, although the display is not exact. A waveform is considered compressed when more than three sample points are plotted per pixel on the screen. Standard VGA displays are 640 pixels wide, so a compressed waveform on this type monitor would be any type of waveform displaying more than 2000 samples (approximately) on the screen at any one time. Using the default horizontal scale (which plots eight seconds of data on the screen), any data sampled at more than 250 samples per second would be considered “compressed.”

Update screen interval

The **Update screen interval** option lets you adjust the rate that the screen is updated, which can be useful when you have a large data file (as in sleep studies) and you want to quickly jump through the data. You can set the interval to update in full page, half page, or quarter page increments. Click in the circle next to the desired interval in the “Update screen interval” section and the screen will update in the selected interval when you click on the horizontal scroll bar.

**PC only — Right Mouse Button Shortcut**

As a shortcut to the **Update screen interval** options, you can click in the horizontal scale region with the right mouse button. Hold the mouse button down and scroll to the desired interval, then release the mouse button to activate the new interval.

Other Options

The five “**Other Options**” at the bottom of the dialog box control miscellaneous **AcqKnowledge** functions and features. The first two options handle the way data appears on the screen after it has been transformed (e.g., filtered or mathematically operated on). Neither option affects how data appears on the horizontal axis, although both options change how data is presented along the amplitude (vertical) axis.

- When the **autoscale after transformations** box is checked, all waveforms will automatically be rescaled after a transformation to provide the “best fit” along the amplitude axis.

- The **tile after transformations** option tiles all visible waveforms after any transformation, and is mutually exclusive of the autoscale command. When waveforms are “tiled” they appear to be stacked on top of each other.

- Checking the **use all available memory** box instructs **AcqKnowledge** to attempt to use all the available memory for loading data. Otherwise, a variable sized buffer is used to load portions of large data files. This option works best if there is enough free memory to load the entire data file.
When the **interpolate pastings** box is checked, AcqKnowledge will interpolate/extrapolate time base information when working with data sampled at two different rates. AcqKnowledge will interpolate data to fit the sample rate of the destination window. When doing this, you should copy data to a higher resolution window. Although it is possible to copy data in the other direction (from high resolution to low resolution), it is not recommended since some resolution will be lost in the process.

*For example,* if you have one 30-second waveform sampled at 50 samples/second, and another 30-second waveform sampled at 2,000 samples/second, you can copy the contents of one window into another using the "Insert waveform" command, and AcqKnowledge will interpolate one waveform so that both appear to be 30 seconds long. Data would be copied from the 50Hz (low res) window to the 2,000Hz (high res) window.

* When "Show ToolTips" is deselected, mouse-over tool-tips will not be displayed (or interfere with plotting).

**Use Linear Interpolation — Macintosh only**

To disable measurement interpolation, uncheck the “Use linear interpolation” option at the bottom of the Display> Preferences dialog.

**Journal Preferences**

Clicking the **Journal**… button in the **Preferences** dialog box generates another dialog box that allows you to set many of the parameters relating to the journal and clipboard functions.  

→To access **Journal Preferences** on a Mac, select **File > Preferences > Journal / Clipboard**.

The **Journal Preferences** dialog box has five checkboxes that control the format of data when it is pasted into the journal or clipboard:

1. **Include measurement name** (i.e., BPM, delta T, Freq, and so forth) with the values.
2. **Include measurement units** (i.e., volts, mmHg, and so forth) after the numeric values.

   **NOTE**: The first two options cause additional text to be pasted into the journal, which can drastically reduce the amount of numeric data that can be pasted into the journal due to limitations on the maximum journal size. See page 42 for more information on working with journal files.

3. **Include channel number** at the top of each column of data.
4. **Use a separate line for each measurement** in the journal/clipboard.
5. **Include time values** copies the horizontal scale values along with the waveform data when data is copied to the clipboard. This means that when you paste data from the AcqKnowledge screen into a spreadsheet or similar application, horizontal scale information is retained.

You can specify the **tab** interval to make columns more readable when you have a high precision setting. You can **change the font** to any font installed on your computer; the default font is 8 point Arial type.

On the Macintosh, you can select an option to wrap Journal text.

Visit the online support center at www.biopac.com
**Size window...**

The *Size Window* function lets you specify exact dimensions for the size of the graph window. You can use this to create consistently sized windows for pasting into documents.

The two text boxes allow you to enter screen width and height, both of which are scaled in terms of pixels. Standard computer displays have 72 pixels per inch (28.3 pixels/cm), so a graph window that is 360 pixels wide by 216 pixels high would be 12.7cm tall and 7.6cm wide.

When the *Reset chart boundaries* box is checked, the boundaries between the waveforms will be reset so that each channel “track” is the same size. This function only works in chart mode.

**Set Font (PC only)**

The *set font* menu item on PCs allows you to change the font used in *AcqKnowledge*. You may select any font installed on your computer. The default is 8 point Arial type. This dialog is also accessible via *Display > Preferences > Journal...*
Chapter 13  Other Menus

Window menu

The **Window** menu uses standard Windows functionality to list open files and the options for how to display them on the screen. See your Windows Manual for details.

About menu

When the **About** menu is selected, a screen is generated that provides information about the **AcqKnowledge** software being used and your system parameters, which can be useful if you need to call BIOPAC for any reason. On the Macintosh this item is available under the Apple menu.

**Note:** For information about the MP acquisition unit and firmware, click **MP menu > About**.

Help menu

You can get on-line, searchable help from the **Help** menu (located under the Apple menu on a Macintosh). You can open the BIOPAC Support documents while you are running **AcqKnowledge**. The files are in PDF format and require adobe Acrobat Reader, which you can download for free at [http://www.adobe.com/support/downloads/main.html](http://www.adobe.com/support/downloads/main.html)

If you have an active web browser, you can easily access Application Notes from the BIOPAC web site.

**Macintosh only — Balloon Help** (MP100 and MP150, not supported on OS X) is an online assistance feature to help novice users learn how to use **AcqKnowledge**. “Balloons” are generated with text describing the software functionality of the item under the mouse. For instance, balloons for a menu item that is checked, unchecked or dimmed are different, and balloons for unavailable items/controls indicate why they are unavailable.

- To show Balloon Help, select Help > Show Balloons; select it again to hide the balloons.
- Mac OS X does not support Balloon Help.
- Due to operating system limitations, Balloon Help is not available for context sensitive (Ctrl-click) menus.
Appendix A - Frequently Asked Questions

Q: I have a large data file and it seems to take a long time to redraw the screen. Is there anything I can do to speed it up?

A: Yes. You can choose from four possible remedies for this.

(1) The simplest solution is to check the Draft mode for compressed waves and Use all available memory boxes in the Preferences dialog box (shown below). Checking these two boxes will cause AcqKnowledge to plot data faster (at the expense of some precision) and use as much available memory as possible. You can cancel the plotting at any time by holding down the ESC key on the MP//WSW (PC) or Ctrl + .” on the MPWS (Mac).

(2) You can reduce the time interval per division, which causes less data to be displayed on the screen at one time, and should reduce plot time.

(3) If the data still takes too much time to redraw and you have a color monitor, try reducing the number of colors displayed.

(4) If you have a high-resolution video card (one capable of displaying many thousands of colors), you may want to reduce the resolution to speed up plotting time.

Q: Can I use other software with the MP System? Can I use AcqKnowledge to control other data Acquisition hardware?

A: No. The MP System was designed to work with the AcqKnowledge software. However, the software can read in previously acquired text files generated by AcqKnowledge or any other software.
Q: I have a device that outputs an RS-232/RS-422 signal. Can I connect this to the digital I/O lines?

A: No. These types of digital output devices have their own communication protocols and are more complex than the digital pulses that the MP System can accept as inputs.

Q: I imported a text file and the time scale is wrong. What happened?

A: When a text file is imported, AcqKnowledge assumes (by default) that the data was sampled at 100Hz or 100 samples per second. This is arbitrary, and there are two ways to adjust this. Both methods involve calculating the interval between sample points. To calculate the sampling interval, you need to know the rate at which the data was originally sampled. The sampling interval is calculated by dividing one by the sampling rate. You can adjust the sampling interval to the appropriate value via the File>Open dialog box before the data is read in, or if the data is already present, change the time scale in the Display>Horizontal scale dialog box.

For instance, if 20 minutes of data was originally collected at 2Hz and is read into AcqKnowledge as a text file, the software will interpret this as data collected at 100 samples per second. To set the time scale to accurately reflect the data, change the sampling interval from 0.01 to 0.5 seconds per sample.

To change this setting before data is read in, click on the Options button in the File>Open dialog box and change the value in the Sampling Interval dialog box. To change the time scale after data has been read in, adjust the units per division in the Display>Horizontal axis dialog box. If the data are time-domain data, you can adjust the seconds/sample interval at the bottom of the dialog box. This value defines the interval between sample points, and can be changed to fit the rate at which the data was originally acquired.

Q: I have the fastest computer available. Why can’t I acquire data to the computer any faster than 11,000Hz on one channel, using an MP100 System?

A: The bottleneck occurs in two places:

1. The first occurs when data is transferred between the MP acquisition unit and the computer. While the MP System can acquire data as fast as 70,000Hz when data are stored directly to the MP acquisition unit memory, the maximum rate drops considerably when data is acquired to the computer memory, and even more so when data is acquired directly to disk.

2. The second bottleneck occurs within the computer itself, and has to do with the time it takes to transfer and process incoming data. Faster computers can perform these tasks more quickly, which is why the maximum possible sampling rate for a Pentium (storing to memory) is faster than a 386SX. With a large number of channels, the aggregate sampling rate can climb to a theoretical maximum of 16,000 samples per second.

To resolve the sampling limitation, use an MP150 System.

Q: I just filtered a waveform and now my data file is huge. Why is that?

A: When AcqKnowledge performs any type of transformation on a waveform (e.g. digital filtering, waveform math), it converts the entire waveform from integer format (two bytes per sample) to floating-point format (eight bytes per sample). Since each sample point in the waveform now takes up four times as much space, the file should be approximately four times as large. AcqKnowledge still saves the file as compactly as possible, and since some of the information stored describes the time base, the file size will not increase by exactly a factor of four.
Q: My MP acquisition unit seems to be connected, but I can’t acquire data. What should I do?

A: This can be caused by one of several conditions:

(a) Check to make sure that the MP acquisition unit is ON and, if so, that all the connections to the MP acquisition unit were made properly. When the MP acquisition unit is powered up, a light on the front panel of the MP acquisition unit will illuminate. If the power light will not illuminate, check to make sure the proper power supply is connected. The power supply that comes with the MP acquisition unit is rated at 12 VDC @ 1 Amp, and using other power supplies may result in damage to the MP acquisition unit.

(b) If the proper power supply is connected but the power light still does not illuminate, disconnect the power supply and check the fuse in the back of the MP acquisition unit. The fuse is a standard 2.0 Amp fast blow fuse, and can be changed by unscrewing the fuse cap and replacing the fuse.

(c) If the power light does illuminate, the next step is to see if the busy light (next to the power light on the front panel of the MP acquisition unit) illuminates when the MP acquisition unit is powered up. When the MP acquisition unit is powered up, the busy light should illuminate for three or four seconds and then extinguish.

NOTE: The busy light is normally off (except at startup), but it will remain on while data is being acquired and will illuminate for the duration of each trial when data is being acquired in averaging mode. If the busy light does not illuminate when the system is powered up or does not turn off after a few seconds, contact BIOPAC at one of the locations listed in Appendix A.

Q: I set up the channels but I only seem to be acquiring noise. What's wrong?

A: A number of phenomena can cause this. Check to make sure that the settings in the Setup Channels dialog box correspond to the channel switch settings on the amplifier modules and/or direct analog connections to the UIM100A. When a direct analog input is set to the same channel as an amplifier, the resulting data will appear quite noisy or erratic. You should also check to see that no two amplifiers are set to the same channel.

Another possible cause is that the gain settings on the amplifiers are too low and should be increased. You may also want to select Autoscale waveforms from the Display menu. This will automatically adjust the waveforms to provide the “best fit” in terms of scaling the data to fit in the available window space.

It is also possible that the electrodes/transducers themselves are the source of the noise. Proper electrode adhesion techniques involve abrading the skin and securing the electrode in place to reduce movement artifact.
Appendix B - Filter characteristics

Filter types

*AcqKnowledge* employs two types of digital filters:

(a) Finite Impulse Response (FIR) perform post-acquisition filtering

(b) Infinite Impulse Response (IIR) perform filtering calculations on-line (during an acquisition) or post-processing (after an acquisition)

Although the similarities between the two types of filters outweigh the differences, some important distinctions remain.

1. First, IIR filters are typically more efficient than FIR filters, which means that IIR filters can filter data faster than FIR filters, which is why IIR filters are used for on-line calculations.

2. Second, IIR filters tend to be less accurate than FIR filters. Specifically, IIR filters tend to cause phase distortion or “ringing.” When the phase of a waveform is distorted, some data points on a waveform are shifted (either forward or backward in time) more than others. This can result in the intervals between events (such as the Q-R interval or the inter-beat interval in an ECG waveform) being slightly lengthened or shortened compared to the original signal. In practice, however, the effect of this distortion is usually minimal since the frequencies which are most distorted are also attenuated the most. By contrast, FIR filters are phase linear, which means that the interval between any two sample points in the filtered waveform will be exactly equal to the distance between the corresponding sample points in the original waveform.

3. Third, IIR filters have a variable Q setting that defines the filter response pattern, but FIR filters do not have a Q component. The optimal Q of an IIR filter is 0.707, with lower values resulting in a flatter response and higher values resulting in a more peaked response. The default Q for all IIR filters is 0.707 (except for Band pass filters where Q defaults to 5), which is appropriate for nearly all filter applications.

In the examples on the following page, the filter responses of several different types of filters are compared. All of the filters are 50Hz low pass filters operating on the same data.

The first graph shows how the number of filter coefficients in FIR filters (Q) affects the filter’s frequency response. Note that as the number of coefficients (Q) increases, the filter becomes more accurate. A good rule of thumb is to set $Q \approx 2(f_s / f_c)$, where $f_s =$ sampling rate and $f_c =$ cutoff frequency.
The next graph shows how the pole or zero locations of the filter, as related to filter “peaking” (specified by Q), affect the frequency response of the filter. The “Q” in this case is not to be confused with the Q from the FIR filter. Note how increasing “Q” in the IIR filter case affects filter “peaking.”

![Graph showing frequency response of filters with different Q values]

**FIR filter performance as a function of changes in pole or zero locations**

Coincidentally, the FIR (Q = 10) and IIR (Q = 0.707) filters have very similar responses in this case.

Technically, the coefficient setting for FIR filters determines the number of multiplies performed by the filtering algorithm. In practical terms, it determines how “steep” the frequency response of the filter is. Filters with a large number of coefficients have a steep roll-off, whereas the frequency response of filters with a smaller number of coefficients is not as steep.

**Window Functions**

Window functions are used for two purposes in AcqKnowledge. Windows are applied to the impulse response in the (FIR) digital filtering functions, and can optionally be applied as part of the FFT function. In either case, a window refers to a computation that spans a fixed number of adjacent data points.

Typically, window functions are used to eliminate discontinuities that may result at the edges of the fixed span of points of the digital filter function (FIR filters) or the data points of the FFT.

**Digital filtering.** When a window is used in digital filtering, the impulse response of the filter (rather than the data itself) is modified. When the impulse response smoothly approaches zero at both the beginning and end of the data, this works relatively well. When the impulse response is not so well behaved, edge effect occurs. Edge effects can be minimized by windowing, or forcing the edges of the impulse response to smoothly approach zero. The exact process depends on the window selected (see below).

Another way to minimize edge effect with an FIR filter is to increase the number of coefficients used to transform the data.

**FFT.** The FFT function also windows data, although the nature of the windowing function is somewhat different in the sense that the window operates on the data. One of the assumptions of the FFT is that the input data is an infinitely repeating signal with the endpoint wrapping around. In practice, the endpoints are almost never exactly equal. You can check this by choosing the Delta measurement item from the measurement popup menus, which returns the amplitude difference between the first selected point and the last. To the extent that the endpoints differ, the FFT output will produce high frequency components as an artifact of the transformation.
By windowing the data, the effects of this phenomenon are greatly diminished. When data are windowed, a window is moved across the data, much as the smoothing function moves across the data. Whereas the smoothing function simply takes the average of a specified number of points, each type of window weights the data somewhat differently.

The Window pull down menu offers the following options:

<table>
<thead>
<tr>
<th>Window</th>
<th>Parameter Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rectangle</td>
<td>n/a</td>
</tr>
<tr>
<td>Bartlett</td>
<td>n/a</td>
</tr>
<tr>
<td>Hanning</td>
<td>n/a</td>
</tr>
<tr>
<td>Hamming</td>
<td>n/a</td>
</tr>
<tr>
<td>Blackman</td>
<td>n/a</td>
</tr>
<tr>
<td>Blackman -61dB</td>
<td>n/a</td>
</tr>
<tr>
<td>Blackman -67dB</td>
<td>n/a</td>
</tr>
<tr>
<td>Blackman -74dB</td>
<td>n/a</td>
</tr>
<tr>
<td>Blackman -92dB</td>
<td>n/a</td>
</tr>
<tr>
<td>Kaiser-Bessel</td>
<td>n/a</td>
</tr>
</tbody>
</table>

Bartlett implements triangular windowing and Rectangle does not window the data. The “shape” of the other windows is defined by the following formula, where $n = \frac{N-1}{N}$ and A, B, C and D are constants:

$$A - B \cos \left( \frac{2\pi n}{N} \right) + C \cos \left( \frac{2\pi 2n}{N} \right) + D \cos \left( \frac{2\pi 3n}{N} \right)$$

The table below details the different parameter values for each type of window.

<table>
<thead>
<tr>
<th>Type of Window</th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bartlett</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
</tr>
<tr>
<td>Blackman</td>
<td>0.42000</td>
<td>0.50000</td>
<td>0.08000</td>
<td>0.00000</td>
</tr>
<tr>
<td>Blackman -61</td>
<td>0.44959</td>
<td>0.49364</td>
<td>0.05677</td>
<td>0.00000</td>
</tr>
<tr>
<td>Blackman -67</td>
<td>0.42323</td>
<td>0.49755</td>
<td>0.07922</td>
<td>0.00000</td>
</tr>
<tr>
<td>Blackman -74</td>
<td>0.40217</td>
<td>0.49703</td>
<td>0.09392</td>
<td>0.00183</td>
</tr>
<tr>
<td>Blackman -92</td>
<td>0.35875</td>
<td>0.48809</td>
<td>0.14128</td>
<td>0.01168</td>
</tr>
<tr>
<td>Hanning</td>
<td>0.50000</td>
<td>0.50000</td>
<td>0.00000</td>
<td>0.00000</td>
</tr>
<tr>
<td>Hamming</td>
<td>0.54000</td>
<td>0.46000</td>
<td>0.00000</td>
<td>0.00000</td>
</tr>
<tr>
<td>Kaiser-Bessel</td>
<td>0.40243</td>
<td>0.49804</td>
<td>0.09831</td>
<td>0.00183</td>
</tr>
<tr>
<td>Rectangle</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
</tr>
</tbody>
</table>

Visit the online support center at www.biopac.com
Appendix C - Hints for Working with Large Files

It is not uncommon for users to generate large data files (on the order of several megabytes) through some combination of (a) high-speed acquisitions, (b) long acquisitions, and (c) multi-channel acquisitions. Users frequently encounter system limitations (such as storage space limitations) and find the files are difficult and slow in loading to memory.

The software that comes with your MP System stores the data in as compact a format as possible. Each sample takes up roughly two bytes of storage space. When a waveform (or a section of a waveform) is transformed (i.e., filtered or integrated) each data point takes up roughly eight bytes of storage space. As a result, file size can change drastically after transforming one or more waves.

The following tips can help you get the most out of your MP System when working with large data files.

- **Use virtual memory**
  
  Since AcqKnowledge runs under Macintosh® (System 7.0 or better) or under Windows® (version 3.1 or better), most computers are able to take advantage of the virtual memory feature. While this is slower than conventional memory, it will at least make it possible to load some files that might otherwise be impossible to load.

- **Remove waveforms**
  
  Since each waveform adds to the total size of the file, try removing (or copying to another file) some of the waveforms from a multi-channel file. This is especially true if you would like to perform transformations of some sort on at least one of the waves.

- **Sample slowly**
  
  Theoretical and methodological concerns will, to a large extent, dictate sampling rate. However, if you can reduce the sampling rate, choose to do so. Or, use Transform > Resample (page 186) to resample data after collecting it.

- **Display preferences**
  
  Check the “Use all available memory” and the “Draft mode for compressed waves” options under the Preferences menu item. This should decrease the time it takes to redraw waveforms and allow the software to access all available memory for storage.

- **Store to disk**
  
  Although slightly slower than storing to RAM, acquiring data directly to disk allows you to recover data in the event of a power loss to the MP System. Furthermore, much larger data files can typically be stored directly to disk than to memory.

- **Use the Append mode**
  
  The Append mode allows you to pause the acquisition for arbitrary periods. This can be helpful when recording only a few key events that will occur randomly over a long period of time, since it will reduce unnecessary data.

- **Stop plotting**
  
  If the screen is taking a long time to redraw (because the data files are large), you can stop plotting and change the horizontal scale to a smaller number before redrawing. To stop plotting from disk or memory, use the ESC key on the MPWSW (PC) or ⌘+“.” on the MPWS (Mac).
Appendix D - Customizing Menu Functionality

AcqKnowledge now includes a powerful customization feature lets you choose the program features to display as menu options. If you have a specific procedure, you can limit the menu options to list only those functions you need, thereby reducing the chance for confusion or error in your lab. For instance, you might choose to remove the “Setup Triggering” and “Setup Stimulator” options from the MP menu, as shown below:

Follow the simple procedure below to customize menu display for your own needs.

1. Launch AcqKnowledge.
2. **Mac users:**
   a) Choose Display > Preferences.
   b) Click on “Create default menu configuration file.”
   c) Click “Yes” when prompted about editing the file.

   **PC users:**
   a) Display the Journal window.
   
   - Use the icon from the toolbar at the top of the graph window, or
   - Click on the Display menu, select Show, and drag to select Journal.
   b) Click on the icon at the top of the Journal window to access the Journal > Open dialog.
   c) Type “menu.dsc” in the “File name” entry box.
Alternately, you can pull down the “Files of type” menu and select “All files” and then select the “menu.dsc” file from the listing (which will automatically write it in the “File name” entry).

For a complete list of the options included in the “menu.dsc” file, see the end of this section.

3. Find the menu and item you want to change (scroll through list as necessary) and type “OFF” to disable the menu display. For example, you might change the File > New option to OFF, as shown below.

- Note that ON/OFF is case-sensitive and you must type in ALL CAPS.
- Deleting a file listing instead of typing OFF will not remove the feature; it will default to ON unless you type OFF.

To reactivate a menu item that you have turned OFF, just repeat the above procedure and type “ON” for the menu item you desire.

4. Activate the Journal Save As dialog.

  **Mac users:** File > Save Journal as…
  
  **PC users:** Click on the icon at the top of the Journal window.
5. Save the “menu.dsc” file with the exact same name in the exact same location.
   - You can type “menu.dsc” in the “File name” entry box, or
   - You can pull down the “Files of type” menu and select “All files” and then select the “menu.dsc” file from the listing.

6. You should be prompted that the file already exists. Click Yes to replace the existing file.

7. Exit the AcqKnowledge program. You do not have to save any graph or journal changes—the “menu.dsc” file has already been saved. Click No if prompted.

8. Restart AcqKnowledge.

9. Check your menu listing.

Note: Application menu customization has a corresponding effect on contextual menu display on the Macintosh. If a contextual menu item does not have a corresponding application menu item, the menu customization file identifier will begin with “IDM_CM.”

The menu display options that can be controlled are listed on the following pages → → →

Visit the online support center at www.biopac.com
MENU.DSC File – Menu Display Options

//@ File menu
IDM_FILENEW=ON
IDM_FILEOPEN=ON
IDM_FILIESAVE=ON
IDM_FILECLOSE=ON
IDM_FILESAVEAS=ON
IDM_FILEPRINT=ON
IDM_FILESETUP=ON
IDM_FILE_MRU=ON
IDM_FILEEXIT=ON

//@ Edit menu
IDM_EDITUNDO=ON
IDM_EDITCUT=ON
IDM_EDITCOPY=ON
IDM_EDITPASTE=ON
IDM_EDITCLEAR=ON
IDM_EDITCLEARALL=ON
IDM_EDITSELECT=ON
IDM_EDITINSERT=ON
IDM_EDITDUPLICATE=ON
IDM_EDITREMOVE=ON
IDM_EDITCLIPCOPYMEASUREMENT=ON
IDM_EDITCLIPCOPYWAVEDATA=ON
IDM_EDITCLIPCOPYGRAPH=ON
IDM_EDITPASTEMEASUREMENT=ON
IDM_EDITPASTEWAVEDATA=ON

//@ Transform menu
IDM_XFRMLOWPASS=ON
IDM_XFRMHIGHPASS=ON
IDM_XFRMBANDPASS=ON
IDM_XFRMBANDSTOP=ON
IDM_IIR_LOWPASS=ON
IDM_IIR_HIGHPASS=ON
IDM_IIR_BANDPASS=ON
IDM_IIR_BANDSTOP=ON
IDM_IIR_BANDPASS_LH=ON
IDM_IIR_BANDPASS=ON
IDM_IIR_BANDSTOP=ON
IDM_XFRMABS=ON
IDM_XFRMATAN=ON
IDM_XFRMCONNECT=ON
IDM_XFRMEXP=ON
IDM_XFRMLIMIT=ON
IDM_XFRMLN=ON
IDM_XFRMLOG=ON
IDM_XFRMNOISE=ON
IDM_XFRMSIN=ON
IDM_XFRMSQRT=ON
IDM_XFRMTHRESHOLD=ON
IDM_TMPSET=ON
IDM_TMPREMOVEMEAN=ON
IDM_TMPCORRELATION=ON
IDM_TMPMEANSQUARE=ON
IDM_TMPINVERSMEANSQUARE=ON
IDM_TMPCONVOLUTION=ON
IDM_XFRMINTEGRAL=ON
IDM_XFRMDERIVATIVE=ON
IDM_XFRMINTEGRATE=ON
IDM_XFRMSMOOTH=ON
IDM_XFRMDIFFERENCE=ON
IDM_XFRMHISTOGRAM=ON
IDM_XFRMRESAMPLE=ON
IDM_XFRMEXPRESSSION=ON
IDM_XFRMCHHAPMATH=ON
IDM_XFRMFFT=ON [also controls IFFT]
IDM_XFRMFINDPEAK=ON
IDM_XFRMFINDNEXT=ON
IDM_XFRMFINDALL=ON
IDM_XFRMRATE=ON

menu.dsc file listing continues...
### MENU.DSC menu display options continued

**// Display menu**

- IDM_DISPTILE=ON
- IDM_DISPAUTOTILE=ON
- IDM_DISPOVERLAP=ON
- IDM_DISPCOMPARE=ON
- IDM_DISPAUTOTIME=ON
- IDM_DISPZOOMPREV=ON
- IDM_DISPZOOMNEXT=ON
- IDM_DISPGRID_OPTIONS=ON
- IDM_ARRANGEWAVES=ON
- IDM_DISPPOS=ON
- IDM_DISPHORIZAXIS=ON
- IDM_DISPSCOPE=ON
- IDM_DISPCHART=ON
- IDM_DISPCHAOS=ON
- IDM_DISPGRID=ON
- IDM_DISPMARKERS=ON
- IDM_DISPMEASURES=ON
- IDM_DISPCHANNELS=ON
- IDM_DISPLINE=ON
- IDM_DISPSTEP=ON
- IDM_DISPDOT=ON
- IDM_DOTSIZE1=ON
- IDM_DOTSIZE2=ON
- IDM_DOTSIZE3=ON
- IDM_DOTSIZE5=ON
- IDM_DOTSIZE7=ON
- IDM_DISPLASTDOT=ON
- IDM_DISPSTATS=ON
- IDM_DISPPREFS=ON
- IDM_DISPSIZE=ON
- IDM_DISPFONT=ON

**// Window menu**

- IDM_WINDOWTILE=ON
- IDM_WINDOWTILEVERT=ON
- IDM_WINDOWCASCADE=ON
- IDM_WINDOWICONS=ON
- IDM_WINDOWCLOSEALL=ON

**// About menu**

- IDM_HELPABOUT=ON [About AcqKnowledge]

**// MP menu**

- IDM_CHANNELS=ON
- IDM_ACQUISITION=ON
- IDM_TRIGGERING=ON
- IDM_STIMULATOR=ON
- IDM_INPUTVALUES=ON
- IDM_MANUAL=ON
- IDM_AUTOSELECT=ON
- IDM_AUTOPLOT=ON
- IDM_AUTOSCROLL=ON
- IDM_WARNINGONOVERWRITE=ON
- IDM_CONFIG=ON [MP150 only]
- IDM_SELECT_MP_SERIAL_NUMBER=ON [MP150 only]
- IDM_ORGTEMPLATE=ON [MP150 only]
- IDM_ABOUT=ON [About MP acquisition unit]
Appendix E – Locking/Unlocking the MP150A for Network Operations

The MP150 is primarily designed to work in Local Area Networks (LAN). In a LAN, each MP150 unit may be accessed from any workstation (PC or Mac) running an Ethernet version of AcqKnowledge software. Theoretically, two or more workstations (WS) could be connected to one MP150 at the same time, but the MP150 cannot perform independent acquisitions simultaneously, so in such cases one or all connected WS would receive corrupted/invalid data and/or crash.

To prevent this, AcqKnowledge uses new “lock/unlock” technology that establishes communication between an MP150 and one — and only one — dedicated WS in the Network.

Locked  An MP150 becomes “locked” in operation to a WS (and unusable to other users) if

a) An MP150A unit is selected from the “MP150 Serial number Dialog.” The dialog lists all MP150A units that are powered ON and sitting on the same local area network. Unfortunately, this dialog cannot provide the locked/unlocked status of each MP150 in the LAN. You may refer to the BUSY and ACTIVITY lights on the MP150 to determine the status—if you can not connect to an <MP150 but its lights indicate data traffic or acquisition, the MP150 you are trying to connect to is connected to another WS.

b) When AcqKnowledge is launched. AcqKnowledge will “remember” and try to connect the last MP150 used by a WS; if the last used MP150 is not available, the user must pick an available MP150A unit from the “MP150 Serial number” dialog.

c) With the advent of any new communications or the start of any type of acquisition to the MP150A unit. When a WS communicates with an “unlocked” MP150A unit, AcqKnowledge sends a “lock” command.

When an MP150 is locked, its serial number is listed in the MP150 Serial Number dialog but any attempt to select a locked MP150 will generate a Hardware Not Found prompt:

Unlocked An MP150 automatically “unlocks” and becomes available to other users

a) When the user exits AcqKnowledge.

d) The user selects another MP150 in the MP150 Serial Number dialog.

e) The user selects the “No Hardware” option in the MP150 Serial Number dialog.

Other, less common conditions that may unlock the MP150 include

f) The MP150 is powered OFF and then ON.

g) The MP150 does not receive commands/data from the WS or AcqKnowledge for about 5 minutes. This time-out can occur when

- An AcqKnowledge dialog (About, Calculation setup, etc.) is open for a long time
- AcqKnowledge or the WS crashes for any reason
- You turn the connected WS off without exiting AcqKnowledge.
If the MP150 becomes unlocked due to a time-out, two scenarios are possible:

1) The MP150 is locked
   If another user has locked the MP150 you had been using, you will see the No Hardware Prompt. Check the MP150 lights to determine its status.

2) The MP150 is unlocked
   Your WS will “lock” the MP150 as soon as you initiate communication or acquisition; until then, the MP150 remains unlocked and available to others.

No Hardware
When a user selects the “No Hardware” option, the menu of available MP150A units is grayed out and becomes unselectable. If a user attempts to connect to a locked MP150A, an error message will be generated to advise that the MP150 unit is locked to a different computer.
Appendix F – Firmware Upgrade Utility

PC: MP150TOOLS.EXE Utility to Upgrade MP150A Firmware
(for Windows 98/98SE/Me/2000/XP)

MAC: MP150 Tools Firmware Upgrade (see page 245)

You may use the MP150 Firmware Upgrade Utility from any version to any version without limitation. It is a very safe procedure that cannot damage the MP150.

Before performing a Firmware Upgrade, make certain that no other users are connected to or using the MP150 you plan to upgrade. Any attempts to communicate with the MP150 via any user’s AcqKnowledge software may affect the viability of the upgrade. Fluctuations in the power source during an upgrade may also affect the outcome.

The MP150 is delivered with a factory-programmed firmware version that is not affected by the upgrade procedure—you can always restore the original firmware with the Firmware Rollback Switch (see page 245 for details).

MP150TOOLS.EXE — for PC users

1. If connected to more than one MP150A, directly or remotely:
   a) Launch AcqKnowledge (v3.7.0 or greater) if it is not running.
   b) Click on MP150>MP150 serial number.
   c) Select the serial number of the MP150A to be updated, make a note of it, and click OK.

2. Exit (Ctrl-Q) all BIOPAC applications running on your PC.

3. Open Explorer (right-click Start menu>Explore).

4. Locate and open the AcqKnowledge installation folder (the default location is C:Program Files>Biopac Systems, Inc>AcqKnowledge).

5. Select and open the MP150Tools.exe file.

6. An information dialog will be generated with the updated version of MP150 firmware that is going to be uploaded to the selected MP150A. Click on the “OK” button

   Note: If you did not exit all BIOPAC applications as required in Step 2, the following prompt will be generated. The utility will quit when you hit OK so you can exit all BIOPAC applications, then you must restart the utility.

7. A utility window will be generated.
8. To confirm the MP150A selected for updating, click (or choose File>Show MP150 info) to generate an information dialog with the current MP150A firmware version and the Serial number of the selected MP150A.

**Note:** If your computer is NOT (directly or remotely) connected to an MP150A, an error message will be generated. Clicking on OK will exit the utility so you can connect an MP150A to your computer.

9. To begin the update procedure, click on the icon or (use File>Update MP150). The update process may take up to 10 seconds. During the update process, the Activity and Busy lights on the MP150A should be active as follows: BOTH ON for 3-5 seconds, then BOTH FLASH SIMULTANEOUSLY for 3-5 seconds, then a normal SET UP/SELF-TEST procedure.

10. When the firmware has been updated successfully, a confirmation prompt will be generated. Click OK.

**Note:** If the update could not be completed, an error message will be generated and, on the MP150 unit, the Activity light will be ON and the Busy light will be OFF. Click OK to exit the utility, and then turn the MP150 unit OFF and then ON.

The MP150 will detect an incomplete upgrade or damaged firmware and will run on the factory-programmed firmware. If the Startup/Self-Test does not function normally after an upgrade error, you should use the Firmware Rollback Switch on the bottom of the MP150 unit.


The next time you launch AcqKnowledge, you can check the firmware version by clicking on MP150>About MP150 to generate an information dialog with the MP150A serial number and firmware version. If the firmware version is not as expected, repeat the Firmware Upgrade. If the MP150 fails to operate after downloading a new firmware revision, use the Firmware Rollback Switch on the bottom of the MP150 unit.

Visit the online support center at www.biopac.com
**MP150 Tools Firmware Upgrade — for Macintosh users**

1. Find the **MP150 Tools Firmware Upgrade** file in the BIOPAC program folder and open it.
2. Click **Next** to begin the procedure.
3. Use the **connect** dialog to designate an MP150 to upgrade.
   - You must connect to an MP150 to complete the firmware upgrade.
4. Confirm the designated MP150 information and click **Yes**.
5. Click **Start** to initiate the firmware upgrade.
   - A warning will be generated if the firmware to be installed is older than the current firmware.
6. When the upgrade is complete, a success dialog will be generated. Click **Quit** to close out.
   - If the firmware upgrade was not successful, you will be prompted to “rollback” to an older firmware version. *See* below for details on the Firmware Rollback Switch.

**Firmware Rollback Switch**

**IMPORTANT!**

Use the Firmware Rollback Switch **only** if the MP150 fails to operate after a Firmware Upgrade.

In all other cases, just turn the MP150 power OFF and then ON and check the results of the Start up/Self-Test.

The Firmware Rollback Switch is located on the bottom of the MP150 unit and is recessed to prevent accidental activation.

Activation of the Firmware Rollback Switch will cause the MP150 unit to operate under the factory-loaded firmware version. If no upgrades have been performed (the MP150 has only the factory-loaded firmware), the Firmware Rollback Switch will have no effect.

*Procedure:*

1. Turn the MP150 unit OFF.
2. Turn the MP150 unit upside down and use a small-tipped device (an unfolded paperclip will do) to depress and hold the switch down.
3. Continue to hold the switch down, and turn the MP150 unit ON.
   - One green and one yellow LED light will begin to blink simultaneously 5 times.
   
   **While the lights are blinking simultaneously, you may cancel the Rollback by releasing the Firmware Rollback Switch. If Rollback is cancelled, the MP150 will try to load the latest firmware upgraded version.**
   
   - Then the MP150 will perform a normal Startup/Self-Test with the factory-loaded firmware.
4. When the simultaneous blinking stops, release the switch.
   - The MP150 is now restored to the previous version of firmware.
   - You can check the firmware version via the MP150>**About MP150** menu item in AcqKnowledge.
## Appendix G – Analysis Features by Application

Features for the following application categories are detailed in this section:

<table>
<thead>
<tr>
<th>Page</th>
<th>Application</th>
</tr>
</thead>
<tbody>
<tr>
<td>248</td>
<td>EEG</td>
</tr>
<tr>
<td>250</td>
<td>ERS</td>
</tr>
<tr>
<td>252</td>
<td>Psychophysiology</td>
</tr>
<tr>
<td>255</td>
<td>Electrical Bioimpedance / Cardiac Output</td>
</tr>
<tr>
<td>257</td>
<td>EOG Eye Movement</td>
</tr>
<tr>
<td>259</td>
<td>Plethysmography</td>
</tr>
<tr>
<td>261</td>
<td>Sleep Studies</td>
</tr>
<tr>
<td>264</td>
<td>ECG: Cardiology</td>
</tr>
<tr>
<td>267</td>
<td>Cardiovascular Hemodynamics</td>
</tr>
<tr>
<td>269</td>
<td>EGG: Electrogastrogram</td>
</tr>
<tr>
<td>272</td>
<td>Continuous Noninvasive Blood Pressure</td>
</tr>
<tr>
<td>274</td>
<td>In vitro Pharmacology</td>
</tr>
<tr>
<td>276</td>
<td>Laser Doppler Flow</td>
</tr>
<tr>
<td>278</td>
<td>Micro-electrode Recording</td>
</tr>
<tr>
<td>280</td>
<td>Pulmonary Function</td>
</tr>
<tr>
<td>282</td>
<td>Exercise Physiology</td>
</tr>
<tr>
<td>284</td>
<td>EMG</td>
</tr>
<tr>
<td>286</td>
<td>Biomechanics</td>
</tr>
<tr>
<td>288</td>
<td>Remote Monitoring</td>
</tr>
<tr>
<td>290</td>
<td>Amplifiers &amp; Interfaces</td>
</tr>
</tbody>
</table>

### QUICK STARTS

**Quick Start** Template files (*.gtl graph template files) were installed to the Samples folder in the BIOPAC program folder for PC users.

Use a Quick Start file to establish the settings required for a particular application or as a good starting point for customized applications.

Appropriate Quick Start are designated with a **Q#** where applicable.

Set “Files of type” to “graph template” or “All files” to see the available templates.
Summary of Application Features
See the appropriate application section for more information about how to use your MP System and AcqKnowledge software for the features listed. For additional support, or for help with an unlisted application, please contact the BIOPAC Technical Support Division — an Applications Specialist will be glad to help you.

<table>
<thead>
<tr>
<th>Active Electrodes</th>
<th>Gait Analysis</th>
<th>Pressure Volume Loops</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allergies</td>
<td>Gastric Myoelectric Activity</td>
<td>Psychophysiology</td>
</tr>
<tr>
<td>Amplitude Histogram</td>
<td>Gastric Slow Wave Propagation</td>
<td>Pulsatile Tissue Studies</td>
</tr>
<tr>
<td>Anaerobic Threshold</td>
<td>Gastrointestinal Motility Analysis</td>
<td>Pulse Rate Measurement</td>
</tr>
<tr>
<td>Animal studies</td>
<td>Hardware Flexibility</td>
<td>Pulse Transit Time</td>
</tr>
<tr>
<td>Auditory Evoked Response (AER)</td>
<td>Heart Rate Variability</td>
<td>Range of Motion</td>
</tr>
<tr>
<td>Automate Acquisition Protocols</td>
<td>Heart Sounds</td>
<td>Real-time EEG Filtering</td>
</tr>
<tr>
<td>Automated Data Analysis</td>
<td>Histogram Analysis</td>
<td>Real-time EEG Filtering</td>
</tr>
<tr>
<td>Automatic Data Reduction</td>
<td>Imaging Equipment, Interfacing</td>
<td>Recurrent Patterns</td>
</tr>
<tr>
<td>Autonomic Nervous System Studies</td>
<td>Indirect Blood Pressure Recordings</td>
<td>Regional Blood Flow</td>
</tr>
<tr>
<td>Biomechanics Measurements</td>
<td>Integrated (RMS) EMG</td>
<td>Relative BP Measurement</td>
</tr>
<tr>
<td>Blood Flow / Blood Pressure / Blood Volume</td>
<td>Interface with Existing Equipment</td>
<td>Remote Monitoring</td>
</tr>
<tr>
<td>Body Composition Analysis</td>
<td>Interface with Third-party transducer</td>
<td>Respiratory Exchange Ratio</td>
</tr>
<tr>
<td>Breath-By-Breath Respiratory Gas Analysis</td>
<td>Invasive Electrode Measurements</td>
<td>Rheumatology</td>
</tr>
<tr>
<td>Cardiac Output</td>
<td>Interfacing</td>
<td>Saccadic Eye Movements</td>
</tr>
<tr>
<td>Cardiology Research</td>
<td>Isotonic Contraction</td>
<td>Sexual Arousal Studies</td>
</tr>
<tr>
<td>Cell Transport</td>
<td>Isometric Contraction</td>
<td>Signal Averaging</td>
</tr>
<tr>
<td>Cerebral Blood Flow</td>
<td>Langendorff Heart Preparations</td>
<td>Simultaneous Monitoring</td>
</tr>
<tr>
<td>Chaos Plots</td>
<td>Left Cardiac Work</td>
<td>Single Channel Analysis</td>
</tr>
<tr>
<td>Common Interface Connections</td>
<td>Long-term Monitoring</td>
<td>Single-fiber EMG</td>
</tr>
<tr>
<td>Connect to MP Systems</td>
<td>Lung Volume Measurement</td>
<td>Software-controlled Stimulator</td>
</tr>
<tr>
<td>Control Pumps and Valves</td>
<td>LVP</td>
<td>Somatosensory Evoked Response</td>
</tr>
<tr>
<td>Cross- and Auto-correlation</td>
<td>Median &amp; Mean Frequency Analysis</td>
<td>Spectral Analysis</td>
</tr>
<tr>
<td>Current Clamping</td>
<td>Micro-electrode signal amplification</td>
<td>Spike Counting</td>
</tr>
<tr>
<td>Defibrillation &amp; Electrocautery</td>
<td>Migrating Myoelectric Complex</td>
<td>SpO2 Analysis</td>
</tr>
<tr>
<td>Dividing EEG into Specific Epochs</td>
<td>Motor Unit Action Potential</td>
<td>Stand Alone Amplifiers</td>
</tr>
<tr>
<td>ECG Analysis</td>
<td>Movement Analysis</td>
<td>Standard Operating Procedures</td>
</tr>
<tr>
<td>ECG Recordings, 12-Lead</td>
<td>MRI Applications</td>
<td>Startle Eye Blink Tests</td>
</tr>
<tr>
<td>ECG Recordings, 6-Lead</td>
<td>Multi-Channel Sleep Recording</td>
<td>Startle Response</td>
</tr>
<tr>
<td>EEG Spectral Analysis</td>
<td>Nerve Conduction Studies</td>
<td>Stimulator, software-controlled</td>
</tr>
<tr>
<td>Einthoven’s Triangle</td>
<td>Neurology Research</td>
<td>Systemic Vascular Resistance</td>
</tr>
<tr>
<td>EMG and Force</td>
<td>Nominvasive Cardiac Output</td>
<td>Template Analysis</td>
</tr>
<tr>
<td>EMG Power Spectrum Analysis</td>
<td>Nominvasive Electrode Measurements</td>
<td>Tissue Bath Monitoring</td>
</tr>
<tr>
<td>End-tidal CO2</td>
<td>Nystagmus Investigation</td>
<td>Tissue Conductance Measurement</td>
</tr>
<tr>
<td>Episode Counting</td>
<td>Oculomotor Research</td>
<td>Tissue Magnitude &amp; Phase Modeling</td>
</tr>
<tr>
<td>Ergonomics Evaluation</td>
<td>Off-line ECG Averaging</td>
<td>Tissue Resistance &amp; Reactance</td>
</tr>
<tr>
<td>Event-related Potentials</td>
<td>On-line ECG Analysis</td>
<td>Using Chamber Measurements</td>
</tr>
<tr>
<td>Evoked Response</td>
<td>Orthostatic Testing</td>
<td>Ventricular Late Potentials</td>
</tr>
<tr>
<td>Exercise Physiology</td>
<td>Peripheral Blood Flow</td>
<td>Vestibular Function</td>
</tr>
<tr>
<td>External equipment, controlling</td>
<td>Peristaltic (Slow Wave) Propagation</td>
<td>Video Capture, Synchronous</td>
</tr>
<tr>
<td>Extra-cellular Spike Recording</td>
<td>Planted Tissue</td>
<td>Visual Attention</td>
</tr>
<tr>
<td>Facial EMG</td>
<td>Fine Wire EMG</td>
<td>Visual Evoked Response</td>
</tr>
<tr>
<td>FFT &amp; Histograms</td>
<td>Forced Expiratory Flow &amp; Volume</td>
<td>VO2 Consumption</td>
</tr>
<tr>
<td>FFT for Frequency Analysis</td>
<td>Field Potential Measurements</td>
<td>Volume/Flow Loop Relationships</td>
</tr>
<tr>
<td>Field Potential Measurements</td>
<td>Fine Wire EMG</td>
<td>Working Heart Preparations</td>
</tr>
</tbody>
</table>

Quick Start graph template files are available for over 40 of applications for PC users, as indicated by this numbered symbol in the following description. Just open as “File of type: Graph template” and then click Start — the appropriate parameters are automatically established when you open a template file. See page 150 for details.
EEG FEATURES

Real-time EEG Filtering

Record single- or multi-channel montages with on-line calculation channels for Delta, Theta, Alpha, and Beta wave activity. On-line calculation channels allow the display of raw and filtered data in real time, and users can employ a variety of other transformations to filter the data off-line and further analyze the data.

Spectral Analysis

Use AcqKnowledge to obtain the power spectrum of the EEG. The power spectrum indicates the power of each frequency component present in the source time domain waveform. Perform power spectral analysis on EEG data from different leads and overlap the results. The FFT in AcqKnowledge allows frequency representation using linear or logarithmic scaling.

Amplitude Histogram

Create an amplitude histogram to highlight changes within the EEG recording. Use this powerful feature to compare baselines on pre- and post-protocol data. View multiple histograms within the same graph window for easy visual comparisons of skewness and kurtosis. The degree of deviation from Gaussian distribution of the EEG has been shown to depend on the behavioral state of the subject. The software will automatically set the amplitude range based on the selected area of data, or the user can manually enter a range and adjust the number of bins to maximize the display resolution.

Spike Counting

The Peak detection function will isolate individual EEG spikes, measure and count them, and enter the result into the Journal file. Select the measurements desired and the software will do the rest. Perform the analysis over the entire recording, pre-selected regions, or a pre-defined time period (e.g., every 30 seconds). Automation features allow the user to select data specific to experimental protocols, such as day/night cycles.

Visit the online support center at www.biopac.com
Episode Counting

To determine the number of episodes (sleep spindles, k complexes, epileptic spikes) within a given time period, integrate appropriately filtered EEG data. Next, use the Peak detection function to locate each episode, count episodes, analyze the time duration of each episode, and determine the frequency of occurrence. This feature is useful for studying episodic activity in humans and small animals over long time durations, including day/night cycles.

Evoked Responses

Record and analyze auditory, visual and somatosensory evoked responses. The on-line averaging function allows the user to perform detailed evoked response studies. The system can trigger a stimulator at the start of each averaging sweep, or an external stimulator can trigger the start of a new sweep. Set the length of the averaging sweep, the number of averages and the latency between averaging passes. Remove any stimulus artifact with the artifact rejection utility. Use the averaging software for a range of evoked potential studies on humans and animals, such as visual (VER), somatosensory (SER) and auditory (AER) responses.

Event-related Potentials

The STP100W package will present a variety of visual and auditory stimuli on one computer while the AcqKnowledge software records the responses on another computer. As the stimuli are presented, the STP100W simultaneously (with 1ms resolution) sends trigger signals to the MP System for data synchronization and collection. The STP100W software (SuperLab™ Pro) can be used to change the placement of visual stimuli on the screen, change the screen’s background color, choose from a variety of input and timing options, and provide feedback based on either response or reaction time. Different trigger channels can be paired to different visual or auditory stimuli to perform sophisticated evoked response averaging tests (e.g., P300). The off-line averaging function in AcqKnowledge displays the averaged response to each different stimulus triggered from the STP100W system.

Dividing EEG into Specific Epochs

Use the display scrolling controls to adjust the rate at which data is scrolled across the screen. For example, set the horizontal axis to sweep exactly 30 seconds of data across the screen. This mode is very useful when scoring sleep studies in 30-second epochs.

Cross- and Auto-correlation

To correlate one channel of EEG data with another, use the off-line correlation function in AcqKnowledge. To obtain the auto-correlation of a signal, correlate a channel with itself. To obtain the power spectral density, perform the FFT on the auto-correlation result.
Nerve Conduction Studies

Q04 The system software permits easy determination of peak times and maximum responses. Stimulate and record signals from nerves in-vivo or in-vitro; using the built-in software-averaging mode, it’s possible to record signals from in-vivo nerves using skin surface electrodes only. Evaluate the effects of stimulation to motor nerve endings in terms of electrical or mechanical response. Configure stimulation sources to provide electrical, mechanical or visual stimulation, and vary the duration and level of stimulus. In addition to the stimulator, up to 16 amplifiers can be simultaneously employed to record nerve and/or muscle responses.

Signal Averaging

Remove background noise and extract the signal of interest with the on-line signal-averaging mode. Set the sweep duration and the number of averaging trials. Specify artifact rejection criteria, and determine the triggering options. The software will calculate the average and display the result in real time. The software counts and displays the total number of averages, the number of averages left to complete the sequence, and the number rejected from the test.

Software-controlled Stimulator

Use the graphical setup features in the AcqKnowledge Stimulator dialog to design the appropriate stimulus. The stimulator setup provides a variety of pre-formatted output options including square, sine and triangle waves. It’s also possible to create stimulus waveforms of any polarity and shape. The output options are adjusted either graphically or numerically for easy control of amplitude, duration and start time. Users can also output a previously recorded waveform or create customized stimuli using the waveform math tools.

Auditory Evoked Response (AER) & Jewett Sequence

Q05 To perform on-line AER studies, combine the auditory output options of the STM100C Stimulator with the signal averaging functions of the MP System. Use the OUT101 Tubephone to efficiently direct acoustical stimuli. The software will display the results and allow users to measure the amplitude and time of Fast (2-12 msec), Middle (12-50 msec), Slow (50-300 msec), and Late responses (250-600 msec).

Visit the online support center at www.biopac.com
Visual Evoked Response

Q06 Perform VER studies with the TSD122 Stroboscope and the averaging features of the MP System. Trigger the averaging cycle with the stroboscope, or vice-versa. Users can substitute different visual stimulators (e.g. checkerboard generators) for the stroboscope.

Somatosensory Evoked Response

Q07 Perform somatosensory tests by using the MP System with a STM100C stimulator and either the STMISO series or a solenoid.

1) The STMISO series, used with the STM100C, will provide either voltage or current stimulation.

2) A solenoid will provide a mechanical stimulation to provoke a touch sensation in the subject synchronously with neuronal recording. Drive a solenoid directly from the STM100C stimulator and use the ERS100C amplifier to record the evoked potentials.

Average the potentials to obtain a clear picture of the response amplitude and latency.

Event-related Potentials (STP100W)

Q08 The STP100W package will present a variety of visual and auditory stimuli on one computer while the AcqKnowledge software records the responses on another computer. As the stimuli are presented, the STP100W simultaneously (with 1ms resolution) sends trigger signals to the MP System for data synchronization and collection. The STP100W software (SuperLab™) can be used to change the placement of visual stimuli on the screen, change the screen’s background color, choose from a variety of input and timing options, and provide feedback.

Feedback can be based on either response or reaction time. Different trigger channels can be paired to different visual or auditory stimuli to perform sophisticated evoked response averaging tests (e.g., P300). The off-line averaging function in AcqKnowledge displays the averaged response to each different stimulus triggered from the STP100W system.

Extra-cellular Spike Recording

Q09 Record and analyze extra-cellular spikes using a glass or wire microelectrode and the MCE100C microelectrode amplifier. Use the averaging function in AcqKnowledge to determine the average response, or count the number of spikes with the peak detection function. To identify trends within the firings, use the Histogram and FFT analysis functions. Measure the amplitude, duration, and frequency of each spike.

Automatically Control External Equipment

Use the digital I/O lines on the MP System to drive multiple stimulating devices—control lights, buzzers, relays and solenoids. Drive solid-state relays directly from the I/O lines to control high-powered external
devices. Use the on-line Calculation channels to create synchronization and control channel outputs.

**Evoked Response**

Powerful on- and off-line averaging features make it possible to perform a wide variety of evoked response studies. Record and measure evoked potentials, late potentials, startle, nerve conduction and field potentials. Use the 100C-series biopotential amplifiers to record visual, somatosensory and auditory evoked responses. Use the stimulator to output pre-defined waveforms or tones, tone pips, clicks (pulses) or other, more complex waveforms.

**PSYCHOPHYSIOLOGY FEATURES**

**Autonomic Nervous System Studies**

Q10 Evaluate sympathetic and parasympathetic nervous system effects on humans and animals. Record ECG, electrogastrogram (EGG), skin temperature and electrodermal activity for evidence of sympathetic/parasympathetic nervous system effects. When sympathetic activity increases, heart rate rises, EGG frequency slows, skin temperature drops and electrodermal activity increases.

Visit the online support center at www.biopac.com
Event-related Potentials (P300)

The STP100W package will present a variety of visual and auditory stimuli on one computer while the AcqKnowledge software records the responses on another computer. As the stimuli are presented, the STP100W simultaneously (with 1ms resolution) sends trigger signals to the MP System for data synchronization and collection. The STP100W software (SuperLab™) can be used to change the placement of visual stimuli on the screen, change the screen’s background color, choose from a variety of input and timing options, and provide feedback based on either response or reaction time. Different trigger channels can be paired to different visual or auditory stimuli to perform sophisticated evoked response averaging tests (e.g., P300).

The off-line averaging function in AcqKnowledge displays the averaged response to each different stimulus triggered from the STP100W system. Useful in other presentation modalities, the TSD200 Pulse Transducer can be attached to a computer monitor to provide event mark timing from a presentation program such as PowerPoint®.

Startle Eye Blink Tests

Use the stimulator with the OUT100 headphones to present auditory stimuli for classic startle response measurements. Use the EMG100C amplifier to record eye blinks (facial EMG). Use AcqKnowledge to integrate the recorded EMG in real time. Use the measurement tools to determine the startle response and amplitude directly, or automate analysis with the peak detection tools. (See the EMG Application)

Software-controlled Stimulator

The stimulator provides a variety of pre-formatted output options including square, sine and triangle, or users can design an appropriate stimulus with the graphical setup features; stimulus waveforms can be of any polarity and shape. The output options are adjusted either graphically or numerically for easy control of amplitude, duration and start time. Users can also output a previously recorded waveform or create customized stimuli using the waveform math functions.

Sexual Arousal Studies

Monitor a variety of different psychophysiological parameters including vaginal plethysmography (TCIPPG1), penile plethysmography (TCI111/TCI112), temperature, GSR, respiration, and pulse. Monitor pulse rate, respiration rate, pulse amplitude, and area under the pulse curve on-line with calculation channels. Use the STP100W package to present a wide range of images while sending marker/trigger information to the MP System. Use the automatic analysis features, triggering off of the image markers, to determine the amplitude, duration, and onset timing of the subject’s response.
Automated Data Analysis

There are a variety of tools for measuring response times and response amplitudes. Perform measurements manually by selecting an area of data, or automatically over specified time periods or around the time of a trigger (pre- and post-trigger values). Measurement results can be automatically entered into a journal file for further analysis or displayed as a new graph channel.

Heart Rate Variability

For Heart Rate Variability studies, record a wide bandwidth ECG signal, calculate the R-R interval, and then apply the FFT or Histogram transformation to the R-R interval data. The FFT allows frequency representation using linear or logarithmic scaling. Users can select from a variety of windowing and display options to easily reproduce published results.

Automatically Control Other Equipment

The MP System will interface with a wide variety of devices such as pumps, valves, stimulators and switches. The MP System has 16 digital I/O lines that can be manually or automatically controlled with the AcqKnowledge software. By using the online Calculation and Control channel functions it’s possible to automatically trigger devices to turn on and off. Use the stimulator and control channels to perform multiple stimulus paradigms. Stimulate the subject based on the result of a physiological response.

Auditory & Visual Evoked Response Testing

Combine the auditory output options of the Stimulator with the signal averaging functions of the MP System to perform on-line AER studies. Display the results and measure the amplitude and time of Fast (2-12 msec), Middle (12-50 msec), Slow (50-300 msec), and Late responses (250-600 msec). Use the stroboscope and the averaging features to perform VER studies. Trigger the averaging cycle with the stroboscope, or vice-versa.
ELECTRICAL BIOPIMPEDEANCE / CARDIAC OUTPUT FEATURES

Cardiac Output

Q13 To determine Cardiac Output noninvasively, employ electrical bioimpedance measurement techniques with the EBI100C. With pairs of EL500 electrodes attached to the neck and torso, the EBI100C can isolate the base \( Z(t) \) and delta impedance \( \frac{dZ}{dt} \) values, which vary as the heart pumps blood. In real time, \( \frac{dZ}{dt} \) magnitude and heart rate can be determined on a cycle-by-cycle basis. Simultaneously, the DA100C and the TSD108 can identify aortic valve opening and closing times.

Use the Equation Generator to combine data from these various sources to compute Stroke Volume and Cardiac Output on-line. One possible equation for determining Stroke Volume is (from Nyboer, 1970):

\[
V = r \cdot \left( \frac{L^2}{ZO^2} \right) \cdot T \cdot \left( \frac{dZ_{\text{min}}}{dt} \right)
\]

where

- \( V \) = Stroke Volume
- \( r \) = Resistivity of Blood
- \( T \) = LVET
- \( L \) = Length Between Recording Electrodes
- \( \frac{dZ_{\text{min}}}{dt} \) = Magnitude of Largest Impedance Change During Systole

Systemic Vascular Resistance & Left Cardiac Work

By recording cyclic Stroke Volume (SV) along with the blood pressure waveform using the NIBP100, and computing mean arterial pressure (MAP) using AcqKnowledge, it’s possible to derive Systemic Vascular Resistance (SVR) and Left Cardiac Work (LCW). Divide MAP by SV to obtain a parameter proportional to SVR. Multiply MAP by SV to obtain a parameter proportional to LCW.

Peripheral Blood Flow

When used in conjunction with an occluding cuff, electrical bioimpedance measurements on limbs can assess arterial blood flow and venous thrombosis. To prevent venous outflow without significantly changing arterial inflow, rapidly inflate the TSD120 cuff to 40-50 mmHg. The blood inflow causes an increase in the volume of the limb. To measure the arterial flow rate, use the slope of the initial impedance change. The volume change that occurs after the impedance change reaches a plateau is a measure of the compliance of the venous system. Once the volume has stabilized, quickly deflate the cuff. For thrombosis to exist in the veins, the time constant of the outflow lengthens. The percentage outflow...
drop can be measured directly, at any time, once  
the cuff pressure is released.

Tissue Magnitude & Phase Modeling

The EBI100C measures tissue impedance magnitude and phase simultaneously at any of four operational frequencies (12.5, 25, 50 and 100kHz). Accordingly, the EBI100C can be used to develop an electrical model of the tissue measured. Real and imaginary parts of the tissue impedance can be determined over this range of frequencies, which points to specific electrical circuit elements (resistors, capacitors and inductors) that can be assembled to electrically model the actual tissue impedance characteristics.

Pulse Rate Measurement

The EBI100C easily measures the change in thoracic impedance that occurs as the heart beats. As blood is forced out of the aorta during ventricular ejection, the impedance through the torso drops momentarily. The derivative of this waveform (dZ/dt) can be processed to record pulse rate (BPM) on a cycle-by-cycle basis in real time. The dZ/dt waveform is directly related to the aortic ejection velocity.

Tissue Resistance & Reactance

Tissue resistance is mathematically described as the real part of the tissue impedance and tissue reactance is defined as the imaginary part of the tissue impedance. To determine these parameters, measure the impedance magnitude and phase using the EBI100C. Use the AcqKnowledge Equation Generator to multiply the magnitude by the cosine of the phase to obtain the tissue resistance and by the sine of the phase to obtain the tissue reactance. Invert the resistance value to obtain tissue conductance.

Body Composition Analysis

Although there is no direct theoretical relationship between whole body resistance and/or reactance and adiposity, empirical relationships exist to relate total body water and fat free mass to impedance, weight, height, gender and age. In effect, lean body impedance is a function of the specific resistivity of the lean tissue, together with its cross-sectional area and its length. When investigating body composition, the EBI100C can be used to perform multi-frequency measurements of different body parts to obtain the segment’s resistive and reactive components using standard tetrapolar electrode placement.

Respiration Monitoring

For bioimpedances measured across the thorax using the EBI100C, a small impedance change is observed with each inspiration and expiration. For respiration monitoring, electrodes are placed across the mid-thorax along the mid-axillary line. Filtering can be employed in AcqKnowledge to minimize motion artifacts. Because the EBI100C measures the thoracic impedance directly, the module can measure arbitrarily low breathing rates. When initially calibrated against a pneumotach, the EBI100C can also be used to estimate ventilation.

Visit the online support center at www.biopac.com
**Nystagmus Investigation**

*Q15* Use AcqKnowledge to turn LEDs on and off when studying pendular or jerky nystagmus. The subject sits still and focuses on the slowly moving LED target lights. To isolate both slow and fast phase nystagmus components, change the switching speed of the lights during recording.

**Saccadic Eye Movements**

*Q16* Saccadic eye movement can be recorded from a seated subject reading text from a book while the subject’s head remains relatively still and relaxed. As the subject tracks across the page, the eye will make larger voluntary movements, known as saccades, or fixate on a number of points in quick succession. The software lets users identify where the subject’s eyes were located during the recording section; users can also isolate the areas where the subject struggled with a particular word or phrase.

**Eye Travel & Position**

The X/Y display mode will track a subject’s eye travel and display the exact pattern of movement. This application requires two EOG amplifiers, one for horizontal eye movements and the other for vertical. The subject remains in a fixed position with the head still
during recording. The software will display the data in both chart and X/Y display modes. There are a number of tests where this feature is useful, such as determining a subject’s visual path when first exposed to a sign, advertisement, or new ergonomic layout.

### Vestibular Function

For caloric induced nystagmus, synchronize the vestibular stimulation with the nystagmus recording to obtain precise nystagmus latency. For rotationally induced nystagmus, use the TEL100C System to record the EOG to provide a significant degree of movement (up to 60 meters). For continuous rotation studies, couple the TEL100C transmission signal through a slip ring.

### Visual Evoked Response

To perform VER studies, use the TSD122 Stroboscope and the averaging mode of the MP System. The stroboscope will trigger the MP System or the averaging software can trigger an external stimulator. An Evoked Response or Electroencephalogram Amplifier (ERS100C or EEG100C) is used to record the evoked response while the software performs on-line averaging. The averaging software allows the user to set the number of averages and the length of the average, and to adjust the artifact rejection criteria. Display and overlap multiple responses for a quick comparison between subjects and trials.

### Oculomotor Research & Visual Attention

During normal viewing conditions, a subject makes 3-5 saccades per second, separated by periods (fixations) of 200-300 ms where the eyes do not make large or fast movements. To isolate saccade-to-saccade latencies for histogram timing analysis, record the derivative (velocity) of eye movement and use the Rate Detector to calculate the latencies. Alternatively, by using the Rate Detector to calculate the maximum cyclic value of the derivative, it’s possible to determine the average velocity of saccadic movement over long time periods.
PLETHYSMOGRAPHY FEATURES

**Indirect Blood Pressure Recordings**

**Q17** Record indirect blood pressure with a blood pressure cuff (TSD120) and a contact microphone (TSD108) placed over the brachial artery. Increase cuff pressure to occlude the vessel and slowly release it; as the pressure signal drops, the microphone will record the Korotkoff sounds. Easily determine systolic and diastolic BP with the measurement tools.

Continuous noninvasive blood pressure measurement is also possible — see the NIBP application.

**Sexual Arousal Studies**

Monitor a variety of different psychophysiological parameters, including vaginal plethysmography (TCIPPG1), penile plethysmography (TCI111/112), temperature, electrodermal activity (GSR), respiration, and pulse. On-line calculation channels allow users to monitor pulse rate, respiration rate, pulse amplitude, and area under the pulse curve.

Use the STP100W to present images synchronously with physiological data collection. Use the automatic analysis features, in conjunction with the image markers, to determine the amplitude, duration, and onset timing of the subject’s response.

**Blood Volume**

**Q18** Measure variations in blood flow indirectly via changes in opacity with the plethysmogram transducer (TSD200). Typically, the transducer is attached to the finger to record the peripheral pulse. The software will calculate measurements on a beat-by-beat basis.

**Pulse Transit Time & Relative BP Measurement**

Pulse Transit Time (PTT) is the time it takes the pulse pressure waveform to propagate through a length of the arterial tree. The pulse pressure waveform results from the ejection of blood from the left ventricle and moves with a velocity much greater than the forward movement of the blood itself. To measure pulse transit time, record the onset of the R-wave with an ECG100C amplifier and record the pulse waveform at the fingertip using a TSD200 and the PPG100C amplifier. Use AcqKnowledge to determine the cyclic peak time of both waveforms, then subtract the ECG R-wave peak time from the PPG peak time.

To calculate Pulse Wave Velocity (PWV), first measure the distance from the heart to the location of the TSD200 sensor, then divide the distance by the PTT.
PWV is related to blood pressure delta (Systolic - Diastolic) in accordance with the following equation (from Bramwell & Hill, 1922):

\[ \text{PWV} = K \cdot \left[ V \cdot (P/V) \right] \]

*Where*
- **PWV** = Pulse Wave Velocity
- **K** = Constant
- **V** = Initial Vessel Volume
- **P** = Pressure Delta
- **V** = Vessel Volume Delta

### Regional Blood Flow

Occlude the venous return with the blood pressure cuff (TSD120) and measure the swelling of the distal portion of the limb with a mercury strain gauge. The mercury strain gauge interfaces with the DA100C amplifier and a TCI111/112. This experiment allows users to monitor changes from a baseline reading and compare responses from one subject to the next. Typically, the initial slope of the response is determined, and a series of measurements are taken, including:

- **Venous capacitance** — The inflow curve plateaus because eventually the venous pressure rises sufficiently to force blood past the occluding cuff; the increased volume at this point thus represents the capacity of the venous system to store blood and is termed the venous capacitance.

- **Venous outflow** — Use venous outflow to determine deep venous thrombosis (DVT). Rapidly release the cuff pressure from the point of maximum swelling and record the time taken for the signal to return to the normal (pre-inflation) level. The level of flow resistance determines the time it takes the flow signal to return to normal.

- **Venous compliance** — To measure venous capacitance as a function of pressure, follow the procedure for measuring venous capacitance but use different occluding cuff pressures. The slope of this relationship measures the venous compliance.
SLEEP STUDIES FEATURES

Multi-Channel Sleep Recording

Q19 Record up to 16 channels of sleep data. Review data in 15- or 30-second epochs for quick visual assessments. Use the Journal to indicate points of interest in the sleep record. Copy critical measurements to the Journal with a single command.

Real-time EEG Filtering

Q20 Use on-line Calculation channels to record single- or multi-channel EEG montages for Delta, Theta, Alpha, and Beta wave activity and to display raw and filtered data in real time. To extract sleep spindles from the raw EEG data, create a real-time (6-15) Hz bandpass filter. To isolate K complexes, run the EEG data through a (12-14) Hz bandpass filter. If preferred, filter data off-line and use a variety of other transformations to further analyze the data.

EEG Spectral Analysis

AcqKnowledge can be used to obtain the power spectrum of the EEG, with frequency representation in linear or logarithmic scaling. The power spectrum, which can be used to analyze a variety of physiological signals, indicates the power of frequency components in the source time domain waveform and is defined as the square of the linear spectrum magnitude.

Template Analysis

Use the Template functions to isolate certain repeated EEG patterns within the recording. Select a wavelet of EEG data (i.e., spindle or K complex) to create the template and let the software determine the template’s Correlation, Convolution, Mean Square Error or Inverse Mean Square Error with respect to the entire recording. To quickly locate patterns of interest within a large sleep file, run the Peak detector over the Template function results.

On-line ECG Analysis

Q20 Use on-line calculation channels to display ECG results on a beat-by-beat basis, or make the same calculations off-line. Utilize the bar graph display option for a clear view of the heart rate data and other vital signals.
Heart Rate Variability

To perform Heart Rate Variability studies, record a wide bandwidth ECG signal, calculate the R-R intervals, and then apply the linearly scaled FFT transformation to the R-R interval data. Compute the power spectrum by squaring the linear spectrum magnitude. Select from a variety of windowing and display options to easily reproduce published results.

SpO2 Analysis

Automatically identify points in the sleep record where the SpO2 level has dropped below a user-set threshold (e.g. 80%). Use AcqKnowledge to count these events on-line and automatically record the time they occur. To sound alarms (OUT102) or trigger other devices when preset thresholds are crossed, use the Control channel functions in AcqKnowledge.

EMG & Movement Analysis

When recording EMG (via the EMG100C) and movement (via the TSD109), users can set limits and thresholds to isolate specific events within the recording. Identify when a subject is moving versus experiencing a muscle tremor episode. After events are identified, users can perform cross-channel analysis on the rest of the data to validate the event.

Recurrent Patterns

Use the Template functions in AcqKnowledge to locate suspected repeated patterns in the sleep record. Apply the template functions to any kind of raw data, such as EEG, ECG, or EOG, or to calculated data, such as heart or respiration rate. Select an example of the wave pattern and then correlate the pattern with the entire sleep record; high points in the resulting correlation function indicate points of similarity.

Automatic Data Reduction

The powerful data reduction function will reduce large data files to a manageable size for further statistical analysis. Analyze both primary signals (such as respiration) and derived data (such as respiration rate). Select the appropriate measurement, enter the desired time epoch, and the software will automatically analyze the data and enter the values into a Journal file. For refined analysis, display the measured values as a new
channel and apply the analysis and measurement tools to the summarized results.
ECG: CARDIOLOGY FEATURES

**Einthoven’s Triangle & 6-Lead ECG**

Q22 The on-line Calculation channels allow users to take full advantage of the principle of Einthoven’s triangle. Use just two ECG100C amplifiers to obtain six leads of ECG data. Acquire data from Lead I and Lead III (or any two leads from a 3-lead combination) and the on-line Equation Generator will calculate and display Lead II plus the Augmented Leads (aVR, aVL and aVF).

**12-Lead ECG Recordings**

Q23 To record a 12-lead ECG, eight ECG100C amplifiers are required. Two of the amplifiers can record Leads I, II, III, aVR, aVL, and aVF. Apply the Wilson Terminal (WT100C) to these amplifiers to generate a virtual reference for the six remaining amplifiers, which are assigned the precordial chest leads (V1-V6). Alternatively, users can obtain a 12-lead recording with three ECG100C modules and the low-cost TSD155C multi-lead ECG cable. This cost-effective option displays Leads I, II, III, aVR, aVL, and aVF simultaneously, plus one chest lead. Move the chest lead from one precordial location to the next to record a complete 12-lead ECG.

**On-line ECG Analysis**

Q20 On-line Calculation channels display results on a beat-by-beat basis; calculations can also be made off-line. Use the bar graph option for a clear view of heart rate data, as in biofeedback type studies or during surgery.

**Automated Off-line ECG Analysis**

The powerful Peak detection feature can automatically isolate the different components of the ECG complex. The software will isolate each component, measure it for time and amplitude, and paste the results into a Journal file for further analysis or display them as new data channels.

**Heart Rate Variability (FFT & Histograms)**

To perform Heart Rate Variability studies, record a wide bandwidth ECG signal, calculate the R-R intervals in AcqKnowledge, and then apply an FFT or Histogram transformation to analyze the R-R interval data. Use the linearly scaled FFT function to evaluate the R-R interval data for periodicity. Use the Histogram function to point to variations in the interval distribution, such as skewness or kurtosis. Select from a variety of windowing and display options to easily reproduce published results.
Heart Sounds

Record the sounds associated with valve openings and closings and with the flow of blood within the heart during the cardiac cycle. Place a TSD108 Physiological Sounds Microphone on the anterior surface of the chest over the heart to record heart sounds. To isolate different sounds, combine the heart sounds recording with the ECG and display in Scope mode to overlap the two signals and determine when the sounds are created in relation to the ECG complex.

Off-line ECG Averaging

Quickly isolate changes in the ECG complex. Display the averaged ECG complex before, during and after dosing or exercising. Select an area and the software will calculate the average ECG complex. By performing this routine for baseline, control and dosing additions, users can display all the results in one graph and overlap them to highlight any changes that occurred during the course of the experiment. This capability is useful for long-term hemodynamic, exercise physiology and cardiology investigations.

Chaos Plots

Take advantage of the X/Y display option to view chaos plots from a regular ECG recording. For a greater understanding of cardiac disease, plot heart rate against itself with a time delay to isolate attractors within patterns.

FFT for Frequency Analysis

Use the FFT in AcqKnowledge to evaluate the frequency components in one or more ECG complexes. To estimate the power spectral density of an ECG signal, perform the FFT and square the linear voltage magnitude using the Equation Generator. Normalize the result by dividing the squared magnitude by the number of samples multiplied by the sampling period.

Template Analysis

The Template functions allow users to isolate abnormal ECG signals within the recording. Select a representative ECG complex to create the template and let the software determine the template’s Correlation, Convolution, Mean Square Error or Inverse Mean Square Error with respect to the entire recording.
Run the Peak detector over the Template function results to quickly locate abnormal complexes within a large data file.

**Ventricular Late Potentials**

Ventricular Late Potentials (VLPs) are small-amplitude, short-duration waves that occur after the QRS complex and are precursors to cardiac arrhythmias. VLPs are detected through the application of signal averaging on the ECG signal. To perform a VLP measurement on an ECG recording, use the AcqKnowledge off-line averaging function to trigger on the R-wave peaks and to average the time delta of 20ms to 200ms after each peak’s occurrence. Use the measurement tools to calculate the duration and RMS values of the VLPs.

**Automatic Data Reduction**

Use the powerful data reduction function to reduce large (24-hour) data files to manageable sizes. Select the appropriate measurements and enter the desired time period—the software will automatically analyze the data and enter the values into a Journal file or display them as new data channels. Analyze both primary signals (such as arterial blood pressure) and derived data (such as Systolic BP). The summarized data in the Journal file can be automatically displayed within AcqKnowledge for access to a range of analysis and measurement tools for further refined analysis.
CARDIOVASCULAR HEMODYNAMICS FEATURES

On-line Analysis

Q25 Sophisticated algorithms will record and analyze, on-line, a variety of hemodynamic signals. The calculation channels process raw hemodynamic data to provide meaningful parameters on a beat-by-beat basis. The result of one calculation can be fed into another calculation channel to provide sophisticated multi-level analysis.

ECG Analysis

Q20 Collect ECG data from one-, three- or multi-lead montages. Investigate heart rate variability with the on-line R-R interval calculator. Use the powerful ECG averaging function to evaluate changes in the ECG complex before, during and after exercise or dosing. Combine ECG data with other parameters to perform a complete physiological examination. Apply the Template functions to isolate certain phenomena within the ECG recording and analyze data over user-defined time periods with the automated data reduction function. Compare waveforms, find peaks and perform complex analyses in real time or after data collection.

LVP

Q28 Calculate and record LVP data from acute, chronic and isolated heart preparations. Interface with a variety of invasive transducers, including the popular series of Millar Mikro-Tip™ Catheters.

Blood Pressure

Q26 Record continuously for short- and long-term single- and multi-animal studies (24+ hours), or pre-program to record for specific time periods and dosing schedules. The software provides a detailed, beat-by-beat analysis of blood pressure signals. Powerful automatic data reduction tools reduce large data files into manageable sizes. Extract a variety of values over user-defined time periods.

AcqKnowledge can provide mathematically precise mean blood pressure via the arithmetic mean calculator from the Rate function, or can estimate mean arterial pressure via the following MAP formula in the Equation Generator:

\[ MAP = \frac{[2 \cdot \text{Diastolic} + \text{Systolic}]}{3} \]
Pressure Volume Loops

Flexible graphing capabilities let users display data in a variety of formats (Chart, Scope or X/Y); simple toolbar icons make it easy to switch between display modes. For example, use the X/Y mode to plot Left Ventricular Pressure against Myocardial Wall Thickness, or any other data channel.

Blood Flow

Q27 Interface with an array of flow meters, including ultrasonic, electromagnetic, and the LDF100C Laser Doppler Flow module. The software will provide beat-by-beat, on-line analysis for acute, chronic and in-vitro preparations. Take full advantage of the data reduction features in AcqKnowledge to summarize large data files.

Automatic Data Reduction

The powerful data reduction function will reduce large (24-hour) data files to manageable sizes. Select the appropriate measurements (Max, Min, Mean, Std Dev, Delta, Pk-Pk, Time of max, Time of min) and the summary time delta—the software will automatically analyze the data and enter the values into a Journal file and display them as new data channels. Analyze both primary signals (such as arterial blood pressure) and derived data (such as Systolic BP). The summarized data can be automatically displayed within AcqKnowledge for full access to all the analysis and measurement tools for further refined analysis.

Automatically Control Other Equipment

The MP System will interface with a wide variety of devices such as pumps, valves, stimulators and switches. The MP System has 16 digital I/O lines that can be manually or automatically controlled from within the software. Use the on-line Calculation and Control channels to automatically trigger devices to turn on and off.

Interface with Existing Equipment

MP Systems will interface with a wide variety of third-party equipment such as flow meters, force plates, sonomicrometers, telemetry equipment, transducers, amplifiers, metabolic carts, and bedside monitors. BIOPAC offers two interface solutions: isolated for human use and non-isolated for animal and in vitro applications. See the Amplifiers & Interfaces application.

Automate Acquisition Protocols

Automatically trigger pre-programmed trials to record the data around dosing periods, 24 hours a day, seven days a week. Record continuously (24+ hours) or pre-program to record for specific time periods and dosing events. The system will accept outputs from other equipment to provide automatic event marking during hemodynamic experiments.

Create Standard Operating Procedures

Save customized algorithms and display settings to a Template file. Tailor the menu displays by removing options and use the Journal to display specific procedural instructions for Standard Operating Procedures.

MRI Applications

New (EL254-RT and EL258-RT) carbon fiber lead electrodes provide high quality signals without interfering with the MRI. Add an ECG alarm (OUT102) for an audible reference of the subject’s heart rate while in the imager.

Defibrillation & Electrocautery

Use the MEC111C Module Extension Cable to protect the MP System amplifiers against high frequency currents.

Visit the online support center at www.biopac.com
Noninvasive Cardiac Output Measurement

Cardiac Output can be determined, noninvasively, by employing electrical bioimpedance measurement techniques with the EBI100C. With pairs of electrodes attached to the neck and torso, the EBI100C can isolate the base $[Z(t)]$ and delta impedance (dZ/dt) values, which vary as the heart pumps blood. Determine dZ/dt maximum and BPM on a cycle-by-cycle basis, in real time. Simultaneously identify aortic valve opening and closing times with the DA100C and the TSD108. To compute Stroke Volume and Cardiac Output on-line, combine data from these various sources with the Equation Generator.

EGG: ELECTROGASTROGRAM FEATURES

EGG can be recorded cutaneously with disposable or reusable surface electrodes, or with needle electrodes or custom electrode arrays for direct smooth-muscle measurements of the stomach, small intestine and colon. For measurements inside layers of smooth muscle tissue, use the EL450 Teflon®-coated needle electrodes.

Up to 16 EGG100C amplifiers can be used simultaneously to record surface or subcutaneous signals. JUMP100C jumper connectors are used to reference amplifier inputs to satisfy any combination of monopolar or bipolar recording modes.

Invasive/Noninvasive Electrode Measurements

The EGG100C amplifier can be used to isolate elements of the gastrointestinal system for recording, through the use of either surface or needle electrodes.

Gastric Myoelectric Activity

The normal stomach generates a myoelectric signal (EGG) that oscillates with a period of three cycles per
minute. The EGG can be measured noninvasively by using the EGG100C amplifier and standard leads with disposable electrodes. After the data is recorded, the signal median frequency and power spectral density can be determined using AcqKnowledge. This type of signal processing is useful for evaluating abnormal gastric rhythms, such as tachygastria or bradygastria. It’s also possible to evaluate the EGG signal using the phase-space techniques associated with non-linear dynamics. Plotting EGG rate against a delayed version of itself in X/Y mode can point to patterns not otherwise evident in the time series data.

**Gastric Slow Wave Propagation**

The gastric slow wave (ECA) originates in the proximal stomach and propagates distally towards the pylorus. For recording, place multiple surface electrodes on the abdomen along the gastric axis and connect them to respective EGG100C amplifiers that have a common reference electrode placed near the xiphoid process. For consistent electrode-to-electrode spacing, use the EL500 dual electrodes with LEAD110 leads. For extremely tight electrode-to-electrode spacing, use the EL254 or EL258 reusable Ag-AgCl lead electrodes. The signals amplified at each electrode will be displayed on consecutive channels in AcqKnowledge. For manual measurements, use the cursors to evaluate waveform differences. For automated timing analysis, run the Peak time detector on one channel and search the remaining channels for their respective peak times. To verify the delta time consistency, automatically calculate the difference in peak times between the channels.

**Gastrointestinal Motility Analysis**

The ECA and ERA components of the EGG can be isolated using the digital filters in AcqKnowledge. To isolate the ECA (slow wave) component, apply a 0.1 Hz low-pass filter to the EGG data. To filter out the ERA component, which consists of spike bursts present on the plateaus of the ECA signal, run a 0.5 Hz high-pass filter. Perform filtering in real time as the EGG is recorded, or in post processing, after data has been collected.

**Peristaltic (Slow Wave) Propagation**

Peristaltic electrical signal propagation can be recorded using monopolar or bipolar recording techniques with the EGG100C and AcqKnowledge. To derive either long or short distance bipolar data, configure the amplifier to record with a common reference (monopolar) and then use the software to subtract one monopolar channel from another. After data collection, use the peak detection algorithms present in AcqKnowledge to analyze the time shifts between propagated signals on different channels.

**Migrating Myoelectric Complex**

A histogram of the migrating myoelectric complex (MMC) can be extracted from bipolar EGG recordings. Use AcqKnowledge to perform peak-to-peak measurements on slow waves (ECA) automatically. The resultant cyclic peak data can be presented in histogram form to illustrate the presence or absence of spikes (ERA).

**Animal Studies**

The EGG100C amplifier, when used with standard needle or fine-wire electrodes, will record invasive EGG measurements on animals, directly on the tissue of the
component organs of the gastrointestinal system. To record peristaltic propagation on the small intestine, create a custom electrode array using a soft-spring plastic clip with leads of silver wire looped at the desired recording sites and terminate the silver wire leads with a Touchproof socket for connection to the EGG100C. This type of electrode array has fixed and very repeatable electrode-to-electrode spacing.

**Automatic Data Reduction**

The powerful data reduction function will reduce large (24-hour) data files to manageable sizes. Select the appropriate measurements (Max, Min, Mean, Std Dev, Delta, Pk-Pk, Time of max, Time of min) and the summary time delta—the software will automatically analyze the data and enter the values into a Journal file and display them as new data channels. Analyze both primary signals (such as direct EGG) and derived data (such as the ECA component). The summarized data can be automatically displayed within AcqKnowledge for full access to all the analysis and measurement tools for further refined analysis.
CONTINUOUS NONINVASIVE BLOOD PRESSURE FEATURES

Psychophysiology

AcqKnowledge will extract beat-by-beat systolic, diastolic and mean blood pressure data from the raw blood pressure waveform. Simultaneously, data can be collected from ECG, EOG, EMG, RSP, GSR and SKT amplifiers. The Equation Generator can be used to algorithmically combine various channels to generate an indicator when the subject manifests a specific physiological state. Examine the startle response of beat-by-beat blood pressure along with eye blink measurements. Use AcqKnowledge to produce a short noise burst or click and direct the signal to the STM100C to drive the OUT100 headphones. Record the physiological changes in direct response to the sound burst.

Neurology Research

Nervous system functions such as sudomotor axon reflex, vasomotor, cardiac-vagal and adrenergic functions can be indicated with measurements such as beat-by-beat blood pressure, electrodermal response, skin temperature, ECG and respiration.

Cardiology Research

To indicate systemic vascular resistance on a beat-by-beat basis, combine blood pressure data (via NIBP100) with cardiac output data (via EBI100C). Use the Equation Generator to determine vascular resistance as blood pressure divided by blood flow. For blood pressure measurements, AcqKnowledge can provide mathematically precise mean blood pressure via the arithmetic mean calculator from the Rate function, or via the following MAP formula in the Equation Generator.

\[
\text{MAP} = \frac{(2 \times \text{Diastolic}) + \text{Systolic}}{3}
\]
**Autonomic Testing**

During certain activities, elements of the autonomic nervous system can be tested by simultaneously measuring beat-by-beat blood pressure, ECG and end-tidal CO₂. These activities include the tilt table test, deep breathing test and the Valsalva maneuver. For example, upright position angles of greater than 30 degrees (on the tilt table) usually activate the sinoaortic baroreflex, which is essential for the maintenance of blood pressure and cerebral perfusion while standing.

**Long-term Monitoring**

The NIBP100 can be attached to a subject for an extended period, due to its novel tonometric measurement technique, which, unlike the auscultatory and oscillometric techniques, does not restrict the subject’s blood flow.

**Orthostatic Testing**

Blood pressure varies based on the subject’s physical orientation in a gravitational field. The NIBP100 can be attached to a subject placed on a tilt table. Use TSD109 accelerometers to determine the exact tilt in all three spatial dimensions and record the X, Y and Z accelerometer signals simultaneously with the varying blood pressure signal.

**Automatic Data Reduction**

The powerful data reduction function will reduce large (24-hour) data files to manageable sizes. Select the appropriate measurements (Max, Min, Mean, Std Dev, Delta, Pk-Pk, Time of max, Time of min) and the summary time delta—the software will automatically analyze the data and enter the values into a Journal file and display the data as a new channel. Analyze both primary signals (such as blood pressure) and derived data (such as Systolic BP). The summarized data can be automatically displayed within AcqKnowledge for full access to a range of measurement tools for further refined analysis.
IN VITRO PHARMACOLOGY FEATURES

Tissue Bath Monitoring

**Q32** Record and analyze tissue bath preparations. The TSD105A and TSD125 Series force transducers work down to the milligram range and will record responses from small aortic rings to much larger preparations. Interface with a wide variety of tissue bath stations and force transducers. Use the keyboard/mouse event marking system, or utilize one or two of the 8-channel digital marker boxes to precisely identify drug additions and wash cycles. Use the software to compare responses and analyze the data on-line for fast and efficient protocol management. The system will even allow users to trigger valves to control wash cycles and other devices during recording.

**Pulsatile Tissue Studies**

**Q33** Automatically analyze pulsatile tissue data with the on-line calculation channels. The calculations will provide real-time values for maximum, minimum, peak-to-peak and the area under the curve for each response. To assist in identifying trends within the data, the measured values are displayed on the screen as new data channels. The Peak detection function will allow users to perform the same analysis off-line. The software will automatically measure the maximum, minimum, peak to peak and area for each response and paste the values into the Journal file. The data is easily exported to third-party statistical packages for further analysis.

**Langendorff & Working Heart Preparations**

**Q34** Interface with flow meters, fluid-filled balloon-tipped catheters and pressure-tipped catheters to monitor flow rates and left ventricular pressure. Perform a variety of LVP measurements, both on- and off-line. Use the built-in stimulator to pace the heart. Powerful automatic data reduction tools reduce large data files into manageable sizes and can extract a variety of values over user-defined time periods. Record continuously for short- and long-term studies (24+ hours), or pre-program to record for specific time periods and dosing events.

**Isolated Lung Studies**

**Q35** Calculate tidal volume, airway resistance and dynamic compliance, and monitor temperature, pressure, pH, and pO2. Automatically control a ventilator to start and stop during an experiment. Record and analyze flow and pressure signals on-line. The real-time Integration function has a unique feature that will provide accurate volume measurements even if the flow transducer’s baseline is drifting. Use the on-line calculation channels.

On-line Analysis

Use AcqKnowledge to automatically analyze the peak response to a drug and enter measurement results into the Journal for further analysis. Record the absolute peak response or the mean peak response over a user-defined time period. The mean peak response function prevents sudden spikes from swamping the measurements.
for advanced measurements and monitor a variety of pulmonary values such as compliance and resistance.

**Field Potential Measurements**

To perform field potential measurements, position electrodes around the isolated tissue or organ and use the MCE100C to record the potential. Each MCE100C can record a single differential potential. Multiple MCE100C amplifiers can be configured for unipolar (common reference) or bipolar (multiple reference) recordings. Up to 16 channels of field potential data can be collected simultaneously. Measurements can be performed synchronously with external voltage or current stimulators.

→ *See also:* Field Potential in the Micro-electrode Recording section.

**Automatic Data Reduction**

Use the powerful data reduction function to reduce large, 24-hour files to a manageable size, ready for further statistical analysis. Select the appropriate measurements and enter the desired time period, and the software will automatically analyze the data and enter the values into a Journal file and display them as new data channels. Analyze both primary signals (such as arterial blood pressure) and derived data (such as systolic BP).

**Control Pumps and Valves**

Control up to 16 digital I/O lines to interface with valves and pumps. Trigger devices manually from the keyboard, or automatically as pre-defined events occur. Turn pumps on and off or set an audible alarm to sound when a signal falls within or outside a user-defined range.

**Interface with Existing Equipment**

The Transducer Connector Interfaces (TCIs) interface the DA100C with transducers from other manufacturers such as Grass, Gould, Beckman, Viggo-Spectramed, etc. The MP System also provides direct connection to any equipment with an analog output, using the appropriate connection cable to the UIM100C. See the Amplifiers & Interfaces application.
LASER DOPPLER FLOW FEATURES

Applications

- Cerebral Blood Flow
- Rheumatology
- Allergies
- Irritants & Inflammation
- Planted Tissue
- Data Analysis
- Data Reduction
- Micro-circulation Studies
- Tumor Micro-perfusion
- Invasive & Endoscopic Blood Flow
- Microangiopathy Investigations
- Venous Insufficiency
- Burn Healing
- Stroke Models
- Metabolic Studies
- Iontophoresis Monitoring
- Multi-channel Options

Advantages of Laser Doppler Flowmetry

Principally, Laser Doppler Flowmetry (LDF) makes use of the fact that when a coherent, low-powered laser illuminates tissue, light is scattered in static structures as well as in moving blood cells within the microcirculatory beds. Photons, scattered by the moving blood cells, are spectrally broadened according to the Doppler effect. LDF is established as an effective and reliable method for the measurement of blood perfusion in the microvasculature because LDF provides continuous, noninvasive and real-time measurement capabilities.

LDF offers substantial advantages over other methods in the measurement of microvascular blood perfusion. Studies have shown that it is both highly sensitive and responsive to local blood perfusion and is also versatile and easy to use for continuous subject monitoring. The laser Doppler technique is strictly noninvasive (the probe is not actually required to touch the surface of the tissue) and in no way harms or disturbs the normal physiological state of microcirculation. Furthermore, the small dimensions of available probes enable them to be employed in experimental environments not readily accessible using other techniques.

Cerebral Blood Flow

Laser Doppler monitoring of cerebral blood flow can be performed with many different types of fiber-optic probes, dependent on the size and location of the area to be investigated. To measure subcutaneous microvascular blood flow, use needle (TSD144, TSD145) or disposable fiber (TSD147A, TSD147B) probes. For cutaneous measurements, use surface (TSD140, TSD141, TSD146) or suturable (TSD143) probes.

Rheumatology

Research the micro-vascular blood flow changes resulting from different rheumatic disorders, such as rheumatoid arthritis, Raynaud’s phenomenon and connective tissue disease. For investigations of Raynaud’s phenomenon, use the digit probe (TSD142). To assess ischemia of the small intestine, use needle probes (TSD144, TSD145).
Allergies

The nasal skin and mucosa are often subject to allergic reaction. To evaluate micro-vascular blood flow of the skin, standard surface probes (TSD141, TSD146) are suitable. To perform measurements on the nasal mucosa, use needle probes (TSD144, TSD145) with the appropriate clamp.

Irritants & Inflammation

Evaluate skin reactions resulting from hypersensitivity and inflammatory mediators. To measure micro-vascular blood flow on the skin surface, use the TSD140, TSD141 or TSD146 probes. To objectively quantify the flow changes resulting from inflammation, take a real-time measurement of the mean or median value of the LDF100C flow signal.

Planted Tissue

Flaps and planted tissues typically exhibit changes in blood flow after the planting procedure. The MP System can be programmed to control a visual or auditory alarm if the mean or peak-to-peak blood flow signals from the LDF100C drop below a specified level. Use AcqKnowledge to isolate pulsatile signals and evaluate the peak-to-peak values in real time.

Data Analysis

The software will provide full on-line analysis of pulsatile flow data for each cardiac cycle. Use the automatic data reduction function to determine statistical measurements over a user-defined time period.

Data Reduction

Use the data reduction function to reduce large data files to a manageable size for further statistical analysis. Select the appropriate measurements and enter the desired time period—the software will automatically analyze the data and enter the values into a Journal file and display the data as a new channel. Analyze both primary signals (such as blood flow) and derived data (such as max flow).
MICRO-ELECTRODE RECORDING FEATURES

Applications

• General microelectrode signal amplification
  • Single/Multiple Cell Recording
  • Brain Slices
  • Smooth, Skeletal, Cardiac Muscle
  • Corneal / Retinal Potentials
  • Cortical, Muscle & Nerve Action/Resting Potentials
  • Extra- / Intra-cellular Signal Amplification
  • Cell Transport/Ussing Chamber Measurements
• Current Clamping
• Field Potential Measurements
• Tissue Conductance Measurement
• Ion-selective Micro-electrode Interfacing
• Iontophoresis
• Single Channel Analysis
• Hardware Flexibility

General micro-electrode signal amplification

The MCE100C microelectrode amplifier is designed to work with a wide range of microelectrodes in a variety of measurement applications. To record biopotentials, use standard reusable or disposable Ag-AgCl electrodes or needle electrodes. For cellular measurements, interface the MCE100C with etched metal electrodes, micropipette and metal film-coated electrodes. The MCE100C can be configured to support a range of electrode signal input compensation requirements.

To maintain a high frequency amplifier response, two input capacity compensation methods — Driven Shield Compensation and Negative Capacity Generation — can be optionally applied for recording. Employ the compensation methods simultaneously or ground the input shields (to reduce noise) and then apply Negative Capacity compensation to counter the effects of the shield and/or electrode capacitance.

Cell Transport/Ussing Chamber Measurements

For certain applications, the MCE100C can perform cell transport measurements. Typically, these applications require the use of a small current applied through a pair of electrodes. By monitoring the voltage change across the electrodes it’s possible to assess aspects of cellular motility. Using AcqKnowledge, standard or arbitrary current (up to 100nA) wave shapes can be output using the MCE100C. Current signals can be output simultaneously with recording.

Current Clamping

Q36 The MCE100C has an integral current clamp feature that is controlled via an applied voltage signal (100mV/nA), which can be employed during recording at the user’s discretion. Clamp current can be monitored simultaneously with microelectrode signal recording, and the current can be changed during recording with the synchronous output of a stimulus voltage waveform.

Visit the online support center at www.biopac.com
**Field Potential Measurements**

Field potential measurements can be performed using the MCE100C with electrodes positioned around the preparation. Each MCE100C can record a single differential potential. Multiple MCE100C amplifiers can be configured for unipolar (common reference) or bipolar (multiple reference) recordings. Up to 16 channels of field potential data can be collected simultaneously. Measurements can be performed synchronously with external voltage or current stimulators.

**Tissue Conductance Measurement**

Tissue conductance measurements can be performed with the MCE100C using either AC or DC excitation currents. Use surface, needle or microelectrodes to interface to the tissue. Use four electrodes to perform standard tetrapolar measurements—two to drive current and two to monitor voltage. Monitor the excitation current using the current monitor output. For tissue conductance, use the Equation Generator to divide the current signal by the monitored voltage. For tissue resistance, invert the tissue conductance. The MCE100C can measure tissue resistances between 1,000 and 10,000,000 ohms.

**Ion-selective Micro-electrode Interfacing**

To perform potentiometric measurements using electrochemical cells, record voltages with nearly zero current flow. Use ion-specific electrodes to isolate a change in the respective ion concentration in the test solution. To determine ionic activity, use the Equation Generator in AcqKnowledge to implement the Nernst equation.

**Iontophoresis**

Iontophoresis is a method of inducing ionic drug solutions to pass into tissue by the application of a small electrical current. Use the MCE100C to inject precise amounts of current (up to 100nA) into the tissue during signal acquisition; use the recording electrodes or a separate stimulating electrode to inject the current. To specify the shape, amplitude, duration and repetition rate of the current control waveform, use the Stimulator Setup dialog in AcqKnowledge.

**Single Channel Analysis**

Q37 Use the amplitude histogram function in AcqKnowledge to inspect the raw data from a single ion channel to determine if multiple channels are present, and use the threshold function to create an events list from the raw single channel data. Apply the rate detector to the events list to determine individual event area (duration) and then histogram the results to obtain the dwell time histogram. To calculate first latency histograms, bin the time delta between the stimulus onset and the first opening.

**Hardware Flexibility**

Use the MCEKITC to interface a variety of microelectrode cables to the MCE100C amplifier. For your pre-existing setup, choose an appropriate Analog Connection Cable to connect your microelectrode amplifier to the MP System.
PULMONARY FUNCTION FEATURES

Lung Volume Measurement

Q38 To record inspired and expired air flow, choose an air flow transducer appropriate to the flow rates expected from the subject and connect the transducer to the DA100C amplifier. BIOPAC offers a wide variety of air flow transducers to cover applications ranging from high-flow exercise physiology measurements to low-flow animal studies. Integrate the air flow associated with a maximal inspiration and expiration to obtain the Forced Vital Capacity (FVC) measurement. Determine Tidal Volume (TV) on a breath-by-breath basis by using the AcqKnowledge rate detector. To determine the inspiratory capacity (IC), inspiratory reserve volume (IRV) and expiratory reserve volume (ERV) in the same recording, use the Equation Generator to derive them from the FCV and TV measurements.

Forced Expiratory Flow & Volume

The forced expiratory flow (FEF) is a measure of the average flow over specified portions of the spirometry curve. The spirometry maneuver requires the subject to inhale to total lung capacity and then exhale forcefully to residual volume. Integrate FEF to obtain forced expiratory volume (FEV). AcqKnowledge generates the spirometry curve via an X/Y plot of expired volume versus expired flow. The FEF values can be measured directly on the spirometry curve at the standard 25%, 50% and 75% volume points. To evaluate FEV, use AcqKnowledge to present the spirometry curve data as a function of time. To determine FEV0.5 and FEV1.0, place time cursors 1/2 second and one second after the start of expiration, respectively.

Volume/Flow Loop Relationships

Easily compare normal tidal breathing loops to maximum breathing loops by using the X/Y mode to plot flow versus volume. This graphical representation clearly indicates the subject’s reserve capacity in relation to normal breathing. AcqKnowledge can also be used to automatically determine the breath-by-breath volume/flow loop area as a function of time.

Visit the online support center at www.biopac.com
Automatic Data Reduction

Powerful automatic data reduction tools reduce large data files into manageable sizes. The data reduction tools can extract a variety of concise measurements from very long data recordings. For example, it’s possible to extract the mean tidal volume from consecutive 30-second periods. Record continuously for short- and long-term studies (24+ hours), or pre-program to record for specific time periods and dosing events. Automatically trigger pre-programmed trials to record the data around dosing periods, 24 hours a day, seven days a week.

Animal studies

The MP System will interface with a variety of pulmonary function chambers to provide detailed on-line analysis of pulmonary function data. Use the TSD160 Series pressure transducers to record plethysmogram chamber pressure. A large selection of very low flow pneumotachs (TSD137 Series) covers a wide range of air flow rates. The software will record the primary pressure and flow signals while on-line calculation channels integrate the flow signal and calculate resistance, compliance, respiration rate, and peak inspiratory and expiratory flow.
EXERCISE PHYSIOLOGY FEATURES

Respiratory Exchange Ratio

Q39 The Respiratory Exchange Ratio (RER) is determined by dividing $VCO_2$ produced by $VO_2$ consumed. The measurement is very similar to the setup required for $VO_2$ consumption, except that the produced $CO_2$ flow is integrated simultaneously with the consumed $O_2$ flow. The RER can be presented in real time, with values representing the running average of RER for the last (user-specified) number of seconds. Save the graphical RER waveform as text to create tabulated RER data; tabulated data can easily be ported to other applications.

End-tidal $CO_2$

To measure end-tidal $CO_2$ on a breath-by-breath basis, use the AFT20 gas sampling interface kit to connect the CO2100C module directly to the sampling port on the AFT25 facemask. Use AcqKnowledge’s rate detector to find the peak of the cyclic $CO_2$ concentration signal. The running peak value represents the breath-by-breath end-tidal $CO_2$.

$VO_2$ Consumption

Oxygen consumption measurements nominally incorporate the use of a mixing chamber (AFT15A/B), facemask with non-rebreathing T valve (AFT25) and an air flow transducer (TSD107B). Typically, air flow measurements are performed on the inspiration side of the AFT25. The expiration side is directed to the AFT15, where $O_2$ and $CO_2$ concentrations are monitored using the O2100C and CO2100C, respectively. Use the Equation Generator in AcqKnowledge to perform the Haldane transformation and STP corrections. The final result can provide real-time oxygen consumption measurements, permitting precise determination of $VO_2$ maximum, deficit, and post-exercise $VO_2$ consumption.
Anaerobic Threshold

The relationship between ventilation and oxygen uptake becomes non-linear above the anaerobic threshold. This threshold can be determined by establishing a ratio of inspired volume and VO$_2$ consumption. Use AcqKnowledge to integrate the airflow signal to obtain total inspired volume in real time. Divide the identically integrated O$_2$ consumption flow signal by the inspired volume; the resultant value will be constant to the point of anaerobic threshold. After the threshold is reached, this value starts to drop.

Breath-By-Breath Respiratory Gas Analysis

For breath-by-breath gas analysis, it’s important to identify the response time of the gas measurement modules. Because the modules sample the inspired and expired air stream directly from the subject, without a mixing chamber to average the gas concentration levels, the modules are required to track quickly varying concentration levels. When fully optimized, the O2100C and CO2100C modules can achieve response times on the order of 200ms and can thus track breathing rates approaching 105 BPM. To enhance a module’s response time, run the module at a higher air sampling flow rate and use AcqKnowledge to create a summed derivative filter.

Noninvasive Cardiac Output

Cardiac Output (CO) is typically determined just prior to and after exercise. Due to mechanical modulation of the electrode/skin interface, vigorous exercise can introduce considerable artifact into the thoracic impedance measurement performed by the EBI100C. You can employ digital filtering techniques and signal averaging to help isolate the dZ/dt signal during exercise. One possibility is to average the dZ/dt signal by synchronizing the averaging function with the ECG R-wave; reduce random noise in the dZ/dt waveform by increasing the number of averages.
EMG FEATURES

Median & Mean Frequency Analysis
Analysis of EMG signals in the frequency domain can provide useful insight into the nature of the EMG data. The frequency spectrum data may be used to generate other measures associated with EMG frequency analysis. Select an area of EMG data and use the Fast Fourier Transform function to perform a linear magnitude FFT on the selected data, and then integrate the result to determine the median and mean frequency. AcqKnowledge can be used to calculate these parameters after the EMG data has been collected.

EMG Power Spectrum Analysis
A common tool for investigating the EMG is the Power Spectrum Density (PSD). Use AcqKnowledge to compare responses from one part of the recording to the next. Calculate the PSD by squaring the linear FFT magnitude.

Integrated (RMS) EMG
Q40 Calculate the integrated EMG envelope on- and off-line. The integration function incorporates an RMS (Root Mean Square) feature set to operate over a user-specified number of samples. Adjust the RMS time constant by increasing or decreasing the number of samples used to perform the integration. The number of samples used in the RMS integration divided by the sample rate is proportional to the time constant of the integration.

EMG and Force
Q41 For in-depth studies of muscle work and fatigue, use the EMG100C amplifier with a hand dynamometer (TSD121C). The software will display the force measurements (calibrated in pounds or kilograms) as well as the raw and integrated EMG data. It’s possible to simultaneously measure EMG with signals from force plates, load cells, and pressure transducers.

Visit the online support center at www.biopac.com
Active Electrodes & Fine Wire EMG

The TSD150 Series of active electrodes interface with the HLT100C High Level Transducer interface module. The TSD150 electrodes have built-in amplification, which allows the subject to be a greater distance from the recording equipment. The TSD150 will record both surface and fine wire EMG. The transducers are easily adapted to fine wire recording by unscrewing the surface electrode pads and attaching spring clamps (included with each TSD150).

Automatic Spike Counting

The Peak Detection features let users automatically analyze raw EMG spike data. Select the desired measurements and the software will calculate the values for each spike in the data file or within a selected area. This analysis can also be performed over pre-defined time intervals—enter a time interval and the software will run through the file, analyze the data, and enter the results into a Journal file and display the data as a new channel.

Histogram Analysis

Use the Histogram display features to identify trends within the EMG data. Select an area of data, or the entire data file, and the Histogram feature will bin the values into their appropriate amplitude ranges. The software will automatically determine the display range and the number of bins, or you can set them manually. Histogramming highlights differences in the EMG when the muscle is under a variety of loads and conditions.

Facial EMG & Startle Response

Q11 Use the STM100C stimulator and the MP System Control channels to perform multiple stimulus paradigms. Present a pre-defined auditory stimulus or stimulate the subject based on the result of a physiological response. Use the EMG amplifier to record facial EMG (eye blinks) and set the software to integrate the signal on-line. Calculate the time and amplitude of the response using the measurement tools. Automate analysis with the Peak Detection features and display the results as a new channel.

Interface with Imaging Equipment

The MP System can be synchronized with imaging systems (MRI, video capture, etc.). An imaging system can be used to trigger the recording or, alternatively, the MP System can be used to trigger the imager.

Single-fiber EMG

Record and analyze single-fiber potentials with a concentric needle electrode (EL451). Set the EMG100C to a 100 Hz - 5 kHz recording bandwidth. For improved rejection of low frequency background activity of distant fibers, run the data through a real-time 500 Hz HP filter in AcqKnowledge.

Motor Unit Action Potential

The motor unit action potentials (MUPs) are the summation of all single-fiber potentials innervated. Evaluate wave shapes of MUPs and measure amplitude, rise time and duration using the EMG100C with concentric needle electrodes (EL451).
BIOMECHANICS FEATURES

Gait Analysis

\textbf{Q42} Simultaneously acquire up to 16 channels of gait-specific data. One setup might incorporate two channels for heel/toe strike timing, ten channels for EMG signals and four channels of goniometry data. When using a force plate, the six force and moment signals are sent directly from the force plate amplifier to the UIM100C via standard analog cables, leaving ten channels for additional signal recording. Event markers let users log important events in the data and include comments during or post acquisition.

Range of Motion

\textbf{Q44} All parts of the body can be evaluated for range of motion. Goniometers are available for evaluating one or two degrees of freedom from the same joint (e.g. wrist flexion/extension and radial/ulnar deviations). Use the X/Y plotting feature to inspect motion resulting from two degrees of freedom. Place torsiometers along the spine to measure twisting along the spinal axis. To determine maximum extension and flexion of the digits, place miniature goniometers on the back of fingers. Determine velocity of motion by using AcqKnowledge to perform a derivative on the recorded movement data, and then run a second derivative on the data to calculate acceleration.

Isometric Contraction

Isolate a wide range of muscle groups and evaluate their isometric contraction characteristics for performance quantification. Configure the TSD121C hand dynamometer to measure handgrip force or a wide range of pulling forces. To measure pulling forces, secure the dynamometer to a fixed surface, then connect a tether between the dynamometer and the muscle group under investigation. If the exerted force will exceed 100kg, use pulleys to attenuate muscle forces to less than 100kg. For additional insight, acquire EMG data during isotonic force measurement.

Isotonic Contraction

Examine muscle groups for isotonic performance by placing the TSD109 accelerometer on a target limb actively hoisting weights of specific sizes. The accelerometer records the precise time the weight moves, and the subsequent acceleration of that movement. For isometric to isotonic transition investigations, use the TSD121C Hand Dynamometer with the Dynagrips option. Place the dynamometer in-line between the weight to be hoisted and the target limb.

Visit the online support center at www.biopac.com
As the weight is lifted, the hand dynamometer will measure the applied lifting and transition forces, while the Accelerometer indicates the transition timing.

**Ergonomics Evaluation**

Body position and posture can be analyzed over a wide range of static and dynamic conditions and these measurements can be used to determine the ergonomic characteristics of a specific work activity or environment.

To reliably record head tilt with respect to the X-, Y- and Z-axes simultaneously, place a TSD109 accelerometer on the head. To directly measure adequate bending in the knees or unsafe rounding in the lower spine, use goniometers.

**Synchronize with Video Capture**

There are several ways to synchronize motion analysis equipment employing video capture with the MP System.

1) The video capture system can send a TTL trigger start pulse to the MP System.
2) The vertical sync pulse from the camera can be directed to an unused analog input and then AcqKnowledge’s peak counter can compare the exact video recording time to the other data channels recorded by the MP System.
3) The MP System can send a synchronizing trigger to the video capture system.

**Remote Monitoring**

For biomechanical measurements, the recording cables attached to the subject must be durable but unobtrusive. The TEL100C remote monitoring module set supports an extremely wide range of biomechanical measurements, with minimal cable hindrance and maximal motion flexibility. With the appropriate Smart Sensor, the TEL100C can perform the same recordings as standard amplifiers and transducers when using an MP System.

The TEL100C can be located up to 60 meters from the recording computer—data is transmitted to the MP System using a single, lightweight, coaxial transmission cable.

Each TEL100C will amplify up to four channels of data and the input channels automatically configure themselves for the type of Smart Sensor plugged into the amplifier/transmitter. See the Smart Sensors.
REMOTE MONITORING FEATURES

Biomechanics Measurements

The TEL100C has four universal amplifiers that allow the recording of a variety of biomechanical data. Goniometers (SS20 Series), accelerometers (SS26 & SS27), and heel/toe strike transducers (SS28) will interface with the TEL100C system. Maximum acceleration, angle of limb movement, and the time of heel and toe strikes can be calculated in real time.

The software will display and analyze data while the subject is walking or running (up to 60 meters away from the MP System). For detailed studies, include biopotential signals, such as EMG or ECG, and force measurements (via SS25). While collecting data from the TEL100C, the MP System can simultaneously interface with a variety of video monitoring systems and force plates.

Exercise Physiology

The TEL100C works efficiently with subjects performing anaerobic exercises because it eliminates the masses of cabling usually attached to the subject. The TEL100C module will record a wide variety of signals and AcqKnowledge will perform on-line analysis for an array of measurements. View data online, in real time, without waiting for data to download.

Visit the online support center at www.biopac.com
Simultaneous Monitoring

Monitor up to four subjects and display their data simultaneously. While subjects perform specified activities, record data and analyze it on-line. Each subject can be as far as 60 meters from the MP System, which can be useful for environmental monitoring or repetitive stress studies.

Subjects wear separate transmitter modules and can perform their daily routine with minimal interference, even as data is transmitted back to the MP System.

Use the TEL100C to record a variety of physiological signals, including EEG, ECG, temperature, GSR, and respiration. Use the data reduction tools in AcqKnowledge to automate and simplify the analysis process.

Automatic Data Reduction

Use the powerful data reduction function to reduce large data files to a manageable size for further statistical analysis. Analyze both primary signals (such as respiration) and derived data (such as respiration rate).

Select the appropriate measurement and enter the desired time period—the software will automatically analyze the data and enter the values into a Journal file and display the data as a new channel. The summarized Journal file can be automatically graphed within AcqKnowledge for full access to a range of measurement tools for refined analysis.
AMPLIFIERS & INTERFACES FEATURES

Connect to MP150 or MP100 Systems

The MP System, used with BIOPAC amplifiers, acts as a complete, fully isolated life science data acquisition system.

**Isolated Inputs & Outputs**

This option is highly recommended when interfacing third-party (non-BIOPAC) mains powered equipment to an MP System. Use the HLT100C module with INISO and OUTISO signal isolators to provide the interface. The INISO and OUTISO isolators plug directly into any of the 16 analog channels on the HLT100C module and incorporate a 3.5mm phone jack for signal input or output connections. Select the appropriate analog connection cable to connect to your external equipment.

**Non-isolated Inputs & Outputs**

When performing animal or in-vitro experiments with an MP System, and not electrically connecting to human subjects, signal connections to external mains powered equipment can be made through the UIM100C module and the corresponding connection cable (analog or digital).

**Interface with Third-party Transducers**

To use existing transducers with the DA100C General-purpose Transducer Amplifier, consider the Transducer Connector Interfaces (TCIs). The TCIs plug directly into the DA100C amplifier and present the appropriate mating connector to a wide variety of transducer types. For unusual transducers, use the TCIKIT to create a customized interface.

**Common Interface Connections**

To interface with the UIM100C, choose the BIOPAC cable that matches your existing connector type.

<table>
<thead>
<tr>
<th>Connector Type</th>
<th>Use BIOPAC Cable</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.5 mm mini-phone jack</td>
<td>CBL100</td>
</tr>
<tr>
<td>BNC female</td>
<td>CBL102</td>
</tr>
<tr>
<td>4 mm Double Banana jack</td>
<td>CBL102 with CBL106</td>
</tr>
<tr>
<td>1/4” phone jack (6.3mm)</td>
<td>CBL105</td>
</tr>
</tbody>
</table>

**Stand Alone Amplifiers**

BIOPAC amplifiers will connect to third-party data acquisition systems, oscilloscopes and chart recording equipment. Use the Isolated Power Supply (IPS100C) to power up to 16 BIOPAC amplifier modules. Snap amplifier modules onto the side of the IPS100C. Use CBL100 series cables to connect to amplifier outputs on the front panel of the IPS100C. The IPS100C is generally used with animal or tissue preparations. When using the IPS100C with amplifiers to collect data from electrodes attached to humans, include the HLT100C module with OUTISO signal isolators to couple signals to external equipment.

**Automatically Control Other Equipment**

The MP System will interface with a wide variety of devices such as pumps, valves, stimulators and switches. The MP System has 16 digital I/O lines that can be manually or automatically controlled from the AcqKnowledge software. Use the on-line Calculation and Control channels to automatically trigger devices to turn on and off.

Visit the online support center at www.biopac.com
INDEX

A
A/D boards (third party), 226
About MP100/150 (menu option), 116
Abs. See absolute value
Absolute mode, 105
absolute value, 76, 174, 186
AcqKnowledge, 22, 32–48
NEW FEATURES, 14
Acquire box, 35, 51
acquisition functions, 49
acquisition length, 36, 87
acquisition setup, 36
Acquisition setup, 55
alpha waves, 166, 192
amplitude scale, 27, 56, 107, 123
Analog
channels, 35, 55–56
output 0, 103
triggers, 95
Analysis functions, 121
Append mode, 82, 232
Application features, 242
Application Notes, 30
arbitrary scale, 217
arbitrary stimuli, 101
cosine, 76, 186
correlation, 177, 179
cosine, 76, 186
cosine, 76, 186
Area (measurement), 131, 208
Artifact rejection, 91, 198
Atan. See arc tangent
Attenuation, Manual Control, 112
Auditory Brainstem Response testing, 30
auto threshold detect, 209
Automated Tissue Bath Analysis, 31
autoplotting, 113
autosave, 92
Autosave file, 82
Autoscale
after transformations, 222
horizontal, 42, 214
waveform, 43
Average (moving), 59
Average over samples, Integrate option, 60
Averaging mode, 31, 36, 88–91
Averaging, off-line Find Peak option, 198
axis adjustment. See horizontal scale, vertical scale

B
band pass filter, 168
band stop filter, 168
base 10 logarithm, 76, 175, 186
baseline drift, 210
blood pressure analysis. See rate calculations
BPM, 67, 208
BPM (measurement), 132

C
Calculate (measurement), 132
Calculation channels, 35, 57–58
calibration, 55–56
center horizontal, 39
center vertical, 39
Channel
Channel boxes, 124, 218
Channel label, 124
Channel Sample Rate, 35, 36, 54
Channel setup, 35, 51, 55, 228
Chart mode, 218
Chart recorder output, 144
chooser, 158
clear, 159, 161
clear all, 161
clipboad, 130, 162–63
coefficients (FIR filters), 170, 229
Collecting data, 34
compare waveforms, 213
connect endpoints, 174
Constant (K)
Calculate measurement option, 132
Control channel
Calculation Channel, 78
Integrate option, 63
Find Peak Averaging option, 198
convolution, 179
copy, 159, 161
copy graph, 163
copy measurement, 162
copy wave data, 162
Correlate (measurement), 133
correlation, 177, 179
cosine, 76, 186
count peaks, 208
cursor functions (peak detector), 200
cursor tool, 125
customizing menu display, 233
cut, 159, 160
cutoff frequency, 169

**D**

Data collection, 34
data compression, 184
Delay
  Calculation channel option, 77
  Trigger Mode setting, 94
Delta, Delta F/S/T/X (measurements), 134
derivative, 180
Difference
  on-line calculation, 66
  transformation function, 182
Digital
  digital channels, 35, 57
digital filtering, 165–71, 230
digital I/O channels, Manual Control, 111
digital output, 78
digital triggers, 93
Disk (storage option), 36, 84, 232
Disk space, 24, 26, 36, 86, 150, 184
Display
  Display menu commands, 211
  Display modes, 38
  Display preferences, 232
  draft mode, 222
duplicate, 162

**E**

ECG analysis, automated, 31
date effects, 230
Editing features, 45, 121
editing tool, 125
Equation Generator, 73–81, 185–86
Ethernet card configure, 115
event marker. See markers
e^ power of a data point, 76
exp. See exponential
exponential, 174
exporting data, 48, 153
Expression commands, 76
Expression evaluator, 73–81, 185–86
external trigger, 89
Eye Travel & Position, 252

**F**

FAQ, 226
Fast Fourier transformations. See FFT
Features
  Active Electrodes, 277
Allergies, 269
Amplitude Histogram, 244
Anaerobic Threshold, 275
Animal studies, 263, 273
Auditory Evoked Response (AER), 246, 249
Automate Acquisition Protocols, 261
Automated Data Analysis, 249, 269
Automated Off-line ECG Analysis, 258
Features - continued
Automatic Data Reduction, 257, 259, 261, 263, 265, 267, 269, 273, 281
Autonomic Nervous System Studies, 248
Autonomic Testing, 265
Biomechanics Measurements, 280
Blood Flow, 261
Blood Pressure, 260
Blood Volume, 254
Body Composition Analysis, 251
Breath-By-Breath Respiratory Gas Analysis, 275
Cardiac Output, 250
Cardiology Research, 264
Cell Transport, 270
Cerebral Blood Flow, 268
Chaos Plots, 259
Common Interface Connections, 282
Connect to MP Systems, 282
Control Pumps and Valves, 267
cross- and auto-correlation, 245
Current Clamping, 270
Defibrillation & Electrocautery, 261
Dividing EEG into Specific Epochs, 245
ECG Analysis, 260
ECG Recordings, 12-Lead, 258
ECG Recordings, 6-Lead, 258
EEG Spectral Analysis, 256
Einthoven’s Triangle, 258
EMG and Force, 276
EMG Power Spectrum Analysis, 276
End-tidal CO2, 274
Episode Counting, 245
Ergonomics Evaluation, 279
Event-related Potentials, 245, 247, 248
Evoked Response, 245, 248
Exercise Physiology, 280
External equipment, controlling, 247, 249, 261, 282
Extra-cellular Spike Recording, 247
Facial EMG, 277
FFT & Histograms, 258
FFT for Frequency Analysis, 259
Field Potential Measurements, 267, 271
Fine Wire EMG, 277
Forced Expiratory Flow & Volume, 272
Gait Analysis, 278
Gastric Myoelectric Activity, 262

Visit the online support center at www.biopac.com
<table>
<thead>
<tr>
<th>Feature</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gastric Slow Wave Propagation, 263</td>
</tr>
<tr>
<td>Gastrointestinal Motility Analysis, 263</td>
</tr>
<tr>
<td>Hardware Flexibility, 271</td>
</tr>
<tr>
<td>Heart Rate Variability, 249, 257, 258</td>
</tr>
<tr>
<td>Heart Sounds, 259</td>
</tr>
<tr>
<td>Histogram Analysis, 277</td>
</tr>
<tr>
<td>Imaging Equipment, Interfacing, 277</td>
</tr>
<tr>
<td>Indirect Blood Pressure Recordings, 254</td>
</tr>
<tr>
<td>Integrated (RMS) EMG, 276</td>
</tr>
<tr>
<td>Interface with Existing Equipment, 261, 267</td>
</tr>
<tr>
<td>Interface with Third-party transducer, 282</td>
</tr>
<tr>
<td>Invasive Electrode Measurements, 262</td>
</tr>
<tr>
<td>Ion-selective Micro-electrode Interfacing, 271</td>
</tr>
<tr>
<td>Irritants &amp; Inflammation, 269</td>
</tr>
<tr>
<td>Isolated Inputs &amp; Outputs, 282</td>
</tr>
<tr>
<td>Isolated Lung Studies, 266</td>
</tr>
<tr>
<td>Isometric Contraction, 278</td>
</tr>
<tr>
<td>Isotonic Contraction, 278</td>
</tr>
<tr>
<td>Jewett Sequence, 246</td>
</tr>
<tr>
<td>Langendorff Heart Preparations, 266</td>
</tr>
<tr>
<td>Laser Doppler Flowmetry, 268</td>
</tr>
<tr>
<td>Left Cardiac Work, 250</td>
</tr>
<tr>
<td>Long-term Monitoring, 265</td>
</tr>
<tr>
<td>Lung Volume Measurement, 272</td>
</tr>
<tr>
<td>LVP, 260</td>
</tr>
<tr>
<td>Median &amp; Mean Frequency Analysis, 276</td>
</tr>
<tr>
<td>Micro-electrode signal amplification, 270</td>
</tr>
<tr>
<td>Migrating Myoelectric Complex, 263</td>
</tr>
<tr>
<td>Motor Unit Action Potential, 277</td>
</tr>
<tr>
<td>Movement Analysis, 257</td>
</tr>
<tr>
<td>MRI Applications, 261</td>
</tr>
<tr>
<td>Multi-Channel Sleep Recording, 256</td>
</tr>
<tr>
<td>Nerve Conduction Studies, 246</td>
</tr>
<tr>
<td>Neurology Research, 264</td>
</tr>
<tr>
<td>Noninvasive Cardiac Output, 261, 275</td>
</tr>
<tr>
<td>Noninvasive Electrode Measurements, 262</td>
</tr>
<tr>
<td>Nystagmus Investigation, 252</td>
</tr>
<tr>
<td>Oculomotor Research, 253</td>
</tr>
<tr>
<td>Off-line ECG Averaging, 259</td>
</tr>
<tr>
<td>On-line Analysis, 260, 266</td>
</tr>
<tr>
<td>On-line ECG Analysis, 256, 258</td>
</tr>
<tr>
<td>Orthostatic Testing, 265</td>
</tr>
<tr>
<td>Peripheral Blood Flow, 250</td>
</tr>
<tr>
<td>Peristaltic (Slow Wave) Propagation, 263</td>
</tr>
<tr>
<td>Planted Tissue, 269</td>
</tr>
<tr>
<td>Pressure Volume Loops, 261</td>
</tr>
<tr>
<td>Psychophysiology, 264</td>
</tr>
<tr>
<td>Pulsatile Tissue Studies, 266</td>
</tr>
<tr>
<td>Pulse Rate Measurement, 251</td>
</tr>
<tr>
<td>Pulse Transit Time, 254</td>
</tr>
<tr>
<td>Range of Motion, 278</td>
</tr>
<tr>
<td>Real-time EEG Filtering, 256</td>
</tr>
<tr>
<td>Real-time EEG Filtering, 244</td>
</tr>
<tr>
<td>Recurrent Patterns, 257</td>
</tr>
<tr>
<td>Regional Blood Flow, 255</td>
</tr>
<tr>
<td>Relative BP Measurement, 254</td>
</tr>
<tr>
<td>Remote Monitoring, 279</td>
</tr>
<tr>
<td>Respiration Monitoring, 251</td>
</tr>
<tr>
<td>Respiratory Exchange Ratio, 274</td>
</tr>
<tr>
<td>Rheumatology, 268</td>
</tr>
<tr>
<td>Saccadic Eye Movements, 252</td>
</tr>
<tr>
<td>Sexual Arousal Studies, 249, 254</td>
</tr>
<tr>
<td>Signal Averaging, 246</td>
</tr>
<tr>
<td>Simultaneous Monitoring, 281</td>
</tr>
<tr>
<td>Single Channel Analysis, 271</td>
</tr>
<tr>
<td>Single-fiber EMG, 277</td>
</tr>
<tr>
<td>Software-controlled Stimulator, 246</td>
</tr>
<tr>
<td>Somatosensory Evoked Response, 247</td>
</tr>
<tr>
<td>Spectral Analysis, 244</td>
</tr>
<tr>
<td>Spike Counting, 244, 277</td>
</tr>
<tr>
<td>SpO2 Analysis, 257</td>
</tr>
<tr>
<td>Stand Alone Amplifiers, 282</td>
</tr>
<tr>
<td>Standard Operating Procedures, 261</td>
</tr>
<tr>
<td>Startle Eye Blink Tests, 248</td>
</tr>
<tr>
<td>Startle Response, 277</td>
</tr>
<tr>
<td>Stimulator, software-controlled, 249</td>
</tr>
<tr>
<td>Systemic Vascular Resistance, 250</td>
</tr>
<tr>
<td>Template Analysis, 256, 259</td>
</tr>
<tr>
<td>Tissue Bath Monitoring, 266</td>
</tr>
<tr>
<td>Tissue Conductance Measurement, 271</td>
</tr>
<tr>
<td>Tissue Magnitude &amp; Phase Modeling, 251</td>
</tr>
<tr>
<td>Tissue Resistance &amp; Reactance, 251</td>
</tr>
<tr>
<td>Ussing Chamber Measurements, 270</td>
</tr>
<tr>
<td>Ventricular Late Potentials, 259</td>
</tr>
<tr>
<td>Vestibular Function, 253</td>
</tr>
<tr>
<td>Video Capture, Synchronous, 279</td>
</tr>
<tr>
<td>Visual Attention, 253</td>
</tr>
<tr>
<td>Visual Evoked Response, 247, 249, 253</td>
</tr>
<tr>
<td>VO2 Consumption, 274</td>
</tr>
<tr>
<td>Volume/Flow Loop Relationships, 272</td>
</tr>
<tr>
<td>Working Heart Preparations, 266</td>
</tr>
<tr>
<td><strong>Features - continued</strong></td>
</tr>
<tr>
<td><strong>Tissue Resistance &amp; Reactance, 251</strong></td>
</tr>
<tr>
<td><strong>Ussing Chamber Measurements, 270</strong></td>
</tr>
<tr>
<td><strong>Ventricular Late Potentials, 259</strong></td>
</tr>
<tr>
<td><strong>Vestibular Function, 253</strong></td>
</tr>
<tr>
<td><strong>Video Capture, Synchronous, 279</strong></td>
</tr>
<tr>
<td><strong>Visual Attention, 253</strong></td>
</tr>
<tr>
<td><strong>Visual Evoked Response, 247, 249, 253</strong></td>
</tr>
<tr>
<td><strong>VO2 Consumption, 274</strong></td>
</tr>
<tr>
<td><strong>Volume/Flow Loop Relationships, 272</strong></td>
</tr>
<tr>
<td><strong>Working Heart Preparations, 266</strong></td>
</tr>
<tr>
<td><strong>FFT, 189–93, 230</strong></td>
</tr>
<tr>
<td><strong>File menu commands, 150</strong></td>
</tr>
<tr>
<td><strong>File size, 227, 232</strong></td>
</tr>
<tr>
<td><strong>Filter</strong></td>
</tr>
<tr>
<td>filter Calculation, 72</td>
</tr>
<tr>
<td>filter characteristics, 229</td>
</tr>
<tr>
<td>filter response, 171</td>
</tr>
<tr>
<td>find all, 201</td>
</tr>
<tr>
<td>find peak, 194</td>
</tr>
<tr>
<td>find rate, 205–11</td>
</tr>
<tr>
<td>finite impulse response filters. See FIR filter</td>
</tr>
<tr>
<td>FIR filters, 165, 169, 229</td>
</tr>
<tr>
<td>Firmware Rollback Switch, 241</td>
</tr>
<tr>
<td>Firmware Upgrade, 239</td>
</tr>
</tbody>
</table>
Font, journal, 223
Formula
  Area, 131
  BPM, 132
  Correlation, 133
  Delta, 134
  Delta T/F/X, 134
  Freq (Frequency), 135
  Integral, 136
  Lin_reg (Linear regression), 137
  Mean, 138
  Slope, 139
  Stddev (Standard deviation), 139
Frequency
  Freq measurement, 135
  frequency, Rate calculation, 208
  frequency, horizontal scale, 217
  frequency spectrum (FFT), 192
Frequently asked questions, 226
Function Calculation, 71, 74

G
Getting Started, 22
GLP guidelines, customizing menus for, 26
Graph template files (gtl)
  Open, 151
  Quick Start Files, 53, 151, 242, 243
  Save As, 157
graph window, 34
gray non-selected waves, 222
Grids, 142
  Clinical grid settings, 144
  Display > Show, 142
  Grid Options, 145

H
Hardware. See note on page 10
Help menu, 225
Hemodynamic measurements, 30
high pass filter, 167
high speed acquisitions, 232
histogram, 183
Hold button, SIV, 107
horizontal
  axis, 27, 216
  scale, 41, 42, 122
  scroll bar, 122
hyperbolic
  cosine, 76, 186
  sine, 76, 186
  tangent, 76, 186
I
I/O 15, 111
I/O channels, digital (Manual Control), 111
IBI, 67, 208
IFFT. See inverse FFT
IIR filters, 165, 172, 229
  include
    channel number, 223
    measurement name, 223
    measurement units, 223
INF (measurement value), 126
infinite impulse response filters. See IIR filters
Input Values Setup (SIV), 107
insert waveform, 162
inserting markers, 46, 141
Installation. See note on page 10
Integral
  Integral (measurement), 136
  transformation function, 180
Integrate, on-line calculation, 59
inter-beat interval. See IBI
interpolate, 223
Intraventricular Pressure Wave analysis, 31
inverse FFT, 193
Inverse mean square error, 179

J
Jewett Sequence, ABR testing for, 30
Journal, 47, 130, 163
  Journal preferences, 48, 221, 223

K
K (Constant), Calculate measurement option, 132
Keyboard shortcuts, 118

L
Latency, 89
limit, 175
Lin_reg (linear regression measurement), 137
line plot, 219
linear (FFT option), 191
ln. See natural logarithm
log, 76, 175, 186
long acquisitions, 232
low pass filter, 167, 180
Lung Volume analysis, 31
LVP Analysis, 31

M
Macintosh memory, 36
Macintosh® system requirements, 24
Manual Control (digital I/O), 111
Markers, 46
   Printing markers, 141
Math Calculation, 69–70
Max (measurement), 137
Max T (measurement), 137
Mean
   measurement, 138
   mean removal, 178
   mean square error, 179
   mean value, 56
Means reference, Tracking option, Find Peak, 196
Measurement
   Table of Explanations, 131
   measurement precision, 221
   measurement rows, 221
   measurement windows, 126
   measurements, 45–46, 126
Median (measurement), 138
Median T (measurement), 138
Memory, 36
   Memory (storage option), 84
Menu display, customizing, 233
Min (measurement), 138
Min T (measurement), 138
moving average, 181
MP, data storage option, 84
MP System
   Features, 26
   Overview, 22
   Requirements, 24
MP150 Serial Number, 115
MP150Tools.exe, 239
P
P300 measurements, 198
pad with endpoint/zeros, 189
paste, 159, 161
   paste measurement, 163
   paste wave data, 163
Pause mode (Append to disk), 83
PC Windows® system requirements, 24
PC-compatible files, 151, 155
peak
   peak detect (find rate option), 209
   peak minimum, 208
   Peaks reference, Tracking option, Find Peak, 196
   Peak-to-Peak (P-P measurement), 138
   phase, 191
   phase distortion, 229
   PICT files, 48, 163
   plotting data, 35, 51
   power supply, 228
   P-P (peak-to-peak measurement), 138
   preferences, 163, 221
   Presets, 52
   Organize Channel Presets, 113
   pretrigger, 94
   Printing, 28, 48, 143, 158
   Print Markers, 141
   pulse stimuli, 96–99
Q
Q coefficient, filter setting, 73, 172, 229
Questions, frequently asked, 226
Quick Start template files, 151
Quitting AcqKnowledge, 158
R
RAM, 24
ramp waves, 100
rate calculation, 66–69, 205–11
Rate detector algorithm, 31
Record, 36
   Record/Record last, 82
   Relative mode, 105
   remove
   remove mean, 178, 191
   remove trend, 190
   remove waveform, 162
   remove waveforms, 232
   repeating mode, 92, 113
   resample, 184
   Reset
   Append acquisition button, 83
   reset chart boundaries, size window, 224
reset chart display, 214
Reset, stimulator setup, 104
reset thresholds, Integrate setup, 63
reset trigger, Integrate setup, 63
reset via channel, Integrate setup, 60
round, 76, 186
RS-232/RS-422 signal, 227

S

Safety Notice, 20
Sample (measurement), 139
sample rate, 84–86, 227, 232
  acquisition sample rate, 36
  channel sample rate, 35, 36, 54
stimulation signal output rate, 96
Saving data, 48
  Save (file command), 154
  Save as (File command), 155
  Save once, 36, 82
scaling, 55–56
scope mode, 38
scroll, 42, 113, 121
Select
  channel, 124
  waveform, 124
  select all, 161
Select Network Adapter, 115
selected range measurements, 127
selecting a channel, 44
selecting a waveform, 44
selecting an area, 44, 159
Serial number, MP150, 115
Set
  Set template, 177
  Set wave positions, 215
Setup
  Setup acquisition, 36
  Setup channels, 35, 51, 55, 228
  Setup stimulator, 96
  Setup triggering, 93
Show
  show channel number, SIV, 107
  show labels, SIV, 107
  show min/max, SIV, 107
  show modified input, 189
  Show options (from Display menu), 218
  show units, SIV, 107
  show values, SIV, 52, 107
  signal averaging, See averaging mode
  sine, 76, 175, 186
  size window, 224
  Slope (measurement), 139
  smoothing
  on-line calculation, 65
  transformation function, 181
  Sound, SIV, 108
Specifications. See MP Hardware Guide.pdf
spectral analysis. See FFT
sqrt. See square root
square, 76, 186
  square root, 76, 175, 186
  square waves, 98
Standard deviation (Stddev measurement), 139
starting an acquisition, 37
statistics, 220
status indicator, 37
Stddev (standard deviation measurement), 139
step plot, 219
Stimulator module STM100A, 112
Stimulator setup, 96
Stimulus signal, 88, 90, 96
stop plotting, 232
stopping an acquisition, 37
Summary to Journal, marker menu, 141
T
Tab interval, journal, 223
tangent, 76, 186
template functions, 176
text files, 48, 130, 153–54, 155
Threshold, Find Peak, 196
tile after transformations, 222
tile waveforms, 213
Time
  Expression source, 75
  measurement, 140
time scale, 216, 227
tone stimuli, 99–100
Toolbars, 40, 120
ToolTips, Show (Display Preference), 226
Transform Math commands, 173
Transform menu commands, 164
Triggering, 93
Trouble Shooting, 226
truncate, 76, 186
U
Undo, 160
Use all available memory, 222
User Support System, 18
V
Value (measurement), 140
Values option, 35, 52
variable sample rates, 35, 36, 50, 96

Visit the online support center at www.biopac.com
vertical axis, 27, 56
vertical scale, 43, 123
viewing data, 41
virtual memory, 232
VO₂ measurement, 31

W
Warning
before overwrite data, 113
Hardware not found, 33
Wave color, 216
Waveform
Selecting, 44, 124
Waveform Arithmetic, 132
Waveform math, 187–88
Window
FFT option, 190
Find rate option, 209
Window menu, 225
Windowing functions, 230
Windows Metafile, 163
Windows® system requirements, 24
WMF files, 48
Working in AcqKnowledge, 32

X
X/Y loop area analysis, 30
X-axis T/F/X (measurements), 140
X-Y mode, 38, 39

Z
Zoom forward/back, 214
Zoom tool, 44, 125
COPYRIGHT
Information in this document is subject to change without notice and does not represent a commitment
on the part of BIOPAC Systems, Inc. This manual and the software described in it are copyrighted with
all rights reserved. Under the copyright laws, this manual or the software may not be copied, in whole or
part, without written consent of BIOPAC Systems, Inc., except in the normal use of the software or to
make a backup copy.

The same proprietary and copyright notices must be affixed to any permitted copies as were affixed to
the original. This exception does not allow copies to be made for others, whether or not sold, but all of
the material purchased (with all backup copies) may be sold, given, or loaned to another person. Under
the law, copying includes translating into another language or format. This software is intended for use
on only one machine at a time.

WARRANTY
BIOPAC Systems, Inc. warrants its hardware products against defects in materials and workmanship for
a period of 12 months from the date of purchase. If BIOPAC Systems, Inc. receives notice of such
defects during the warranty period, BIOPAC Systems, Inc. will at its option, either repair or replace the
hardware products that prove to be defective. This warranty applies only if your BIOPAC Systems, Inc.
product fails to function properly under normal use and within the manufacturer’s specifications. This
warranty does not apply if, in the sole opinion of BIOPAC Systems, Inc., your BIOPAC Systems, Inc.
product has been damaged by accident, misuse, neglect, improper packing, shipping, modification or
servicing, by other than BIOPAC Systems, Inc.

Any returns should be supported by a Return Mail Authorization (RMA) number issued by BIOPAC
Systems, Inc. BIOPAC Systems, Inc. reserves the right to refuse to accept delivery of any shipment
containing any shipping carton which does not have the RMA number(s) displayed on the outside. The
Buyer shall prepay transportation charges to the BIOPAC Systems, Inc. designated site.

BIOPAC Systems, Inc. makes no warranty or representation, either expressed or implied, with respect to
this software, its quality, performance, merchantability, or fitness for a particular purpose. As a result, this
software is sold “As is”, and you, the purchaser, are assuming the entire risk as to its quality and
performance.

In no event will BIOPAC Systems, Inc. be liable for direct, indirect, special, incidental, or consequential
damages resulting from any defect in the software or its documentation, even if advised of the possibility
of such damages, or for damage of any equipment connected to a BIOPAC Systems, Inc. product.

TRADEMARKS
AcqKnowledge and MP are trademarks of BIOPAC Systems, Inc.

Windows is a trademark of Microsoft Corporation.

Macintosh and PowerBook are trademarks of Apple Computer, Inc.

ACKNOWLEDGEMENTS
Technical Writer: Jocelyn Mariah Kremer

Cover and frontispiece illustrations: Creative Resource Group, Santa Barbara, CA

This document was created with Microsoft Word for Windows, JASC, Inc. JasCapture, Adobe Photoshop
and Corel Draw 7.


Visit the online support center at www.biopac.com
On the left hand side of your screen is a list of bookmarks. Each one will take you to the corresponding page. Next to some of the bookmarks are arrows or extra tabs to the left of the text, pointing to the right. If you click on the arrow or the tab it will open a list of sub-categories below the main link, and the arrow will be pointing down or the + will change to a -. To close this sub-category list, click the arrow or tab a second time and it will point to the right again or change back to a +.

When the document says: See Page number __ it is most likely a link. Click on the text to display the specified page. Use the double arrow icon (previous view) on the Acrobat toolbar to return to your original page.

Tools>Find (or Control+F) and type in what you are searching for. If the text you are searching for is located more than once, use Find Again (or Control+g) and the display will jump to the next place the text is found in the record. repeat as necessary to locate all occurrences.

At the end of the document is an Index with all the different parts listed alphabetically. When you find the item you are looking for it will give you a page number you can go to. Do this by clicking and holding on the scroll box on the right hand scroll bar and move your mouse up until you get to the page you are looking for. Or you can find the part on the bookmark list to the left and a link will take you directly there.

Return to First Page